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[bookmark: _Ref-473466208][bookmark: _Toc161994645]Universal Profile Overview
Universal Profile provides users with a consolidated view of their personal information, including organizational hierarchy, action items, and more. Users may access their transcript, create goals, and set their career preferences. Managers may view a user's record, assign training, and award badges.
Troubleshooting Information
The following page contains an administrator's guide for configuring the Universal Profile:
· See Configuration Guide - Universal Profile.
[bookmark: _Ref-661908866][bookmark: _Ref-2142895609][bookmark: _Toc161994646]Universal Profile General Preferences
The Universal Profile General Preferences page enables administrators to configure and customize the Universal Profile pages. Administrators can do the following:
· Customize the title of each Universal Profile page and tab to match their organization's nomenclature. 
· Add a description to each Universal Profile page to give users more detailed instructions. 
· Configure the order in which the Universal Profile tabs appear in the navigation to match their own priority and hierarchy of information, ensuring users are directed to appropriate and relevant content. 
· Enable and customize the My Team drop-down, which may appear on all pages of a manager's Universal Profile and the Universal Profile of their direct reports.
· Enable the new User Record page. Once the new User Record is enabled, this section is no longer available.
Universal Profile General Preferences can be configured by organizational unit (OU).
To access Universal Profile General Preferences, go to Admin > Tools > Core Functions > Universal Profile. Then, click the Universal Profile General link in the General Preferences section.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Universal Profile Preferences - Manage
	Enables administrator to access and edit the Universal Profile General Preferences page. This permission can be constrained by OU and User's OU. This is an administrator permission.
	Universal Profile


[image: ]
Language
If multiple languages are enabled for your portal, the page titles, descriptions, and drop-down display title can be localized into other available languages. To translate the text fields into other languages, select the appropriate language from the Language drop-down in the upper-right corner. By default, the default language of the administrator is selected.
Pages
The Pages section enables administrators to define the page title and description for each page in the Universal Profile in order to match their organization's nomenclature. In addition, administrators can determine the order in which pages appear within the Universal Profile to match the organization's priority and hierarchy of information.
Order
The administrator can drag and drop the pages to determine the order in which the pages appear in the navigation. The page at the top of the list is the Universal Profile homepage. When a user clicks their own name or picture within Universal Profile, they are taken to their own homepage. When a user clicks the name or picture of another user within Universal Profile, they are taken to the user's Bio - About page.
The administrator can also drag and drop the tabs within a page, if applicable, to determine the order in which the tabs appear within the page. The tab at the top of the list appears as the first tab.
Page
The Page column displays all of the default page titles. The following pages may be available:
· Bio - The following tabs are located within the Bio page:
· About - This tab is available to all organizations using the Universal Profile.
· Resume - This tab is only available if Bio - Resume is enabled.
· Career Preferences - This tab is only available if Bio - Career Preferences is enabled.
· Volunteer - This tab is only available if Bio - Volunteer is enabled.
· Onboarding - This tab is only available for portals with Onboarding enabled. This tab displays an applicant's onboarding workflows. The tab is available to recruiters who have access to the applicant's profile and permission to view onboarding for an applicant. This tab is also available to recruiters who have permission to manage employee onboarding.
· Feedback - This page is only available if Universal Profile - Feedback is enabled.
· See the Description section below for important information on adding images to the Feedback page description.
· Actions - This page is only available if Universal Profile - Actions is enabled.
· Transcript - This page is only available if Universal Profile - Transcript is enabled.
· Snapshot - This page is only available if Universal Profile - Snapshot is enabled.
Title
The Title column enables administrators to customize the title that displays on each page within Universal Profile. 
By default, the default page titles appear in the field. To customize the page title, enter the new title in the field, up to 100 characters. The titles that are entered appear at the top of the corresponding pages and in the navigation in Universal Profile.
· Bio - About - The name of the About tab can only be customized in Bio About Preferences. See Bio About Preferences on page 115 for additional information.
· Bio - Resume - The name of the Resume tab can only be customized in Bio Resume and Career Preferences. See Bio Resume and Career Center Preferences (by Division) on page 172 for additional information.
· Bio - Career Preferences - The name of the Career Preferences tab can only be customized in Bio Resume and Career Preferences. See Bio Resume and Career Center Preferences (by Division) on page 172 for additional information.
· Bio - Onboarding - The name of the Onboarding tab cannot be modified.
· Transcript - The name of the Transcript page can only be customized in Transcript Preferences. See Transcript Preferences on page 405 for additional information.
Title Example:
[image: ]
Description
The Description column enables administrators to customize the description that displays on each page within Universal Profile. 
By default, there is no description for each page. To customize the page description, enter the description in the field. This field contains basic formatting tools and accepts HTML. This field has no character limit. The descriptions that are entered appear below the page header or at the top of the tab, when applicable. Note: The description cannot be customized for the Onboarding tab.
· Feedback - If you are adding images to the Feedback page description, it is important to ensure that any images you add respond to different devices' resolution. To do this, be sure to add width="100%" to the image src (e.g., <img src=http://www.123.com/img/abc.jpg" width="100%" />). If you need to specify the width in pixels, be aware that the image will not be responsive when viewed on some devices. If you are adding an image that is smaller than the resolution size, it will be pixelated.
· Transcript - The description on the Transcript page can only be customized in Transcript Preferences. See Transcript Preferences on page 405 for additional information.
Page Description Example:
[image: ]
Tab Description Example:
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My Team Dropdown
This setting controls the View Team button on the user's Universal Profile pages. By clicking this button, a View Team flyout allows managers, approvers, and custom relationships to quickly navigate between direct reports and dotted-line reports. When enabled, the View Team flyout is available to managers and dotted line managers on all pages of their Universal Profile and the Universal Profile of their direct, indirect, and dotted line reports. This flyout displays the manager's reports visually.
My Team Dropdown - Enable Dropdown
This option is selected by default. When this option is selected, the My Team drop-down may be available to managers, approvers, and custom relationships in the selected division.
My Team Dropdown - Add Relationship
The My Team drop-down can be used by managers, approvers, and active custom employee relationships to quickly view and navigate to their direct and indirect reports within Universal Profile. 
When an employee relationship is added to the My Team drop-down, the relationship will have access to the My Team drop-down. By default, only the Manager relationship is configured to use the My Team drop-down.
To enable additional relationships to use the My Team drop-down, select the appropriate relationship from the drop-down. Then, select the Add button. If the My Team drop-down is enabled, at least one relationship must be added to the drop-down.
My Team Dropdown - Employee Relationship Table
The Employee Relationship table displays all of the employee relationships that are able to use the My Team drop-down to view their team.
· Dropdown Display Title - This field enables administrators to configure the text that displays on the My Team drop-down if the drop-down is enabled for the OU. This field is required for each relationship, and the character limit for this field is 50.  If multiple languages are enabled for your portal, select the Translate icon to translate the field into other available languages. 
· Remove from Dropdown [image: ] - Select this icon to remove the role from the My Team drop-down.
My Team Dropdown - Modify Employee Relationship Order
If the user serves in multiple roles that are available within the My Team drop-down, then the user can select a specific role and view the reports that are associated with that role.
Within the Employee Relationship table, the administrator can drag and drop the employee relationships to determine the order in which the relationships appear in the drop-down menu when the user is selecting a role. The first relationship that is available to the user is the role that is selected by default in the My Team drop-down.
New User Record Enablement
This section enables administrators to activate the new User Record page in their portal. Once the new User Record is enabled, this section is no longer available. Note: In the May '17 Release, all clients that have not self-activated the new User Record will automatically be upgraded.
To enable the User Record redesign, select the Accept & Activate button. Once activated, the new User Record redesign is enabled, and the new permissions are automatically added to the Security Roles where the existing permissions being deprecated are found. It may take some time for the changes to take full effect.
Note: Once the new redesign is enabled, organizations cannot revert to the existing User Record user interface. Also, it is not possible to have the old and new User Record enabled at the same time.
· Administrators who previously had the Users - View Core Information and Edit Custom Fields permission are automatically assigned the following permissions:
· Universal Profile - User Record - Edit Users
· Universal Profile - User Record - View Users
· Users - Edit Custom Field Information
· Users - View Custom Field Information
· Users - View General Information
· Administrators who previously had the Users - Edit Core Information permission are automatically assigned the following permissions:
· Universal Profile - User Record - Create Users
· Users - Edit General Information
Overwrite Settings
Select this option to overwrite custom settings for child division OUs. If you overwrite custom settings for child division OUs, the selected settings are applied to both new and existing child OUs. Any previously customized child OUs are updated with the selected settings.
· If there are no customizations to the child OU, then the parent OU customizations are applied to all child OUs.
· Overwrite custom settings checkbox setting
· If this option is selected, all child OU customizations are deleted from the database, which means the parent OU customizations will be applied to new and existing child OUs.
· If this option is unselected, all existing child OU customizations will remain unchanged, and any new child OUs will inherit the parent OU customizations by default.
· If a child OU has been customized to display any widgets, then regardless of the parent OU customizations, the child OU customizations are applied.
· If a child OU has been customized to hide all widgets, then parent OU customizations will take precedence and will be applied.
Submit or Cancel
Click Submit to submit any unsaved changes, or click Cancel to discard any unsaved changes.
[bookmark: _Toc161994647]Universal Profile - My Absence Home
For organizations that have enabled the e-days Absence Management integration, a My Absence Home page is available in the Universal Profile. This page enables users to view their entitlement balances, such as Vacation balances and Sick Day balances. Users can also request an absence from this page.
The various widgets that appear on this page display the different entitlement types that are available to the user, and vary between organizations. Entitlement balances display as either days or hours depending on how they are displayed in e-days. 
[bookmark: concept3]To access the My Absence Home page, go to Home > Universal Profile. Then, click the Absence tab. Note: The location of this link is configurable by your system administrator.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Absence Management – Absence Home – View
	Users with this permission can view the Absence Home page from the Universal Profile. Currently, this permission should only be used by organizations that are using the e-days Absence Management integration. This permission can be constrained by OU, User's OU, User, and User Self and Subordinates.
	Limited Use/Obsolete


[image: ]
Request Absence
Select the Request Absence button to submit a request for time off. This opens the e-days system and automatically logs the use.
Widgets
The various widgets that appear on this page display the different entitlement types that are available to the user, and vary between organizations. Entitlement balances display as either days or hours depending on how they are displayed in e-days. 
My Requests
This section displays the user's previously requested absences, including the status of each request.
[bookmark: _Toc161994648]Universal Profile - Actions Overview
The Actions page is a part of the Universal Profile and it displays all of a user's action items. This may include performance, learning, recruiting, and other action items.
To access the Action Items, go to Home > Universal Profile. Then, click the Actions tab. 
To access another user's Universal Profile - Bio page, select the user's photograph from any Universal Profile or Global Search page. From there, you can access the user's Action Items page by clicking the Action Items tab. Users can view the Action Items page of other users who are within their permission to view the Action Items page.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Action Items - EPM
	Grants ability to view and take action upon Performance (EPM) items on the Action Items page and in the Your Action Items widget. This permission can be constrained by OU, User's OU, User's Self, and User's Self and Subordinates. This is an end user permission.
	Universal Profile



	Action Items - Forms
	Grants ability to view Form actions via the Universal Profile - Actions page or the Welcome/Custom page Actions widget. This permission cannot be constrained.
	Universal Profile



	Action Items - LMS
	Grants ability to view and take action upon Learning (LMS) items on the Action Items page. This permission can be constrained by OU, User's OU, User's Self, and User's Self and Subordinates. This is an end user permission.
	Universal Profile



	Action Items - View
	Grants ability to view action items on the Action Items page and in the Your Action Items widget. Users without this permission cannot access the Action Items page. This permission can be constrained by Employee Relationship, OU, User's OU, User's Self and Subordinates, and User's Self. This is an end user permission.
	Universal Profile
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View Team
The View Team flyout allows managers, approvers, and custom relationships to quickly navigate between subordinates' profiles and transcripts. When enabled, the View Team flyout is available to managers and dotted line managers on all pages of their Universal Profile and the Universal Profile of their subordinates. This flyout displays the manager's reports visually.
The View Team button displays if enabled in the portal. Administrators may enable or disable this flyout via the My Team Dropdown section within Universal Profile General Preferences. See Universal Profile General Preferences on page 2 for additional information.
See Universal Profile - View Team Flyout on page 648 for additional information.
Options
An Options drop-down may be available on various pages of the Universal Profile. This menu may include options such as Assign Training and Create Goal. See Universal Profile Options Drop-down Overview on page 653 for additional information.
Requests Tab
For users with permission to view request items and request forms, Actions page is separated into an Actions tab and a Requests tab. From the Requests tab, approvers can access their pending approval requests, view completed requests, and view approval progress. See Universal Profile - Requests Tab on page 74 for additional information.
Filter Options
At the top of the page, the action item type filter allows users to filter the action items that appear on the page.
Sort Options
At the top of the page, the sort option allows users to determine the order in which action items are displayed on the page. The following options are available:
· By due date - This option sorts action items by due date, displaying the most recent due dates at the top. Action items that have the same due date are sorted alphabetically and then by assignment date. The action items are placed into the following due date groups:
· Due Today - This contains all items that are past due or due today.
· Due Tomorrow - This contains all items that are due on the next day.
· Due within the next week - This contains all items that are due within the next seven days but are not past due or due today or tomorrow.
· Due Later - This contains all items that are due after seven days from the current date.
· By type - This option sorts action items by type of action item in alphabetical order. Action items with the same type are sorted by due date, displaying the most recent due dates at the top. Action items that have the same type and due date are sorted alphabetically.
· By priority - This option sorts action items by priority, displaying the priority action items first. Action items are then sorted by due date with the most recent due dates at the top. Action items with the same priority and due date are sorted alphabetically. The action items are placed into the following priority groups:
· Flagged
· Not Flagged
· By assignment date - This option sorts action items by assignment date, displaying the oldest assignment dates at the top of the page. Action items that have the same assignment date are sorted alphabetically. The action items are placed into the following assignment date groups:
· Assigned more than a month ago - This contains all items that have an assignment date that is more than 30 days from the current date.
· Assigned in the last month - This contains all items that have an assignment date that is within 30 days of the current date, but not within the past seven days, including today.
· Assigned this week - This contains all items that have an assignment date that is within seven days of the current date.
Priority Flag
This button allows users to mark action items as high priority. Also, action items can be filtered by priority from the Sort drop-down at the top of the page. When the priority flag is not selected, it is gray. When the priority flag is selected, the action item is high priority and the flag is red.
Note: If the action items are already sorted by priority in the list, adjusting the priority setting will adjust the flag either to be red or gray but it will not automatically move the action items to the corresponding priority group (flagged, not flagged). To reflect the adjusted priority of action items in the corresponding priority group, refresh the page.
Action Type Conventions
Each action item type follows a set of conventions. The following action item types may be available:
[bookmark: _Toc161994649]Action Items - Compensation
For organizations using the Compensation module, the compensation action items may appear on the Action Items page.
To access the Action Items, go to Home > Universal Profile. Then, click the Actions tab. 
View Team
The View Team flyout allows managers, approvers, and custom relationships to quickly navigate between subordinates' profiles and transcripts. When enabled, the View Team flyout is available to managers and dotted line managers on all pages of their Universal Profile and the Universal Profile of their subordinates. This flyout displays the manager's reports visually.
The View Team button displays if enabled in the portal. Administrators may enable or disable this flyout via the My Team Dropdown section within Universal Profile General Preferences. See Universal Profile General Preferences on page 2 for additional information.
See Universal Profile - View Team Flyout on page 648 for additional information.
Options
An Options drop-down may be available on various pages of the Universal Profile. This menu may include options such as Assign Training and Create Goal. See Universal Profile Options Drop-down Overview on page 653 for additional information.
Compensation Task Action Item Details
When a compensation task action item is displayed on the Action Items page, the following is displayed for each action item:
· Color Strip - The left edge of the action item icon is color coded to represent proximity to the due date of the action item. For example, if the action item due date is past due, then the color strip is red to indicate that action is required immediately. If an action item due date is not eminent, then the color strip is green to indicate that action is not required immediately. See the Color Strip Key section below for additional information.
· Title - This displays the action item title. If the user is a co-planner for the compensation task, then the task title indicates this. Click the action item title to open the Compensation Task Details page for the appropriate compensation task.
· Assignment Date - This displays the date on which the task was started.
· Due Date - This displays the action item due date.
· Status - This displays the current status of the action item. See the Compensation Task Statuses and Actions section below for additional information.
· Priority Flag - This button allows users to mark action items as high priority. Priority can be helpful as a visual indicator to users. Also, action items can be filtered by priority from the Sort drop-down at the top of the page. When the priority flag is not selected, it is gray [image: ]. When the priority flag is selected, the action item is high priority and the flag is red [image: ].
Action Item Options
The following options are available from the action item drop-down menu:
· Complete - Click this option to open the Compensation Task Details page for the appropriate task.
· View History - Click this option to open the Compensation Plan History pop-up.
Compensation Task Statuses and Actions
	Status
	Actions
	Action Behavior

	Not Started
	Complete
	If the user has other compensation managers as subordinates, then this redirects the user to the Compensation Task Details page with the Roll-up Summary tab selected by default.
If the user does not have other compensation managers as subordinates, then this redirects the user to the Compensation Task Details page with the Compensation Plan tab selected by default.

	In Progress
	Complete
	If the user has other compensation managers as subordinates, then this redirects the user to the Compensation Task Details page with the Roll-up Summary tab selected by default.
If the user does not have other compensation managers as subordinates, then this redirects the user to the Compensation Task Details page with the Compensation Plan tab selected by default.


Compensation tasks in Complete, Expired, or Pending Approval status do not appear on the Action Items page.
Color Strip Key
The following colors are available:
· Red - Due today or past due
· Orange - Due within the next seven days, not including today
· Green - Due after seven days
[bookmark: _Toc161994650]Action Items - Feedback
A user's feedback requests appear on the Actions tab within Universal Profile. This enables users to easily respond to a feedback request or decline to respond to the request.
To access the Action Items, go to Home > Universal Profile. Then, click the Actions tab. 
To view feedback requests, go to Home > Universal Profile > Actions.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Action Items - EPM
	Grants ability to view and take action upon Performance (EPM) items on the Action Items page and in the Your Action Items widget. This permission can be constrained by OU, User's OU, User's Self, and User's Self and Subordinates. This is an end user permission.
	Universal Profile


View Team
The View Team flyout allows managers, approvers, and custom relationships to quickly navigate between subordinates' profiles and transcripts. When enabled, the View Team flyout is available to managers and dotted line managers on all pages of their Universal Profile and the Universal Profile of their subordinates. This flyout displays the manager's reports visually.
The View Team button displays if enabled in the portal. Administrators may enable or disable this flyout via the My Team Dropdown section within Universal Profile General Preferences. See Universal Profile General Preferences on page 2 for additional information.
See Universal Profile - View Team Flyout on page 648 for additional information.
Options
An Options drop-down may be available on various pages of the Universal Profile. This menu may include options such as Assign Training and Create Goal. See Universal Profile Options Drop-down Overview on page 653 for additional information.
Feedback Request Action Item Details
When a feedback request is displayed in Universal Profile: Actions, the following is displayed for each request:
· Color Strip - The left edge of the action item icon is color coded to represent proximity to the due date of the action item. For example, if the action item due date is past due, then the color strip is red to indicate that action is required immediately. If an action item due date is not eminent, then the color strip is green to indicate that action is not required immediately. See the Color Strip Key section below for additional information.
· Title - This displays the action item title. Click the action item title to open the feedback request.
· Due Date - This displays the due date for the feedback request. Feedback requests currently do not have due dates, so "No Due Date" is displayed.
· Status - This displays the current status of the request.
· Submitted By - This displays the name of the user who submitted the feedback request. This is only displayed if the feedback is requested by someone other than the feedback recipient.
Note: When accessing pending feedback requests from the Inbox Widget, users are redirected to the Universal Profile: Actions page with the actions filtered to display only feedback requests.
Action Item Options
The following options may be available from the action item drop-down menu for feedback request recipients:
· Launch - Select this option to open the feedback request.
· Decline to Respond - Select this option to remove the feedback request from the Actions page without providing feedback. The Status of the feedback request is changed to Deleted when viewed on the Feedback Requests page.
Color Strip Key
The following colors are available:
· Red - Due today or past due
· Orange - Due within the next seven days, not including today
· Green - Due after seven days
[bookmark: _Toc161994651][bookmark: _Ref-1280242188]Action Item - Forms
For organizations using Forms, the Action Items page displays the form tasks for the user to complete. 
Forms are available to organizations that are using Onboarding or Cornerstone HR. For information on Training Forms, select the following link: See Training Forms Administration.
To access the Action Items, go to Universal Profile > Actions. Note: The location of this link is configurable by your system administrator.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Action Items - View
	Grants ability to view action items on the Action Items page and in the Your Action Items widget. Users without this permission cannot access the Action Items page. This permission can be constrained by Employee Relationship, OU, User's OU, User's Self and Subordinates, and User's Self. This is an end user permission.
	Universal Profile



	Action Items - Forms
	Grants ability to view Form actions via the Universal Profile - Actions page or the Welcome/Custom page Actions widget. This permission cannot be constrained.
	Universal Profile



	Form Completion - View and Edit OU and Employee Relation Fields
	Allow users to view and modify organizational unit (OU) and employee relation fields when completing a form that contains the fields. The constraints on this permission determine which fields the user can view and edit when completing a form. This permission can be constrained by OU, User's OU, User, User Self and Subordinates, and User Subordinates. This is an end user permission.
	Core



	Snapshot Main - View
	Enables user to view the Snapshot page for users within their permission constraints. This permission can be constrained by Employee Relationship, OU, User's OU, User Self and Subordinates, User, User's Self, User's Manager, User's Superiors, User's Subordinates, and User's Direct Reports. Best Practice: For most users, this permission should be constrained by User Self and Subordinates.
	Universal Profile


View Team
The View Team flyout allows managers, approvers, and custom relationships to quickly navigate between subordinates' profiles and transcripts. When enabled, the View Team flyout is available to managers and dotted line managers on all pages of their Universal Profile and the Universal Profile of their subordinates. This flyout displays the manager's reports visually.
The View Team button displays if enabled in the portal. Administrators may enable or disable this flyout via the My Team Dropdown section within Universal Profile General Preferences. See Universal Profile General Preferences on page 2 for additional information.
See Universal Profile - View Team Flyout on page 648 for additional information.
Options
An Options drop-down may be available on various pages of the Universal Profile. This menu may include options such as Assign Training and Create Goal. See Universal Profile Options Drop-down Overview on page 653 for additional information.
Form Task Conditions
Conditions for the task to appear on the Action Items page:
· [bookmark: concept9]The user must meet the availability criteria for the form.
· The task start date or assignment date has been reached.
· The task is not expired.
· The Employee Onboarding functionality is enabled for the portal, allowing users to access and launch onboarding tasks.
· The visibility of onboarding tasks on the Actions tab is controlled by backend settings that are disabled by default. To enable the settings, contact Global Customer Support.
Form Task Action Item Details
When an event action item is displayed on the Action Items page, the following is displayed for each action item:
· Color Strip - The left edge of the action item icon is color coded to represent proximity to the due date of the action item. For example, if the action item due date is past due, then the color strip is red to indicate that action is required immediately. If an action item due date is not eminent, then the color strip is green to indicate that action is not required immediately. See the Color Strip Key section below for additional information.
· Title - This displays the action item title. Click the action item title to perform an action that corresponds with the current status.
· Due Date - This displays the action item due date.
· Status - This displays the current status of the action item.
· Priority Flag - This button allows users to mark action items as high priority. Priority can be helpful as a visual indicator to users. Also, action items can be filtered by priority from the Sort drop-down at the top of the page. When the priority flag is not selected, it is gray [image: ]. When the priority flag is selected, the action item is high priority and the flag is red [image: ].
Action Item Options
The following options are available from the action item drop-down menu:
· Launch - Click this option to open the Training Details page for the form. This page provides details about the form and includes an option to launch the form. click the Launch button to open and complete the form. Users can save forms that are partially completed and continue them at a later time. Once the form is completed, click the Submit button. Once the form is submitted, the form is removed from the Actions tab. The Form Complete email is triggered, if the email is configured and active in Email Management. For onboarding form tasks, if there are dependent tasks, then the applicant must complete the dependent tasks in order to complete the workflow. Completed tasks are removed from the Actions tab.
· Open - This option displays for uploaded file tasks. Uploaded file tasks require the user to fill out an uploaded document, and then submit the completed document. Click the Open option in the drop-down to open the uploaded file task document and complete the document. Once the document is completed, the applicant can click the Mark Complete option in the options drop-down for the task and mark the task as complete. Completed tasks are removed from the Actions tab. If there are dependent tasks, then the applicant must complete the dependent tasks in order to complete the workflow.
Note: If the user does not meet the availability criteria for the form, then a Restricted Access page displays. Users cannot launch forms for which they do not meet the availability criteria defined by the administrator.
Color Strip Key
The following colors are available:
· Red - Due today or past due
· Orange - Due within the next seven days, not including today
· Green - Due after seven days
[bookmark: _Toc161994652][bookmark: concept10]Action Item - Integration Task
Integration tasks are launched from the Actions tab in Universal Profile.
Note: For I-9 tasks, the tasks are available to the user and the employer. Users complete Section 1 of the form, while employers complete Section 2.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Action Items - Employee Onboarding
	Grants ability to view Onboarding actions via the Universal Profile - Actions page or the Welcome/Custom page Actions widget. This permission cannot be constrained. This is an end user permission.
	Universal Profile


View Team
The View Team flyout allows managers, approvers, and custom relationships to quickly navigate between subordinates' profiles and transcripts. When enabled, the View Team flyout is available to managers and dotted line managers on all pages of their Universal Profile and the Universal Profile of their subordinates. This flyout displays the manager's reports visually.
The View Team button displays if enabled in the portal. Administrators may enable or disable this flyout via the My Team Dropdown section within Universal Profile General Preferences. See Universal Profile General Preferences on page 2 for additional information.
See Universal Profile - View Team Flyout on page 648 for additional information.
Options
An Options drop-down may be available on various pages of the Universal Profile. This menu may include options such as Assign Training and Create Goal. See Universal Profile Options Drop-down Overview on page 653 for additional information.
I-9 Tasks
Launch I-9 Task - User
Users can launch tasks for completing the I-9 form from the Actions tab on the Universal Profile page. Launching the task takes the user to the integration partner website.
On the Actions tab, the task title and status display. For E-Verify integrations, a due date displays below the task title on the Actions tab. The due date is the target start date for the onboarding employee.
To launch the task, click the Launch option. This opens the integration partner website in a new window for the user to complete the task. While the page is loading, do not navigate away from the page or the task will not fully load.
If an error occurs when attempting to launch the task, a message displays that explains the error.
To view a sample I-9 form task of Form I-9 Section 1 through an integration with Tracker, click the following image: 
[image: ]
Launch I-9 Task - Employer
Employers can launch I-9 form tasks from the Actions tab on the Universal Profile page. Launching the task takes the employer to the integration partner website where they can complete Section 2 of the form for the specific user. The task is available once the user completes and submits Section 1 of the form.
On the Actions tab, the task title and status display. For E-Verify integrations, a due date displays below the task title on the Actions tab. The due date is the date when the next action is due for the employer.
To launch the task, click the Launch option. This opens the integration partner website in a new window for the user to complete the task. While the page is loading, a Back button displays that allows the employer to return to the Actions tab without opening the task. If an error occurs when attempting to launch the task, a message displays that explains the error.
To view a sample I-9 form task of Form I-9 Section 2 through an integration with Tracker, click the following images: 
[image: ]
[image: ]
W-4 Form Tasks
Users launch W-4 forms from the Actions tab in Universal Profile. The form opens in a new window that logs the user into CIC Plus Paperless Employee via Single Sign-On (SSO).
[bookmark: concept11]Note: If the CIC Plus integration is inactivated, then the W-4 Form task is hidden for users on the Actions tab. Integrations can be inactivated by the administrator in Recruiting and Onboarding Integrations Preferences.
Task Details
The task title, status, and due date display for the task. By default, the due date is the new hire's start date.
Launch Task
To launch the task, click the Launch option. This opens PaperlessEmployee.com, which is the CIC Plus integration partner website. The site opens in a new window for the user to complete the task.
If an error occurs when attempting to launch the task, a message displays that explains the error.
Task Completion
Once task completion is determined by CIC Plus, the task is automatically marked as complete for the user. This triggers the Integration Task Completed email, if enabled by the administrator and active in Email Management.
Make Changes to W-4 Form
Once the W-4 form is submitted by the user, the user cannot re-open the form within the portal to make changes. However, if necessary, the user to access CIC Plus separately to make updates.
[bookmark: _Toc161994653]Action Items - Learning
For organizations using the Learning module, the following learning action items appear on the Action Items page:
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Local Network Player - Launch Courses Offline Through the Network Player
	Enables users to see the Launch Locally link on their transcript for courses that have been downloaded and can be launched through the local network. This permission cannot be constrained. This permission is recommended for end users of the LMS.
	Learning


Note: Level 3 Evaluations only display to users on the Scheduled Tasks page and widget. Level 3 evaluations do NOT display on the Universal Profile - Actions page.
Action Item - Certification
Conditions for the LO to appear on the Action Items page:
· The learning object (LO) must be active on the user's transcript. Archived LOs do not appear, regardless of status.
· If a start date is defined, the LO is only visible if the start date is the current date or has passed. If the start date has not yet passed, then the LO does not appear.
When a certification action item is displayed on the Action Items page, the following is displayed for each action item:
· Color Strip - The left edge of the action item icon is color coded to represent proximity to the due date of the action item. For example, if the action item due date is past due, then the color strip is red to indicate that action is required immediately. If an action item due date is not eminent, then the color strip is green to indicate that action is not required immediately. See the Color Strip Key section below for additional information.
· Title - This displays the action item title. Click the action item title to perform an action that corresponds with the current status. For example, if the status is Approved, then clicking the title registers the user in the LO or redirects them to the shopping cart, if necessary. See the Certification Statuses and Actions section below for additional information.
· Due Date - This displays the action item due date.
· Expiration Date - This displays the date on which the certification expires.
· Status - This displays the current status of the action item.
· Priority Flag - This button allows users to mark action items as high priority. Priority can be helpful as a visual indicator to users. Also, action items can be filtered by priority from the Sort drop-down at the top of the page. When the priority flag is not selected, it is gray [image: ]. When the priority flag is selected, the action item is high priority and the flag is red [image: ].
The following options are available from the action item drop-down menu:
· Action - The option that appears first is dependent upon the current status of the LO. See the Certification Statuses and Actions section below for additional information.
· View Details - Click this option to view the Transcript Details pop-up.
Certification Statuses and Actions
	Status
	Actions
	Action Behavior

	Certified (Renewal in Progress
	Manage
	Redirects the user to the Training Details page

	In Progress
	Manage
	Redirects the user to the Training Details page

	Past Due (Appended)
	Same as primary status actions
	This is dependent upon the primary status


Color Strip Key
The following colors are available:
· Red - Due today or past due
· Orange - Due within the next seven days, not including today
· Green - Due after seven days
Action Item - Curriculum
Conditions for the LO to appear on the Action Items page:
· The learning object (LO) must be active on the user's transcript. Archived LOs do not appear, regardless of status.
· If registration is closed and there are no actions the user can take, then the LO does not appear.
· If a start date is defined, the LO is only visible if the start date is the current date or has passed. If the start date has not yet passed, then the LO does not appear.
· If the link expiration date has passed, the LO does not appear.
When a curriculum action item is displayed on the Action Items page, the following is displayed for each action item:
· Color Strip - The left edge of the action item icon is color coded to represent proximity to the due date of the action item. For example, if the action item due date is past due, then the color strip is red to indicate that action is required immediately. If an action item due date is not eminent, then the color strip is green to indicate that action is not required immediately. See the Color Strip Key section below for additional information.
· Title - This displays the action item title. Click the action item title to perform an action that corresponds with the current status. For example, if the status is Approved, then clicking the title registers the user in the LO or redirects them to the shopping cart, if necessary. See the Curriculum Statuses and Actions section below for additional information.
· Due Date - This displays the action item due date.
· Status - This displays the current status of the action item.
· Priority Flag - This button allows users to mark action items as high priority. Priority can be helpful as a visual indicator to users. Also, action items can be filtered by priority from the Sort drop-down at the top of the page. When the priority flag is not selected, it is gray [image: ]. When the priority flag is selected, the action item is high priority and the flag is red [image: ].
The following options are available from the action item drop-down menu:
· Action - The option that appears first is dependent upon the current status of the LO. See the Curriculum Statuses and Actions section below for additional information.
· Open Curriculum - Click this option to navigate to the Curriculum Details page for the appropriate curriculum. This option may be the first option, depending upon the current status of the LO. This option is only available if the user is in a Registered or In Progress status.
Curriculum Statuses and Actions
	Status
	Actions
	Action Behavior

	Approved
	Register
	Register the user or redirect the user to the shopping cart, if necessary

	Pending Payment
	None/"Pay"
	Redirect the user to the shopping cart

	Registered
	Open Curriculum
	Redirect the user to the Curriculum Details page

	Registered (Level 2 Evaluation)
	Take Pre-Test
	Launch the pre-test

	Registered (Level 3 Evaluation)
	Evaluate Behavior
	Launch evaluation

	In Progress
	Open Curriculum
	Redirect the user to the Curriculum Details page

	Pending Evaluation (Level 1)
	Evaluate
	Redirect the user to the Evaluation page

	Pending Evaluation (Level 2)
	Take Post-Test
	Launch the post-test

	Pending Acknowledgment
	Acknowledge
	Redirect the user to the Acknowledgment Form page

	Pending Completion Signature
	Complete
	Redirect the user to the Training Details page

	Past Due (Appended)
	Same as primary status actions
	This is dependent upon the primary status


Color Strip Key
The following colors are available:
· Red - Due today or past due
· Orange - Due within the next seven days, not including today
· Green - Due after seven days
Action Item - Event
Conditions for the LO to appear on the Action Items page:
· The learning object (LO) must be active on the user's transcript. Archived LOs do not appear, regardless of status.
· If the user is able to register for multiple sessions, then the event does not appear after one session has been selected.
· An event does not appear if the event is assigned, but the manager must select the session for the user.
· An event does not appear if it is in a Denied, Withdrawn, or No Show status.
· If the link expiration date has passed, the LO does not appear.
When an event action item is displayed on the Action Items page, the following is displayed for each action item:
· Color Strip - The left edge of the action item icon is color coded to represent proximity to the due date of the action item. For example, if the action item due date is past due, then the color strip is red to indicate that action is required immediately. If an action item due date is not eminent, then the color strip is green to indicate that action is not required immediately. See the Color Strip Key section below for additional information.
· Title - This displays the action item title. Click the action item title to perform an action that corresponds with the current status. For example, if the status is Approved, then clicking the title registers the user in the LO or redirects them to the shopping cart, if necessary. See the Event Statuses and Actions section below for additional information.
· Due Date - This displays the action item due date.
· Status - This displays the current status of the action item.
· Priority Flag - This button allows users to mark action items as high priority. Priority can be helpful as a visual indicator to users. Also, action items can be filtered by priority from the Sort drop-down at the top of the page. When the priority flag is not selected, it is gray [image: ]. When the priority flag is selected, the action item is high priority and the flag is red [image: ].
The following options are available from the action item drop-down menu:
· Action - The option that appears first is dependent upon the current status of the LO. See the Event Statuses and Actions section below for additional information.
· View Details - Click this option to view the Transcript Details pop-up.
Event Statuses and Actions
	Status
	Actions
	Action Behavior

	Approved
	Select Session
	Open the pop-up to display the available sessions for the event

	Not Started
	Select Session
	Open the pop-up to display the available sessions for the event


Color Strip Key
The following colors are available:
· Red - Due today or past due
· Orange - Due within the next seven days, not including today
· Green - Due after seven days
Action Item - External Training
Conditions for the LO to appear on the Action Items page:
· The learning object (LO) must be active on the user's transcript. Archived LOs do not appear, regardless of status.
· If registration is closed and there are no actions the user can take, then the LO does not appear.
· If a start date is defined, the LO is only visible if the start date is the current date or has passed. If the start date has not yet passed, then the LO does not appear.
When an external training action item is displayed on the Action Items page, the following is displayed for each action item:
· Color Strip - The left edge of the action item icon is color coded to represent proximity to the due date of the action item. For example, if the action item due date is past due, then the color strip is red to indicate that action is required immediately. If an action item due date is not eminent, then the color strip is green to indicate that action is not required immediately. See the Color Strip Key section below for additional information.
· Title - This displays the action item title. Click the action item title to perform an action that corresponds with the current status. For example, if the status is Approved, then clicking the title registers the user in the LO or redirects them to the shopping cart, if necessary. See the External Training Statuses and Actions section below for additional information.
· Due Date - This displays the action item due date.
· Status - This displays the current status of the action item.
· Priority Flag - This button allows users to mark action items as high priority. Priority can be helpful as a visual indicator to users. Also, action items can be filtered by priority from the Sort drop-down at the top of the page. When the priority flag is not selected, it is gray [image: ]. When the priority flag is selected, the action item is high priority and the flag is red [image: ].
The following options are available from the action item drop-down menu:
· Action - The option that appears first is dependent upon the current status of the LO. See the External Training Statuses and Actions section below for additional information.
· View Details - Click this option to view the Transcript Details pop-up.
External Training Statuses and Actions
	Status
	Actions
	Action Behavior

	Registered
	Mark Complete
	Mark the LO complete


Color Strip Key
The following colors are available:
· Red - Due today or past due
· Orange - Due within the next seven days, not including today
· Green - Due after seven days
Action Item - Library
The Library training type will be deprecated with the November 2022 release!
Conditions for the LO to appear on the Action Items page:
· The learning object (LO) appears on the Action Items if one of the following is true:
· The library can be completed
· The library is up for renewal
· The library is active on the user's transcript. Archived LOs do not appear, regardless of status.
· If registration is closed and there are no actions the user can take, then the LO does not appear.
· If a start date is defined, the LO is only visible if the start date is the current date or has passed. If the start date has not yet passed, then the LO does not appear.
· If the link expiration date has passed, the LO does not appear.
When a library action item is displayed on the Action Items page, the following is displayed for each action item:
· Color Strip - The left edge of the action item icon is color coded to represent proximity to the due date of the action item. For example, if the action item due date is past due, then the color strip is red to indicate that action is required immediately. If an action item due date is not eminent, then the color strip is green to indicate that action is not required immediately. See the Color Strip Key section below for additional information.
· Title - This displays the action item title. Click the action item title to perform an action that corresponds with the current status. For example, if the status is Approved, then clicking the title registers the user in the LO or redirects them to the shopping cart, if necessary. See the Library Statuses and Actions section below for additional information.
· Due Date - This displays the action item due date.
· Status - This displays the current status of the action item.
· Priority Flag - This button allows users to mark action items as high priority. Priority can be helpful as a visual indicator to users. Also, action items can be filtered by priority from the Sort drop-down at the top of the page. When the priority flag is not selected, it is gray [image: ]. When the priority flag is selected, the action item is high priority and the flag is red [image: ].
The following options are available from the action item drop-down menu:
· Action - The option that appears first is dependent upon the current status of the LO. See the Library Statuses and Actions section below for additional information.
· View Details - Click this option to view the Transcript Details pop-up.
· Renew License - Click this option to re-register for the LO.
Library Statuses and Actions
	Status
	Actions
	Action Behavior

	Approved
	Register
	Register the user or redirect the user to the shopping cart, if necessary

	Pending Payment
	None/"Pay"
	Redirect the user to the shopping cart

	Registered
	Manage
	Redirect the user to the Training Details page

	Registered (Level 2 Evaluation)
	Take Pre-Test
	Launch the pre-test

	Registered (Level 3 Evaluation)
	Evaluate Behavior
	Launch evaluation

	In Progress
	Manage
	Redirect the user to the Training Details page

	Pending Evaluation (Level 1)
	Evaluate
	Redirect the user to the Evaluation page

	Pending Evaluation (Level 2)
	Take Post-Test
	Launch the post-test

	Pending Acknowledgment
	Acknowledge
	Redirect the user to the Acknowledgment Form page

	Pending Completion Signature
	Complete
	Redirect the user to the Training Details page

	Past Due (Appended)
	Same as primary status actions
	This is dependent upon the primary status


Color Strip Key
The following colors are available:
· Red - Due today or past due
· Orange - Due within the next seven days, not including today
· Green - Due after seven days
Action Item - Material
Conditions for the LO to appear on the Action Items page:
· The learning object (LO) must be active on the user's transcript. Archived LOs do not appear, regardless of status.
· If registration is closed and there are no actions the user can take, then the LO does not appear.
· If a start date is defined, the LO is only visible if the start date is the current date or has passed. If the start date has not yet passed, then the LO does not appear.
· If the link expiration date has passed, the LO does not appear.
When a material action item is displayed on the Action Items page, the following is displayed for each action item:
· Color Strip - The left edge of the action item icon is color coded to represent proximity to the due date of the action item. For example, if the action item due date is past due, then the color strip is red to indicate that action is required immediately. If an action item due date is not eminent, then the color strip is green to indicate that action is not required immediately. See the Color Strip Key section below for additional information.
· Title - This displays the action item title. Click the action item title to perform an action that corresponds with the current status. For example, if the status is Approved, then clicking the title registers the user in the LO or redirects them to the shopping cart, if necessary. See the Material Statuses and Actions section below for additional information.
· Due Date - This displays the action item due date.
· Status - This displays the current status of the action item.
· Priority Flag - This button allows users to mark action items as high priority. Priority can be helpful as a visual indicator to users. Also, action items can be filtered by priority from the Sort drop-down at the top of the page. When the priority flag is not selected, it is gray [image: ]. When the priority flag is selected, the action item is high priority and the flag is red [image: ].
The following options are available from the action item drop-down menu:
· Action - The option that appears first is dependent upon the current status of the LO. See the Material Statuses and Actions section below for additional information.
· Mark Complete - Click this option to mark the LO complete. This option may be the first option, depending upon the current status of the LO. This option is only available if the user is in a Registered or In Progress status.
· View Details - Click this option to view the Transcript Details pop-up.
· Renew License - Click this option to re-register for the LO.
Material Statuses and Actions
	Status
	Actions
	Action Behavior

	Approved
	Register
	Register the user or redirect the user to the shopping cart, if necessary

	Pending Payment
	None/"Pay"
	Redirect the user to the shopping cart

	Registered
	Launch
	Open the course in a pop-up.

	Registered (Level 2 Evaluation)
	Take Pre-Test
	Launch the pre-test

	Registered (Level 3 Evaluation)
	Evaluate Behavior
	Launch evaluation

	In Progress
	Mark Complete
	Mark the LO complete (only available after material has been launched, unless the material has no source)

	Pending Evaluation (Level 1)
	Evaluate
	Redirect the user to the Evaluation page

	Pending Evaluation (Level 2)
	Take Post-Test
	Launch the post-test

	Pending Acknowledgment
	Acknowledge
	Redirect the user to the Acknowledgment Form page

	Pending Completion Signature
	Complete
	Redirect the user to the Training Details page

	Pending Post-Work
	View Pre-Work
	This option directs the user to the Transcript Details page for the corresponding LO. The corresponding section (e.g., Prerequisites, Pre-work, Post-work) is displayed. Note: Administrators and managers viewing another user's transcript do not see this status. 

	Past Due (Appended)
	Same as primary status actions
	This is dependent upon the primary status


Color Strip Key
The following colors are available:
· Red - Due today or past due
· Orange - Due within the next seven days, not including today
· Green - Due after seven days
[bookmark: concept27][bookmark: concept26]Action Item - Online Course
Conditions for the LO to appear on the Action Items page:
· The learning object (LO) must be active on the user's transcript. Archived LOs do not appear, regardless of status.
· If registration is closed and there are no actions the user can take, then the LO does not appear.
· If a start date is defined, the LO is only visible if the start date is the current date or has passed. If the start date has not yet passed, then the LO does not appear.
· If the link expiration date has passed, the LO does not appear.
When an online course action item is displayed on the Action Items page, the following is displayed for each action item:
· Color Strip - The left edge of the action item icon is color coded to represent proximity to the due date of the action item. For example, if the action item due date is past due, then the color strip is red to indicate that action is required immediately. If an action item due date is not eminent, then the color strip is green to indicate that action is not required immediately. See the Color Strip Key section below for additional information.
· Title - This displays the action item title. Click the action item title to perform an action that corresponds with the current status. For example, if the status is Approved, then clicking the title registers the user in the LO or redirects them to the shopping cart, if necessary. See the Online Course Statuses and Actions section below for additional information.
· Due Date - This displays the action item due date.
· Status - This displays the current status of the action item.
· Priority Flag - This button allows users to mark action items as high priority. Priority can be helpful as a visual indicator to users. Also, action items can be filtered by priority from the Sort drop-down at the top of the page. When the priority flag is not selected, it is gray [image: ]. When the priority flag is selected, the action item is high priority and the flag is red [image: ].
The following options are available from the action item drop-down menu:
· Action - The option that appears first is dependent upon the current status of the LO. See the Online Course Statuses and Actions section below for additional information.
· Launch - Click this option to open the online course in a pop-up. This option may be the first option, depending upon the current status of the LO. This option is only available if the user is registered in the LO.
· View Details - Click this option to view the Transcript Details pop-up.
· Renew License - Click this option to re-register for the LO.
Online Course Statuses and Actions
	Status
	Actions
	Action Behavior

	Approved
	Register
	Register the user or redirect the user to the shopping cart, if necessary

	Pending Payment
	None/"Pay"
	Redirect the user to the shopping cart

	Registered
	Launch
	Open the course in a pop-up

	Registered (Level 2 Evaluation)
	Take Pre-Test
	Launch the pre-test

	Registered (Level 3 Evaluation)
	Evaluate Behavior
	Launch evaluation

	Registered (Network Player)
	Launch Locally, Launch Online - Note: These options are only available if the administrator has downloaded the selected online course for the user and if the user has permission to launch courses locally from their transcript.
	Launch Locally - Open the downloaded course from the user's local drive

	Registered (Offline Player)
	Unlock
	Sync the course with the offline player and refresh the LO status

	In Progress
	Launch
	Open the course in a pop-up

	In Progress (Network Player)
	Launch Locally, Launch Online - Note: These options are only available if the administrator has downloaded the selected online course for the user and if the user has permission to launch courses locally from their transcript.
	Launch Locally - Open the downloaded course from the user's local drive

	In Progress (Offline Player)
	Unlock
	Sync the course with the offline player and refresh the LO status

	Pending Evaluation (Level 1)
	Evaluate
	Redirect the user to the Evaluation page

	Pending Evaluation (Level 2)
	Take Post-Test
	Launch the post-test

	Pending Acknowledgment
	Acknowledge
	Redirect the user to the Acknowledgment Form page

	Pending Completion Signature
	Complete
	Redirect the user to the Training Details page

	Pending Prerequisite
	View Prerequisite
	This option directs the user to the Transcript Details page for the corresponding LO. The corresponding section (e.g., Prerequisites, Pre-work, Post-work) is displayed. Note: Administrators and managers viewing another user's transcript do not see this status. 

	Pending Post-Work
	View Post-Work
	This option directs the user to the Transcript Details page for the corresponding LO. The corresponding section (e.g., Prerequisites, Pre-work, Post-work) is displayed. Note: Administrators and managers viewing another user's transcript do not see this status. 

	Pending Pre-Work
	View Pre-Work
	This option directs the user to the Transcript Details page for the corresponding LO. The corresponding section (e.g., Prerequisites, Pre-work, Post-work) is displayed. Note: Administrators and managers viewing another user's transcript do not see this status. 

	Past Due (Appended)
	Same as primary status actions
	This is dependent upon the primary status

	Failed
	Retake - Note: This option is only available if retakes are available for the online course.
	Re-register the user


Color Strip Key
The following colors are available:
· Red - Due today or past due
· Orange - Due within the next seven days, not including today
· Green - Due after seven days
Action Item - Posting
Conditions for the LO to appear on the Action Items page:
· The learning object (LO) must be active on the user's transcript. Archived LOs do not appear, regardless of status.
· If registration is closed and there are no actions the user can take, then the LO does not appear.
· If a start date is defined, the LO is only visible if the start date is the current date or has passed. If the start date has not yet passed, then the LO does not appear.
When a posting action item is displayed on the Action Items page, the following is displayed for each action item:
· Color Strip - The left edge of the action item icon is color coded to represent proximity to the due date of the action item. For example, if the action item due date is past due, then the color strip is red to indicate that action is required immediately. If an action item due date is not eminent, then the color strip is green to indicate that action is not required immediately. See the Color Strip Key section below for additional information.
· Title - This displays the action item title. Click the action item title to perform an action that corresponds with the current status. For example, if the status is Approved, then clicking the title registers the user in the LO or redirects them to the shopping cart, if necessary. See the Posting Statuses and Actions section below for additional information.
· Due Date - This displays the action item due date.
· Status - This displays the current status of the action item.
· Priority Flag - This button allows users to mark action items as high priority. Priority can be helpful as a visual indicator to users. Also, action items can be filtered by priority from the Sort drop-down at the top of the page. When the priority flag is not selected, it is gray [image: ]. When the priority flag is selected, the action item is high priority and the flag is red [image: ].
The following options are available from the action item drop-down menu:
· Mark Complete - Click this option to mark the LO complete.
· Action - The option that appears second is dependent upon the current status of the LO. See the Posting Statuses and Actions section below for additional information.
· View Details - Click this option to view the Transcript Details pop-up.
· Renew License - Click this option to re-register for the LO.
Posting Statuses and Actions
	Status
	Actions
	Action Behavior

	Approved
	Register
	Register the user or redirect the user to the shopping cart, if necessary

	Registered
	Launch
	Open the course in a pop-up or mark the LO complete

	Past Due (Appended)
	Same as primary status actions
	This is dependent upon the primary status


Color Strip Key
The following colors are available:
· Red - Due today or past due
· Orange - Due within the next seven days, not including today
· Green - Due after seven days
[bookmark: concept31][bookmark: concept30]Action Item - Quick Course
Conditions for the LO to appear on the Action Items page:
· The learning object (LO) must be active on the user's transcript. Archived LOs do not appear, regardless of status.
· If registration is closed and there are no actions the user can take, then the LO does not appear.
· If a start date is defined, the LO is only visible if the start date is the current date or has passed. If the start date has not yet passed, then the LO does not appear.
· If the link expiration date has passed, the LO does not appear.
When a quick course action item is displayed on the Action Items page, the following is displayed for each action item:
· Color Strip - The left edge of the action item icon is color coded to represent proximity to the due date of the action item. For example, if the action item due date is past due, then the color strip is red to indicate that action is required immediately. If an action item due date is not eminent, then the color strip is green to indicate that action is not required immediately. See the Color Strip Key section below for additional information.
· Title - This displays the action item title. Click the action item title to perform an action that corresponds with the current status. For example, if the status is Approved, then clicking the title registers the user in the LO or redirects them to the shopping cart, if necessary. See the Quick Course Statuses and Actions section below for additional information.
· Due Date - This displays the action item due date.
· Status - This displays the current status of the action item.
· Priority Flag - This button allows users to mark action items as high priority. Priority can be helpful as a visual indicator to users. Also, action items can be filtered by priority from the Sort drop-down at the top of the page. When the priority flag is not selected, it is gray [image: ]. When the priority flag is selected, the action item is high priority and the flag is red [image: ].
The following options are available from the action item drop-down menu:
· Action - The option that appears first is dependent upon the current status of the LO. See the Quick Course Statuses and Actions section below for additional information.
· View Details - Click this option to view the Transcript Details pop-up.
· Renew License - Click this option to re-register for the LO.
Quick Course Statuses and Actions
	Status
	Actions
	Action Behavior

	Approved
	Register
	Register the user or redirect the user to the shopping cart, if necessary

	Pending Payment
	None/"Pay"
	Redirect the user to the shopping cart

	Registered
	Launch
	Open the course in a pop-up

	Registered (Level 2 Evaluation)
	Take Pre-Test
	Launch the pre-test

	Registered (Level 3 Evaluation)
	Evaluate Behavior
	Launch evaluation

	In Progress
	Launch
	Open the course in a pop-up

	Pending Evaluation (Level 1)
	Evaluate
	Redirect the user to the Evaluation page

	Pending Evaluation (Level 2)
	Take Post-Test
	Launch the post-test

	Pending Acknowledgment
	Acknowledge
	Redirect the user to the Acknowledgment Form page

	Pending Completion Signature
	Complete
	Redirect the user to the Training Details page

	Pending Post-Work
	View Post-Work
	This option directs the user to the Transcript Details page for the corresponding LO. The corresponding section (e.g., Prerequisites, Pre-work, Post-work) is displayed. Note: Administrators and managers viewing another user's transcript do not see this status. 

	Past Due (Appended)
	Same as primary status actions
	This is dependent upon the primary status


Color Strip Key
The following colors are available:
· Red - Due today or past due
· Orange - Due within the next seven days, not including today
· Green - Due after seven days
Action Item - Session
Conditions for the LO to appear on the Action Items page:
· The learning object (LO) must be active on the user's transcript. Archived LOs do not appear, regardless of status.
· If registration is closed and there are no actions the user can take, then the LO does not appear.
· If a start date is defined, the LO is only visible if the start date is the current date or has passed. If the start date has not yet passed, then the LO does not appear.
· If the link expiration date has passed, the LO does not appear.
· If a user registers for a course and is placed on the waitlist, the LO continues to appear on the Action Items page until the activity date for the session has passed.
When a session action item is displayed on the Action Items page, the following is displayed for each action item:
· Color Strip - The left edge of the action item icon is color coded to represent proximity to the due date of the action item. For example, if the action item due date is past due, then the color strip is red to indicate that action is required immediately. If an action item due date is not eminent, then the color strip is green to indicate that action is not required immediately. See the Color Strip Key section below for additional information.
· Title - This displays the action item title. Click the action item title to perform an action that corresponds with the current status. For example, if the status is Approved, then clicking the title registers the user in the LO or redirects them to the shopping cart, if necessary. See the Session Statuses and Actions section below for additional information.
· Due Date - This displays the action item due date.
· Status - This displays the current status of the action item.
· Priority Flag - This button allows users to mark action items as high priority. Priority can be helpful as a visual indicator to users. Also, action items can be filtered by priority from the Sort drop-down at the top of the page. When the priority flag is not selected, it is gray [image: ]. When the priority flag is selected, the action item is high priority and the flag is red [image: ].
The following options are available from the action item drop-down menu:
· Action - The option that appears first is dependent upon the current status of the LO. See the Session Statuses and Actions section below for additional information.
· View Details - Click this option to view the Transcript Details pop-up.
Session Statuses and Actions
	Status
	Actions
	Action Behavior

	Approved
	Register
	Register the user or redirect the user to the shopping cart, if necessary

	Pending Payment
	None/"Pay"
	Redirect the user to the shopping cart

	Registration Pending
	Register
	Register the user or redirect the user to the shopping cart, if necessary

	Registered
	View
	Redirect the user to the Training Details page

	Registered (Level 2 Evaluation)
	Take Pre-Test
	Launch the pre-test

	Registered (Level 3 Evaluation)
	Evaluate Behavior
	Launch evaluation

	No Show
	The event appears in Registered status with a Select Session action
	Open the pop-up to display the available sessions for the event

	Withdrawn
	The event appears in Registered status with a Select Session action
	Open the pop-up to display the available sessions for the event

	Pending Evaluation (Level 1)
	Evaluate
	Redirect the user to the Evaluation page

	Pending Evaluation (Level 2)
	Take Post-Test
	Launch the post-test

	Pending Acknowledgment
	Acknowledge
	Redirect the user to the Acknowledgment Form page

	Pending Completion Signature
	Complete
	Redirect the user to the Training Details page

	Pending Post-Work
	View Post-Work
	This option directs the user to the Transcript Details page for the corresponding LO. The corresponding section (e.g., Prerequisites, Pre-work, Post-work) is displayed. Note: Administrators and managers viewing another user's transcript do not see this status. 


Color Strip Key
The following colors are available:
· Red - Due today or past due
· Orange - Due within the next seven days, not including today
· Green - Due after seven days
Action Item - Test
Conditions for the LO to appear on the Action Items page:
· The learning object (LO) must be active on the user's transcript. Archived LOs do not appear, regardless of status.
· If registration is closed and there are no actions the user can take, then the LO does not appear.
· If a start date is defined, the LO is only visible if the start date is the current date or has passed. If the start date has not yet passed, then the LO does not appear.
· If the link expiration date has passed, the LO does not appear.
· The LO does not appear if the user has run out of attempts to pass the test.
When a test action item is displayed on the Action Items page, the following is displayed for each action item:
· Color Strip - The left edge of the action item icon is color coded to represent proximity to the due date of the action item. For example, if the action item due date is past due, then the color strip is red to indicate that action is required immediately. If an action item due date is not eminent, then the color strip is green to indicate that action is not required immediately. See the Color Strip Key section below for additional information.
· Title - This displays the action item title. Click the action item title to perform an action that corresponds with the current status. For example, if the status is Approved, then clicking the title registers the user in the LO or redirects them to the shopping cart, if necessary. See the Test Statuses and Actions section below for additional information.
· Due Date - This displays the action item due date.
· Status - This displays the current status of the action item.
· Priority Flag - This button allows users to mark action items as high priority. Priority can be helpful as a visual indicator to users. Also, action items can be filtered by priority from the Sort drop-down at the top of the page. When the priority flag is not selected, it is gray [image: ]. When the priority flag is selected, the action item is high priority and the flag is red [image: ].
The following options are available from the action item drop-down menu:
· Action - The option that appears first is dependent upon the current status of the LO. See the Test Statuses and Actions section below for additional information.
· View Details - Click this option to view the Transcript Details pop-up.
Test Statuses and Actions
	Status
	Actions
	Action Behavior

	Approved
	Register
	Register the user or redirect the user to the shopping cart, if necessary

	Pending Payment
	None/"Pay"
	Redirect the user to the shopping cart

	Registered
	Launch
	Open the course in a pop-up

	Registered (Level 2 Evaluation)
	Take Pre-Test
	Launch the pre-test

	Registered (Level 3 Evaluation)
	Evaluate Behavior
	Launch evaluation

	In Progress
	Launch
	Open the course in a pop-up

	Pending Evaluation (Level 1)
	Evaluate
	Redirect the user to the Evaluation page

	Pending Evaluation (Level 2)
	Take Post-Test
	Launch the post-test

	Pending Acknowledgment
	Acknowledge
	Redirect the user to the Acknowledgment Form page

	Pending Completion Signature
	Complete
	Redirect the user to the Training Details page

	Pending Post-Work
	View Post-Work
	This option directs the user to the Transcript Details page for the corresponding LO. The corresponding section (e.g., Prerequisites, Pre-work, Post-work) is displayed. Note: Administrators and managers viewing another user's transcript do not see this status. 

	Past Due (Appended)
	Same as primary status actions
	This is dependent upon the primary status

	Failed
	Retake Test (if available)
	Redirect the user to the test page


Color Strip Key
The following colors are available:
· Red - Due today or past due
· Orange - Due within the next seven days, not including today
· Green - Due after seven days
Action Item - Video
Conditions for the LO to appear on the Action Items page:
· The learning object (LO) must be active on the user's transcript. Archived LOs do not appear, regardless of status.
· If registration is closed and there are no actions the user can take, then the LO does not appear.
· If a start date is defined, the LO is only visible if the start date is the current date or has passed. If the start date has not yet passed, then the LO does not appear.
· If the link expiration date has passed, the LO does not appear.
When a video action item is displayed on the Action Items page, the following is displayed for each action item:
· Color Strip - The left edge of the action item icon is color coded to represent proximity to the due date of the action item. For example, if the action item due date is past due, then the color strip is red to indicate that action is required immediately. If an action item due date is not eminent, then the color strip is green to indicate that action is not required immediately. See the Color Strip Key section below for additional information.
· Title - This displays the action item title. Click the action item title to perform an action that corresponds with the current status. For example, if the status is Approved, then clicking the title registers the user in the LO or redirects them to the shopping cart, if necessary. See the Video Statuses and Actions section below for additional information.
· Due Date - This displays the action item due date.
· Status - This displays the current status of the action item.
· Priority Flag - This button allows users to mark action items as high priority. Priority can be helpful as a visual indicator to users. Also, action items can be filtered by priority from the Sort drop-down at the top of the page. When the priority flag is not selected, it is gray [image: ]. When the priority flag is selected, the action item is high priority and the flag is red [image: ].
The following options are available from the action item drop-down menu:
· Action - The option that appears first is dependent upon the current status of the LO. See the Video Statuses and Actions section below for additional information.
· View Details - Click this option to view the Transcript Details pop-up.
· Renew License - Click this option to re-register for the LO.
Video Statuses and Actions
	Status
	Actions
	Action Behavior

	Approved
	Register
	Register the user or redirect the user to the shopping cart, if necessary

	Registered
	Launch, Mark Complete
	Open the course in a pop-up or mark the LO complete

	Registered (Level 2 Evaluation)
	Take Pre-Test
	Launch the pre-test

	Registered (Level 3 Evaluation)
	Evaluate Behavior
	Launch evaluation

	Pending Evaluation (Level 1)
	Evaluate
	Redirect the user to the Evaluation page

	Pending Evaluation (Level 2)
	Take Post-Test
	Launch the post-test

	Pending Acknowledgment
	Acknowledge
	Redirect the user to the Acknowledgment Form page

	Pending Completion Signature
	Complete
	Redirect the user to the Training Details page

	Pending Post-Work
	View Post-Work
	This option directs the user to the Transcript Details page for the corresponding LO. The corresponding section (e.g., Prerequisites, Pre-work, Post-work) is displayed. Note: Administrators and managers viewing another user's transcript do not see this status. 

	Past Due (Appended)
	Same as primary status actions
	This is dependent upon the primary status


Color Strip Key
The following colors are available:
· Red - Due today or past due
· Orange - Due within the next seven days, not including today
· Green - Due after seven days
[bookmark: _Toc161994654]Action Items - Performance
For organizations using the Performance or Succession module, the following performance action items may appear on the Action Items page:
View Team
The View Team flyout allows managers, approvers, and custom relationships to quickly navigate between subordinates' profiles and transcripts. When enabled, the View Team flyout is available to managers and dotted line managers on all pages of their Universal Profile and the Universal Profile of their subordinates. This flyout displays the manager's reports visually.
The View Team button displays if enabled in the portal. Administrators may enable or disable this flyout via the My Team Dropdown section within Universal Profile General Preferences. See Universal Profile General Preferences on page 2 for additional information.
See Universal Profile - View Team Flyout on page 648 for additional information.
Options
An Options drop-down may be available on various pages of the Universal Profile. This menu may include options such as Assign Training and Create Goal. See Universal Profile Options Drop-down Overview on page 653 for additional information.
General Performance Action Items
When a performance action item is displayed on the Action Items page, the following is displayed for each action item:
· Color Strip - The left edge of the action item icon is color coded to represent proximity to the due date of the action item. For example, if the action item due date is past due, then the color strip is red to indicate that action is required immediately. If an action item due date is not eminent, then the color strip is green to indicate that action is not required immediately. See the Color Strip Key section below for additional information.
· Title - This displays the action item title. Click the action item title to open the appropriate page to complete the action item.
· Due Date - This displays the action item due date.
· Status - This displays the current status of the action item.
· Priority Flag - This button allows users to mark action items as high priority. Priority can be helpful as a visual indicator to users. Also, action items can be filtered by priority from the Sort drop-down at the top of the page. When the priority flag is not selected, it is gray [image: ]. When the priority flag is selected, the action item is high priority and the flag is red [image: ].
Action Item Options
The following options are available from the action item drop-down menu:
· Launch - Click this option to launch the task.
Color Strip Key
The following colors are available:
· Red - Due today or past due
· Orange - Due within the next seven days, not including today
· Green - Due after seven days
Action Item - Competency Assessment
All types of competency assessment tasks appear on the user's Action Items page.
To access the Action Items, go to Home > Universal Profile. Then, click the Actions tab. Note: The location of this link is configurable by your system administrator.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Action Items - EPM
	Grants ability to view and take action upon Performance (EPM) items on the Action Items page and in the Your Action Items widget. This permission can be constrained by OU, User's OU, User's Self, and User's Self and Subordinates. This is an end user permission.
	Universal Profile


View Team
The View Team flyout allows managers, approvers, and custom relationships to quickly navigate between subordinates' profiles and transcripts. When enabled, the View Team flyout is available to managers and dotted line managers on all pages of their Universal Profile and the Universal Profile of their subordinates. This flyout displays the manager's reports visually.
The View Team button displays if enabled in the portal. Administrators may enable or disable this flyout via the My Team Dropdown section within Universal Profile General Preferences. See Universal Profile General Preferences on page 2 for additional information.
See Universal Profile - View Team Flyout on page 648 for additional information.
Options
An Options drop-down may be available on various pages of the Universal Profile. This menu may include options such as Assign Training and Create Goal. See Universal Profile Options Drop-down Overview on page 653 for additional information.
Competency Assessment Action Item Details
When a competency assessment action item is displayed on the Action Items page, the following is displayed for each action item:
· Color Strip - The left edge of the action item icon is color coded to represent proximity to the due date of the action item. For example, if the action item due date is past due, then the color strip is red to indicate that action is required immediately. If an action item due date is not eminent, then the color strip is green to indicate that action is not required immediately. See the Color Strip Key section below for additional information.
· Title - This displays the action item title. Click the action item title to open the Instructions page of the competency assessment task. If no instructions are available, then this opens the Competency Assessment Summary page.
· Due Date - This displays the action item due date.
· Status - This displays the current status of the action item. See the Competency Assessment Statuses and Actions section below for additional information.
· Priority Flag - This button allows users to mark action items as high priority. Priority can be helpful as a visual indicator to users. Also, action items can be filtered by priority from the Sort drop-down at the top of the page. When the priority flag is not selected, it is gray [image: ]. When the priority flag is selected, the action item is high priority and the flag is red [image: ].
Action Item Options
The following options are available from the action item drop-down menu:
· Complete - Click this option to open the Instructions page of the competency assessment task. If no instructions are available, then this opens the Competency Assessment Summary page.
· View all Assessments - Click this option to open the Competency Assessment Summary page.
Competency Assessment Statuses and Actions
	Status
	Actions
	Action Behavior

	Not Started
	Complete
	Redirect the user to the Competency Assessment Summary page for the appropriate assessment

	In Progress
	Complete
	Redirect the user to the Competency Assessment Summary page for the appropriate assessment

	Past Due
	Complete
	Redirect the user to the Competency Assessment Summary page for the appropriate assessment


Competency assessments in Queued, Expired, or Complete status do not appear on the Action Items page.
Color Strip Key
The following colors are available:
· Red - Due today or past due
· Orange - Due within the next seven days, not including today
· Green - Due after seven days
Action Item - Development Plan (Redesign)
This page applies if the Redesigned Development Plans functionality is enabled. 
Users can access their Development Plan action item from the Actions tab in Universal Profile.
To access the Action Items page, go to Home > Universal Profile. Then, click the Actions tab.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Action Items - EPM
	Grants ability to view and take action upon Performance (EPM) items on the Action Items page and in the Your Action Items widget. This permission can be constrained by OU, User's OU, User's Self, and User's Self and Subordinates. This is an end user permission.
	Universal Profile


[image: ]
Task Details and Options
The following information options are available for Development Plan action items:
· Plan Title - The title of the plan displays next to the Development Plan action item icon [image: ].
· Due Date - This field displays the due date for the plan.
· Status - This field displays the status of plan. This is based on due dates for the plan.
· Complete - Click this option from the drop-down to open the Development Plan Details page for the appropriate plan.
· View as PDF - Click this option from the drop-down to export the development plan details to PDF format.
· View all Development Plans - Click this option from the drop-down to open the Development Plan Summary page.
Development Plan Statuses and Actions
	Status
	Actions
	Action Behavior

	Not Started
	Complete
	Redirect the user to the Dev Plan Details page

	In Progress
	Complete
	Redirect the user to the Dev Plan Details page

	Past Due
	Complete
	Redirect the user to the Dev Plan Details page

	Approved
	Complete
	Redirect the user to the Dev Plan Details page

	Pending Completion Approval
	Complete
	Redirect the user to the Dev Plan Details page

	Pending Cancellation Approval
	Complete
	Redirect the user to the Dev Plan Details page

	Completion Approval Denied
	Complete
	Redirect the user to the Dev Plan Details page


Development plans in Complete, Cancelled, or Expired status do not appear on the Action Items page.
Development plans that are in a Completed or Cancelled status do not appear on the Actions tab or "Your Action Items" widget.
Color Strip Key
The following colors are available:
· Red - Due today or past due
· Orange - Due within the next seven days, not including today
· Green - Due after seven days
Action Item - Development Plan
To access the Action Items, go to Home > Universal Profile. Then, click the Actions tab. Note: The location of this link is configurable by your system administrator.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Action Items - EPM
	Grants ability to view and take action upon Performance (EPM) items on the Action Items page and in the Your Action Items widget. This permission can be constrained by OU, User's OU, User's Self, and User's Self and Subordinates. This is an end user permission.
	Universal Profile


View Team
The View Team flyout allows managers, approvers, and custom relationships to quickly navigate between subordinates' profiles and transcripts. When enabled, the View Team flyout is available to managers and dotted line managers on all pages of their Universal Profile and the Universal Profile of their subordinates. This flyout displays the manager's reports visually.
The View Team button displays if enabled in the portal. Administrators may enable or disable this flyout via the My Team Dropdown section within Universal Profile General Preferences. See Universal Profile General Preferences on page 2 for additional information.
See Universal Profile - View Team Flyout on page 648 for additional information.
Options
An Options drop-down may be available on various pages of the Universal Profile. This menu may include options such as Assign Training and Create Goal. See Universal Profile Options Drop-down Overview on page 653 for additional information.
Development Plan Action Item Details
When a development plan action item is displayed on the Action Items page, the following is displayed for each action item:
· Color Strip - The left edge of the action item icon is color coded to represent proximity to the due date of the action item. For example, if the action item due date is past due, then the color strip is red to indicate that action is required immediately. If an action item due date is not eminent, then the color strip is green to indicate that action is not required immediately. See the Color Strip Key section below for additional information.
· Title - This displays the action item title. Click the action item title to open the Development Plan Details page for the appropriate plan.
· Due Date - This displays the action item due date.
· Status - This displays the current status of the action item. See the Development Plan Statuses and Actions section below for additional information.
· Priority Flag - This button allows users to mark action items as high priority. Priority can be helpful as a visual indicator to users. Also, action items can be filtered by priority from the Sort drop-down at the top of the page. When the priority flag is not selected, it is gray [image: ]. When the priority flag is selected, the action item is high priority and the flag is red [image: ].
Action Item Options
The following options are available from the action item drop-down menu:
· Complete - Click this option to open the Development Plan Details page for the appropriate plan.
· View as PDF - Click this option to export the development plan details to PDF format.
· View all Development Plans - Click this option to open the Development Plan Summary page.
Development Plan Statuses and Actions
	Status
	Actions
	Action Behavior

	Not Started
	Complete
	Redirect the user to the Dev Plan Details page

	In Progress
	Complete
	Redirect the user to the Dev Plan Details page

	Past Due
	Complete
	Redirect the user to the Dev Plan Details page

	Approved
	Complete
	Redirect the user to the Dev Plan Details page

	Pending Completion Approval
	Complete
	Redirect the user to the Dev Plan Details page

	Pending Cancellation Approval
	Complete
	Redirect the user to the Dev Plan Details page

	Completion Approval Denied
	Complete
	Redirect the user to the Dev Plan Details page


Development plans in Complete, Cancelled, or Expired status do not appear on the Action Items page.
Color Strip Key
The following colors are available:
· Red - Due today or past due
· Orange - Due within the next seven days, not including today
· Green - Due after seven days
Action Item - Goal
The following goals do not appear on the user's Action Items page:
· Shared Goals
· Goals in the following statuses: Pending Creation Approval, Denied, Cancelled, Complete
To access the Action Items, go to Home > Universal Profile. Then, click the Actions tab.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Action Items - EPM
	Grants ability to view and take action upon Performance (EPM) items on the Action Items page and in the Your Action Items widget. This permission can be constrained by OU, User's OU, User's Self, and User's Self and Subordinates. This is an end user permission.
	Universal Profile


View Team
The View Team flyout allows managers, approvers, and custom relationships to quickly navigate between subordinates' profiles and transcripts. When enabled, the View Team flyout is available to managers and dotted line managers on all pages of their Universal Profile and the Universal Profile of their subordinates. This flyout displays the manager's reports visually.
The View Team button displays if enabled in the portal. Administrators may enable or disable this flyout via the My Team Dropdown section within Universal Profile General Preferences. See Universal Profile General Preferences on page 2 for additional information.
See Universal Profile - View Team Flyout on page 648 for additional information.
Options
An Options drop-down may be available on various pages of the Universal Profile. This menu may include options such as Assign Training and Create Goal. See Universal Profile Options Drop-down Overview on page 653 for additional information.
Goal Action Item Details
When a goal action item is displayed on the Action Items page, the following is displayed for each action item:
· Color Strip - The left edge of the action item icon is color coded to represent proximity to the due date of the action item. For example, if the action item due date is past due, then the color strip is red to indicate that action is required immediately. If an action item due date is not eminent, then the color strip is green to indicate that action is not required immediately. See the Color Strip Key section below for additional information.
· Title - This displays the action item title. Click the action item title to open the Manage Goals page for the appropriate goal.
· Due Date - This displays the action item due date.
· Status - This displays the current status of the action item. See the Goal Statuses and Actions section below for additional information.
· Priority Flag - This button allows users to mark action items as high priority. Priority can be helpful as a visual indicator to users. Also, action items can be filtered by priority from the Sort drop-down at the top of the page. When the priority flag is not selected, it is gray [image: ]. When the priority flag is selected, the action item is high priority and the flag is red [image: ].
Action Item Options
The following options are available from the action item drop-down menu:
· Manage - Click this option to open the Manage Goals page for the appropriate goal. See Goal - Manage.
· View all Goals - Click this option to open the Goals Summary page. See View Goals - My Goals.
Goal Statuses and Actions
	Status
	Actions
	Action Behavior

	First user-defined status
	Manage
	Redirect the user to the Manage Goals page for the appropriate goal

	Second user-defined status
	Manage
	Redirect the user to the Manage Goals page for the appropriate goal

	Third user-defined status
	Manage
	Redirect the user to the Manage Goals page for the appropriate goal

	Pending Modification Approval
	Manage
	Redirect the user to the Manage Goals page for the appropriate goal

	Pending Completion Approval
	Manage
	Redirect the user to the Manage Goals page for the appropriate goal

	Pending Cancellation Approval
	Manage
	Redirect the user to the Manage Goals page for the appropriate goal

	Approved
	Manage
	Redirect the user to the Manage Goals page for the appropriate goal

	Modification Denied
	Manage
	Redirect the user to the Manage Goals page for the appropriate goal


Goals in the fourth user-defined status or the Pending Approval status do not appear on the Action Items page.
Color Strip Key
The following colors are available:
· Red - Due today or past due
· Orange - Due within the next seven days, not including today
· Green - Due after seven days
Action Item - Observation Checklist
An observation checklist task appears in the Actions page for users in the following scenarios:
· If a validator/verifier exists for a checklist, then the checklist is available to validators.
· If no validator/verifier exists for a checklist, then the checklist is available to the manager who is able to validate/verify.
· When the manager adds a verifier or co-planner, the observation checklist becomes available in the verifier or co-planner's Actions page and it is no longer available in the manager's Actions page.
To access the Action Items, go to Home > Universal Profile. Then, click the Actions tab.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Action Items - EPM
	Grants ability to view and take action upon Performance (EPM) items on the Action Items page and in the Your Action Items widget. This permission can be constrained by OU, User's OU, User's Self, and User's Self and Subordinates. This is an end user permission.
	Universal Profile


View Team
The View Team flyout allows managers, approvers, and custom relationships to quickly navigate between subordinates' profiles and transcripts. When enabled, the View Team flyout is available to managers and dotted line managers on all pages of their Universal Profile and the Universal Profile of their subordinates. This flyout displays the manager's reports visually.
The View Team button displays if enabled in the portal. Administrators may enable or disable this flyout via the My Team Dropdown section within Universal Profile General Preferences. See Universal Profile General Preferences on page 2 for additional information.
See Universal Profile - View Team Flyout on page 648 for additional information.
Options
An Options drop-down may be available on various pages of the Universal Profile. This menu may include options such as Assign Training and Create Goal. See Universal Profile Options Drop-down Overview on page 653 for additional information.
Observation Checklist Action Item Details
When an observation checklist action item is displayed on the Action Items page, the following is displayed for each action item:
· Color Strip - The left edge of the action item icon is color coded to represent proximity to the due date of the action item. For example, if the action item due date is past due, then the color strip is red to indicate that action is required immediately. If an action item due date is not eminent, then the color strip is green to indicate that action is not required immediately. See the Color Strip Key section below for additional information.
· Title - This displays the action item title. Click the action item title to open the Manage Checklist page with the page filtered so that only checklists from the selected task are displayed. On the Manage Checklist page, the Checklist search filter is not available because the page is automatically filtered by the selected checklist.
· Due Date - This displays the earliest due date for any item within the checklist.
· Remaining - This displays the number of checklists within the task that have not yet been completed.
· Priority Flag - This button allows users to mark action items as high priority. Priority can be helpful as a visual indicator to users. Also, action items can be filtered by priority from the Sort drop-down at the top of the page. When the priority flag is not selected, it is gray [image: ]. When the priority flag is selected, the action item is high priority and the flag is red [image: ].
Action Item Options
The following options are available from the action item drop-down menu:
· Launch - Click this option to open the Manage Checklist page with the page filtered so that only checklists from the selected task are displayed. On the Manage Checklist page, the Checklist search filter is not available because the page is automatically filtered by the selected checklist.
Color Strip Key
The following colors are available:
· Red - Due today or past due
· Orange - Due within the next seven days, not including today
· Green - Due after seven days
Action Item - Performance Review Task
All steps of a performance review appear on the user's Action Items page, including reopened steps.
To access the Action Items, go to Home > Universal Profile. Then, click the Actions tab. Note: The location of this link is configurable by your system administrator.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Action Items - EPM
	Grants ability to view and take action upon Performance (EPM) items on the Action Items page and in the Your Action Items widget. This permission can be constrained by OU, User's OU, User's Self, and User's Self and Subordinates. This is an end user permission.
	Universal Profile


View Team
The View Team flyout allows managers, approvers, and custom relationships to quickly navigate between subordinates' profiles and transcripts. When enabled, the View Team flyout is available to managers and dotted line managers on all pages of their Universal Profile and the Universal Profile of their subordinates. This flyout displays the manager's reports visually.
The View Team button displays if enabled in the portal. Administrators may enable or disable this flyout via the My Team Dropdown section within Universal Profile General Preferences. See Universal Profile General Preferences on page 2 for additional information.
See Universal Profile - View Team Flyout on page 648 for additional information.
Options
An Options drop-down may be available on various pages of the Universal Profile. This menu may include options such as Assign Training and Create Goal. See Universal Profile Options Drop-down Overview on page 653 for additional information.
Performance Review Action Item Details
When a performance review action item is displayed on the Action Items page, the following is displayed for each action item:
· Color Strip - The left edge of the action item icon is color coded to represent proximity to the due date of the action item. For example, if the action item due date is past due, then the color strip is red to indicate that action is required immediately. If an action item due date is not eminent, then the color strip is green to indicate that action is not required immediately. See the Color Strip Key section below for additional information.
· Title - This displays the action item title. If the user is a co-planner for the review task, then the task title indicates this. Click the action item title to open the appropriate step of the performance review.
· Due Date - This displays the action item due date.
· Status - This displays the current status of the action item. See the Performance Review Task Statuses and Actions section below for additional information.
· Priority Flag - This button allows users to mark action items as high priority. Priority can be helpful as a visual indicator to users. Also, action items can be filtered by priority from the Sort drop-down at the top of the page. When the priority flag is not selected, it is gray [image: ]. When the priority flag is selected, the action item is high priority and the flag is red [image: ].
Action Item Options
The following options are available from the action item drop-down menu:
· Launch - Click this option to open the appropriate step of the task.
· Print PDF - Click this option to open the Print Review pop-up.
· Work Offline - Click this option to download the performance review as an Excel file, which can then be completed offline and uploaded to the system.
· View all Reviews - Click this option to open the Performance Reviews Summary page.
Performance Review Task Statuses and Actions
	Status
	Actions
	Action Behavior

	Not Started
	Launch
	Redirect the user to the selected step of the task

	In Progress
	Launch
	Redirect the user to the selected step of the task

	Past Due
	Launch
	Redirect the user to the selected step of the task


Performance review tasks in Queued, Expired, or Complete status do not appear on the Action Items page.
Color Strip Key
The following colors are available:
· Red - Due today or past due
· Orange - Due within the next seven days, not including today
· Green - Due after seven days
Action Item - Performance Review Batch Rating
Reviewers can access the Batch Rating page for a performance review task from the Universal Profile - Actions page.
To access the Action Items, go to Home > Universal Profile. Then, click the Actions tab. Note: The location of this link is configurable by your system administrator.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Action Items - EPM
	Grants ability to view and take action upon Performance (EPM) items on the Action Items page and in the Your Action Items widget. This permission can be constrained by OU, User's OU, User's Self, and User's Self and Subordinates. This is an end user permission.
	Universal Profile


View Team
The View Team flyout allows managers, approvers, and custom relationships to quickly navigate between subordinates' profiles and transcripts. When enabled, the View Team flyout is available to managers and dotted line managers on all pages of their Universal Profile and the Universal Profile of their subordinates. This flyout displays the manager's reports visually.
The View Team button displays if enabled in the portal. Administrators may enable or disable this flyout via the My Team Dropdown section within Universal Profile General Preferences. See Universal Profile General Preferences on page 2 for additional information.
See Universal Profile - View Team Flyout on page 648 for additional information.
Options
An Options drop-down may be available on various pages of the Universal Profile. This menu may include options such as Assign Training and Create Goal. See Universal Profile Options Drop-down Overview on page 653 for additional information.
Performance Review Batch Rating Action Item Details
When batch rating is enabled for a performance review task, a Batch Rating task will appear on the Universal Profile - Actions page for reviewers for any step that contains a Competency Rating or Question List section.
When a Batch Rating task appears on the Universal Profile - Actions page, it is displayed above the associated review steps. For example, if Batch Rating Task A - Step 1 includes the Review Step 1 for User A, User B, and User C, then Batch Rating Task A - Step 1 appears immediately above Review Step 1 for User A, User B, and User C. This enables the reviewer to choose to either complete the batch rating task for all users within the review step or individually review each reviewee within the review step.
Batch Rating tasks are not available for Self, Peer, and Subordinates review steps.
When a batch rating action item is displayed on the Action Items page, the following is displayed for each batch rating action item:
· Color Strip - The left edge of the action item icon is color coded to represent proximity to the due date of the action item. For example, if the action item due date is past due, then the color strip is red to indicate that action is required immediately. If an action item due date is not eminent, then the color strip is green to indicate that action is not required immediately. See the Color Strip Key section below for additional information.
· Title - This displays the action item title, including the name of the review step, which is configured by the administrator when the review task is created. Click the action item title to open the Batch Rating page for the performance review step.
· Due Date - This displays the action item due date. If there are multiple due dates within a group of batched tasks, then the earliest due date is displayed.
· Task - This displays the name of the performance review task for which the performance review step is being completed.
· Priority Flag - This button allows users to mark action items as high priority. Priority can be helpful as a visual indicator to users. Also, action items can be filtered by priority from the Sort drop-down at the top of the page. When the priority flag is not selected, it is gray [image: ]. When the priority flag is selected, the action item is high priority and the flag is red [image: ].
Action Item Options
The following option is available from the action item drop-down menu:
· Launch - Click this option to open the appropriate step of the task.
Color Strip Key
The following colors are available:
· Red - Due today or past due
· Orange - Due within the next seven days, not including today
· Green - Due after seven days
Action Item - Succession Planning Task
All types of succession planning (SMP) tasks appear on the user's Action Items page.
To access the Action Items, go to Home > Universal Profile. Then, click the Actions tab. Note: The location of this link is configurable by your system administrator.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Action Items - EPM
	Grants ability to view and take action upon Performance (EPM) items on the Action Items page and in the Your Action Items widget. This permission can be constrained by OU, User's OU, User's Self, and User's Self and Subordinates. This is an end user permission.
	Universal Profile


View Team
The View Team flyout allows managers, approvers, and custom relationships to quickly navigate between subordinates' profiles and transcripts. When enabled, the View Team flyout is available to managers and dotted line managers on all pages of their Universal Profile and the Universal Profile of their subordinates. This flyout displays the manager's reports visually.
The View Team button displays if enabled in the portal. Administrators may enable or disable this flyout via the My Team Dropdown section within Universal Profile General Preferences. See Universal Profile General Preferences on page 2 for additional information.
See Universal Profile - View Team Flyout on page 648 for additional information.
Options
An Options drop-down may be available on various pages of the Universal Profile. This menu may include options such as Assign Training and Create Goal. See Universal Profile Options Drop-down Overview on page 653 for additional information.
Succession Task Action Item Details
When a succession planning action item is displayed on the Action Items page, the following is displayed for each action item:
· Color Strip - The left edge of the action item icon is color coded to represent proximity to the due date of the action item. For example, if the action item due date is past due, then the color strip is red to indicate that action is required immediately. If an action item due date is not eminent, then the color strip is green to indicate that action is not required immediately. See the Color Strip Key section below for additional information.
· Title - This displays the action item title. If the user is a co-planner for the SMP task, then the task title indicates this. Click the action item title to open the appropriate step of the task. If a task owner or reviewer attempts to open a task outside of their task period, the system prints the task rather than opening the task.
· Due Date - This displays the action item due date.
· Status - This displays the current status of the action item. See the Succession Planning Task Statuses and Actions section below for additional information.
· Priority Flag - This button allows users to mark action items as high priority. Priority can be helpful as a visual indicator to users. Also, action items can be filtered by priority from the Sort drop-down at the top of the page. When the priority flag is not selected, it is gray [image: ]. When the priority flag is selected, the action item is high priority and the flag is red [image: ].
Action Item Options
The following options are available from the action item drop-down menu:
· Launch - Click this option to open the appropriate step of the task.
· View as PDF - Click this option to download the task as a PDF. Print functionality is compatible with portals that utilize SSO, providing an asynchronous PDF generation process that prevents timeouts and page crashes.
Succession Planning Task Statuses and Actions
	Status
	Actions
	Action Behavior

	Not Started
	Launch
	Redirect the user to the selected step of the task

	In Progress
	Launch
	Redirect the user to the selected step of the task

	Past Due
	Launch
	Redirect the user to the selected step of the task


Succession planning tasks in Queued, Expired, or Complete status do not appear on the Action Items page.
For employee relationship tasks, the status is automatically updated to In Progress when the manager gets a new subordinate, even if the manager does not reopen the task. If the task status is complete and a new manager is assigned the task, the task status is updated to In Progress.
For assessor tasks, the status is automatically updated to In Progress when the assessor gets a new assessee, even if the assessor does not reopen the task. If the task is configured to allow assessors to be added after the task period starts, the task status is automatically updated to In Progress if a new assessor is added.
For job pool tasks that are an assessor based assignment, if the task status is complete before the task expires and a new incumbent is added to a position, the task status is automatically updated to In Progress even if the assessor does not reopen the task.
For job pool tasks that are a position to be planned assignment, if the task status is complete before the task expires and a new incumbent is added to a position, the task status is automatically updated to In Progress even if the assessor does not reopen the task.
Color Strip Key
The following colors are available:
· Red - Due today or past due
· Orange - Due within the next seven days, not including today
· Green - Due after seven days
[bookmark: _Toc161994655]Action Items - Planning
Planning tasks appear as actions in the Actions tab in Universal Profile. The following types of tasks appear as actions:
· Complete Headcount Plan [PlanName – AreaName] - This task appears for any planner user who has been assigned a headcount plan, whether as Co-Planner, Primary Planner, or Owner. The status of this task is Assigned. To access the task, click the Go To Planning button, which opens the Planning homepage, not the specific plan that requires action.
· Review Headcount Plan [PlanName – AreaName] - This task appears for senior planners that assigned subplans, once the subplanner submitted the subplan to the senior planner. The status of this task is For Review. To access the task, click the Go To Planning button, which opens the Planning homepage, not the specific plan that requires action.
Users cannot change the status of the action in Universal Profile. The action must be completed in the Planning application, at which point the action is updated to completed on the Universal Profile.
[bookmark: concept54]To access the Action Items, go to Home > Universal Profile. Then, click the Actions tab. Note: The location of this link is configurable by your system administrator.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Action Items - View
	Grants ability to view action items on the Action Items page and in the Your Action Items widget. Users without this permission cannot access the Action Items page. This permission can be constrained by Employee Relationship, OU, User's OU, User's Self and Subordinates, and User's Self. This is an end user permission.
	Universal Profile



	Work Force Planning - Administrator
	Grants access to the Headcount Planning page. Users with this permission can also create new headcount plans for any part of the organization, as well as create subplans that have been assigned to them. Administrators can only view plans that they have created or to which they were assigned as a Co-Planner or Primary Planner. This is an administrator permission.
	Core Administration



	Work Force Planning - Owner
	Grants owner-level access to plans. Users with this permission can view their assigned plans and can create plans. This permission cannot be constrained.
	Core Administration



	Work Force Planning - Subplanner
	Grants the ability to complete subplans that have been assigned to the user as a Primary Planner or a Co-Planner. Users with this permission cannot create new headcount plans or view all plans. Within the plans assigned to them, users can assign subplans to their direct reports.
	Core Administration


Use Case
Jane is the manager of a medium-sized department in a growing business. She is taking part in the annual headcount plan and entering the headcount needs she forecast for the next two years. She has also assigned subplans to a few of the managers below her so that she can get more accurate forecasts for those specific teams.
Using Universal Profile, she is able to see when her plan is due, and she can keep track of when the subplans are returned to her for her review.
[image: ]
[bookmark: _Toc161994656][bookmark: concept55]Action Items - Review Applicants
Applicant reviewers can access their applicant review task from the Actions tab in Universal Profile. The task appears for users who are designated as an applicant reviewer or the hiring manager for at least one job requisition.
You can sort the action options filter to view only Review Applicants tasks.
[image: ]
Review Applicants Task
The following information appears for Review Applicants tasks:
· Task Title - Review: Applicants for [Job Title (Requisition ID)]
· Due Date - The Review tasks do not have a due date.
· Status - The status of Review tasks is Pending. This is based on due dates for the review.
· Actions Button - The option available in the actions button for Review tasks is Review.
[bookmark: _Toc161994657]Action Items - Training Form
Training form tasks are available from the Universal Profile: Actions page.
To access the Action Items, go to Home > Universal Profile. Then, click the Actions tab.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Action Items - EPM
	Grants ability to view and take action upon Performance (EPM) items on the Action Items page and in the Your Action Items widget. This permission can be constrained by OU, User's OU, User's Self, and User's Self and Subordinates. This is an end user permission.
	Universal Profile


View Team
The View Team flyout allows managers, approvers, and custom relationships to quickly navigate between subordinates' profiles and transcripts. When enabled, the View Team flyout is available to managers and dotted line managers on all pages of their Universal Profile and the Universal Profile of their subordinates. This flyout displays the manager's reports visually.
The View Team button displays if enabled in the portal. Administrators may enable or disable this flyout via the My Team Dropdown section within Universal Profile General Preferences. See Universal Profile General Preferences on page 2 for additional information.
See Universal Profile - View Team Flyout on page 648 for additional information.
Options
An Options drop-down may be available on various pages of the Universal Profile. This menu may include options such as Assign Training and Create Goal. See Universal Profile Options Drop-down Overview on page 653 for additional information.
Training Form Action Item Details
When a training form item is displayed on the Action Items page, the following is displayed for each action item:
· Color Strip - The left edge of the action item icon is color coded to represent proximity to the due date of the action item. For example, if the action item due date is past due, then the color strip is red to indicate that action is required immediately. If an action item due date is not eminent, then the color strip is green to indicate that action is not required immediately. See the Color Strip Key section below for additional information.
· Title - This displays the action item title. Click the action item title to open the training form.
· Due Date - This displays the due date for the training form.
· Status - This displays the current status of the action item.
· Priority Flag - This button allows users to mark action items as high priority. Priority can be helpful as a visual indicator to users. Also, action items can be filtered by priority from the Sort drop-down at the top of the page. When the priority flag is not selected, it is gray [image: ]. When the priority flag is selected, the action item is high priority and the flag is red [image: ].
Action Item Options
The following options are available from the action item drop-down menu:
· Launch - Click this option to open the Manage Training Forms page.
Color Strip Key
The following colors are available:
· Red - Due today or past due
· Orange - Due within the next seven days, not including today
· Green - Due after seven days
[bookmark: _Ref-475592395][bookmark: _Ref1311271238][bookmark: _Toc161994658]Universal Profile - Requests Tab
[bookmark: concept58][bookmark: concept57]From the Requests tab, approvers can manage their pending approval requests, view completed requests, and view approval progress. The tab only displays for users with permission to view request items and request forms.
Use Cases
· Veronica is a recruiter who has multiple requisition requests to review. While she is in the Universal Profile performing actions under the Requests tab, she sees that she needs to approve requisition requests that Summer, a Hiring Manager, has initiated.
· Summer is a Hiring Manager who has multiple positions to fill on her team. After Veronica has created the requisitions that Summer requested, Summer goes to the Universal Profile to approve those requisitions before Veronica posts them.
To view approval requests, go to Home > Universal Profile > Actions. Then, click the Requests tab.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Request Items - Forms
	Allows user to access form requests on Universal Profile Request items. This permission cannot be constrained.
	Universal Profile



	Request Items - View
	Allows user to access the Requests tab on the Universal Profile > Actions tab. This permission cannot be constrained.
	Universal Profile



	Requisition: Approver
	Enables approver to access and approve/deny requisitions for which they are an approver. This permission cannot be constrained. Note: This is a dynamically assigned permission. If the user is removed as an approver for an offer that is in a Pending Offer status, the user can no longer access that version of the offer. This permission cannot be manually assigned.
	Recruiting



	Requisition: Manage
	Grants ability to access and manage all requisitions regardless of ownership (constraints permitting). This permission also grants read-only access to the Applicant Review tab when creating or editing a job requisition. This permission can be constrained by OU, User's OU, and Grade.
	Recruiting


[image: ]
View Team
The View Team flyout allows managers, approvers, and custom relationships to quickly navigate between subordinates' profiles and transcripts. When enabled, the View Team flyout is available to managers and dotted line managers on all pages of their Universal Profile and the Universal Profile of their subordinates. This flyout displays the manager's reports visually.
The View Team button displays if enabled in the portal. Administrators may enable or disable this flyout via the My Team Dropdown section within Universal Profile General Preferences. See Universal Profile General Preferences on page 2 for additional information.
See Universal Profile - View Team Flyout on page 648 for additional information.
Options
An Options drop-down may be available on various pages of the Universal Profile. This menu may include options such as Assign Training and Create Goal. See Universal Profile Options Drop-down Overview on page 653 for additional information.
Sort & Filter Options
The following sorting and filter options are available:
· Request Type - This option allows you to filter the list of requests by the request type. The following options are available:
· Show All - This option is selected by default. When selected, all requests appear on the page.
· Development Plan Approval
· Form Approval
· Goal Approval
· Peer Approval
· Requisition Approval - This option allows you to filter by job requisition approvals.
· Requisition Request - This option allows you to filter by requisition request approvals.
· Training Forms
· Date - This option allows you to sort the requests by the date submitted, the request status, or the request type.
· Status - This option allows you to sort the requests by pending, approved, denied, or returned status. The Pending status is selected by default. You can also select the Show All option to show requests with any of the request statuses.
· Approved - This status indicates that the submitted request has been approved. The request is now considered completed. Note: When viewing approved requisitions and requisition requests, a Review button displays for the item. Click Review to view the details of the approval decision and any comments that were submitted.
· Denied - This status indicates that the submitted request has been denied. The approver may have included comments to explain why the request was denied. Note: When viewing denied requisitions and requisition requests, a Review button displays for the item. Click Review to view the details of the approval decision and any comments that were submitted.
· Denied and Returned - This status indicates that the submitted request has been denied and returned to the user.
· Pending Approval - This status indicates that the submitted request is pending action from the approver to approver, deny, or deny and return the request.
Note: Approved and Denied goals are no longer visible after they are approval or denial.
· Keyword Search - This option allows you to filter the requests by the request title or the user who submitted the request. Enter the search terms in the field. 
· For Form requests, you cannot search for the form using the target user's name even though the target user's name appears in the request title. For example, if the request title is "Address Change Form for John Doe," you cannot search for this form using "John" or "Doe." 
· For requests with a "Submitted By" value in the metadata, you can search for the request using the first name or last name of the user who submitted the request, but you cannot include both in the search query. For example, John Doe submitted the request, you can search for the request using "John" or "Doe" but not "John Doe."
· For requests with a "Submitted For" value in the metadata, you can search for the request using the First Name and Last Name, the First Name, or the Last Name of the user who submitted the request.
Note: There is no character limit to this field. However, the more search terms you enter, the more specific the search results. To expand the search results, you can enter fewer search terms. 
· Start/End Date - This option allows you to filter the requests by a date range from when the request was submitted. Enter a date in the field or select a date from the calendar. The requests that display are the requests that were submitted by the user within the defined date range. The results display in order of the requests' status, from pending to approved, denied, returned. Within each group, the results display in order of least to most recently submitted.
Once the sort and filter options are defined, click Search to display the request results.
Request Details for Form Approval Requests
Each request contains the following information:
· Title and Target User - Title of request and the name of the target user. Although the target user name is displayed in the Title, it is not possible to search by target user name.
· Date Submitted - Date the request was submitted.
· Status - Current status of the request.
· Submitted by - The username of the person who submitted the request. The Keyword search can be performed by "First Name" or "Last Name."
· Submitted For - The username of the target user. It only appears under Observation Checklists. The Keyword search can be performed by "First Name Last Name" or just "First Name" or "Last Name"of the target user. 
  
Request Types
The following types of requests may be available:
Actions - Compensation Plan Approvals
From the Actions tab, approvers can access their pending approval requests. Only pending compensation plan approval requests are displayed. The tab only displays for users with permission to view request items.
Approvers can view compensation plan approval requests that require their approval or denial from the Universal Profile: Actions page.
To view approval requests, go to Home > Universal Profile > Actions. Then, click the Actions tab.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Action Items - EPM
	Grants ability to view and take action upon Performance (EPM) items on the Action Items page and in the Your Action Items widget. This permission can be constrained by OU, User's OU, User's Self, and User's Self and Subordinates. This is an end user permission.
	Universal Profile



	Request Items - View
	Allows user to access the Requests tab on the Universal Profile > Actions tab. This permission cannot be constrained.
	Universal Profile


When a compensation plan approval request is displayed, the following is displayed for each request:
· Color Strip - The left edge of the action item icon is color coded to represent proximity to the due date of the action item. For example, if the action item due date is past due, then the color strip is red to indicate that action is required immediately. If an action item due date is not eminent, then the color strip is green to indicate that action is not required immediately. See the Color Strip Key section below for additional information.
· Title - This displays the action item title. Click the action item title to open the Approval tab of the compensation plan.
· Due Date - This displays the due date for the compensation plan.
· Status - This displays the current status of the request.
· Compensation Manager - This displays the user who is serving as the compensation manager for the compensation plan.
Options
The following option may be available from the action item drop-down menu for compensation managers and co-planners:
· Review Plan - This option opens the Approval tab of the compensation plan, where the approver can review and approve the compensation plan. Compensation plan approvers can only approve a compensation plan from the Approval tab of the compensation plan. This ensures the approver has viewed the details of the compensation plan that is being approved. 
Color Strip Key
The following colors are available:
· Red - Due today or past due
· Orange - Due within the next seven days, not including today
· Green - Due after seven days
[bookmark: concept60]Actions - Requests - Development Plans
From the Requests tab, approvers can access their pending approval requests. The tab only displays for users with permission to view request items.
Approvers can view development plan approval requests from the Requests tab of the Universal Profile: Actions page.
To view approval requests, go to Home > Universal Profile > Actions. Then, click the Requests tab.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Request Items - View
	Allows user to access the Requests tab on the Universal Profile > Actions tab. This permission cannot be constrained.
	Universal Profile


Emails
	EMAIL NAME
	EMAIL DESCRIPTION
	ACTION TYPE



	Development Plan Approval Denied
	This email is triggered when a development plan approval request is denied. The user receives the email stating that their Development Plan Approval Request is denied.
	Performance Management



	Development Plan Approval Granted
	This email is triggered when a user's development plan is approved. This email is sent to the user who submitted the plan.
	Performance Management


When a development plan approval request is displayed on the Requests tab, the following is displayed for each request:
· Color Strip - The left edge of the action item icon is color coded to represent proximity to the due date of the action item. For example, if the action item due date is past due, then the color strip is red to indicate that action is required immediately. If an action item due date is not eminent, then the color strip is green to indicate that action is not required immediately. See the Color Strip Key section below for additional information.
· Title - This displays the action item title. Click the action item title to view the user's development plan.
· Date Submitted - This displays the date on which the item was submitted for approval.
· Status - This displays the current status of the request.
· Submitted by - This displays the name of the user who submitted the development plan for approval.
Approve
To approve the request, click the Approve button [image: ]. This commits your approval decision for that development plan. The development plan's status is updated to Approved. If the email is configured, then this action triggers an email notification to alert the user that their development plan was approved.
Deny
To deny the request, click the Deny button [image: ]. If the email is configured, then this action triggers an email notification to alert the user that their development plan was denied.
Options
The following options may be available from the action item drop-down menu:
· View - Select this option to view the user's development plan. After reviewing the plan, click the Back button to return to the Requests page.
· Edit - This option may be available depending on the configuration of the development plan. Select this option to edit the user's development plan.
Color Strip Key
The following colors are available:
· Red - Due today or past due
· Orange - Due within the next seven days, not including today
· Green - Due after seven days
Actions - Requests - Forms
[bookmark: concept62][bookmark: concept61]From the Requests tab, approvers can access their pending approval requests, view completed requests, and view approval progress. The tab only displays for users with permission to view request items and request forms.
Forms are available to organizations that are using Onboarding or Cornerstone HR. For information on Training Forms, select the following link: See Training Forms Administration.
To view approval requests, go to Home > Universal Profile > Actions. Then, click the Requests tab.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Request Items - Forms
	Allows user to access form requests on Universal Profile Request items. This permission cannot be constrained.
	Universal Profile



	Request Items - View
	Allows user to access the Requests tab on the Universal Profile > Actions tab. This permission cannot be constrained.
	Universal Profile


When a form approval request is displayed on the Requests tab, the following is displayed for each request:
· Color Strip - The left edge of the action item icon is color coded to represent proximity to the due date of the action item. For example, if the action item due date is past due, then the color strip is red to indicate that action is required immediately. If an action item due date is not eminent, then the color strip is green to indicate that action is not required immediately. See the Color Strip Key section below for additional information.
· Title - This field displays the linked title of the form. Click the link to view the form.
· Date Submitted - This field displays the date on which the form was submitted.
· Status - This field displays the approval status as Approved, Denied, Denied and Returned, or Pending Approval.
· Submitted By - This field displays the name of the user who submitted the request.
· Attachments - If a form has any attachments in a User Attachment field, then the number of files attached to the form is displayed.
· Effective Date - If a form requires approval and has effective dating enabled, then the form's effective date is displayed. The effective date is displayed regardless of the approval status of the form (e.g., Pending, Approved, Denied, Returned).
Approve
To approve the request, click the Approve button [image: ]. This commits your approval decision for that step in the approval workflow and any other steps for which you are an approver. If this is the last step in the workflow and you are the only approver in the step, then the request is considered completed, and the form's status is updated to Approved. If there are other approval steps in the workflow or if other approvers are in your step of the workflow who are required to submit an approval decision, then the request is not considered completed until all steps in the workflow are finished.
Deny
To deny the request, click the Deny button [image: ]. Denying a request ends the approval workflow process.
View Details of Form Request
To view the details of a form for which you are an approver, click the drop-down in the far right of the form row. Then, click View. This opens the form so that you can see the content of the form and the user's responses, as well as approve, deny, or deny and return the form. You can also view the progress of the approval workflow. If you have already made an approval decision for the request, then your decision displays at the top of the form along with the date on which you submitted your decision. Click Done to close the form. See Form - Approve or Deny on page 103 for additional information.
Options
The following options may be available from the action item drop-down menu:
· Approval Progress - The approval workflow is defined by the administrator when creating the form. Your step of the approval process may be the only step or one of many steps. In addition, there may be more than one approver in your step. Steps can also be configured so that if there are multiple approvers in a step and one of the approvers approves or denies the form before you, then you can no longer make an approval decision. To view the progress of the form's approval workflow, click the drop-down in the far right of the form row. Then, click Approval Progress. This opens the Approval Progress pop-up. See Form - View Approval Progress on page 106 for additional information.
· Approve - This option only displays for requests that are in a Pending status. Click Approve from the drop-down to approve the request. This commits your approval decision for that step in the approval workflow and any other steps for which you are an approver. If this is the last step in the workflow and you are the only approver in the step, then the request is considered completed, and the form's status is updated to Approved. If there are other approval steps in the workflow or if other approvers are in your step of the workflow who are required to submit an approval decision, then the request is not considered completed until all steps of the workflow are finished. See Form - Approve or Deny on page 103 for additional information.
· Deny - This option only displays for requests that are in a Pending status. Click Deny from the drop-down to deny the request. Denying a request ends the approval workflow process. See Form - Approve or Deny on page 103 for additional information.
FAQs
What happens to the request if onboarding is cancelled for the onboarding user?
The approval request is automatically removed from the Requests tab for all approvers.
What if I'm an approver in more than one step?
If the same approver is in multiple steps, then their approval decision applies to each step they are in. Once they have submitted their approval decision, they are skipped in any remaining steps in the workflow.
What approval workflow is used for forms completed by proxy?
For forms that are completed by proxy, the approver is based on the user for whom the form is being completed.
[bookmark: concept63]Actions - Requests - Goals
From the Requests tab, approvers can access their pending approval requests, view completed requests, and view approval progress. The tab only displays for users with permission to view request items.
Approvers can view goal approval requests from the Requests tab of the Universal Profile: Actions page.
To view approval requests, go to Home > Universal Profile > Actions. Then, click the Requests tab.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Request Items - View
	Allows user to access the Requests tab on the Universal Profile > Actions tab. This permission cannot be constrained.
	Universal Profile


Emails
	EMAIL NAME
	EMAIL DESCRIPTION
	ACTION TYPE



	Goal Approved
	This email is triggered when a user submits a goal or requests to cancel a goal and the request is approved by the approver.
	Performance Management



	Goal Denied
	This email is triggered when a user submits a goal or requests to cancel a goal and the request is denied by the approver.
	Performance Management


When a goal approval request is displayed on the Requests tab, the following is displayed for each request:
· Color Strip - The left edge of the action item icon is color coded to represent proximity to the due date of the action item. For example, if the action item due date is past due, then the color strip is red to indicate that action is required immediately. If an action item due date is not eminent, then the color strip is green to indicate that action is not required immediately. See the Color Strip Key section below for additional information.
· Title - This displays the action item title. Click the action item title to open the View Goal or Edit Goal page. The ability for an approver to edit a user's goal is configured by the administrator.
· Date Submitted - This displays the date on which the item was submitted for approval.
· Goal Owner - This displays the name of the user who submitted the goal for approval. 
· Status - This displays the current status of the request.
Approve
To approve the request, click the Approve button [image: ]. This commits your approval decision for that goal. The goal's status is updated to Approved. If the email is configured, then this action triggers an email notification to alert the user that their goal was approved.
Deny
To deny the request, click the DENY button. This opens a Deny Request pop-up asking for your confirmation. Once confirmed, the goal's status will be updated to Denied. If the email is configured, then this action triggers an email notification to alert the user that their goal was denied.
Options
The following options may be available from the action item drop-down menu:
· View - This option is available if the goal is locked or if managers and approvers are not allowed to edit an employee's goal. This option opens a read-only version of the user's goal. The approver is able to add comments and attachments to the goal. The option to Approve or Deny the goal is available when viewing the goal. See Goal - Approve or Deny on page 109 for additional information.
· Edit - This option is available if managers and approvers are allowed to edit an employee's goal. This option opens the Edit Goals page for the goal. See Goal - Create/Edit (New Design).
Color Strip Key
The following colors are available:
· Red - Due today or past due
· Orange - Due within the next seven days, not including today
· Green - Due after seven days
[bookmark: concept64]Actions - Requests - Observation Checklists
From the Requests tab, approvers can access their pending approval requests, view completed requests, and view approval progress. The Requests tab only displays for users with permission to view request items.
Approvers can view observation checklist approval requests from the Requests tab of the Universal Profile: Actions page.
To view approval requests, go to Home > Universal Profile > Actions. Then, click the Requests tab.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Request Items - View
	Allows user to access the Requests tab on the Universal Profile > Actions tab. This permission cannot be constrained.
	Universal Profile


Emails
	EMAIL NAME
	EMAIL DESCRIPTION
	ACTION TYPE



	Observation Checklist Completed
	This email is triggered when an observation checklist is completed.
	Observation Checklist



	Checklist Approval Denied
	This email can be configured as a notification. When configured as a notification, the email is triggered immediately after a checklist changes from Pending Completion Approval status to Denied status. The available recipients in the Send To and CC fields are User's Manager, Checklist Verifier, or Assessee.
	Observation Checklist


When an observation checklist approval request is displayed on the Requests tab, the following is displayed for each request:
· Color Strip - The left edge of the action item icon is color coded to represent proximity to the due date of the action item. For example, if the action item due date is past due, then the color strip is red to indicate that action is required immediately. If an action item due date is not eminent, then the color strip is green to indicate that action is not required immediately. See the Color Strip Key section below for additional information.
· Title - This displays the action item title. Click the action item title to view the observation checklist.
· Date Submitted - This displays the date on which the item was submitted for approval.
· Status - This displays the current status of the request.
· Submitted For - This displays the name of the assessee for whom the observation checklist was submitted for approval.
Approve
To approve the request, click the Approve button [image: ]. This commits your approval decision for that observation checklist. The observation checklist's status is updated to Approved. If the email is configured, then this action triggers an email notification to alert the user that their observation checklist was approved and completed.
Deny
To deny the request, click the Deny button [image: ]. If the email is configured, then this action triggers an email notification to alert the user that their observation checklist was denied.
Options
The following options may be available from the action item drop-down menu:
· View - Select this option to view the user's observation checklist. After reviewing the observation checklist, click the Back button to return to the Requests page.
Color Strip Key
The following colors are available:
· Red - Due today or past due
· Orange - Due within the next seven days, not including today
· Green - Due after seven days
[bookmark: concept65]Actions - Requests - Offer Letters
Offer letters can be reviewed, approved, and denied from the Requests tab in Universal Profile. This allows you to make all relevant actions from the Requests tab. This streamlines the offer letter approval process by reducing the amount of time it will take for users to make offer letter decisions, which allows recruiters and hiring managers to focus on improved service and delivering value.
Use Cases
Rachel is a recruiter who has multiple offer letters to review. While she is in the Universal Profile performing actions under the Requests tab, she sees that she needs to approve some offer letters that Summer, a Hiring Manager, has initiated.
Summer is a Hiring Manager who has multiple positions to fill on her team. While she is in the Universal Profile performing other actions, she also approves offer letters for the candidates whom she recently decided to hire.
Scenario 1: View Status of Offer Letters from Universal Profile > Actions
· Rachel goes to the Universal Profile > Actions page in order to check the status of her open offer letters.
· From the Actions page Rachel selects the Requests tab.
· From the Requests tab, Rachel can see all requests requiring action, including Offer Letters Approval action items.
· From the Requests tab filter, Rachel selects "Offer Letters" and "Pending" in the Universal Profile status filter to view all offer letters awaiting her approval.
Scenario 2: Approve Offer Letters from Universal Profile > Actions
· From the Requests tab filter, Rachel can see offer letter approvals that require her attention.
· Rachel sees an offer letter approval tile with a status of Pending Approval.
· The approval tile contains a Review Offer Letter icon [image: ].
· Rachel clicks the Review Offer Letter icon [image: ] to view the offer letter.
· The offer letter opens and displays the offer letter details, as well as Approve/Deny buttons. In addition, a Download Offer Letter button and Comments section displays.
· Rachel reviews the offer letter, enters comments (optional), and selects the Approve button.
· The offer letter status is moved from Pending to Approved with comments added by Rachel.
· The Offer Letter action item is removed from the Universal Profile status Pending filter and appears in the Approved and Show All filters.
· When Rachel comes back to view this offer letter in the future, the offer letter will appear with read-only comments and no buttons to approve or deny.
Scenario 3: Deny Offer Letters from Universal Profile > Actions
· From the Requests tab filter, Rachel can see offer letter approvals that require her attention.
· Rachel sees an offer letter approval tile with a status of Pending Approval.
· The approval tile contains a Review Offer Letter icon [image: ].
· Rachel clicks the Review Offer Letter icon to view the offer letter.
· The offer letter opens and displays the offer letter details, as well as Approve/Deny buttons. In addition, a Download Offer Letter button and Comments section displays.
· Rachel reviews the offer letter, enters comments (optional), and selects the Deny button.
· The offer letter status is changed from Pending to Denied, with comments added by Rachel.
· The Offer Letter action item is removed from the Universal Profile status Pending filter and appears in the Denied and Show All filters.
· When Rachel comes back to view this offer letter in the future, the offer letter will appear with read-only comments and no buttons to approve or deny.
Scenario 4: Remove Offer Letters Approved by Alternates
Rachel was not able to approve some of her offer letters, since she was recently out of the office. Because Rachel was out of the office, one of the offer letters was approved by her alternate, Summer, who is the hiring manager.
· From the Requests tab filter, Rachel can see offer letter approvals that require her attention.
· Rachel sees an offer letter approval tile with a status of Approved by Alternate. The tile contains the Review Offer Letter icon [image: ] and a Remove option.
· Rachel selects the Review Offer Letter icon [image: ] to view the offer letter.
· The offer letter displays the Offer Letter Details, a Download Offer Letter button, read-only comments, and a Close button.
· After reviewing the offer letter, Rachel closes the offer letter.
· Satisfied with the actions that Summer took in her absence, Rachel selects the Remove option.
· The Offer Letter action item is removed from the Pending list of items, and will only appear under the Show All filter.
· When Rachel comes back to view this offer letter in the future, the offer letter will appear with read-only comments and no buttons to approve or deny.
Scenario 5: Review and Remove Notification-Only Offer Letters
Rachel is not the approver in this scenario. Instead, she has been selected to receive a notification when an approval action is taken on an offer letter. Because Rachel is the notification recipient in this scenario, she expects to see a notification tile for all offer letters for which she is the notification recipient.
· From the Requests tab filter, Rachel can see offer letter approvals that require her attention.
· Rachel sees an offer letter approval tile with a status of Notification Only. The tile contains the Review Offer Letter icon [image: ] and a Remove option.
· Rachel selects the Review Offer Letter icon [image: ] to view the offer letter.
· The offer letter displays the offer letter details, a Download Offer Letter button, read-only comments, and a Close button.
· After reviewing the offer letter, Rachel closes the offer letter.
· Satisfied with the actions that Summer took in her absence, Rachel selects the Remove option.
· The Offer Letter action item is removed from the Pending list of items, and will only appear under the Show All filter.
· When Rachel comes back to view this offer letter in the future, the offer letter will appear with read-only comments and no buttons to approve or deny.
Scenario 6: View Offer Letter Approval status of Direct Reports
Rachel is not the approver in this scenario. Instead, she would like to view the offer letter approval status of her direct report, Summer.
· To view Summer's approval actions, Rachel selects Summer from the My Direct Reports drop-down.
· From the Requests tab, Rachel can see offer letter approvals that require Summer's attention.
· While Rachel can view offer letters pending Summer's approval, she cannot take action for any of Summer's Offer Letter approvals.
To view your offer letter approval actions, go to Universal Profile > Actions.
Note: When viewing the Universal Profile for a direct report, the Requests tab will display the Offer Letter action items for which they are part of the approval cycle. The action items display as read-only and allow you to view the general details of the offer letter, such as the requisition title and status. The offer letter itself cannot be viewed.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Offer: Approver
	Grants ability to access and approve/deny offer letters and include comments for offers for which the user is listed as an approver. Grants ability to access pages related to requisitions for which the user is listed as an approver, including read-only access to all tabs of the Edit Requisition page in Manage Job Requisitions. This permission cannot be constrained. Note: This is a dynamically assigned permission that is not available in Security Role Administration. This permission cannot be constrained. Once assigned, the permission is never removed dynamically, which enables approvers to revisit offer letters that they have already approved or denied. If an approver is removed from an offer that is in a Pending Offer status, the approver can no longer access that version of the offer letter in their Pending tab. If an approver is removed from a past version of an offer, the approver's access to the past offer remains. This permission cannot be manually assigned.
	Recruiting



	Request Items - View
	Allows user to access the Requests tab on the Universal Profile > Actions tab. This permission cannot be constrained.
	Universal Profile


Action Item Type Filter
You can use the action item type filter to filter the Requests tab to only display offer letters that are pending your approval. Select Offer Letter in the filter to update the page with only offer letters.
Offer Letter Approval Action Item
The Offer Letter Approval action item displays on the Requests tab in order of most recently submitted.
The following displays for the action item:
· Job Title - Click the job title to open the Edit Requisition page. This allows you to view details about the requisition. Requisition owners can edit the Requisition Status field, as per existing functionality for offer letter approvals. Click Back or Save to return to the Universal Profile > Actions page. Note: When viewing the requisition, custom fields are visible to users who meet the availability criteria for the custom field.
· Submitted - This field displays the date on which the offer letter was submitted for approval.
· Primary Owner - This field displays the primary owner of the job requisition.
· Status - This field displays the status of the offer letter. The following are the possible values:
· Pending
· Approved
· Denied
· [Approved/Denied] by Alternate
· Notification Only
· Candidate - This field displays the name of the candidate for whom the offer letter was created.
· Review Offer Letter - Click the Review Offer Letter icon [image: ] to open the offer letter. When viewing the offer letter, you can approve or deny it by clicking the associated button at the bottom of the letter. See Approve/Deny Offer Letter below for more information.Note: The Review Offer Letter icon is only available while you are still able to submit an approval decision.
· Remove - Click Remove to remove the action item from your active list. Upon removing the action item, it can be viewed by clicking the Show All option in the action item status filter. Or, you can click the Approved option in the status filter to view approved requests. Or, you can click the Denied option in the status filter to view denied requests. You can also remove the action item from your active list by clicking the X icon in the upper-right corner of the tile.
[image: ]
Notification Only Approvers
For approvers who are added to the approval workflow as "Notification Only," the Offer Letter Approval action item displays on the Requests tab with a status of "Notification Only."
You can view the offer letter by clicking the Review Offer Letter icon [image: ].
You can remove the action item from your pending requests by clicking Remove. Upon removing the action item, it can be viewed by clicking the Show All option in the action item status filter.
Note: The Notification only option is selected for an approver when configuring the offer letter approval workflow. See the Offer Letter Workflow - Approval topic in Online Help for more information about this setting.
Approved/Denied by Alternate Approver in Your Approval Workflow Step
When you are part of an approval workflow step that includes another user who is required to submit an approval decision, the following scenarios may occur in the approval process:
· The other approver in your step approves the offer letter before you have submitted an approval decision. In this case, the action item displays "Approved by Alternate," and you can no longer submit an approval decision.
[image: ]
· The other approver in your step denies the offer letter before you have submitted an approval decision. In this case, the action item displays "Denied by Alternate," and you can no longer submit an approval decision.
· The other approver in your step denies the offer letter at the same time that you are viewing the offer letter but have not yet submitted a decision. The letter will be denied and you will not be able to submit an approval decision. In this case, the action item displays "Denied by Alternate."
Note: These scenarios occur if the approval step is configured as an OR rule by the administrator or if the step is part of an AND pair combined in a single approval sequence.
Approved/Denied by Alternate Approver in Overall Approval Workflow
As with existing functionality for offer letter approvals, if any approver that is in an approval step before yours approves or denies the offer letter, then the entire offer letter is approved or denied. The action item will display on the Requests tab as "[Approved/Denied] by Alternate," and you can no longer submit an approval decision.
View Offer Letter
You can view the offer letter by clicking the Review Offer Letter button [image: ]. This opens the offer letter. From here, you can view details of the offer letter, such as proposed compensation and the expected start date of the position. You can also approve or deny the offer letter.
[bookmark: 856909602]Approve/Deny Offer Letter
You can approve or deny the offer letter directly from the action item. To approve or deny:
1. Click the Review Offer Letter icon [image: ]. This opens the offer letter. Note: The Review Offer Letter icon is only available if you are still able to submit an approval decision.
2. Click Deny at the bottom of the offer letter to deny the offer letter.
3. Click Approve at the bottom of the offer letter to approve the offer letter.
Once your approval decision is made, the status of the offer letter changes to Approved or Denied, depending on the decision. The action item is removed from your list of actions and moves to the next step in the approval cycle.
[image: ]
Add Comments
When viewing the offer letter, you can enter comments about the offer in the Comment section. There is no character limit.
Comments can be viewed by others in the approval workflow.
Edit Offer Letter
Offer letters cannot be edited from the Universal Profile > Actions > Requests tab. Editing an offer letter can only be done from the Statuses tab on the Applicant Profile page. See the Create Offer Letter topic in Online Help for more information about editing offer letters.
[bookmark: concept66]Actions - Requests - Peers
From the Requests tab, approvers can access their pending approval requests, view completed requests, and view approval progress. The tab only displays for users with permission to view request items.
Approvers can view peer approval requests from the Requests tab of the Universal Profile: Actions page.
To view approval requests, go to Home > Universal Profile > Actions. Then, click the Requests tab.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Bio About - View
	Enables user to view the Bio page for users within their permission constraints. This permission must be enabled to view the Transcript page within Universal Profile. If a user does not have this permission and they click a person's name or user photo within the Universal Profile, then the Bio page will not open.
On the Learner Home page, this permission also allows end users to view the Completions & Hours field, the training sidebar, and the Continue Learning carousel. 
This permission can be constrained by Employee Relationship, OU, User's OU, User's Direct Reports, User Self and Subordinates, and User. Note: For security purposes, this permission is constrained to User Self and Subordinates by default. However, the permission constraints can be modified to allow users to view the Bio About page for other users.
	Universal Profile



	Request Items - View
	Allows user to access the Requests tab on the Universal Profile > Actions tab. This permission cannot be constrained.
	Universal Profile


When a peer approval request is displayed on the Requests tab, the following is displayed for each request:
· Color Strip - The left edge of the action item icon is color coded to represent proximity to the due date of the action item. For example, if the action item due date is past due, then the color strip is red to indicate that action is required immediately. If an action item due date is not eminent, then the color strip is green to indicate that action is not required immediately. See the Color Strip Key section below for additional information.
· Title - This displays the action item title. Click the action item title to view the Universal Profile - Bio page for the peer. The user's Bio page cannot be viewed if the approver does not have permission to view the peer's Bio page or if the peer is an external user.
· Date Submitted - This displays the date on which the item was submitted for approval.
· Group - This displays the peer group to which the peer is being added.
· Submitted by - This displays the name of the user who submitted the peer for approval.
Approve
To approve the request, click the Approve button [image: ]. This commits your approval decision for that peer. If the email is configured, then this action triggers an email notification to alert the user that their development plan was approved.
Deny
To deny the request, click the Deny button [image: ]. 
Options
The following options may be available from the action item drop-down menu:
· View - Select this option to view the Universal Profile - Bio page for the peer. The user's Bio page cannot be viewed if the approver does not have permission to view the peer's Bio page or if the peer is an external user.
Color Strip Key
The following colors are available:
· Red - Due today or past due
· Orange - Due within the next seven days, not including today
· Green - Due after seven days
Actions - Requests - Requisition Approval
Users with permission to approve requisitions (listed as a Requisition Approver on a requisition’s hiring team) can approve/deny job requisitions from the Actions > Requests tab in the Universal Profile.
To view approval requests, go to Home > Universal Profile > Actions. Then, click the Requests tab.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Request Items - View
	Allows user to access the Requests tab on the Universal Profile > Actions tab. This permission cannot be constrained.
	Universal Profile



	Requisition: Approver
	Enables approver to access and approve/deny requisitions for which they are an approver. This permission cannot be constrained. Note: This is a dynamically assigned permission. If the user is removed as an approver for an offer that is in a Pending Offer status, the user can no longer access that version of the offer. This permission cannot be manually assigned.
	Recruiting


[image: ]
View Pending Items
The following information displays for pending requisition approval items:
· Icon - An icon displays for each pending approval item. The icon displays a red checkmark for Requisition Approvals.
· Color Strip - A color strip displays on the left side of the item. The following colors display:
· Red - This indicates that the action is more than six days old.
· Yellow - This indicates the action is 3-6 days old.
· Green - This indicates that the action is less than three days old.
· Title - This displays the title of the requisition. Hover over the title to view the Position organizational unit (OU). The title of the requisition is clickable. Click the title to open the Edit Requisition page, which allows you to review the details of the requisition prior to making a decision. You can also modify the requisition and submit the changes if the requisition is in an editable status. For more information about editable fields based on requisition status, see the 
Note: The visibility of custom fields on a requisition is based on the availability settings for the field in Custom Field Administration.
· Date Submitted - This displays the date on which the item was submitted.
· Primary Owner - This displays the primary owner of the item.
· Status - This displays the approval status of the item. The statuses that display are dependent upon the approval status options for requisitions.
· ID - This displays the requisition ID.
Deny Requisition
To deny the requisition:
1. Click the deny button [image: ]. This opens the deny pop-up.
2. Enter comments about your approval decision in the Comment box, up to 2000 characters.
3. Click Deny to process the denial.
Once you have submitted your decision, the pending action item is removed from the Requests tab. The status is updated to Denied, and the approval process is considered completed. No subsequent approvers in the workflow can make an approval decision. Any approval decisions and comments made prior to the denial are saved.
Approve Requisition
To approve the requisition:
· Click the approve button [image: ]. This opens the approve pop-up.
· Enter comments about your approval decision in the Comment box, up to 2000 characters.
· Click Approve to process the approval.
Once you have submitted your decision, the pending action item is removed from the Requests tab. This commits your approval decision for that step in the approval workflow and any other steps for which you are an approver.
If this is the last step in the workflow and you are the only approver in the step, then the request is considered completed, and the form's status is updated to Approved.
If there are other approval steps in the workflow or if other approvers are in your step of the workflow, then the request is not considered completed until all steps in the workflow are finished.
Actions - Requests - Requisition Requests
Users who are identified in Admin > Recruit > Requisition Requests as requisition request approvers can approve/deny requisition requests.
To view approval requests, go to Home > Universal Profile > Actions. Then, click the Requests tab.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Request Items - View
	Allows user to access the Requests tab on the Universal Profile > Actions tab. This permission cannot be constrained.
	Universal Profile



	Requisition: Approver
	Enables approver to access and approve/deny requisitions for which they are an approver. This permission cannot be constrained. Note: This is a dynamically assigned permission. If the user is removed as an approver for an offer that is in a Pending Offer status, the user can no longer access that version of the offer. This permission cannot be manually assigned.
	Recruiting



	Requisition: Manage
	Grants ability to access and manage all requisitions regardless of ownership (constraints permitting). This permission also grants read-only access to the Applicant Review tab when creating or editing a job requisition. This permission can be constrained by OU, User's OU, and Grade.
	Recruiting


[image: ]
View Pending Items
The following information displays for pending requisition request approval items:
· Icon - An icon displays for each pending approval item. The icon displays a blue plus sign for Requisition Request Approvals.
· Color Strip - A color strip displays on the left side of the item. The following colors display:
· Red - This indicates that the action is more than six days old.
· Yellow - This indicates the action is 3-6 days old.
· Green - This indicates that the action is less than three days old.
· Title - The title of the item is clickable. Click the title to open the Requisition Request page, which allows you to review the details of the request prior to making a decision. In addition, visibility of custom fields on the requisition are dependent upon how the availability for the custom field is configured by the administrator in Custom Field Administration.
· Date Submitted - This displays the date on which the item was submitted.
· Primary Owner - This displays the primary owner of the item.
· Requested By - This displays the name of the person who submitted the requisition request.
· Status - This displays the approval status of the item. The statuses that display are dependent upon the approval status options for requisition requests.
· Division - The division associated with the requisition request.
· Location - The location associated with the requisition request. 
View/Deny/ApproveRequisition Request
Click the Review Requisition Request button [image: ] to open the View Requisition Request page. This allows you to view a read-only version of the requisition request.
As with existing functionality, you can decline or approve the request from the View Requisition Request page. Approval of a request involves creating the requisition by clicking the Create Requisition button. Once you have submitted your approval decision, the pending action item is removed from the list.
For more information about declining/creating requisition requests, see the Review/Decline/Accept Requisition Request topic in Online Help.
View Direct Reports' Universal Profile
When viewing the Actions > Requests page for another user's Universal Profile via the My Direct Reports option, there are no clickable options for the requisition request. You can view the general details of the request, such as the date submitted and requester, but you cannot take action on the request.
[bookmark: concept69]Actions - Requests - Training Forms
From the Requests tab, approvers can access their pending approval requests and view approval progress. The tab only displays for users with permission to view request items.
Approvers can view training form approval requests from the Requests tab of the Universal Profile: Actions page.
To view approval requests, go to Home > Universal Profile > Actions. Then, click the Requests tab.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Request Items - View
	Allows user to access the Requests tab on the Universal Profile > Actions tab. This permission cannot be constrained.
	Universal Profile


Emails
	EMAIL NAME
	EMAIL DESCRIPTION
	ACTION TYPE



	Training Form Approved
	User's training form marked Approved by an Approver.
	Training Form Management



	Training Form Denied
	User's training form marked Denied by an Approver.
	Training Form Management


When a training form approval request is displayed on the Requests tab, the following is displayed for each request:
· Color Strip - The left edge of the action item icon is color coded to represent proximity to the due date of the action item. For example, if the action item due date is past due, then the color strip is red to indicate that action is required immediately. If an action item due date is not eminent, then the color strip is green to indicate that action is not required immediately. See the Color Strip Key section below for additional information.
· Title - This displays the action item title. Click the action item title to view the user's training form.
· Date Submitted - This displays the date on which the item was submitted for approval.
· Status - This displays the current status of the request.
· Submitted by - This displays the name of the user who submitted the training form for approval.
Approve
To approve the request, click the Approve button [image: ]. This commits your approval decision for that training form. The training form's status is updated to Approved. If the email is configured, then this action triggers an email notification to alert the user that their training form was approved.
Deny
To deny the request, click the Deny button [image: ]. If the email is configured, then this action triggers an email notification to alert the user that their training form was denied.
Options
The following options may be available from the action item drop-down menu:
· View - Select this option to view the user's training form. After reviewing the form, click the Back button to return to the Requests page.
Color Strip Key
The following colors are available:
· Red - Due today or past due
· Orange - Due within the next seven days, not including today
· Green - Due after seven days
[bookmark: _Ref982656776][bookmark: _Ref-1476514157]Form - Approve or Deny
Form approval requests can be approved or denied by opening the form and using the approval options on the form. Approvers can only provide comments when making an approval decision directly on the form. When viewing the form, approvers can see the form questions and the user's responses, as well as access the approval progress.
Note: Approvers can also approve/deny requests from the Requests tab in Universal Profile. See Universal Profile - Requests Tab on page 74 for additional information.
To view approval requests, go to Universal Profile > Actions. Then, click the Requests tab.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Action Items - Forms
	Grants ability to view Form actions via the Universal Profile - Actions page or the Welcome/Custom page Actions widget. This permission cannot be constrained.
	Universal Profile



	Request Items - Forms
	Allows user to access form requests on Universal Profile Request items. This permission cannot be constrained.
	Universal Profile



	Request Items - View
	Allows user to access the Requests tab on the Universal Profile > Actions tab. This permission cannot be constrained.
	Universal Profile


Emails
	EMAIL NAME
	EMAIL DESCRIPTION
	ACTION TYPE



	Training Form Approved
	User's training form marked Approved by an Approver.
	Training Form Management



	Training Form Denied
	User's training form marked Denied by an Approver.
	Training Form Management
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View Form
When viewing the form to make an approval decision, the form is read-only. The form displays all questions and the user's responses to the questions.
When reviewing a form that has updated values, you can see the current value next to the submitted value. An asterisk is displayed next to field a field name if the submitted field value has been changed from the current value.
Note: Attachment fields will not display a "Current" value in non-effective dated forms, and Attachment and Question Bank fields will not display a "Current" value in effective dated forms.
Alert for Effective Dating
For organizations using Effective Dating on the user record, a message is displayed on a form if a field value in a form will be overwritten by a future-dated change to the user record.
The message is visible when submitting a form and when approving a form. The message indicates that a future scheduled change will overwrite one or more fields on the form. 
The message does not include the fields which will be overwritten. However, users with permission to access user records can view and access a direct link to the target user record. The user must have the appropriate permissions to view 
Approve/Deny Form
The approval options display at the bottom of the form. For forms with multiple pages, the approval options and comments box display on the last page of the form. The following options are available:
· Deny - Click Deny to deny the form. The request status is updated to Denied, and the form request is considered completed. No subsequent approvers in the workflow can make an approval decision. Any approval decisions and comments made prior to the denial are saved.
· Deny and Return - Click Deny and Return to deny the form and return it to the submitter. The request status is updated to Returned, and the form request is considered completed. Any approval decisions and comments made prior to the denial are saved. The user is notified that the form has been denied and returned. The user can modify the form and resubmit. Once the user resubmits the form, the approval workflow starts again from the beginning. Note: For forms that were completed by proxy, the form is returned to the user who originally completed the form. The form can be corrected and resubmitted by the original user.
· Approve - Click Approve to approve the form. This commits your approval decision for that step in the approval workflow and any other steps for which you are an approver. If this is the last step in the workflow and you are the only approver in the step, then the request is considered completed, and the form's status is updated to Approved. If there are other approval steps in the workflow or if other approvers are in your step of the workflow, then the request is not considered completed until all steps in the workflow are finished.
For information about the approval process, see the Approval Progress topic in Online Help.See Form - View Approval Progress on page 106 for additional information.
Approval Comment
Enter comments about your approval decision in the Approval Comment box, up to 1500 characters. Providing comments is optional.
Best Practice: When using the Deny and Return option, it is a best practice to provide comments that explain why the form is being returned to the user.
View Approval Progress
To view the approval progress of the approval workflow, click the View Approval Progress link from the Options drop-down. This opens the Approval Progress pop-up.See Form - View Approval Progress on page 106 for additional information.
[bookmark: _Ref-796114485]Form - View Approval Progress
The Approval Progress pop-up displays all steps of the approval workflow. The approval decision and any comments by approvers display for each step.
To access the Approval Progress pop-up:
· Click the Approval Progress link in the options drop-down on the Actions > Requests tab in Universal Profile.
· Click the Approval Progress link in the Options drop-down on the form.
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Approver Details
The following information displays in the approval box for approvers:
· Approver Name - The approver's name displays at the top of the box. For approval steps that have not yet been reached in the workflow, the approver's name displays as the employee relationship to the user. Note: If the form is completed and submitted by someone other than the user, such as the user's manager, then the employee relationship is the approver's relationship to the user not the person who filled out the form.
· Approval Status - The approval status displays below the approver's name. The following are the possible statuses:
· Approved - This status indicates that the approver approved the form.
· Denied - This status indicates that the approver denied the form.
· Returned - This status indicates that the approver denied the form and returned it to the submitter.
· Approval Status Icon - A checkmark displays in the box if the status is Pending or Approved. An X displays in the box if the approver denies the form or denies and returns the form.
· Approval Decision Date - The date on which the approver submitted their approval decision displays to the right of the approval status.
· Comments - If the approver entered comments when making their approval decision, then the comments display in the box.
If the box is grayed out, the approval step has not yet been assigned or has been retracted.
Approval Steps
Each row in the pop-up represents a step in the approval workflow. Steps can include one or more approvers. The following approval rules apply:
Step with One Approver
1. If a step only has one approver, and the approver approves the request, then the step is considered completed. The workflow moves to the next step. If there are no additional steps, then the workflow is complete and the form is considered Approved and completed.
2. If a step only has one approver, and the approver denies the request, then the workflow is stopped. The request status is updated to Denied, and the form request is considered completed. No subsequent approvers in the workflow can make an approval decision. Any approval decisions and comments made prior to the denial are saved. Changes cannot be made to the form by the user if the form is denied. Note: In order to allow users to make changes to denied forms, the approver must select the Deny and Return option instead of the Deny option.
3. If a step only has one approver, and the approver clicks the Deny and Return button on the form, then the workflow is stopped. Any approval decisions and comments made prior to the denial are saved. The request status is updated to Returned, and the form request is considered completed. The user is notified that the form has been denied and returned. The user can modify the form and resubmit. Once the user resubmits the form, the approval workflow starts again from the beginning.
Step with Two Approvers
1. If a step has two approvers, and both approvers approve the request, then the workflow moves to the next step. If there are no additional steps, then the workflow is complete and the form is considered Approved and completed.
2. If a step has two approvers, and one of the approvers in the step denies the request, then the workflow is stopped. The request status is updated to Denied, and the form request is considered completed. The other approver in the step and in the workflow can no longer make an approval decision. No subsequent approvers in the workflow can make an approval decision. Any approval decisions and comments made prior to the denial are saved.
3. If a step only has one approver, and the approver clicks the Deny and Return button on the form, then the workflow is stopped. Any approval decisions and comments made prior to the denial are saved. The user is notified that the form has been denied and returned. The user can modify the form and resubmit. Once the user resubmits the form, the approval workflow starts again from the beginning.
AND/OR Rules
1. For approval steps with two approvers with AND between the approver's names, both approvers must make an approval decision before the workflow can move to the next step in the approval process.
2. For approval steps with two approvers with OR between the approver's names, only one of the approvers needs to submit an approval decision before the workflow can move to the next step in the approval process.
[bookmark: _Ref-1770552641]Goal - Approve or Deny
Approvers can approve or deny a goal from the Requests tab of the Universal Profile: Actions page. When viewing a goal approval request, users may have the option to view or edit the goal. The availability of these options is based on whether the goal is locked and whether the approver or manager is able to edit the user's goal.
When viewing or editing a user's goal from the Requests tab of the Actions page, the user can approve or deny the goal from this page. The following options are available at the bottom of the page:
· Approve - Click this button to approve the goal. This commits your approval decision for that goal. The goal's status is updated to Approved. If the email is configured, then this action triggers an email notification to alert the user that their goal was approved.
· Deny - Click this button to deny the goal. This opens a Deny Request pop-up asking for your confirmation. Once confirmed, the goal's status will be updated to Denied. If the email is configured, then this action triggers an email notification to alert the user that their goal was denied. Note: If the approver edited the goal prior to denying it, then the approvers changes are discarded.
· Cancel - Click this button to exit the page without approving or denying the goal and return to the previous page.
Note: Approved and Denied goals are no longer visible after they are approval or denial.
To view approval requests, go to Home > Universal Profile > Actions. Then, click the Requests tab.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Action Items - EPM
	Grants ability to view and take action upon Performance (EPM) items on the Action Items page and in the Your Action Items widget. This permission can be constrained by OU, User's OU, User's Self, and User's Self and Subordinates. This is an end user permission.
	Universal Profile



	Request Items - View
	Allows user to access the Requests tab on the Universal Profile > Actions tab. This permission cannot be constrained.
	Universal Profile


Emails
	EMAIL NAME
	EMAIL DESCRIPTION
	ACTION TYPE



	Goal Approved
	This email is triggered when a user submits a goal or requests to cancel a goal and the request is approved by the approver.
	Performance Management



	Goal Denied
	This email is triggered when a user submits a goal or requests to cancel a goal and the request is denied by the approver.
	Performance Management


[bookmark: _Toc161994659]Universal Profile - Bio Overview
The Universal Profile: Bio page includes the following functionality:
· About - This tab displays basic information about the user.
· Resume - This tab enables users to view and edit their resume sections.
· Career - This tab enables users to view and edit their career preferences.
· Onboarding - This tab enables users to view onboarding workflows.
To access the Bio homepage, go to Home > Universal Profile. Then, select the Bio tab. Note: The location of this link is configurable by your system administrator.
To access another user's Universal Profile - Bio page, select the user's photograph from any Universal Profile or Global Search page.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Bio Career Preferences - View
	Grants ability to view the Bio - Career Preferences page for users within the permission constraints. This permission can be constrained by Employee Relationship, OU, User's OU, User Self and Subordinates, User's Direct Reports, User's Self, and User.
	Universal Profile



	Bio About - View
	Enables user to view the Bio page for users within their permission constraints. This permission must be enabled to view the Transcript page within Universal Profile. If a user does not have this permission and they click a person's name or user photo within the Universal Profile, then the Bio page will not open.
On the Learner Home page, this permission also allows end users to view the Completions & Hours field, the training sidebar, and the Continue Learning carousel. 
This permission can be constrained by Employee Relationship, OU, User's OU, User's Direct Reports, User Self and Subordinates, and User. Note: For security purposes, this permission is constrained to User Self and Subordinates by default. However, the permission constraints can be modified to allow users to view the Bio About page for other users.
	Universal Profile



	Bio Resume - View
	Enables user to view the Bio - Resume page for users within their permission constraints. If a user does not have permission to view the Bio - Resume page, then the Resume tab is not available. This permission can be constrained by Employee Relationship, OU, User's OU, User Self and Subordinates, User's Direct Reports, User's Self, and User.
	Universal Profile



	Connect - View
	Enables users to access Connect live feed and profile screens. This is an end user permission.
Note: This permission applies to the legacy version of Connect.
	Connect



	View Goals
	Grants ability to view own goals and (depending on role and settings) goals of others (manager's visible goals, direct subordinate's goals, company goals, division goals). This permission can be constrained by Employee Relationship, OU, User's OU, and User Self and Subordinates. This is an end user permission.
	Performance
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Troubleshooting Information
The following page contains an administrator's guide for configuring the Universal Profile:
· See Configuration Guide - Universal Profile.
View Team
The View Team flyout allows managers, approvers, and custom relationships to quickly navigate between subordinates' profiles and transcripts. When enabled, the View Team flyout is available to managers and dotted line managers on all pages of their Universal Profile and the Universal Profile of their subordinates. This flyout displays the manager's reports visually.
The View Team button displays if enabled in the portal. Administrators may enable or disable this flyout via the My Team Dropdown section within Universal Profile General Preferences. See Universal Profile General Preferences on page 2 for additional information.
See Universal Profile - View Team Flyout on page 648 for additional information.
Options
An Options drop-down may be available on various pages of the Universal Profile. This menu may include options such as Assign Training and Create Goal. See Universal Profile Options Drop-down Overview on page 653 for additional information.
Connect
When viewing the Universal Profile - Bio page of another user, you can send a connection request for the user by selecting the Connect button in the upper-right corner of their profile.
User Information
At the top of the page, the information that is displayed about the user is determined by the administrator.
The user's photo may be displayed. Select the user's photo to view an enlarged version of the photo in a pop-up. In addition, the following user information may be displayed:
· User's First and Last Name
· User OU 1
· User OU 2
Note: Users may be able to edit their photo via the My Account > Preferences page. See My Account - Preferences.
Bio Page Categories
The Bio page is separated into main categories, which can be accessed by clicking the appropriate tab below the user's basic information. The following tabs may be available:
· About
· Resume
· Career
· Onboarding
[bookmark: _Toc161994660]Bio - About Overview 
[bookmark: _Ref1654847412]Bio About Preferences
Use the Bio About Preferences page to configure which information appears on the About tab of the Universal Profile - Bio page.
To access the Bio About Preferences page, go to Admin > Tools > Core Functions > Universal Profile > Bio About.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Bio About Preferences - Manage
	Enables administrator to access and edit the Bio About Preferences page. The availability of this permission is controlled by a backend setting. This permission can be constrained by OU and User's OU. This is an administrator permission.
	Universal Profile
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Title
[image: ]
In the Title field, set the name of the About tab on the Universal Profile: Bio page. The default value for this field is "About." This field is required. The character limit for this field is 50.
General Panel
[image: ]
This section enables administrators to configure what is displayed in the General section on the Bio page - About tab.
· First Field - From the drop-down, select the user's OU identifier that should display first in the General panel. Division is selected by default.
· Second Field - From the drop-down, select the user's OU identifier that should display second in the General panel. Position is selected by default.
· User Photo - Select this option to display the user's photo. If this option is not selected, then no photo is displayed.
Contact Info Panel
[image: ]
This section enables administrators to configure what is displayed in the Contact Info section on the Bio page - About tab.
· Direct Phone - Select this option to display the user's Direct Phone number, which is stored in the User Record.
· Mobile Phone - Select this option to display the user's Mobile Phone number, which is stored in the User Record.
· E-mail - Select this option to display the user's email address, which is stored in the User Record.
· User ID - Select this option to display the user's User ID, which is stored in the User Record. This enables users to easily reference their User ID.
· Location - Select this option to display the user's Location OU.
· Address (Text) - Select this option to display the user's address in text format.
· Address (Map) - Select this option to display a Google map of the user's address.
Summary Panel
[image: ]
This section enables administrators to configure whether the user's Connect summary from their Connect profile is displayed in the Summary section on the Bio page - About tab. This field can be edited in-line on the Bio - About page.
Skills Panel
[image: ]
This section enables administrators to configure whether the user's Career Center skills from their Career Center resume are displayed in the Skills section on the Bio page - About tab. This option is only available to administrators with permission to view a user's Career Center information.
Interests Panel
[image: ]
This section enables administrators to configure whether the user's interests from their Connect profile are displayed in the Interests section on the Bio page - About tab. This option is only available to administrators with permission to view a user's Connect information. This field can be edited in-line on the Bio - About page..
Subjects Panel
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This section is only available if the Learning module is enabled.
The Learner Home and Browse for Training pages can display training from a user's favorite subjects. In addition, the Browse for Training page can be filtered to display training from a user's favorite subjects.
When this option is selected, the following occurs:
· The Subjects section is available on the Universal Profile: Bio - About page, which enables users to configure their favorite training subjects.
· The Your Subjects section is available on the Learner Home page, which enables users to configure their favorite subjects.
· The My Subjects training filter is available on the Browse for Training page, which only displays training from the user's favorite training subjects.
· The My Subjects section on the Browse for Training landing page may be enabled via Browse for Training Preferences. This section displays training that is associated with the user's favorite training subjects.
Additional Information Panel
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This section enables administrators to configure which User Record custom fields are displayed on the About tab of the Bio page. The selected information is displayed in the Additional Info section.
To add a User Record custom field, click the plus icon to the right of the Additional Information Panel heading. A list of available User Record custom fields is displayed. All of the newly added fields are added to Column 1.
The administrator can reorganize the fields by dragging and dropping the fields into the desired column or position within the column. Fields that are in column 1 will display in the left column on the Bio - About page, and fields that are in column 2 will display in the right column.
To delete a field, click the Remove icon [image: ] to the left of the field name.
Organizational Chart Panel
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This section enables administrators to configure whether the user's organizational chart information is displayed in the Organizational Chart section on the Bio page - About tab. This includes the user's manager and direct reports.
Following Panel
[image: ]
This section enables administrators to configure whether the Following section is displayed on the Bio page - About tab. If enabled, this section displays all of the communities, topics, and postings the user is currently following. 
This functionality is only available to organizations using New Connect.
Postings Created Panel
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This section enables administrators to configure whether the Postings Created section is displayed on the Bio page - About tab. If enabled, this section displays all of the postings the user has created. 
This functionality is only available to organizations using New Connect.
Connections Panel
[image: ]
This section enables administrators to configure whether the user's Connect connections are displayed in the Connections section on the Bio page - About tab.
Overwrite Settings
Select this option to overwrite custom settings for child division OUs. If you overwrite custom settings for child division OUs, the selected settings are applied to both new and existing child OUs. Any previously customized child OUs are updated with the selected settings.
· If there are no customizations to the child OU, then the parent OU customizations are applied to all child OUs.
· Overwrite custom settings checkbox setting
· If this option is selected, all child OU customizations are deleted from the database, which means the parent OU customizations will be applied to new and existing child OUs.
· If this option is unselected, all existing child OU customizations will remain unchanged, and any new child OUs will inherit the parent OU customizations by default.
· If a child OU has been customized to display any widgets, then regardless of the parent OU customizations, the child OU customizations are applied.
· If a child OU has been customized to hide all widgets, then parent OU customizations will take precedence and will be applied.
Submit/Cancel
· Click Submit to finalize any unsaved changes.
· Click Cancel to discard any unsaved changes.
Bio - About Overview 
The Bio - About page is the default landing page for the Universal Profile. This page displays a user's image, contact information, summary information, skills, interests, team hierarchy, and additional information. Users with the appropriate permissions may be able to view their own Bio Profile page or the Bio page for other users within their permission constraints.
To access the Bio - About page, go to Home > Universal Profile. Click the Bio tab, and then click the About subtab. Note: The location of this link is configurable by your system administrator.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Bio About - View
	Enables user to view the Bio page for users within their permission constraints. This permission must be enabled to view the Transcript page within Universal Profile. If a user does not have this permission and they click a person's name or user photo within the Universal Profile, then the Bio page will not open.
On the Learner Home page, this permission also allows end users to view the Completions & Hours field, the training sidebar, and the Continue Learning carousel. 
This permission can be constrained by Employee Relationship, OU, User's OU, User's Direct Reports, User Self and Subordinates, and User. Note: For security purposes, this permission is constrained to User Self and Subordinates by default. However, the permission constraints can be modified to allow users to view the Bio About page for other users.
	Universal Profile



	Bio Career Preferences - View
	Grants ability to view the Bio - Career Preferences page for users within the permission constraints. This permission can be constrained by Employee Relationship, OU, User's OU, User Self and Subordinates, User's Direct Reports, User's Self, and User.
	Universal Profile



	Bio Resume - View
	Enables user to view the Bio - Resume page for users within their permission constraints. If a user does not have permission to view the Bio - Resume page, then the Resume tab is not available. This permission can be constrained by Employee Relationship, OU, User's OU, User Self and Subordinates, User's Direct Reports, User's Self, and User.
	Universal Profile



	View Goals
	Grants ability to view own goals and (depending on role and settings) goals of others (manager's visible goals, direct subordinate's goals, company goals, division goals). This permission can be constrained by Employee Relationship, OU, User's OU, and User Self and Subordinates. This is an end user permission.
	Performance


Emails
	EMAIL NAME
	EMAIL DESCRIPTION
	ACTION TYPE



	New Connection Request
	This email is triggered when a user receives a connection request. This email can be sent as a notification to Request Recipient or a specific user. Note: This email is only triggered for connections within New Connect, not Old Connect.
	New Connect
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View Team
The View Team flyout allows managers, approvers, and custom relationships to quickly navigate between subordinates' profiles and transcripts. When enabled, the View Team flyout is available to managers and dotted line managers on all pages of their Universal Profile and the Universal Profile of their subordinates. This flyout displays the manager's reports visually.
The View Team button displays if enabled in the portal. Administrators may enable or disable this flyout via the My Team Dropdown section within Universal Profile General Preferences. See Universal Profile General Preferences on page 2 for additional information.
See Universal Profile - View Team Flyout on page 648 for additional information.
Options
An Options drop-down may be available on various pages of the Universal Profile. This menu may include options such as Assign Training and Create Goal. 
See Universal Profile Options Drop-down Overview on page 653 for additional information.
Connect
When viewing the Universal Profile - Bio page of another user, you can send a connection request for the user by selecting the Connect button in the upper-right corner of their profile.
See Connection Request - Send on page 147 for additional information.
Follow User
Connecting with a user or requesting to connect with a user automatically follows the user. When sending a connection request, this occurs immediately and does not require the user to accept the connection request. When accepting a connection request, this occurs as soon as the connection is accepted. Similarly, removing a connection automatically unfollows the user.
See Connection - Follow on page 138 for additional information.
User Information
At the top of the page, the information that is displayed about the user is determined by the administrator.
The user's photo may be displayed. Select the user's photo to view an enlarged version of the photo in a pop-up. In addition, the following user information may be displayed:
· User's First and Last Name
· User OU 1
· User OU 2
Note: Users may be able to edit their photo via the My Account > Preferences page. See My Account - Preferences.
Bio Page Subtabs
The following subtabs may be available on the Bio page:
· About
· Resume
· Career
· Onboarding
· Volunteer
Contact Information
Administrators can configure which information is displayed in this section. This section may display the following information:
· Direct Phone - This displays the user's direct phone number from their user record. When viewing this content from a device that can make phone calls, clicking the phone number will dial the phone number.
· Mobile Phone - This displays the user's mobile phone number from their user record. When viewing this content from a device that can make phone calls, clicking the phone number will dial the phone number.
· Email - This displays the user's primary email address from their user record. Click the email address to compose a new email using your computer's default mail program.
· User ID - This displays the user's User ID. This enables users to easily reference their User ID.
· Location - This displays the user's location OU.
· Address - To the right of the user's contact information, the user's address appears as either text or as a map (if enabled).
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Summary
This section only appears on this page if enabled by the administrator.
To edit the Summary information, select the Edit icon [image: ]. After editing the Summary information, click the Save button to save the changes, or click Cancel to discard any unsaved changes. Note: Only the profile owner can edit this content.
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Skills
This section only appears on this page if enabled by the administrator. This section may display the user's Career Center skills from their Career Center resume. When enabled, this section is only available to users with permission to view a user's Career Center information.
If this section is enabled, but the user has no Career Center skills, then this section does not appear. If this section is enabled, but Skills are disabled by the administrator in Career Center Preferences, then this section does not appear.
Click a skill tag to open the Global Search page and search for all users who have this Career Center skill. This functionality is only available if the user is able to search for people using the Skills filter in Global Search.
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Volunteer Skills
This section only appears on this page if enabled by the administrator. This section may display the user's Volunteer skills from their Volunteer Skills Profile. When enabled, this section is only available to users with permission to view a user's volunteer transcript information.
If this section is enabled, but the user has no volunteer skills, then this section does not appear.
Click a skill tag to open the Global Search page and search for all users who have this volunteer skill. This functionality is only available if the user is able to search for people using the Volunteer Skills filter in Global Search.
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Interests
This section only appears on this page if enabled by the administrator. This section may display the user's interests from their Connect profile. When enabled, this is section only available to users with permission to view a user's Connect information.
If this section is enabled, but the user has no Connect interests, then this section does not appear.
Click an interest tag to open the Global Search page and search for all users who have this interest. This functionality is only available if the user is able to search for people using the Interests filter in Global Search.
To edit the Interests information, select the Edit icon [image: ]. This enables a text editor that allows you to edit the interests. 
· To add an interest, enter the interest name and then either press the [Enter] key on your keyboard or insert a comma directly after the interest name.
· To remove an interest, click the Remove icon [image: ] to the right of the interest name.
After editing the Interests information, click the Save button to save the changes, or click Cancel to discard any unsaved changes. Note: Only the owner of the page can edit this content.
[image: ]
Subjects
This section only appears on this page if enabled by the administrator. This section displays the user's favorite training subjects. This section is only visible when a user views their Universal Profile. This section is also visible to managers and administrators who have permission to view the user's transcript items. 
When a user has selected their favorite training subjects, the user can filter training by their favorite subjects on the Browse for Training page. If enabled, the Browse for Training landing page may display training from the user's favorite subjects.
Click a subject tag to open the Global Search page and search for all training associated with the selected subject. This functionality is only available if the user is able to search for training using the Training filter in Global Search.
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To edit the Subjects information, select the Edit icon [image: ]. This option is only available to the owner of the profile when they are viewing their profile.
· To add a subject, click the Select icon [image: ]. This opens a pop-up in which you can search for and select predefined training subjects. Up to 25 subjects can be selected, but if more are selected through the Your Subjects section on Learner Home, these will display in the Bio section of the Universal Profile.
· To remove a subject, click the Remove icon [image: ] to the right of the subject name.
After editing the Subjects information, click the Save button to save the changes, or click Cancel to discard any unsaved changes. Note: Only the owner of the page can edit this content.
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Additional Info
Administrators can include User Record custom fields on the Universal Profile - Bio - About page. When User Record custom fields are added to the About page, they appear in the Additional Info section. Users can only view a custom field if they are within the custom field's availability.
If there are no fields that are available to or configured to display for the user, then the Additional Info section is hidden.
Team
This section only appears on this page if enabled by the administrator. This section may display the team hierarchy for the user. This includes the user's manager and direct reports. For each user in the hierarchy, the user's photo, name, and OU identifiers are displayed.
At the top of the hierarchy, the user's manager is displayed.
Below the manager, the user is displayed.
Below the user, each of the user's direct reports is displayed in alphabetical order by last name. Up to 12 direct reports are displayed. If the user has more than 12 direct reports, click the View all link to expand the section to display all subordinates.
[image: ]
Following
This section only appears on this page if enabled by the administrator and if there is content that is available to the user. Also, this functionality is only available to organizations using New Connect.
This section displays all of the communities, topics, and postings the user is currently following. Communities are displayed first, in alphabetical order, followed by topics in alphabetical order and postings in alphabetical order. Click an item to open the community, topic, or posting.
An item is only displayed if the user who is viewing the page is within the availability of the item. Up to 10 items are displayed in this section. If there are more than 10 items available, click the View all link to view all of the items. See Bio - About - Following on page 132 for additional information.
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Postings Created
This section only appears on this page if enabled by the administrator and if there is content that is available to the user. Also, this functionality is only available to organizations using New Connect.
This section displays all of the postings the user has created. Postings are displayed in the order in which they were created with the most recently created posting displayed first. Click a posting to open the posting.
A posting is only displayed if the user who is viewing the page is within the availability of the posting. In addition, a posting is only displayed if the author is currently a member of the posting's community. Up to 10 items are displayed in this section. If there are more than 10 items available, click the View all link to view all of the items. See Bio - About - Postings Created on page 134 for additional information.
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Connections
This section only appears on this page if enabled by the administrator. This section may display the user's Connect connections. For each connection, the user's photo, name, and position are displayed. 
To view the Connections panel on your own About page, you must have permission to view Connect information. To view the Connections panel on another user's About page, the administrator must enable the ability for others to view the user's Connect profile in Connect Preferences.
Up to nine connections are displayed. Click the View all connections link to open the My Connections page for the user. See Connection - View on page 143 for additional information.
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[bookmark: _Ref-536456989][bookmark: _Ref-1147954782]Bio - About - Following
The Following page displays all of the communities, topics, postings, and authors the user is following.
This functionality is only available to organizations using New Connect.
To access the Bio - Following page for a user, navigate to the user's Universal Profile page. Then, click the Bio tab. If the About subtab is not selected by default, click the About subtab. Then, click the View all link in the Following section. Note: The Following section is only available if enabled by the administrator in Bio About Preferences.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Bio About - View
	Enables user to view the Bio page for users within their permission constraints. This permission must be enabled to view the Transcript page within Universal Profile. If a user does not have this permission and they click a person's name or user photo within the Universal Profile, then the Bio page will not open.
On the Learner Home page, this permission also allows end users to view the Completions & Hours field, the training sidebar, and the Continue Learning carousel. 
This permission can be constrained by Employee Relationship, OU, User's OU, User's Direct Reports, User Self and Subordinates, and User. Note: For security purposes, this permission is constrained to User Self and Subordinates by default. However, the permission constraints can be modified to allow users to view the Bio About page for other users.
	Universal Profile
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Edit Page
When viewing your own Following page, you have the option to edit which items are being followed.
To edit the Following page, click the Edit icon [image: ] in the upper-right corner of the page. The page refreshes, which allows you to remove a followed item and to add additional items.
Followed Items and Authors
The items and authors that the user is following are categorized and displayed in alphabetical order. An item is only displayed if the user who is viewing the page is within the availability of the item. Each section is only displayed if there are available items within the section. If more than 30 items are available in a category, then a Show More link is available. Click this link to display the additional items.
The following categories may be available:
· Communities - Click a community tag to view the Main page of the community.
· Topics - Click a topic tag to view the Topic Details page for the topic.
· Postings - Click a posting tag to view the posting.
· Author - Click an author tag to view the Postings Created page for the author. See Bio - About - Postings Created on page 134 for additional information.
[bookmark: _Ref34946517]Bio - About - Postings Created
The Postings Created page displays all of the postings that the author has created that are available to the user who is viewing the page.
This functionality is only available to organizations using New Connect.
To access the Bio - Postings Created page for a user, navigate to the user's Universal Profile page. Then, click the Bio tab. If the About subtab is not selected by default, click the About subtab. Then, click the View all link in the Postings Created section.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Bio About - View
	Enables user to view the Bio page for users within their permission constraints. This permission must be enabled to view the Transcript page within Universal Profile. If a user does not have this permission and they click a person's name or user photo within the Universal Profile, then the Bio page will not open.
On the Learner Home page, this permission also allows end users to view the Completions & Hours field, the training sidebar, and the Continue Learning carousel. 
This permission can be constrained by Employee Relationship, OU, User's OU, User's Direct Reports, User Self and Subordinates, and User. Note: For security purposes, this permission is constrained to User Self and Subordinates by default. However, the permission constraints can be modified to allow users to view the Bio About page for other users.
	Universal Profile
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Sort Postings
In the upper-left corner of the Postings table, the sort option allows users to determine the order in which postings are displayed on the page. The following options are available:
· Sort by Latest Reply - This is the default sort option.
· Sort Alphabetically
· Sort by Create Date
· Sort by Type
· Sort by Most Views
· Sort by Most Likes
Follow
When viewing the Postings Created page of another user, users can choose to follow the author by clicking the Follow button to the right of the Sort Postings drop-down menu. If you are already following the user, then Followed is displayed. Click the Followed button to unfollow the user.
When following a user, you may receive a notification whenever the user creates a new posting. Also, the author is added to your Following section and the Bio - Following page.
Postings Table
A user can only view an author's posting if they are a member of the community that is associated with the posting.
The following information is displayed for each posting that the author has created that is available to the user who is viewing the page:
· Postings - The icon indicates the type of posting. To the right of the icon, the posting title is displayed. Click the posting title to view the posting.
· Latest Reply - This displays the details of the posting's most recent reply, including the posting author's photograph and name and the date and time of the reply. Click the reply author's name or photograph to view their Universal Profile.
· Likes - This displays the number of likes the posting has received.
[bookmark: concept81]Connections Overview
[bookmark: _Ref-220367062]Connection - Follow
Connecting with a user or requesting to connect with a user automatically follows the user. When sending a connection request, this occurs immediately and does not require the user to accept the connection request. When accepting a connection request, this occurs as soon as the connection is accepted. Similarly, removing a connection automatically unfollows the user.
To access the Bio - About page, go to Home > Universal Profile. Click the Bio tab, and then click the About subtab. Note: The location of this link is configurable by your system administrator.
To access another user's Universal Profile - Bio page, select the user's photograph from any Universal Profile or Global Search page.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Bio About - View
	Enables user to view the Bio page for users within their permission constraints. This permission must be enabled to view the Transcript page within Universal Profile. If a user does not have this permission and they click a person's name or user photo within the Universal Profile, then the Bio page will not open.
On the Learner Home page, this permission also allows end users to view the Completions & Hours field, the training sidebar, and the Continue Learning carousel. 
This permission can be constrained by Employee Relationship, OU, User's OU, User's Direct Reports, User Self and Subordinates, and User. Note: For security purposes, this permission is constrained to User Self and Subordinates by default. However, the permission constraints can be modified to allow users to view the Bio About page for other users.
	Universal Profile



	View New Connect
	Grants ability to view the new Connect pages, including Live Feed, All Teams, Team Overview, Team Feed, Team Tasks, Task Details, and Connections. This permission cannot be constrained.
	New Connect
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Connecting with a user or requesting to connect with a user automatically follows the user. When sending a connection request, this occurs immediately and does not require the user to accept the connection request. When accepting a connection request, this occurs as soon as the connection is accepted. Similarly, removing a connection automatically unfollows the user.
When viewing the Universal Profile of another user, users can choose to follow the user by selecting the Follow button in the upper-right corner of their profile. If you are already following the user, then Followed is displayed. Select the Followed button to unfollow the user.
Below the Follow button, the widget displays the number of followers the user has.
When following a user, you may receive a notification whenever the user creates a new posting. Also, the author is added to your Following section and the Bio - Following page. See Bio - About - Following on page 132 for additional information.
[bookmark: _Ref623060293]Connection - Remove
An existing connection can be removed from the Connections page.
To access the Bio - About page, go to Home > Universal Profile. Click the Bio tab, and then click the About subtab. Note: The location of this link is configurable by your system administrator.
To access another user's Universal Profile - Bio page, select the user's photograph from any Universal Profile or Global Search page.
In the Connections section, click the View All link.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Bio About - View
	Enables user to view the Bio page for users within their permission constraints. This permission must be enabled to view the Transcript page within Universal Profile. If a user does not have this permission and they click a person's name or user photo within the Universal Profile, then the Bio page will not open.
On the Learner Home page, this permission also allows end users to view the Completions & Hours field, the training sidebar, and the Continue Learning carousel. 
This permission can be constrained by Employee Relationship, OU, User's OU, User's Direct Reports, User Self and Subordinates, and User. Note: For security purposes, this permission is constrained to User Self and Subordinates by default. However, the permission constraints can be modified to allow users to view the Bio About page for other users.
	Universal Profile



	View New Connect
	Grants ability to view the new Connect pages, including Live Feed, All Teams, Team Overview, Team Feed, Team Tasks, Task Details, and Connections. This permission cannot be constrained.
	New Connect
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To remove an existing connection, hover the computer cursor over a user ID card. This displays a drop-down in the upper-right corner of the ID card. Select the drop-down icon and select the Remove Connection link. This immediately removes the user as a connection. No notifications are sent to either user.
[bookmark: _Ref-382451270]Connection - View
The Connections page displays a user's connections. Users are only able to view their own pending connections. Users cannot view another user's pending connections.
To access the Bio - About page, go to Home > Universal Profile. Click the Bio tab, and then click the About subtab. Note: The location of this link is configurable by your system administrator.
To access another user's Universal Profile - Bio page, select the user's photograph from any Universal Profile or Global Search page.
In the Connections section, click the View All link.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Bio About - View
	Enables user to view the Bio page for users within their permission constraints. This permission must be enabled to view the Transcript page within Universal Profile. If a user does not have this permission and they click a person's name or user photo within the Universal Profile, then the Bio page will not open.
On the Learner Home page, this permission also allows end users to view the Completions & Hours field, the training sidebar, and the Continue Learning carousel. 
This permission can be constrained by Employee Relationship, OU, User's OU, User's Direct Reports, User Self and Subordinates, and User. Note: For security purposes, this permission is constrained to User Self and Subordinates by default. However, the permission constraints can be modified to allow users to view the Bio About page for other users.
	Universal Profile



	View New Connect
	Grants ability to view the new Connect pages, including Live Feed, All Teams, Team Overview, Team Feed, Team Tasks, Task Details, and Connections. This permission cannot be constrained.
	New Connect
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At the top of the page, the following tabs are available:
· Connections - This tab displays the user's number of connections. Click this tab to view all of the user's connections.
· Pending - This tab displays the user's number of pending connections. This includes the number of pending connection requests received plus the number of pending connection requests sent. Click this tab to view your pending connections. Users are only able to view their own pending connections. Users cannot view another user's pending connections.
The following information is displayed for each user ID card that is displayed on the Pending Connections page:
· User Photo
· First and Last Name
· OU Identifier
Remove Connection
An existing connection can be removed from your connections from the Connections page. See Connection - Remove on page 141 for additional information.
[bookmark: _Ref619206674]Connection Request - Accept or Ignore
Connection requests can be accepted or ignored from the Pending Connections page.
The Pending Connections page can be accessed in the following ways:
· From the Welcome Page, in the Your Inbox widget, select the View connection requests link. 
· From the Universal Profile - Bio - About page, in the Connections section, select the View All link. Then, click the Pending tab.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Bio About - View
	Enables user to view the Bio page for users within their permission constraints. This permission must be enabled to view the Transcript page within Universal Profile. If a user does not have this permission and they click a person's name or user photo within the Universal Profile, then the Bio page will not open.
On the Learner Home page, this permission also allows end users to view the Completions & Hours field, the training sidebar, and the Continue Learning carousel. 
This permission can be constrained by Employee Relationship, OU, User's OU, User's Direct Reports, User Self and Subordinates, and User. Note: For security purposes, this permission is constrained to User Self and Subordinates by default. However, the permission constraints can be modified to allow users to view the Bio About page for other users.
	Universal Profile



	View New Connect
	Grants ability to view the new Connect pages, including Live Feed, All Teams, Team Overview, Team Feed, Team Tasks, Task Details, and Connections. This permission cannot be constrained.
	New Connect


[image: ]
To accept or ignore a pending connection request, select the appropriate button on the user ID card of the pending connection.
· If the request is accepted, the user is added as a connection.
· If the request is ignored, the connection request is moved into the Ignored connection requests section at the bottom of the page.
An ignored connection request can be accepted. To accept an ignored connection request, select the Accept button on the user ID card of the ignored connection.
In addition, a connection request can be accepted when viewing the Universal Profile - Bio page for a user who has sent you a connection request. If the user whose page you are viewing has sent you a connection request, but you have not yet responded, then selecting Accept confirms the connection and you are immediately connected. Accepting a connection request from a user automatically follows the user.
[bookmark: _Ref-1682278574]Connection Request - Send
Connection requests can be sent from the Universal Profile - Bio pages. The Connections section of the Bio - About page displays the user's total number of connections and team.
To access the Bio - About page, go to Home > Universal Profile. Click the Bio tab, and then click the About subtab. Note: The location of this link is configurable by your system administrator.
To access another user's Universal Profile - Bio page, select the user's photograph from any Universal Profile or Global Search page.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Bio About - View
	Enables user to view the Bio page for users within their permission constraints. This permission must be enabled to view the Transcript page within Universal Profile. If a user does not have this permission and they click a person's name or user photo within the Universal Profile, then the Bio page will not open.
On the Learner Home page, this permission also allows end users to view the Completions & Hours field, the training sidebar, and the Continue Learning carousel. 
This permission can be constrained by Employee Relationship, OU, User's OU, User's Direct Reports, User Self and Subordinates, and User. Note: For security purposes, this permission is constrained to User Self and Subordinates by default. However, the permission constraints can be modified to allow users to view the Bio About page for other users.
	Universal Profile



	Send Connection Request
	Grants ability to send connection requests to other users within the new Connect. This permission can be constrained by OU and User's OU. The constraints that are placed upon this permission determine to whom the user can send connection requests. If a user is constrained by a specific OU, then the user can only send connection requests to users within that OU.
	New Connect



	View New Connect
	Grants ability to view the new Connect pages, including Live Feed, All Teams, Team Overview, Team Feed, Team Tasks, Task Details, and Connections. This permission cannot be constrained.
	New Connect


Emails
	EMAIL NAME
	EMAIL DESCRIPTION
	ACTION TYPE



	New Connection Request
	This email is triggered when a user receives a connection request. This email can be sent as a notification to Request Recipient or a specific user. Note: This email is only triggered for connections within New Connect, not Old Connect.
	New Connect
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When viewing the Universal Profile - Bio page of another user, you can send a connection request for the user by selecting the Connect button in the upper-right corner of their profile.
· If you are not connected to the user, the Connect button is available. Selecting Connect sends a connection request to the user. If enabled, the New Connection Request email is triggered when a connection request is sent.
· If the user whose page you are viewing has sent you a connection request, but you have not yet responded, then selecting Accept confirms the connection and you are immediately connected. Accepting a connection request from a user automatically follows the user.
· If you are not connected to the user, but you have already sent a connection request to the user, then "Connection Pending" is displayed and the button is disabled.
· If you are already connected to the user, then Connected is displayed and the button is disabled.
· When sending a connection request, this action automatically follows the user. This occurs immediately and does not require the user to accept the connection request.
Below the Connect button, the Bio - Connect widget displays the following information:
· Connections - The number of connections the user has.
· Mutual - The people to whom you are both connected.
· Followers - The number of followers the user has.
Connection Request - View Pending Connections
The Pending Connections page displays a user's pending connection requests. Users are only able to view their own pending connections. Users cannot view another user's pending connections.
The Pending Connections page can be accessed in the following ways:
· From the Welcome Page, in the Your Inbox widget, select the View connection requests link. 
· From the Universal Profile - Bio - About page, in the Connections section, select the View All link. Then, click the Pending tab.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Bio About - View
	Enables user to view the Bio page for users within their permission constraints. This permission must be enabled to view the Transcript page within Universal Profile. If a user does not have this permission and they click a person's name or user photo within the Universal Profile, then the Bio page will not open.
On the Learner Home page, this permission also allows end users to view the Completions & Hours field, the training sidebar, and the Continue Learning carousel. 
This permission can be constrained by Employee Relationship, OU, User's OU, User's Direct Reports, User Self and Subordinates, and User. Note: For security purposes, this permission is constrained to User Self and Subordinates by default. However, the permission constraints can be modified to allow users to view the Bio About page for other users.
	Universal Profile



	View New Connect
	Grants ability to view the new Connect pages, including Live Feed, All Teams, Team Overview, Team Feed, Team Tasks, Task Details, and Connections. This permission cannot be constrained.
	New Connect
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At the top of the page, the following tabs are available:
· Connections - This tab displays the user's number of connections. Click this tab to view all of the user's connections.
· Pending - This tab displays the user's number of pending connections. This includes the number of pending connection requests received plus the number of pending connection requests sent. Click this tab to view your pending connections. Users are only able to view their own pending connections. Users cannot view another user's pending connections.
The Pending Connections page is organized into the following categories:
· Connection requests sent to you - This section displays all of the pending connection requests that have been sent to you by others.
· Connection requests you sent - This section displays all of the pending connection requests that you have sent to others.
· Ignored connection requests - This section displays all of the connection requests that you have ignored.
The following information is displayed for each user ID card that is displayed on the Pending Connections page:
· User Photo
· First and Last Name
· OU Identifier
Accept or Ignore a Pending Connection Request
Pending connection requests that have been sent to you can be accepted or ignored from the Pending Connections page. See Connection Request - Accept or Ignore on page 145 for additional information.
Display Ignored Connection Requests
To view the connection requests that have been ignored, click the show link at the bottom of the page. This displays user ID cards for all of the ignored connection requests. Note: This option is not available if the ignored connection requests are currently displayed.
An ignored connection request can be accepted. See Connection Request - Accept or Ignore on page 145 for additional information.
Hide Ignored Connection Requests
To hide the connection requests that have been ignored, click the hide link at the bottom of the page. This hides the user ID cards for all of the ignored connection requests. Note: This option is not available if the ignored connection requests are currently hidden.
[bookmark: _Toc161994661]Bio - Onboarding
Visibility Note: The Onboarding tab only displays if a user is currently or has previously been through onboarding. 
The Onboarding tab displays an applicant's onboarding workflows. Workflows are launched by the recruiter from the Applicant Profile page, and the applicant and recruiter can then view the workflows from Universal Profile. The tab displays all workflows that have been launched for the applicant.
This page is available to recruiters who have access to the applicant's profile and also permission to view onboarding for an applicant. This page is also available to recruiters who have permission to manage employee onboarding. The Employee Onboarding functionality must also be enabled for the portal.
To access the Onboarding tab, go to Universal Profile > Bio and select the Onboarding tab. Or, go to Recruit > Onboarding Dashboard and click the user's name on the dashboard.
For detailed information about the Universal Profile, See Universal Profile Overview on page 1 for additional information.
Use Case
A Human Resources Manager is looking through the Universal Profile > Bio pages of various employees within the company. She can see the Onboarding tab for users who are currently onboarding or who have previously gone through onboarding. She cannot see an Onboarding tab for users who have not been through onboarding before.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Employee Onboarding: Manage
	Grants ability to manage user onboarding in the Onboarding Dashboard and the Onboarding tab on the Universal Profile. This permission can be constrained by OU, User's OU, and User Self and Subordinates.
	Employee Onboarding



	Employee Onboarding: Manage Onboarding Tasks
	Grants the ability to cancel an onboarding task or mark the task as complete. This permission also grants the ability to cancel onboarding workflows after the hire date.
	 



	Employee Onboarding: View
	Grants ability to view the Onboarding Dashboard and the Onboarding tab on the Universal Profile. This permission can be constrained by OU, User's OU, and User Self and Subordinates.
	Employee Onboarding



	View Goals
	Grants ability to view own goals and (depending on role and settings) goals of others (manager's visible goals, direct subordinate's goals, company goals, division goals). This permission can be constrained by Employee Relationship, OU, User's OU, and User Self and Subordinates. This is an end user permission.
	Performance
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Onboarding Workflows
The Onboarding tab displays all workflows that have been assigned to the applicant. Each workflow displays in a separate panel that can be expanded or collapsed. The most recent workflow is expanded by default.
The following information displays in the upper portion of the workflow details:
Organizational Units on Hire Date
This section displays the new hire's future OUs that they will move into on their hire date. Both standard and custom OUs display.
Employee Relationships on Hire Date
This section displays the new hire's future relationships that they will get on their hire date.
Status
This field displays the applicant's progress in the workflow. The applicant's workflow progress status displays to the right of the field name. The following are the potential statuses:
· In progress - This indicates that the applicant has not yet been onboarded to an employee.
· Completed
· Cancelled
· Onboarding
· Working - For portals that have Onboarding enabled and User Types and Statuses, the external applicant's status changes from Onboarding to Working when the applicant reaches their onboarding hire date.
The completion percentage displays next to the status. The applicant's progress also displays as a colored progress bar.
Canceled Onboarding for External Applicants
If onboarding is canceled for external applicants, then the user type that was defined in the User Type section on the Start Onboarding page is removed. This allows external applicants to have the appropriate user type of external applicant when onboarding is canceled.
In addition, the user's status is canceled so that the external applicant returns to being an external applicant instead of being a user in the system.
Task Table Section
The following columns and information display in the table:
Task Title
This column displays the title of the task, including integration tasks.
For form tasks, the title displays as a link. Click the link to view the form.
Status
This column displays the status of the task, including integration tasks. The following are the possible statuses:
· Cancelled - This status displays if onboarding is cancelled for the user.
· Completed - For form tasks, this status displays if the user has submitted the form. For I-9 E-Verify tasks, this status displays if all steps of the task are completed.
· In Progress - For form tasks, this status displays if the user has started completing the form but has not yet submitted the form. For I-9 E-Verify tasks, this status displays if the task has been assigned and at least one or more steps of the task are not yet completed by the assignee.
· Not Started - This status displays if the user has not yet started the task. This status also displays if a Not Started status is submitted by the integration provider.
Status Options
Users with permission to manage onboarding tasks can mark a task completed or cancelled. This helps to better manage onboarding tasks that are no longer needed or have been completed outside the workflow.
Note: Tasks can be cancelled or completed whether they are assigned before the hire date or after the hire date.
Use Cases
· A new hire changes their manager in the first month of employment but has an onboarding form assigned to their former manager that has not been completed. The onboarding coordinator wants to be able to mark the task as complete so that they can manage outstanding tasks. With the existing functionality, the onboarding form stays with the former manager without a way to mark it as complete because the manager change occurred outside the onboarding workflow. With this enhancement, the onboarding coordinator can mark the task complete on the new hire’s Universal Profile > Onboarding tab.
· A new hire completes a direct deposit form on paper outside the onboarding workflow. The form remains on the new hire’s onboarding dashboard as a task that has not been completed, despite the form having been completed offline. This is impactful because the onboarding coordinator clients utilizes percent task completion to trigger their data feeds to the HRIS. Having a task sit open impacts the ability for the user to be sent over to the HRIS. If a user is not sent over to the HRIS, then the onboarding coordinator is unable to get new hire into the payroll and benefits system.
· A new hire has an onboarding task that is no longer relevant in their onboarding process. However, with the existing functionality, the onboarding coordinator does not have a way to cancel the task. With this enhancement, the onboarding coordinator can cancel the individual task from the new hire’s Universal Profile > Onboarding tab.
· A new hire has an optional task on their onboarding workflow. The new hire chooses not to complete the task. The onboarding coordinator wants to be able to cancel the task since it is no longer relevant to their onboarding process, which is different than the task being completed offline. With this enhancement, the onboarding coordinator can cancel the task so that the task is removed from the workflow and the percentage of task is not impacted because it is reset to match the updated number of tasks.
The following options are available in the drop-down in the Status column:
Mark Onboarding Task Complete
To mark a task as complete:
1. Click the options drop-down in the Status column.
2. Select Mark Complete. The Onboarding tab updates to show the task as completed. This action also triggers the Onboarding Form Completed email, if enabled and active in Email Administration.
Once the task is marked complete:
· The onboarding completion percentage, which displays on the onboarding dashboard and in the Status field on the new hire's Universal Profile > Onboarding tab, is updated automatically based on the tasks that have been completed.
· It is removed from the user's Universal Profile > Actions page.
· Tasks that are In Progress or Complete will still be associated with the hire date.
· The task can still be viewed in the Onboarding tab as completed.
· For form tasks, child tasks can be triggered to the appropriate assignees upon parent tasks being marked as completed so that the child task can be completed. Child tasks cannot be marked complete until the parent task is completed.
· For integration tasks, because child tasks are dependent upon a response from a vendor, marking an integration task as completed does not trigger any reviewer or child tasks.
Mark Onboarding Task Cancelled
To mark a task as cancelled:
1. Click the options drop-down in the Status column.
2. Select Mark Cancelled. 
Once the task is marked cancelled:
· It is removed from the user's Universal Profile > Actions page.
· The onboarding completion percentage, which displays on the onboarding dashboard and in the Status field on the new hire's Universal Profile > Onboarding tab, is updated automatically to reflect the change as a result of the cancelled task.
· Tasks that are In Progress or Complete will still be associated with the hire date.
· The task can still be viewed in the Onboarding tab as Cancelled.
· Any child tasks are also cancelled if the parent task is cancelled. The parent and child tasks are removed from the user's Universal Profile > Actions page.
Note: Both form tasks and integration tasks can be cancelled.
Assignee
This column displays the name of the user assigned to the task.
Result
This column displays for all tasks but only provides results for integration tasks. The column is blank for form tasks.
I-9 E-Verify Tasks
For I-9 E-Verify tasks, the result displays the status of the I-9 form after it has been submitted to the third party application. The column displays one of the following results of the e-verification, depending on the case state of the verification process:
· Action Required - This result displays if an action is required by the employer to complete the e-verify process for the new hire.
· Approved - This status indicates that the submitted form has been approved. The form is now considered completed.
· Authorized - This result indicates that the user's identity has been verified and the user is authorized to work in the United States. This result displays if the e-verification has been completed and the case is closed.
· Authorized - Closed Case - This result indicates that the new hire is authorized to work in the United States, and the employer must access the third party application to close the e-verify case to make the work authorization official.
· Denied - This status indicates that the submitted form has been denied. The approver may have included comments to explain why the form was denied. When a form is denied, the user cannot make changes to the form and resubmit it for approval. A form that requires approval is not considered completed until the form is approved or denied.
· Denied and Returned - This status indicates that the submitted form has been denied and returned to the user. The user can access the returned form from the Universal Profile > Actions tab, where they can make changes to the form and resubmit it for approval.
· N/A - If a result has not yet been received, then N/A displays.
· Pending - This result displays if a decision to verify whether or not the new hire is authorized to work in the United States is pending on the verification.
· Pending Approval - This status indicates that the submitted form is pending action from the approver to approve, deny, or deny and return the form.
· Unauthorized - This result indicates that the user's identity has been verified and the user is not authorized to work in the United States. This result displays if the e-verification has been completed and the case is closed.
· Unauthorized - Close Case - This result indicates that the new hire is determined to be not authorized to work in the United States, and the employer must access the third party application to close the e-verify case to make the work authorization official.
W-4 Form Tasks
The result displays status updates for W-4 form tasks. The updates are sent by CIC Plus. The following results may display:
· [Number of] Pending Form(s) - This indicates the number of forms that the user has not yet completed in CIC Plus. This status displays when a task is in an In Progress status and there is at least one pending form status received from CIC Plus.
Once all forms are completed, the Result column is blank and the Status column displays a Completed status.
[bookmark: _Toc161994662]Bio - Career Profile/Preferences Overview 
[bookmark: _Ref390719343]Bio Resume and Career Center Preferences (by Division)
Note: This functionality is only available when the Bio - Resume functionality is enabled. To enable this functionality, contact Global Customer Support.
The Bio Resume and Career Center Preferences page functions similarly to the Career Center Preferences page. However, the Tab section is divided into two sections: Tabs in Universal Profile - Bio and Tabs in Career Center. The Resume and Career Preferences tabs are located in the Universal Profile - Bio section, while the Career Path, Search Other Jobs, and Refer Jobs tabs are located in the Career Center section.
Manage the Universal Profile and Career Center Preferences, in the following locations:
·  Admin > Tools > Succession Management > Bio Resume and Career or
·  Admin > Tools > Core Functions > Universal Profile > Bio Resume and Career
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Bio Career Preferences - View
	Grants ability to view the Bio - Career Preferences page for users within the permission constraints. This permission can be constrained by Employee Relationship, OU, User's OU, User Self and Subordinates, User's Direct Reports, User's Self, and User.
	Universal Profile



	Competency Assessment Model Admin - Edit
	Grants ability to edit competency models. This permission cannot be constrained. This is an administrator permission.
	Performance - Administration



	Competency Assessment Model Admin - Manage
	Grants ability to create, edit, delete, and view competency models. This permission cannot be constrained. This is an administrator permission.
	Performance - Administration



	Competency Assessment Model Admin - View
	Grants ability to view competency models. This permission cannot be constrained. This is an administrator permission.
	Performance - Administration


[image: ]
Tabs
Use the Tabs section to customize the tab names within the Career Center or Universal Profile - Bio page.
· Tab Name - Set the tab names as necessary. The character limit for this field is 25.
· Active - Make the tab active and available. If the tab is inactive, it does not appear to users. At least one tab must be active.
· Translate[image: ]- Localize the tab name into other available languages.
Resume
[image: ]
Use the Resume section to determine which sections on the Resume will be active for users in the OU. Each section defined in Resume Administration appears in the list of sections, including custom sections. See Resume for additional information.
· Active - Make the Resume section active. If this section is inactive, it does not appear on the Resume page.
· Read Only - Make the section read-only. Read only sections cannot be modified by the user. By default, the Current Position and Internal Positions sections are read-only. If the administrator enabled the Allow users to enter their own position description option for the Current Position Section, then this section will not default to read-only. The read-only setting for the Internal Positions section cannot be modified.
· Admin Read Only - If this option is selected, the corresponding Resume section cannot be modified. Because these preferences are set at the OU level, the Admin Read Only option applies to administrators within the corresponding OU.
· Order - To reorder the sections within the Resume page, drag and drop the sections into the desired order.
Based on the Admin Read Only and Read Only option selections, the following scenarios are possible:
	Read Only?
	Admin Read Only?
	Result

	Yes
	Yes
	No user can update the corresponding resume section.

	No
	Yes
	Only the end user can update the corresponding resume section.

	Yes
	No
	Only the administrator can update the corresponding resume section.

	No
	No
	The end user and administrator can update the corresponding resume section.


Competency Model
[image: ]
The Competency Model lets you attach a competency model to the Competencies section of the Resume for the OU. Users then have the option to add competencies from the selected model to their Resume. You can add a different competency model to each OU. If the Competencies section is active for the Resume, then a competency model is required to save the preferences.
To add a competency model:
1. Click Search icon [image: ] to select competency model, and then enter the appropriate search criteria. When selecting a competency model, you can only view and select a competency model if it is within the Admin Visibility settings for the competency model and if you have permission to view, edit, or manage competency models.
2. Click the Add icon[image: ] to add the competency model. If a behavior competency model is selected for the OU, then the option Display selected behaviors appears and will be checked by default. If checked, the selected behavior will appear on the user view of the resume when a behavior competency is added.
Career Preferences
[image: ]
The Career Preferences section displays all available questions, including custom questions. Newly added custom questions will not be set to active by default.
Active - Determine which questions are active and appear on the Bio - Career tab for users in this OU. If a question is set to inactive, then that question does not appear to the end user on the Bio - Career tab. If any one of the standard relocation questions is checked, then the other standard relocation questions are checked automatically. If any one of the standard relocation questions is unchecked, then the other standard relocation questions are unchecked automatically.
To reorder the questions within the Bio - Career tab, drag and drop the question titles into the desired order.
Job Interest Categories
[image: ]
Th e Job Interest Categories section displays all of the available job interest categories created on the Job Interest Categories page. In order for The category must be selected as Active on the Career Center Preferences page to be active and available for users. Categories that are active on this page are available for selection by users.
Job Interest Categories are activated at the OU level, so only users within the affected OUs have access to the selected job interest categories.
Career Center Search Fields
[image: ]
The Career Center Search Fields section determines which additional fields are available as search criteria when searching for jobs within the Career Center.
To make a field available as a search criterion when searching for jobs within the Career Center, select the Active checkbox for the field.
This section is only available to organizations using the Recruiting module. 
 
Overwrite Settings
Select this option to overwrite custom settings for child division OUs. If you overwrite custom settings for child division OUs, the selected settings are applied to both new and existing child OUs. Any previously customized child OUs are updated with the selected settings.
· If there are no customizations to the child OU, then the parent OU customizations are applied to all child OUs.
· Overwrite custom settings checkbox setting
· If this option is selected, all child OU customizations are deleted from the database, which means the parent OU customizations will be applied to new and existing child OUs.
· If this option is unselected, all existing child OU customizations will remain unchanged, and any new child OUs will inherit the parent OU customizations by default.
· If a child OU has been customized to display any widgets, then regardless of the parent OU customizations, the child OU customizations are applied.
· If a child OU has been customized to hide all widgets, then parent OU customizations will take precedence and will be applied.
Submit or Cancel
Click Submit so save the changes.
Click Cancel to discard any unsaved changes.
Bio - Career Overview
[bookmark: concept93][bookmark: concept92]The Bio - Career page enables users to view and edit their career preferences.
To access the Bio - Career page, go to Home > Universal Profile. Click the Bio tab. Then, click the Career subtab. Note: The location of this link is configurable by your system administrator.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Bio About - View
	Enables user to view the Bio page for users within their permission constraints. This permission must be enabled to view the Transcript page within Universal Profile. If a user does not have this permission and they click a person's name or user photo within the Universal Profile, then the Bio page will not open.
On the Learner Home page, this permission also allows end users to view the Completions & Hours field, the training sidebar, and the Continue Learning carousel. 
This permission can be constrained by Employee Relationship, OU, User's OU, User's Direct Reports, User Self and Subordinates, and User. Note: For security purposes, this permission is constrained to User Self and Subordinates by default. However, the permission constraints can be modified to allow users to view the Bio About page for other users.
	Universal Profile



	Bio Career Preferences - View
	Grants ability to view the Bio - Career Preferences page for users within the permission constraints. This permission can be constrained by Employee Relationship, OU, User's OU, User Self and Subordinates, User's Direct Reports, User's Self, and User.
	Universal Profile



	Global Search - People
	Grants ability to search for people via Global Search. If this permission is constrained to a specific OU, then that constraint is automatically applied within Global Search, including search filters and search results. This is an end user permission. The availability of this permission is controlled by a backend setting.
Note: In Universal Profile > Bio > Career Preferences, this permission is required for users to search for jobs.
	Core



	View Goals
	Grants ability to view own goals and (depending on role and settings) goals of others (manager's visible goals, direct subordinate's goals, company goals, division goals). This permission can be constrained by Employee Relationship, OU, User's OU, and User Self and Subordinates. This is an end user permission.
	Performance
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View Team
The View Team flyout allows managers, approvers, and custom relationships to quickly navigate between subordinates' profiles and transcripts. When enabled, the View Team flyout is available to managers and dotted line managers on all pages of their Universal Profile and the Universal Profile of their subordinates. This flyout displays the manager's reports visually.
The View Team button displays if enabled in the portal. Administrators may enable or disable this flyout via the My Team Dropdown section within Universal Profile General Preferences. See Universal Profile General Preferences on page 2 for additional information.
See Universal Profile - View Team Flyout on page 648 for additional information.
Options
An Options drop-down may be available on various pages of the Universal Profile. This menu may include options such as Assign Training and Create Goal. See Universal Profile Options Drop-down Overview on page 653 for additional information.
Connect
When viewing the Universal Profile - Bio page of another user, you can send a connection request for the user by selecting the Connect button in the upper-right corner of their profile.
User Information
At the top of the page, the information that is displayed about the user is determined by the administrator.
The user's photo may be displayed. Select the user's photo to view an enlarged version of the photo in a pop-up. In addition, the following user information may be displayed:
· User's First and Last Name
· User OU 1
· User OU 2
Note: Users may be able to edit their photo via the My Account > Preferences page. See My Account - Preferences.
Bio Page Subtabs
The following subtabs may be available on the Bio page:
· About
· Resume
· Career
· Onboarding
· Volunteer
Career Preferences
Each question that is configured by the administrator in Career Preferences is displayed on the Bio - Career page.
Career Preferences - Edit
To edit the career preferences, click the Edit icon [image: ] in the upper-right corner of the Career Preferences section. Each career preferences question becomes editable.
For fields that use a rich text editor, a Spell Checker is available. To check the spelling of the text box contents, click the ABC icon [image: ] in the text box toolbar. This opens the Spell Checker pop-up.
After editing the career preferences, click Save to save the changes, or click Cancel to discard any unsaved changes.
Job Interests
The Job Interests panel appears in the upper-right corner of the Bio - Career page, and it displays all of the job interests that the user has identified. When a user marks a job as an interest in Career Center, the job is added to the Job Interests panel. If the user has not identified any job interests, then the Job Interests panel does not appear.
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Add Job Interests
Jobs can be marked as interests in the following manners:
· Career Center > Search Jobs > Position Details > Add as Interest
· Career Center > Career Path > Position Details > Add as Interest
Job Interests Panel
For each job in the Job Interests panel, the following information is displayed:
· Job Title - This is the title of the requisition that the user marked as an interest.
· Job Interest Category - This drop-down enables the user to select a category for the job interest. The available job interest categories are configured by the administrator in Succession Management.
· Job Options - If the Recruiting module is enabled for the portal, then the following options may be available below the Job Interest Category drop-down menu:
· Apply Now - This option is available when there is an open requisition for the job. Clicking the link opens the Position Details page for the corresponding job.
· Create Job Alert - This option is available when there are no open requisitions for the job and the user has not yet created an alert for the job. Clicking the link enables job alerts to be sent to the user by email when a requisition is open for the job, provided the email is configured by the administrator. The job alert is immediately sent to the user when the job is posted to Career Center.
· Remove Job Alert - This option is available when there are no open requisitions for the job and the user has already created an alert for the job. Clicking the link removes the existing job alert for the job.
Remove Job Interests
If the user is no longer interested in a job, they can remove the job interest by clicking the Remove icon [image: ] in the upper-right corner of the corresponding job interest. This removes the job as an interest and the job interest no longer appears in the panel.
Edit Job Interests
When editing the Bio - Career page, all of the career preferences become editable. When this occurs, the Job Interests panel is hidden and a Job Interests section is added at the bottom of the page.
This section includes a link to the Career Center where users can add additional job interests. This link is only available if the user has permission to view the Career Center and if the Career Path tab of the Career Center is enabled via Bio Resume & Career Preferences. See Bio Resume and Career Center Preferences (by Division) on page 159 for additional information.
[image: ]
[bookmark: _Toc161994663]Bio - Resume Overview 
[bookmark: _Ref-580840509]Bio Resume and Career Center Preferences (by Division)
Note: This functionality is only available when the Bio - Resume functionality is enabled. To enable this functionality, contact Global Customer Support.
The Bio Resume and Career Center Preferences page functions similarly to the Career Center Preferences page. However, the Tab section is divided into two sections: Tabs in Universal Profile - Bio and Tabs in Career Center. The Resume and Career Preferences tabs are located in the Universal Profile - Bio section, while the Career Path, Search Other Jobs, and Refer Jobs tabs are located in the Career Center section.
Manage the Universal Profile and Career Center Preferences, in the following locations:
·  Admin > Tools > Succession Management > Bio Resume and Career or
·  Admin > Tools > Core Functions > Universal Profile > Bio Resume and Career
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Bio Career Preferences - View
	Grants ability to view the Bio - Career Preferences page for users within the permission constraints. This permission can be constrained by Employee Relationship, OU, User's OU, User Self and Subordinates, User's Direct Reports, User's Self, and User.
	Universal Profile



	Competency Assessment Model Admin - Edit
	Grants ability to edit competency models. This permission cannot be constrained. This is an administrator permission.
	Performance - Administration



	Competency Assessment Model Admin - Manage
	Grants ability to create, edit, delete, and view competency models. This permission cannot be constrained. This is an administrator permission.
	Performance - Administration



	Competency Assessment Model Admin - View
	Grants ability to view competency models. This permission cannot be constrained. This is an administrator permission.
	Performance - Administration


[image: ]
Tabs
Use the Tabs section to customize the tab names within the Career Center or Universal Profile - Bio page.
· Tab Name - Set the tab names as necessary. The character limit for this field is 25.
· Active - Make the tab active and available. If the tab is inactive, it does not appear to users. At least one tab must be active.
· Translate[image: ]- Localize the tab name into other available languages.
Resume
[image: ]
Use the Resume section to determine which sections on the Resume will be active for users in the OU. Each section defined in Resume Administration appears in the list of sections, including custom sections. See Resume for additional information.
· Active - Make the Resume section active. If this section is inactive, it does not appear on the Resume page.
· Read Only - Make the section read-only. Read only sections cannot be modified by the user. By default, the Current Position and Internal Positions sections are read-only. If the administrator enabled the Allow users to enter their own position description option for the Current Position Section, then this section will not default to read-only. The read-only setting for the Internal Positions section cannot be modified.
· Admin Read Only - If this option is selected, the corresponding Resume section cannot be modified. Because these preferences are set at the OU level, the Admin Read Only option applies to administrators within the corresponding OU.
· Order - To reorder the sections within the Resume page, drag and drop the sections into the desired order.
Based on the Admin Read Only and Read Only option selections, the following scenarios are possible:
	Read Only?
	Admin Read Only?
	Result

	Yes
	Yes
	No user can update the corresponding resume section.

	No
	Yes
	Only the end user can update the corresponding resume section.

	Yes
	No
	Only the administrator can update the corresponding resume section.

	No
	No
	The end user and administrator can update the corresponding resume section.


Competency Model
[image: ]
The Competency Model lets you attach a competency model to the Competencies section of the Resume for the OU. Users then have the option to add competencies from the selected model to their Resume. You can add a different competency model to each OU. If the Competencies section is active for the Resume, then a competency model is required to save the preferences.
To add a competency model:
1. Click Search icon [image: ] to select competency model, and then enter the appropriate search criteria. When selecting a competency model, you can only view and select a competency model if it is within the Admin Visibility settings for the competency model and if you have permission to view, edit, or manage competency models.
2. Click the Add icon[image: ] to add the competency model. If a behavior competency model is selected for the OU, then the option Display selected behaviors appears and will be checked by default. If checked, the selected behavior will appear on the user view of the resume when a behavior competency is added.
Career Preferences
[image: ]
The Career Preferences section displays all available questions, including custom questions. Newly added custom questions will not be set to active by default.
Active - Determine which questions are active and appear on the Bio - Career tab for users in this OU. If a question is set to inactive, then that question does not appear to the end user on the Bio - Career tab. If any one of the standard relocation questions is checked, then the other standard relocation questions are checked automatically. If any one of the standard relocation questions is unchecked, then the other standard relocation questions are unchecked automatically.
To reorder the questions within the Bio - Career tab, drag and drop the question titles into the desired order.
Job Interest Categories
[image: ]
Th e Job Interest Categories section displays all of the available job interest categories created on the Job Interest Categories page. In order for The category must be selected as Active on the Career Center Preferences page to be active and available for users. Categories that are active on this page are available for selection by users.
Job Interest Categories are activated at the OU level, so only users within the affected OUs have access to the selected job interest categories.
Career Center Search Fields
[image: ]
The Career Center Search Fields section determines which additional fields are available as search criteria when searching for jobs within the Career Center.
To make a field available as a search criterion when searching for jobs within the Career Center, select the Active checkbox for the field.
This section is only available to organizations using the Recruiting module. 
 
Overwrite Settings
Select this option to overwrite custom settings for child division OUs. If you overwrite custom settings for child division OUs, the selected settings are applied to both new and existing child OUs. Any previously customized child OUs are updated with the selected settings.
· If there are no customizations to the child OU, then the parent OU customizations are applied to all child OUs.
· Overwrite custom settings checkbox setting
· If this option is selected, all child OU customizations are deleted from the database, which means the parent OU customizations will be applied to new and existing child OUs.
· If this option is unselected, all existing child OU customizations will remain unchanged, and any new child OUs will inherit the parent OU customizations by default.
· If a child OU has been customized to display any widgets, then regardless of the parent OU customizations, the child OU customizations are applied.
· If a child OU has been customized to hide all widgets, then parent OU customizations will take precedence and will be applied.
Submit or Cancel
Click Submit so save the changes.
Click Cancel to discard any unsaved changes.
Bio - Resume Overview
The Bio - Resume page enables users to view and edit their resume sections.
To access the Bio - Resume page, go to Home > Universal Profile. Click the Bio tab. Then, click the Resume subtab. Note: The location of this link is configurable by your system administrator.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Bio About - View
	Enables user to view the Bio page for users within their permission constraints. This permission must be enabled to view the Transcript page within Universal Profile. If a user does not have this permission and they click a person's name or user photo within the Universal Profile, then the Bio page will not open.
On the Learner Home page, this permission also allows end users to view the Completions & Hours field, the training sidebar, and the Continue Learning carousel. 
This permission can be constrained by Employee Relationship, OU, User's OU, User's Direct Reports, User Self and Subordinates, and User. Note: For security purposes, this permission is constrained to User Self and Subordinates by default. However, the permission constraints can be modified to allow users to view the Bio About page for other users.
	Universal Profile



	Bio Resume - View
	Enables user to view the Bio - Resume page for users within their permission constraints. If a user does not have permission to view the Bio - Resume page, then the Resume tab is not available. This permission can be constrained by Employee Relationship, OU, User's OU, User Self and Subordinates, User's Direct Reports, User's Self, and User.
	Universal Profile



	Users - Manage User Resume
	Grants access to view and edit user resumes from Admin/User Search page. This permission only works when used in conjunction with the Users - View permission.
	Talent/Succession - Administration



	Users - View
	Grants the ability to search for and view summary information about users in the portal via the Admin/Users screen. This permission can be constrained by OU, User's OU, User Self and Subordinates, and Users. If multiple constraints are added, these constraints are considered OR statements. This is an administrator permission.
	Core Administration



	View Goals
	Grants ability to view own goals and (depending on role and settings) goals of others (manager's visible goals, direct subordinate's goals, company goals, division goals). This permission can be constrained by Employee Relationship, OU, User's OU, and User Self and Subordinates. This is an end user permission.
	Performance


[image: ]
View Team
The View Team flyout allows managers, approvers, and custom relationships to quickly navigate between subordinates' profiles and transcripts. When enabled, the View Team flyout is available to managers and dotted line managers on all pages of their Universal Profile and the Universal Profile of their subordinates. This flyout displays the manager's reports visually.
The View Team button displays if enabled in the portal. Administrators may enable or disable this flyout via the My Team Dropdown section within Universal Profile General Preferences. See Universal Profile General Preferences on page 2 for additional information.
See Universal Profile - View Team Flyout on page 648 for additional information.
Options
An Options drop-down may be available on various pages of the Universal Profile. This menu may include options such as Assign Training and Create Goal. See Universal Profile Options Drop-down Overview on page 653 for additional information.
Connect
When viewing the Universal Profile - Bio page of another user, you can send a connection request for the user by selecting the Connect button in the upper-right corner of their profile.
User Information
At the top of the page, the information that is displayed about the user is determined by the administrator.
The user's photo may be displayed. Select the user's photo to view an enlarged version of the photo in a pop-up. In addition, the following user information may be displayed:
· User's First and Last Name
· User OU 1
· User OU 2
Note: Users may be able to edit their photo via the My Account > Preferences page. See My Account - Preferences.
Bio Page Subtabs
The following subtabs may be available on the Bio page:
· About
· Resume
· Career
· Onboarding
· Volunteer
Resume Sections
Within the Resume section, the following sections may appear:
· Previous Position
· Current Position
· Prior Experience
· Education
· Skills
· Key Accomplishments
· Competencies
· Awards
· Certifications
· Licenses
· Role/Experience
· Special Training/Development
· Background Experience
· Internal Positions
For sections with a date field or date range field, entries are displayed in reverse chronological order with the most recent entries displayed at the top of the section. If a single entry has more than one date or date range field, then entries are sorted in reverse chronological order using the date or date range field in the lowest position number. For example, if there are date range fields in position 2 and 7, then the entries are ordered using the date range field in position 2.
For sections without a date field or date range field, entries are ordered in the order in which they are added to the section, with the most recently added entries displayed at the top of the section.
Each Resume section entry is limited to six lines. If an entry exceeds six lines, then the entry is truncated and a more... link appears at the end of the sixth line. Click the link to expand the entry to display all lines.
Note: In order for a user to be able to update another user's resume page, the user must have permission to manage user resumes and the permission to view users. If you would like managers to be able to make changes to the resume page for their direct reports, then the constraints of the permissions must not be restricted in a way that prevents the manager from making changes (i.e., restricted to a user who is not a direct report). See the Permissions section above for permission details.
Max Items
Administrators can define the maximum number of items that can be selected for each section on the Resume tab. If a maximum is defined for a section, then the maximum number of entries is displayed in the section header. For example, if the maximum number of skills that can be selected is set to three, then "Max 3" is displayed in the Skills section header. If no maximum is defined for a section, then no maximum is displayed in the section header.
If you attempt to select more items than is allowed for the section, then an error message is displayed.
If you have already selected the maximum number of allowed items for a section, then you must remove one or more selection before you can add a new item.
Resume Section Entry - Add
[bookmark: concept98]To add an entry to any of the Resume sections, click the plus icon [image: ] to the right of the section heading. Depending on how the administrator configured the resume section, you may be able to add more than one item to the section at a time.
If the section IS NOT configured to allow you to select more than one item at a time, then a new, blank entry is added at the top of the section. Which fields are available for each section is dependent upon which fields are defined for the section by the administrator in Resume Administration. See the Resume Section Entry - Edit section below for additional information.
If the section IS configured to allow you to select more than one item at a time, then a text box is displayed, which allows you to type the name of a skill in the text box. As you enter text in the Search field, predictive search results appear in a menu below the field. You can select an item from the predictive search results, and it will be added above the Search field.
[image: ]
If the section IS configured to allow you to select more than one item at a time, you can also select the View Full List link below the Search field to browse all items for the Resume section. Select the Arrow icon [image: ] next to a category to view items within the category. If an item in the list is already on the user's Resume, then "Currently on resume" is displayed next to the item. When you select an item, it will be added above the Search field.
[image: ]
[image: ]
After selecting the appropriate items, select the Done button to configure the selected items. Each selected item is added as an entry in the Resume section, and you must add additional information for each item. For example, for each skill that is selected, you must add information such as Proficiency, Years of experience, etc. See the Resume Section Entry - Edit section below for additional information.
Resume Section Entry - Edit
To edit an existing entry of a Resume section, click the Options icon [image: ] to the right of the entry. Then, select Edit. The selected entry becomes editable.
If directions are defined for the section, then they appear only when editing the entry. 
For fields that use a rich text editor, a Spell Checker is available. To check the spelling of the text box contents, click the ABC icon [image: ] in the text box toolbar. This opens the Spell Checker pop-up.
For fields that have predefined attributes, click the Select icon [image: ] to select a predefined attribute. This opens the Select Attribute pop-up. See Select Attribute Pop-up for additional information.
After editing the entry information, click Save to save the changes, or click Cancel to discard any unsaved changes.
[image: ]
Resume Section Entry - Delete
To delete an existing entry of a Resume section, click the Options icon [image: ] to the right of the entry. Then, select Delete. Upon confirmation, the selected entry is removed.
[bookmark: _Toc161994664]Universal Profile - Feedback - Overview
The Feedback homepage allows you to view your own feedback, recognition, and milestone posts. You may also be able to request feedback from this page. When viewing the Feedback homepage for another user, you can post feedback for that user.
This functionality is fully optimized for use on mobile devices and is only available for organizations using the Performance module.
To access the Feedback homepage, go to Home > Universal Profile. Then, click the Feedback tab. Note: The location of this link is configurable by your system administrator.
[bookmark: concept100]When viewing another user's Feedback page, you may be able to view feedback, post feedback, award badges, assign training, and launch off-cycle performance reviews.
To access another user's Universal Profile - Bio page, select the user's photograph from any Universal Profile or Global Search page. From there, you can access the user's Feedback page by clicking the Feedback tab.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Assign Training
	Grants ability to assign learning objects to the transcripts of those for whom the user is the assigned manager, approver or cost center approver. This is a manager/approver permission.
	Learning



	Feedback - Delete
	Enables user to delete a feedback post or comment on a user's page. The user can delete feedback from the Feedback page of any user who is within the permission constraints. This permission can be constrained by OU, User's OU, User Self and Subordinates, and User's Self. The permission constraints apply to the creator of the post or comment, not the target user.
	Universal Profile



	Feedback - Request for other users
	Enables user to request feedback on behalf of other users from their Feedback page. This permission can be constrained by User's Subordinates, Direct Reports, and Custom Relationship.
	Universal Profile



	Feedback - Request
	Enables user to request feedback from the Feedback page of their Universal Profile. Users can only request feedback from other users within their permission constraints. This permission can be constrained by OU, User's OU, User Self and Subordinates, and User's Self. This is an end user permission.
Note: This permission should not be constrained by Employee Relationship, as this constraint would not be effective and does not stop the user from requesting feedback from users outside of Employee Relationship constraint if applied.
Note: This permission should not be constrained by Restrict to Employee Relationship because the User Picker is unable to evaluate this constraint.
	Universal Profile



	Feedback Details - View
	Enables user to view the Feedback Details page and provide feedback when they are requested to provide feedback. This permission cannot be constrained. This is an end user permission.
	Universal Profile



	Feedback - View and Post
	Enables user to view the Feedback page of the Universal Profile and to post feedback. Users can only view the Feedback page for users within their permission constraints. Similarly, users can only post feedback for users within their permission constraints. This permission can be constrained by OU, User's OU, User Self and Subordinates, User's Self, and Employee Relationship. This is an end user permission.
	Universal Profile



	Launch Off-Cycle Performance Review Task
	Enables a user to launch an off-cycle performance review task. Having this permission does not guarantee that the user can launch an off-cycle review, only that they will have access to the Launch Performance Review page. A task must still be configured properly for the user to successfully launch an off-cycle review task. This permission works only if user has been designated to launch at least one currently active off-cycle performance review task. This permission can be constrained by OU, User's Subordinates, and Employee Relationship. This is an end user permission and does not apply to an administrator role.



	View Goals
	Grants ability to view own goals and (depending on role and settings) goals of others (manager's visible goals, direct subordinate's goals, company goals, division goals). This permission can be constrained by Employee Relationship, OU, User's OU, and User Self and Subordinates. This is an end user permission.
	Performance


[image: ]
Troubleshooting Information
The following page contains an administrator's guide for configuring the Universal Profile:
· See Configuration Guide - Universal Profile.
Navigation
The navigation links displays the other available areas of the Universal Profile. Click the navigation tab to access the corresponding page. The following areas may be available:
· Bio - This tab opens the user's Bio homepage. This is only available if the corresponding user is within your permission to view a user's bio homepage.
· Feedback - This tab opens the user's Feedback page. This is only available if the corresponding user is within your permission to view feedback. In addition, this tab is only available for organizations using the Performance module.
· Action Items - This tab opens the user's Action Items page. This may include performance, learning, and volunteer action items. This is only available if the corresponding user is within your permission to view Action Items.
· Transcript - This tab opens the user's transcript. This option is available if the Learning module is enabled for the portal. This tab is only available if you are the corresponding user or the user's manager.
Filter Feedback and Badges
You can view only feedback, only badges, or both. This is controlled by the checkboxes below the Feedback field at the top of the page. 
· Feedback - Feedback posts and requests are displayed on the Feedback page. 
· Badges - Badges and goal posts are displayed on the Feedback page. 
Both are checked by default. If both options are unchecked, then no posts display.
Create Request
Click the Create Request button to request feedback for yourself or for another user. This option is only available to users who have permission to request feedback on behalf of others. See Feedback - Request Overview on page 202 for additional information.
View Team
The View Team flyout allows managers, approvers, and custom relationships to quickly navigate between subordinates' profiles and transcripts. When enabled, the View Team flyout is available to managers and dotted line managers on all pages of their Universal Profile and the Universal Profile of their subordinates. This flyout displays the manager's reports visually.
The View Team button displays if enabled in the portal. Administrators may enable or disable this flyout via the My Team Dropdown section within Universal Profile General Preferences. See Universal Profile General Preferences on page 2 for additional information.
See Universal Profile - View Team Flyout on page 648 for additional information.
Options
An Options drop-down may be available on various pages of the Universal Profile. This menu may include options such as Assign Training and Create Goal. See Universal Profile Options Drop-down Overview on page 653 for additional information.
Post Feedback for User
If you have the appropriate permissions, you can post feedback for another user. See Feedback - Post for Another User on page 198 for additional information.
Request Feedback
If you have the appropriate permissions, you can request feedback from your manager and peers. See Feedback - Request Overview on page 202 for additional information.
View Feedback
When someone posts feedback for you, it appears on your Feedback page. The following information is displayed with each feedback post:
· User Image - Image of the user who posted the feedback. If the user does not have an image in the system or if the feedback post is anonymous, then a generic image is displayed.
· User Name - Name of the user who posted the feedback. If the feedback post is anonymous, then "Anonymous" is displayed as the user's name.
· Feedback Content - Content of the feedback post. 
· Timestamp - Indicates when the post is made. The timestamp is always displayed in the time zone of the user who is viewing the feedback.
View Comments
[image: ]
When users add comments to a post, the comments appear below the original post in reverse chronological order with the most recent comments displayed at the bottom. A timestamp is displayed with each comment to indicate when the comment was made. The timestamp is always displayed in the time zone of the user who is viewing the post.
· Show more comments - If a posting has more than one reply at its root level, select this link to view up to 10 of the most recent replies. If 10 comments are displayed and there are additional comments available, then a View full posting link is displayed. Select the link to view the Posting Details page in a new tab where all of the posting replies are visible.
· Show recent replies - If a posting reply has one or more replies,select this link or the Reply icon to view up to 10 of the most recent replies. If 10 comment replies are displayed and there are additional comment replies available, then a View full posting link is displayed. Select the link to view the Posting Details page in a new tab where all of the posting replies are visible.
Goals in Feedback
If your organization uses the Performance functionality, when you complete a goal, this achievement appears as a post on your Feedback page and is visible to you and your managers. See Goals - View in Feedback on page 223 for additional information.
[bookmark: _Ref1333908384][bookmark: _Toc161994665]Feedback Preferences
Use the Feedback Preferences page to configure which options are available when users are requesting and providing feedback within the Universal Profile: Feedback page. 
To access the Feedback Preferences page, go to Admin > Tools > Core Functions > Universal Profile > Feedback.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Feedback Preferences - Manage
	Enables administrator to access and edit the Feedback Preferences page. From this page, administrators can configure which options are available when users are requesting and providing feedback within the Universal Profile: Feedback page. This permission can be constrained by OU and User's OU. This is an administrator permission.
	Universal Profile


[image: ]
General Preferences
This section enables administrators to determine which options are available to users when they are requesting feedback within the Universal Profile: Feedback page.
The following options are available:
· Allow feedback requests on goals - When this option is selected, users have the option to request feedback on one of their non-shared personal goals in My Goals. Users are able to select a specific goal. Users can also add one yes/no or rating question to their request.
· Submit question(s) with a Yes/No response - When this option is selected, users have the option to add a question to their feedback request in which the user who responds to the question will provide either a Yes or No response.
· Submit question(s) with a rating response - When this option is selected, users have the option to add a question to their feedback request in which the user who responds to the question will provide a rating.
· Add an attachment - When this option is selected, users can add an attachment to their feedback request.
Visibility
The Visibility section enables administrators to configure which visibility options are available and which visibility options are selected by default. Visibility options can be configured for feedback requests and for unsolicited feedback.
Visibility - Unsolicited Feedback
The Unsolicited Feedback section enables administrators to configure which visibility options are available and which are selected by default for unsolicited feedback. Unsolicited feedback refers to feedback in which a user voluntarily provides feedback, awards a badge, or comments on an existing feedback item on another user's Feedback page. This type of feedback is not prompted by a feedback request. The following options are available:
· Included - Select this option to make the corresponding visibility option available to users when selecting the visibility settings for their unsolicited feedback.
· Selected By Default - Select this option to make the corresponding visibility option selected by default for users when selecting the visibility settings for their unsolicited feedback. This option can only be selected if the Included option is also selected for the visibility option.
The following visibility options are available:
· Feedback Recipient - This refers to the user who is receiving any type of feedback.
· Managers - This option includes all direct and indirect managers for the feedback recipient.
· Everyone - This refers to anyone who views the recipient's Feedback page. If the Selected By Default option is selected for this visibility option, then the Selected By Default option is automatically unselected and disabled for all other visibility options.
Visibility - Feedback Requests
The Feedback Requests section enables administrators to configure which visibility options are available and which are selected by default for feedback requests. Feedback requests refers to feedback that is provided when a user requests feedback from others, including general requests for feedback or requests for feedback on a specific goal. The following options are available:
· Included - Select this option to make the corresponding visibility option available to users when selecting the visibility settings for their feedback request.
· Selected By Default - Select this option to make the corresponding visibility option selected by default for users when selecting the visibility settings for their feedback request. This option can only be selected if the Included option is also selected for the visibility option.
The following visibility options are available:
· Feedback Recipient - This refers to the user who is receiving any type of feedback.
· Managers - This option includes all direct and indirect managers for the feedback recipient.
· Everyone - This refers to anyone who views the recipient's Feedback page. If the Selected By Default option is selected for this visibility option, then the Selected By Default option is automatically unselected and disabled for all other visibility options.
· Request Recipients - This refers to all users who are included in the request for feedback.
Ratings Display
Feedback ratings can be displayed as a numeric value, as text, or both. This section enables administrators to select how ratings are displayed to users who are providing and receiving feedback.
Overall Rating Scale
This section enables administrators to view and modify the rating scale that is used for feedback questions that use a rating response. The rating scale is displayed as it is currently configured. If the administrator modifies the rating scale, then this section reflects the modifications.
To edit the overall rating scale for feedback requests, click the Edit icon [image: ] next to the section heading. See Feedback Preferences - Edit Rating Scale on page 195 for additional information.
Overwrite Settings
Select this option to overwrite custom settings for child division OUs. If you overwrite custom settings for child division OUs, the selected settings are applied to both new and existing child OUs. Any previously customized child OUs are updated with the selected settings.
· If there are no customizations to the child OU, then the parent OU customizations are applied to all child OUs.
· Overwrite custom settings checkbox setting
· If this option is selected, all child OU customizations are deleted from the database, which means the parent OU customizations will be applied to new and existing child OUs.
· If this option is unselected, all existing child OU customizations will remain unchanged, and any new child OUs will inherit the parent OU customizations by default.
· If a child OU has been customized to display any widgets, then regardless of the parent OU customizations, the child OU customizations are applied.
· If a child OU has been customized to hide all widgets, then parent OU customizations will take precedence and will be applied.
Submit/Cancel
· Click Submit to submit any unsaved changes.
· Click Cancel to discard any unsaved changes.
[bookmark: _Ref823786668]Feedback Preferences - Edit Rating Scale
When requesting feedback from the Universal Profile: Feedback page, users may be able to request feedback in which the feedback provider selects a rating. Administrators are able to define the rating scale that is used for feedback questions that use a rating system.
To edit the overall rating scale for feedback requests, go to Admin > Tools > Core Functions > Universal Profile > Feedback. In the Overall Rating Scale section, click the Edit icon [image: ] next to the section heading.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Feedback Preferences - Manage
	Enables administrator to access and edit the Feedback Preferences page. From this page, administrators can configure which options are available when users are requesting and providing feedback within the Universal Profile: Feedback page. This permission can be constrained by OU and User's OU. This is an administrator permission.
	Universal Profile


[image: ]
Language
If multiple languages are available for the portal, the rating scale titles can be localized by selecting the appropriate language from the Language drop-down menu. The titles for the administrator's default language must be entered prior to translating the titles for other languages.
When a rating scale is configured for the very first time, it inherits the language of that administrator and that language is considered to be the default language for the rating scale. See the Rating Scale Default Language Use Case for additional information.
Scale
The scale determines how many rating options are available to feedback providers when responding to rating questions. This field is required, and the maximum value for this field is 15. 
When this field is modified and the administrator moves the cursor from the field, the rating table is automatically updated based on the number of ratings to be used. Additional rows appear for every point on the defined scale.
Include N/A rating
When this option is selected, a scoreless value titled N/A is included in the rating scale. This rating option can be selected by feedback providers if the question does not apply to the user or if there is no other rating option that is applicable to the user.
Rating Table
This table displays all of the rating options and their text titles. The number of rating options that are available is dependent on the value entered in the Scale field.
In the Title fields, enter a text title for each rating value. 
Save/Cancel
· Click Save to commit any modifications to the rating scale.
· Click Cancel to discard any unsaved changes.
When the rating scale is modified, the new rating scale settings are only applied to feedback requests that are created after the modifications are saved. Any existing feedback requests will continue to use the rating scale that was set when the feedback request was created. Note: Changes to rating titles are immediately reflected in new and existing feedback requests.
[bookmark: _Ref1617729435][bookmark: _Toc161994666]Feedback - Post for Another User
When viewing another user's Feedback page, you are able to post feedback for the user if you have the appropriate permission.
To access the Feedback homepage, go to Home > Universal Profile. Then, click the Feedback tab. Note: The location of this link is configurable by your system administrator. Users can only view the Feedback page for users who are within their permission constraints.
To access another user's Universal Profile - Bio page, select the user's photograph from any Universal Profile or Global Search page. 
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Feedback - View and Post
	Enables user to view the Feedback page of the Universal Profile and to post feedback. Users can only view the Feedback page for users within their permission constraints. Similarly, users can only post feedback for users within their permission constraints. This permission can be constrained by OU, User's OU, User Self and Subordinates, User's Self, and Employee Relationship. This is an end user permission.
	Universal Profile


Emails
	EMAIL NAME
	EMAIL DESCRIPTION
	ACTION TYPE



	Feedback Provided Notification
	This email is triggered when an employee provides feedback for another employee on their Universal Profile - Feedback page. Feedback can be provided by posting directly to the Feedback page or by commenting on a Feedback post. This email is not triggered when the manager provides feedback to a direct report that is only visible to the user's manager. This email can be sent as a notification to Feedback Recipient or a specific user.
	Universal Profile


Post Feedback
[image: ]
To post feedback, enter the text for your feedback in the Share your feedback field. The character limit is 4000.
If necessary, you can clear the text that you have entered in the Share your feedback field by clicking the Cancel icon [image: ] in the upper-right corner of the field.
Attach a File
You can attach files to your feedback, if applicable, by clicking the Attach a file button [image: ]. This can be done to provide reference material for the feedback post. See Feedback - Attach File on page 216 for additional information.
Award a Badge
If your organization is utilizing the Performance functionality, you can award a badge with your feedback request, if applicable, by clicking the Give a badge button [image: ]. A badge is a form of recognition that also has an associated point value that can be tracked. See Badge - Give a Badge on page 200 for additional information.
Set Visibility
[image: ]
Set the visibility to determine who is able to view the post. See Feedback - Set Visibility on page 221 for additional information.
Post/Cancel
· Click Post to submit the feedback.
·  Click Cancel to discard the feedback. If the email is configured and enabled in Email Administration, the Feedback Provided Notification email is triggered.
Frequently Asked Questions
Why can't I view the Feedback page for another user?
The permission that is listed in the Permissions section above controls a user's ability to view the Feedback page. If there are constraints on this permission, then these constraints limit which users' Feedback page they can view. Similarly, these constraints limit for which users they can post feedback.
[bookmark: _Ref1456913540]Badge - Give a Badge
Use an employee's Feedback page to give them a badge for positive recognition. A badge may also have an associated point value. Depending on the portal configuration, users may be able to view their points and a points leaderboard on the Universal Profile - Snapshot page.
Note: Badge & Point Preferences should only be configured by the Division Organizational Unit (OU) type. If Badge & Point Preferences are configured by a different OU type, then the badges will not be available to users to select and grant to others. See Badge & Point Preferences - Badges.
To access another user's Universal Profile - Bio page, select the user's photograph from any Universal Profile or Global Search page. Then, select the Feedback tab.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Feedback - View and Post
	Enables user to view the Feedback page of the Universal Profile and to post feedback. Users can only view the Feedback page for users within their permission constraints. Similarly, users can only post feedback for users within their permission constraints. This permission can be constrained by OU, User's OU, User Self and Subordinates, User's Self, and Employee Relationship. This is an end user permission.
	Universal Profile


Emails
	EMAIL NAME
	EMAIL DESCRIPTION
	ACTION TYPE



	Badge Provided Notification
	This email is triggered when an employee provides a badge for another employee on their Universal Profile - Feedback page. This email is not triggered for the Completed Goal post. This email can be sent as a notification to Feedback Recipient, Feedback Recipient's Manager, or a specific user.
	Universal Profile


Give a Badge
[image: ]
To give another employee a badge: 
1. Click the Give a badge button [image: ]. This expands the Badges panel. 
2. Click the appropriate badge. You can also hover the computer cursor over the badge to view the badge details, including the badge points. If a badge is set to be Manager Only, then only direct or indirect managers are able to award this badge, and they can only award it to their direct or indirect reports.
3. Enter your feedback.
4. Click Post. The feedback is added to the user's Feedback page and the badge is also displayed in the post.
When adding a badge, you cannot control which users can view the badge. This feedback is always visible to everyone who is able to view the user's Feedback page. If the email is configured and enabled in Email Administration, the Badge Provided Notification email is triggered.
[bookmark: _Ref-1487439673][bookmark: _Ref1787456964][bookmark: _Toc161994667]Feedback - Request Overview
When viewing your own Feedback page, you can request feedback from your manager and peers if you have the appropriate permissions. 
To access the Feedback homepage, go to Home > Universal Profile. Then, click the Feedback tab. Note: The location of this link is configurable by your system administrator.
· From any page in the Universal Profile, select the Options button, and then select Create Feedback Request. This opens the user's Universal Profile Feedback page.
· From the Universal Profile Feedback page, select the Create Request button.
Note: The ability to request feedback is only available if you have the appropriate permissions. In addition, the constraints on these permissions determine whether these options are available when viewing another user's Feedback page.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Feedback - Request for other users
	Enables user to request feedback on behalf of other users from their Feedback page. This permission can be constrained by User's Subordinates, Direct Reports, and Custom Relationship.
	Universal Profile



	Feedback - Request
	Enables user to request feedback from the Feedback page of their Universal Profile. Users can only request feedback from other users within their permission constraints. This permission can be constrained by OU, User's OU, User Self and Subordinates, and User's Self. This is an end user permission.
Note: This permission should not be constrained by Employee Relationship, as this constraint would not be effective and does not stop the user from requesting feedback from users outside of Employee Relationship constraint if applied.
Note: This permission should not be constrained by Restrict to Employee Relationship because the User Picker is unable to evaluate this constraint.
	Universal Profile


Emails
	EMAIL NAME
	EMAIL DESCRIPTION
	ACTION TYPE



	Feedback Request Notification
	This email can be configured as a notification and is triggered when an employee requests feedback from their Feedback page. This email can be sent to a specific user, the Feedback Request Recipient, the Feedback Requester, or the Feedback Requester's Manager.
	Universal Profile


[image: ]
Request Feedback
[image: ]
To request feedback, enter the text for your request in the Feedback field. The character limit is 4000.
If necessary, you can clear the text that you have entered in the Feedback field by clicking the Cancel icon in the upper-right corner of the field.
Add Goal
Users can map a feedback request to a specific goal. This enables users to solicit feedback that is directly related to a goal. Note: The ability to add a goal to a feedback request is set by the administrator in Feedback Preferences.
To add a goal to your feedback request, select the Goal button [image: ]. The Select a goal pop-up opens. See Feedback - Request for Goal on page 207 for additional information.
Add Question
[image: ]
To add a question to your feedback request, click the Add Questions button [image: ]. A blank question is added to the feedback request. Enter the following information for the question:
· What is your question? - In the text field, enter the question text. Be sure that the question text matches the selected rating type. For example, if the rating type is Yes/No, be sure that the question that is being asked can be answered with a yes or no response. This field is required, and the character limit for this field is 500.
· Select Rating Type - From the drop-down menu, select the type of rating that should be used with the question. The following rating types are available:
· Rating - Users who respond to this question will provide a rating between one and five. Note: The ability to submit a question with a rating response is controlled by the administrator in Feedback Preferences.
· Yes/No - Users who respond to this question will provide either a Yes or No response. Note: The ability to submit a question with a yes/no response is controlled by the administrator in Feedback Preferences.
To remove a question from a feedback request, click the Remove icon [image: ] to the right of the Select Rating Type drop-down menu.
To add an additional question, click the Add another question link. An additional blank question is added to the page. Up to 10 questions can be added to a feedback request.
Attach File
You can attach files to your feedback request, if applicable, by clicking the Attach a file button [image: ]. This can be done to provide the project files on which you are requesting feedback. See Feedback - Attach File on page 216 for additional information.
Note: The ability to attach a file to a feedback request is controlled by the administrator in Feedback Preferences.
Select Users for Feedback
After entering your request, enter the names of the users from whom you are requesting feedback in the I would like feedback from field. This field allows you to search for users by name, email, department, or manager. After you enter at least two characters, the system begins to display possible matches for your search. These search results are refreshed after each additional character is entered. Select the appropriate users. The selected users are added to the I would like feedback from field. Note: Users can only request feedback from users within their permission constraints. You can also select users by clicking the Select Users button [image: ].
Set Feedback Visibility
You can set the visibility of the request within the Feedback tab. See Feedback - Set Visibility on page 221 for additional information.
You also have the option to ask for anonymous responses. See Feedback - Make Anonymous on page 206 for additional information.
Post/Cancel
After selecting the appropriate recipients, click Post to submit the request or click Cancel to discard the request. When a feedback request is submitted, an email may be triggered, if configured by the system administrator in Email Administration.
Related Topics
[bookmark: _Ref-1647147085]Feedback - Make Anonymous
When requesting feedback from three or more people, you have the option to ask for anonymous feedback responses by checking the Ask for anonymous feedback responses option. This option is only available if at least three feedback providers have been selected. This helps to ensure that any feedback that is provided is truly anonymous.
When feedback is anonymous, the user who is requesting the feedback will not be able to see the names or photos of the users who provide feedback, but they will be able to see the content of the feedback.
When feedback is not anonymous, the user who is requesting the feedback can see the names and photos of the users who provide feedback.
[image: ]
The following is an example of how anonymous feedback appears to the user who requests feedback.
[image: ]
[bookmark: _Ref-2009356307]Feedback - Request for Goal
Users can map a feedback request to a specific goal. This enables users to solicit feedback that is directly related to a goal.
Note: When a goal is added to a feedback request, the request displays the details and progress of the goal as it existed at the moment the feedback request is posted. If the details of the goal are modified or if progress is updated after the request is posted, then these updates will not be reflected in the feedback request. This behavior is intended to allow feedback providers to see the goal details and progress at the time the feedback was requested. 
To access the Feedback homepage, go to Home > Universal Profile. Then, click the Feedback tab. Note: The location of this link is configurable by your system administrator.Then, place the cursor in the Feedback field. The Feedback field expands to display additional options.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Feedback - Request
	Enables user to request feedback from the Feedback page of their Universal Profile. Users can only request feedback from other users within their permission constraints. This permission can be constrained by OU, User's OU, User Self and Subordinates, and User's Self. This is an end user permission.
Note: This permission should not be constrained by Employee Relationship, as this constraint would not be effective and does not stop the user from requesting feedback from users outside of Employee Relationship constraint if applied.
Note: This permission should not be constrained by Restrict to Employee Relationship because the User Picker is unable to evaluate this constraint.
	Universal Profile



	View Goals
	Grants ability to view own goals and (depending on role and settings) goals of others (manager's visible goals, direct subordinate's goals, company goals, division goals). This permission can be constrained by Employee Relationship, OU, User's OU, and User Self and Subordinates. This is an end user permission.
	Performance


Emails
	EMAIL NAME
	EMAIL DESCRIPTION
	ACTION TYPE



	Feedback Request Notification
	This email can be configured as a notification and is triggered when an employee requests feedback from their Feedback page. This email can be sent to a specific user, the Feedback Request Recipient, the Feedback Requester, or the Feedback Requester's Manager.
	Universal Profile


[image: ]
Add Goal
The option to add a goal to a feedback request is only available if the user has permission to view goals and request feedback. In addition, the option to add a goal is only available if enabled by the administrator in Feedback Preferences.
To add a goal to your feedback request, select the Goal button [image: ]. The Select a goal pop-up opens.
[image: ]
The Select a goal pop-up displays all of the user's approved goals that are within the current goal period. Team goals and shared goals are not displayed. When a goal is selected, the pop-up displays the details of the goal. Select the appropriate goal, and select the Select button. The goal appears within the feedback request.
Note: When a goal is added to a feedback request, the request displays the details and progress of the goal as it existed at the moment the feedback request is posted. If the details of the goal are modified or if progress is updated after the request is posted, then these updates will not be reflected in the feedback request. This behavior is intended to allow feedback providers to see the goal details and progress at the time the feedback was requested. 
After a goal is added to a request, the user can add request text and one question. Then, the user must post the feedback request. 
The Visibility for a request for goal feedback is set to Managers and Me by default. However, this visibility can be adjusted, if necessary. Note: When setting the visibility for the feedback request, be aware that anyone who can view the request can also view the details and progress of the associated goal.See Feedback - Set Visibility on page 221 for additional information.
· When providing unsolicited feedback for another user on the Feedback page, the visibility is set to Everyone by default.
[image: ]
The following information is displayed for the selected goal:
· Title
· Description
· Progress
· Due Date
To view all of the goals details, select the See More link.
Remove Goal
To remove a goal from a feedback request, click the Remove icon [image: ] in the upper-right corner of the goal details. This returns the page to its original state. 
[bookmark: _Ref893094296][bookmark: _Toc161994668]Feedback Requests
Use the Feedback Requests page to view all pending and deleted requests for feedback. When a user requests feedback, you have the option to either respond to the request or to ignore the request.
To access the Feedback homepage, go to Home > Universal Profile. Then, click the Feedback tab. Note: The location of this link is configurable by your system administrator. 
· In the Your Inbox widget on the Welcome page, click the View All Feedback Requests link.
· On the Feedback page, from the Options drop-down, click the View Pending Requests link.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Feedback - View and Post
	Enables user to view the Feedback page of the Universal Profile and to post feedback. Users can only view the Feedback page for users within their permission constraints. Similarly, users can only post feedback for users within their permission constraints. This permission can be constrained by OU, User's OU, User Self and Subordinates, User's Self, and Employee Relationship. This is an end user permission.
	Universal Profile


[image: ]
Show Deleted Requests
Check Show deleted requests if you want deleted requests do appear in the Feedback Requests table.
Feedback Requests Table
The Feedback Requests table displays all pending requests in chronological order with the most recent requests displayed first. New requests that have not yet been viewed appear in bold text.
The following information is displayed for each request:
· Requested By - This column displays the name of the user who created the feedback request.
· Requested For - This column displays the name of the user for whom the feedback request was created.
· Request - This displays the message that is associated with the request. This message was entered by the user who made the request. Click the request message to access the Feedback page of the requester. If the requester is now inactive, then the request message cannot be clicked. See Feedback Request - Respond on page 213 for additional information.
· Date Requested - This displays the date on which the request was made.
Note: If a user requests feedback, but then deletes their request, then the feedback request is removed from the Feedback Requests page for the users from whom feedback was requested. For example, if User A requests feedback from User C and User D, but then User A deletes the request, then the feedback request is removed from the Feedback Requests page for User C and User D. 
Respond to a Request
To respond to a request for feedback, click the request message. This opens the Feedback page of the requester, displaying only the corresponding request. See Feedback Request - Respond on page 213 for additional information.
Delete a Request
To delete a request, check the option box to the right of the request and then click the Delete link.
Multiple requests can be deleted at once. When you click the Delete link, all selected requests are deleted. To delete all requests, check the Delete All option box at the top of the Delete column, and then click the Delete link.
Requests remains on the Feedback Requests page until deleted. Once a request is deleted, it is hidden from the Feedback Requests page, but you can always view it by checking the Show deleted requests option.
View Deleted Requests
When a request is deleted, you can still view it on the Feedback Requests page. 
[bookmark: _Ref-657963338]Feedback Request - Respond
You can request feedback from other employees. 
To respond to a request for feedback, click the Options drop-down within Universal Profile and select View Feedback Requests. Then, click the appropriate request link. This opens the Feedback page for the user who requested the feedback. Depending on the feedback's visibility configuration, existing feedback from other users may be visible on the Feedback Details page. If the user provided anonymous feedback, then the user's name and photo are not displayed.
Note: If a user requests feedback from you, you are able to provide feedback for the user even if you do not have permission to post feedback for that user.
To access the Feedback homepage, go to Home > Universal Profile. Then, click the Feedback tab. Note: The location of this link is configurable by your system administrator
[image: ]
Provide Feedback
To provide feedback, click the text field. If the feedback request contains any questions, the questions are displayed below the text field.
· To add a feedback comment, enter the feedback in the text field. This is required.
· To respond to a question, click the Select drop-down menu and select the appropriate rating. The text to the right of the drop-down menu indicates the type of question. Responses to each question are not required. 
Goal Details
Users can map a feedback request to a specific goal in order to solicit feedback that is directly related to a goal.
When a user is viewing a feedback request that is mapped to a goal, the basic details of the goal are displayed within the request. This enables the feedback provider to view the details and progress of the goal and use this information to help provide feedback. To view all of the goal's details, select the See More link.
Note: When a goal is added to a feedback request, the request displays the details and progress of the goal as it existed at the moment the feedback request is posted. If the details of the goal are modified or if progress is updated after the request is posted, then these updates will not be reflected in the feedback request. This behavior is intended to allow feedback providers to see the goal details and progress at the time the feedback was requested. 
Share Feedback
After entering your feedback, click Share. This adds your comments and question ratings to the feedback request on the requester's Feedback page. Users are not able to modify their ratings after the feedback is shared unless they delete their feedback response. However, the feedback provider is always able to add additional comments to the feedback request.
A date and time stamp is displayed for each post and comment to indicate when the post was made. Timestamps are always displayed in the time zone of the user viewing the post.
[bookmark: _Toc161994669]Feedback - Add Comment
When viewing another user's Feedback page, you are able to comment on a feedback post if you have the appropriate permissions.
To comment on another user's post, navigate to their Feedback page, and enter your comment in the comment box directly below the appropriate post. Then, click Share.
To access another user's Universal Profile - Bio page, select the user's photograph from any Universal Profile or Global Search page. From there, you can access the user's Feedback page by clicking the Feedback tab.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Feedback - View and Post
	Enables user to view the Feedback page of the Universal Profile and to post feedback. Users can only view the Feedback page for users within their permission constraints. Similarly, users can only post feedback for users within their permission constraints. This permission can be constrained by OU, User's OU, User Self and Subordinates, User's Self, and Employee Relationship. This is an end user permission.
	Universal Profile


[image: ]
[bookmark: _Ref-55922609][bookmark: _Toc161994670]Feedback - Attach File
When a user requests feedback or posts feedback, they have the option to attach a file to the post or request. This can be done to provide reference material for your feedback post or feedback request. See the Attachment Restrictions section below for information on attachment restrictions.
To access another user's Universal Profile - Bio page, select the user's photograph from any Universal Profile or Global Search page. From there, you can access the user's Feedback page by clicking the Feedback tab.
Attachment Restrictions
The following attachment restrictions apply:
· You can attach up to three attachments per post.
· The maximum file size is 20 MB.
· The attachment file name cannot exceed 50 characters.
· You cannot upload executable files. 
File Types
You can attach the following file types to feedback:
	File Type
	Extension

	Audio
	· mid
· m4a
· mp3
· wav

	Compressed
	· zip

	Data
	· xls/xlsx

	Image
	· bmp
· gif
· jpeg/jpg
· png

	Presentation
	· pps/ppsx
· ppt/pptx

	Project
	· mpp

	Recording
	· arf

	Text
	· doc/docx
· dot/dotx
· htm/html - The ability to upload htm/html files is controlled by the system administrator.  This limit is controlled by a backend setting,. Organizations may choose to disable the ability to upload HTML files because malicious HTML files may be uploaded, which is a potential security risk.
· pdf
· txt

	Video
	· avi
· flv
· m4v
· mpeg/mpg
· mp4
· rm
· swf
· wma/wmv


Attach a File
Select one of the following options to attach a file:
· To attach a file to a post or request, click the Attach a file button [image: ]. The Attachment area expands.
[image: ]
 
· Drag and drop a file into the Attachment area. Note: The drag-and-drop functionality is not supported by Internet Explorer browsers.
· Click the Select a file button and select a file from your computer. 
[image: ]
After the file has loaded, the attachment appears below the comment box.
[image: ]
Post/Cancel
Click Post to add the attachments to the feedback.
Click the Cancel icon to the right of the attachment name to delete an attachment.
[bookmark: _Toc161994671]Feedback - Delete Post or Comment
You can delete a feedback post, badge, request, or comment from another user's Feedback page by clicking the Delete icon [image: ] in the upper-right corner of the post or comment. This option is only available if you have permission to delete feedback, and you can only delete feedback that has been left by users within your permission constraints.
To access another user's Universal Profile - Bio page, select the user's photograph from any Universal Profile or Global Search page. From there, you can access the user's Feedback page by clicking the Feedback tab.
When a feedback post or badge is deleted, this also deletes any comments that are added to the post.
When a feedback request is deleted, this also deletes any feedback that has been left and any corresponding notifications for the feedback request. 
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Feedback - Delete
	Enables user to delete a feedback post or comment on a user's page. The user can delete feedback from the Feedback page of any user who is within the permission constraints. This permission can be constrained by OU, User's OU, User Self and Subordinates, and User's Self. The permission constraints apply to the creator of the post or comment, not the target user.
	Universal Profile



	Feedback - View and Post
	Enables user to view the Feedback page of the Universal Profile and to post feedback. Users can only view the Feedback page for users within their permission constraints. Similarly, users can only post feedback for users within their permission constraints. This permission can be constrained by OU, User's OU, User Self and Subordinates, User's Self, and Employee Relationship. This is an end user permission.
	Universal Profile


Delete Post, Request, or Badge
[image: ]
Delete Comment
[image: ]
[bookmark: _Ref721727466][bookmark: _Toc161994672]Feedback - Set Visibility
When creating a post on the Feedback page, such as a feedback post or a request for feedback, you have the ability to set the visibility of the post. The visibility limits who is able to view the post.
Visibility can be set when managers are creating a feedback post for a subordinate, when colleagues are creating a feedback post for another user, and when a user is creating a feedback request.
The visibility that is set for the initial post also applies to any comments or responses that are added to the initial post. For example, when the visibility is set for a feedback request, the visibility setting also applies to any feedback responses that are made for the request. Also, when the visibility is set for a feedback post, the visibility setting also applies to any comments that are added to the post.
The options that are available in the drop-down are determined by the administrator in Feedback Preferences. In addition, the administrator can configure which options are selected by default. See Feedback Preferences on page 190 for additional information.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Feedback - Request for other users
	Enables user to request feedback on behalf of other users from their Feedback page. This permission can be constrained by User's Subordinates, Direct Reports, and Custom Relationship.
	Universal Profile



	Feedback - Request
	Enables user to request feedback from the Feedback page of their Universal Profile. Users can only request feedback from other users within their permission constraints. This permission can be constrained by OU, User's OU, User Self and Subordinates, and User's Self. This is an end user permission.
Note: This permission should not be constrained by Employee Relationship, as this constraint would not be effective and does not stop the user from requesting feedback from users outside of Employee Relationship constraint if applied.
Note: This permission should not be constrained by Restrict to Employee Relationship because the User Picker is unable to evaluate this constraint.
	Universal Profile


To set the visibility for the post and corresponding comments, select the appropriate visibility options from the Who would you like to see request responses? drop-down. If a user is able to view the feedback post, they are also able to see the visibility setting of the post. The selected visibility is displayed below the drop-down so that the selected visibility options are explicitly clear.
Note: It is important to note that feedback posts and requests are displayed on the Feedback page. A user must also have permission to view the corresponding user's Feedback page in order to view the feedback post or request.
In all scenarios, the ability to add a comment to a post is available to anyone who can view the post.
When requesting feedback on behalf of another user, the following visibility options may be available:
· User - This option makes the feedback visible to the feedback recipient.
· User's Managers - This option makes the feedback visible to the feedback recipient's direct and indirect managers.
· Request Recipients - This option makes the feedback visible to the feedback request recipients.
· Everyone - This option makes the feedback visible to everyone who has permission to view the feedback recipient's Feedback page.
When requesting feedback for yourself, the following visibility options may be available:
· Managers - This option makes the feedback visible to the feedback recipient's direct and indirect managers.
· Request Recipients - This option makes the feedback visible to the feedback request recipients.
· Everyone - This option makes the feedback visible to everyone who has permission to view the feedback recipient's Feedback page.
When providing unsolicited feedback for another user, the following visibility options may be available:
· User - This option makes the feedback visible to the feedback recipient.
· User's Managers - This option makes the feedback visible to the feedback recipient's direct and indirect managers.
· Everyone - This option makes the feedback visible to everyone who has permission to view the feedback recipient's Feedback page.
Note: If no visibility options are selected, then the feedback is visible only to the feedback provider or request recipient.
Note: When a badge is awarded to a user, this feedback is always visible to everyone who has permission to view the feedback recipient's Feedback page.
[bookmark: _Ref-1395769848][bookmark: _Toc161994673]Goals - View in Feedback
If an organization is utilizing the Performance functionality, when a user goal is 100% complete, this achievement appears as a post on the user's Feedback page. These posts are always visible to the employee and managers and users who can view the post can add comments to the post. The date and time associated with the post is when the goal was marked 100% complete. Both individual and shared goals will appear on the Feedback page.
A goal can only appear on a user's Feedback page once. If a user completes a goal, changes the goal to In Progress and then completes the goal again, the goal will not appear on the Feedback page again.
To access the Feedback homepage, go to Home > Universal Profile. Then, click the Feedback tab. Note: The location of this link is configurable by your system administrator
[image: ]
[bookmark: _Toc161994674][bookmark: _Ref-1694350812][bookmark: concept128]Folder Preferences
The Folder Preferences page enables administrators to create, edit, and remove the document folders that appear on the Snapshot Documents page. Administrators can also customize the availability and visibility of each folder within Snapshot Documents. This enables administrators to determine for which users a folder is available on their Snapshot Documents page and which users have access to the folder for a specific set of users.
To access the Folder Preferences page, go to Admin > Tools > Core Functions > Universal Profile > Folders.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Snapshot Folder Preferences - Manage
	Enables administrator to view the Folder Preferences Admin page and manage folder creation, access, and deletion for the Documents page within Universal Profile: Snapshot. This permission cannot be constrained. This is an administrator permission.
	Universal Profile


[image: ]
Create Folder
To create a folder that may be available on the Snapshot Documents page, click the Create Folder button. See Folder Preferences - Create/Edit Folder on page 337 for additional information.
Folders Table
The Folders table displays all active and inactive folders that have been configured by the administrator. Folders are displayed in alphabetical order. The following information is displayed for each folder:
· Name - This displays the folder name. The folder title may appear on the Snapshot Documents page when the folder is active. 
· Active - This displays whether the folder is active. When active, the folder may be available to users on the Snapshot Documents page. When the folder is inactive, it is never available to users on the Snapshot Documents page.
· Options - The following options are available in the Options column:
· Edit - See the Edit Folder section below for additional information.
· Delete - See the Delete Folder section below for additional information.
Edit Folder
To edit a folder, click the Options drop-down menu, and select Edit. See Folder Preferences - Create/Edit Folder on page 337 for additional information.
Delete Folder
To delete a folder, click the Options drop-down menu, and select Delete. This opens a confirmation pop-up which informs the administrator that deleting the folder also deletes any documents users have uploaded to this folder on the Documents page. Click Yes to delete the folder, or click No to cancel the delete action.
[image: ]
Back
Click Back to return to the Universal Profile Preferences page.
[bookmark: _Ref1450132697][bookmark: _Toc161994675][bookmark: concept129]Folder Preferences - Create/Edit Folder
The Snapshot Documents page enables users and managers to upload and store documents. For example, a user can store project documents in their own Snapshot Documents page. Also, managers can store performance or compliance documents for a subordinate within the subordinate's Snapshot Documents page within Universal Profile. When enabled, users can access the Snapshot Documents page by clicking the Documents widget on the Universal Profile Snapshot page.
The Folder Preferences page enables administrators to create, edit, and remove the document folders that appear on the Snapshot Documents page. Administrators can also customize the availability and visibility of each folder within Snapshot Documents. This enables administrators to determine for which users a folder is available on their Snapshot Documents page and which users have access to the folder for a specific set of users.
To create a Snapshot Documents Folder, go to Admin > Tools > Core Functions > Universal Profile > Folders. Then, click the Create Folder button.
To edit a Snapshot Documents folder, go to Admin > Tools > Core Functions > Universal Profile > Folders. Then, select Edit from the Options drop-down [image: ] for the appropriate folder.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Snapshot Folder Preferences - Manage
	Enables administrator to view the Folder Preferences Admin page and manage folder creation, access, and deletion for the Documents page within Universal Profile: Snapshot. This permission cannot be constrained. This is an administrator permission.
	Universal Profile
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Enter the following information for the new folder:
· Folder Title - Enter the folder title up to 1,000 characters. This is required. The folder title may appear on the Snapshot Documents page when the folder is active.  If multiple languages are enabled for your portal, select the Translate icon to translate the field into other available languages. 
· Active - Select this option to make the folder active. When active, the folder may be available to users on the Snapshot Documents page. When the folder is inactive, it is never available to users on the Snapshot Documents page.
Folder Preferences
This section enables administrators to configure which users have the folder on their Snapshot Documents page within Universal Profile and which users can access the folder. Administrators can also configure what level of access the selected users have for the folder.
Folder Preferences Sections
Folder Preferences for a folder can be configured using multiple segments, which enables administrators to configure different visibility settings and different levels of access depending on whose folder is being accessed. For example, if you are creating a Performance Review folder that is enabled for all sales representatives, then this folder may be owned by the Performance Manager role. However, if you are creating a Performance Review folder that is enabled for the Executive team, then this folder may be owned only by the CEO since the data may be more sensitive.
Sections can be expanded or collapsed by clicking the section's arrow icon. This enables administrators to manage how much information is displayed on the page.
Add Section
To add an additional Folder Preferences section, click the Add Section button. A new section is added to the bottom of the page. 
When a new section is added, the section header displays "New Criteria." Once the page is saved, the section header displays the section's availability settings. Displaying a relevant section header enables administrators to quickly identify a section when editing the section.
Remove Section
To remove a Folder Preferences section, click the Remove icon [image: ] in the upper-right corner of the section. A confirmation pop-up opens to confirm the section removal.
Removing a section removes all availability and visibility within the section. Users who are affected by the change in availability and visibility will notice the change as soon as the folder is saved. When availability and visibility are removed, the documents that are stored within the folder are not affected.
Availability
The Availability settings determine for which users the folder is available on their Snapshot Documents page within Universal Profile. If a folder is available for a user, this does not mean that the folder is visible to the user. The ability to view and upload documents to the folder is configured in the Visibility settings.
The Availability settings determine for which users the folder is available on their Snapshot Documents page within Universal Profile. If a folder is available for an organizational unit (OU), this means that documents can be stored on the Snapshot Documents page of users within the selected OU. Availability, in this instance, does not dictate who can access the folder; the ability to access the folder, for the set of users defined in the Availability section, is defined in the Visibility section. For more clarity, see the Use Case section below.
To add users to the folder's availability, select the appropriate option from the drop-down menu. Then, click the Select icon [image: ] to select the appropriate organizational unit (OU), group, or user. Alternatively, administrators can also enter the OU, group, or user name in the field.
Select the Include Subordinates option to include any subordinate OUs, groups, or users in the availability.
To remove a selection from the Availability section, click the Remove icon [image: ] to the left of the selection.
Visibility
The Visibility settings determine which users have access to the folder for the set of users who are selected in the Availability section. These settings also determine what level of access the selected users have for the folder. Note: The visibility settings are always enforced, even if a link to a folder or document is shared with another user. 
Visibility can be configured by employee relationship (e.g., Manager, Indirect Manager, Subordinates) or OU criteria (i.e., OU, group, or user). From the drop-down menu, select whether you are selecting an employee relationship or an OU, group, or user.
· When selecting an employee relationship, click the Select icon [image: ] to select the appropriate relationship. Alternatively, administrators can also enter the relationship name in the field.
· When selecting an OU, group, or user, select the appropriate option from the drop-down menu. Then, click the Select icon [image: ] to select the appropriate OU, group, or user. Alternatively, administrators can also enter the OU, group, or user name in the field.
Select the Include Subordinates option to include any subordinate OUs, groups, or users in the visibility.
In the Action Group column, select which level of access the selected OU, group, or user should have for the folder. The following options are available:
· Viewer - Users in this group can view all files within the folder.
· Contributor - Users in this group can view all files within the folder, upload files to the folder, and remove any files that they have uploaded to the folder.
· Owner - Users in this group can view all files within the folder, upload files to the folder, and remove any files within the folder. Note: Forms saved in folders cannot be deleted by the folder owner.
To remove a selection from the Visibility section, click the Remove icon [image: ] to the left of the selection.
Availability and Visibility Use Case
1. A folder is created for storing PDF performance reviews. All users participate in performance reviews, and only an employee's manager and HR should be able to access this content.
2. The Availability can be set to All Employees.
3. The HR Manager employee relationship is added to the Visibility as an Owner so that the HR managers can upload and delete performance review documents.
4. The Manager employee relationship is added to the Visibility as a Contributor so that managers can upload performance review documents and delete any documents that they have uploaded.
Save/Cancel
Click Save to save the folder configuration, or click Cancel to discard any unsaved changes to the folder.
When a new section is added, the section header displays "New Criteria." Once the page is saved, the section header displays the section's availability settings. Displaying a relevant section header enables administrators to quickly identify a section when editing the section.
[bookmark: _Toc161994676]Universal Profile - Skills Overview
Capabilities describe what a person can do or what they know. This may include skills, competencies, knowledge, and other types of data. On the Skills Profile, a user may declare which skills they currently have, which skills they want to further develop, and which ones they would like to ignore.
[bookmark: _Ref-1490366779][bookmark: _Toc161994677][bookmark: concept130]Skills Profile
Skills Profile is a page within the Universal Profile that enables users to view, select, and configure the skills they have and the skills they'd like to develop.
The Capabilities and Skills Profile functionality is currently in an Early Adopter phase. See Skills Profile & Capabilities Library - Overview.
To access the Skills Profile page, go to Home > Universal Profile. Then, click the Skills tab.
To access another user's Universal Profile - Bio page, select the user's photograph from any Universal Profile or Global Search page. From there, you can access the user's Skills Profile page by clicking the Skills tab.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Capabilities - Skills Profile - View
	Grants the ability to view an employee Skills Profile. Users with this permission may view the Skills Profile for anyone in the organization. However, individual ratings have privacy settings that control visibility within the Skills Profile. This permission cannot be constrained. This is an end user permission.
	Core Administration



	Skills Profile - Critical Skills - View
	Grants the ability to view the Critical Skills table for any user. This permission cannot be constrained. This is an administrator permission.
Administrators must also have permission to access the user's Skills Profile.
	Core Administration



	User Ratings
	For end users, this permission grants the ability to perform ratings and view ratings. For administrators, this permission is required, along with the specific user rating administration permissions to edit rating scales or templates. This permission cannot be constrained.
	Core Administration
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Back to Profile
Select the Back to Profile button to navigate to the Universal Profile Bio page for the user whose Skills Profile you are viewing.
Get Started
Select the Get Started button to begin the Get Started wizard. This wizard guides you through the process of selecting which skills you currently have, which skills you want to develop, and which skills you do not want to develop. See Skills Profile - Get Started Wizard on page 246 for additional information.
Critical skills widget
If you belong to an organizational unit (OU) with an associated capability model, a Critical skills widget is available on your Skills Profile. This widget displays a graphical representation of your critical skills and status. Within the graph, the widget displays the total number of critical skills in which your proficiency is below expectations. If you have no skills in which your proficiency is below expectations, the widget displays the number of skills in which your proficiency meets expectations. If you have no skills in which your proficiency meets expectations, the widget displays the number of skills in which your proficiency is above expectations. 
If a critical skill does not have a target, then your status is determined in the following way:
1. If you have not declared the skill, your status is Below expectations.
2. If you have declared the skill, your status is Expectations met.
Select the View critical skills link to access the Critical skills page. This option is only available if enabled in Skills Profile Preferences. See Skills Profile - View Critical Skills on page 275 for additional information.
Your skill proficiency widget
This widget displays a graphical representation of your declared skills and proficiency level. Within the graph, the widget displays the total number of declared skills.
Complete your profile widget
This widget visually displays the completeness of your skills profile and encourages you based on incomplete areas. The following steps are tracked in the Complete your profile widget:
· Add at least five skills to your profile
· Add two skills you want to develop
· Rate at least five of your skills - When you select the Rate my skills link, you will see actions based on your organization's configuration. For example, you may see Rate My Interest or Rate My Proficiency.
Select the Add skills link to open the Manage Skills pop-up where you can add skills to your profile.
This widget is hidden once all three tasks are complete.
Skills you're developing
When viewing another user's Skills Profile, this section is titled Skills they're developing.
This section displays any skills you have indicated that you want to develop. These skills may be used to suggest learning and development paths.
Add skills you're developing
You may add skills you want to develop by selecting the Add Skill icon [image: ] in the upper-right corner of the section or the Develop skills button. Note: The Develop skills button is only available if no skills have been selected in this section. See Skills Profile - Add Skill on page 237 for additional information.
Options for skills you're developing
In this section, you can perform the following actions for any skills listed in this section:
· View Skill Details - To view the full description of a skill and your skill rating, select the left side of a skill in your profile. The Skill Details appear in a flyout on the right. See Skills Profile - View Skill Details on page 272 for additional information.
· Remove Skill - To remove a skill from this section, select the menu icon on the right side of the skill button. Then, select Remove.
· Rate My Interest - To rate your interest in a skill from this section, select the menu icon on the right side of the skill button. Then, select Rate My Interest. See Skills Profile - Rate My Interest on page 261 for additional information.
· Request Feedback - To request feedback from others regarding your proficiency in a skill from this section, select the menu icon on the right side of the skill button. Then, select Request Feedback. See Skills Profile - Request Feedback for Skill Proficiency on page 267 for additional information.
Your declared skills
When viewing another user's Skills Profile, this section is titled Their declared skills.
This section displays any skills you have indicated that you already have. These can be skills in any proficiency level (e.g., novice, intermediate, expert). These skills will be used to track progress and identify relevant opportunities for development.
Add skills you have
You may add skills that you have by selecting the Add Skill icon [image: ] in the upper-right corner of the section or the Add skills button. Note: The Add skills button is only available if no skills have been selected in this section. See Skills Profile - Add Skill on page 237 for additional information.
Options for your declared skills
In this section, you can perform the following actions for any skills listed in this section:
· View Skill Details - To view the full description of a skill and your skill rating, select the left side of a skill in your profile. The Skill Details appear in a flyout on the right. See Skills Profile - View Skill Details on page 272 for additional information.
· Want to Develop - If you want to develop a skill in this section, select the menu icon on the right side of the skill button. Then, select Want to develop. The skill remains in the Your declared skills section, but it is also added to the Suggested skills for your profile section. These skills may be used to suggest learning and development paths.
· Add to My Profile - Select this option to add the skill to your profile as a skill you have. This option is only available when viewing another user's profile.
· Remove Skill - To remove a skill from this section, select the menu icon on the right side of the skill button. Then, select Remove.
· Rate My Proficiency - To rate your proficiency in a skill from this section, select the menu icon on the right side of the skill button. Then, select Rate My Proficiency. See Skills Profile - Rate Skill Level on page 264 for additional information.
· Rate My Interest - To rate your interest in a skill from this section, select the menu icon on the right side of the skill button. Then, select Rate My Interest. See Skills Profile - Rate My Interest on page 261 for additional information.
· Request Feedback - To request feedback from others regarding your proficiency in a skill from this section, select the menu icon on the right side of the skill button. Then, select Request Feedback. See Skills Profile - Request Feedback for Skill Proficiency on page 267 for additional information.
· Endorse - To endorse a user for a specific skill, select the menu icon on the right side of the skill button. Then, select Give Endorsement. Endorsements are also visible to others in the system to encourage the positive recognition that they carry. An endorsement does not confer a specific judgment about proficiency, but it generally means you are willing to vouch for the person's proficiency in a certain skill.
· Feedback Templates - If feedback templates are available and the Compare Skills feature connector is enabled, then users can provide feedback based on the available ratings, such as "Rate Your Proficiency" or "Rate Your Interest & Enjoyment."
Suggested skills for your profile
When viewing another user's Skills Profile, this section is titled Suggested skills for their profile.
This section displays a list of suggested skills you might have based on profile information processed by the AI-based Skills Graph. This currently includes your position (and its associated title, description, responsibilities, competencies, and capability models), any training you've completed, previous positions on your resume/CV, your bio summary, and any subjects or interests you have selected. The number of suggested skills is highly variable per user and is dependent on the confidence level returned by the Skills Graph.
Options for suggested skills
In this section, you can perform the following actions for any skills listed in this section:
· View Skill Details - To view the full description of a skill and your skill rating, select the left side of a skill in your profile. The Skill Details appear in a flyout on the right. See Skills Profile - View Skill Details on page 272 for additional information.
· Want to Develop - If you want to develop a skill in this section, select the menu icon on the right side of the skill button. Then, select Want to develop. The skill is removed from this section and added to the Skills you're developing section. These skills may be used to suggest learning and development paths.
· Hide Recommendations - To hide learning and development recommendations for a skill in this section, select the menu icon on the right side of the skill button. Then, select Hide recommendations. The skill is removed from this section, and it is no longer suggested as a skill to develop. You may still search for this skill by name when adding skills to develop. This skill is added to the Skills you're excluding section if this section has not been hidden by an administrator.
· Add to Profile - If you have one of the skills in this section in any proficiency level (e.g., novice, intermediate, expert), select the menu on the right side of the skill button. Then, select Add to profile. The skill is removed from this section and added to the Your declared skills section. These skills will be used to track progress and identify relevant opportunities for development.
· Remove Skill - To remove a skill from this section, select the menu icon on the right side of the skill button. Then, select Remove.
Skills you're excluding
This section displays any skills you have indicated that you do not want to develop. The system will not suggest these skills any longer, and they will not be used to suggest learning and development paths.
Note: Administrators may disable this section via Capabilities Preferences. See Capabilities Preferences - Skills Profile.
Add skills to exclude
You may add skills that to this section by selecting the Add Skill icon [image: ] in the upper-right corner of the section or the Select skills button. Note: The Select skills button is only available if no skills have been selected in this section. See Skills Profile - Add Skill on page 237 for additional information.
Options for skills you're excluding
In this section, you can perform the following actions for any skills listed in this section:
· View Skill Details - To view the full description of a skill and your skill rating, select the left side of a skill in your profile. The Skill Details appear in a flyout on the right. See Skills Profile - View Skill Details on page 272 for additional information.
· Want to Develop - If you want to develop a skill in this section, select the menu icon on the right side of the skill button. Then, select Want to develop. The skill is removed from this section, and it is added to the Skills you're developing section. These skills may be used to suggest learning and development paths.
· Remove Skill - To remove a skill from this section, select the menu icon on the right side of the skill button. Then, select Remove.
[bookmark: _Ref376559665][bookmark: concept131]Skills Profile - Add Skill
The Skills Profile page enables users to view and manage skills they have, skills they want to develop, and skills they do not want to develop.
Users can add skills to any of the sections by selecting the Add Skill icon [image: ] in the upper-right corner of the appropriate section. This opens the Manage Skills flyout.
To select a skill, you may select one of the listed skills or search for a skill that is not listed. When you select a skill, it is displayed below the search field. You may remove a skill by selecting the X next to the skill.
After selecting one or more skills, select the Add button. The selected skills are added to your Skills Profile.
When you add a skill to your Skills Profile, then any skills that are linked as similar are suggested in the Skills You Might Have section of the Skills Profile. For example, if Business Strategy is linked to Business Development as a similar skill, and you indicate that you have the Business Strategy skill, then Business Development will be suggested to you as a skill that you might have.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Capabilities - Skills Profile - View
	Grants the ability to view an employee Skills Profile. Users with this permission may view the Skills Profile for anyone in the organization. However, individual ratings have privacy settings that control visibility within the Skills Profile. This permission cannot be constrained. This is an end user permission.
	Core Administration


[image: ]
[bookmark: concept133][bookmark: concept132]Skills Profile - Compare Skills
The Compare Skills page enables managers and users a central view of all the user's skill ratings. Managers can use this information as a conversation starter and guide around skills when having development conversations with their employees, and users can use this information for self-reflection and calibration.
Compare Skills displays the latest ratings from multiple dimensions/sources while respecting visibility settings for ratings.
The Compare Skills page is only available to users if enabled by the system administrator in Skills Profile Preferences. See Capabilities Preferences - Skills Profile.
To access the Skills Profile page, go to Home > Universal Profile. Then, select the Skills tab. Within the Skill menu, select the Compare Skills option. This option is also available within the three-dot menu in the Your Skills section. This option is only available when viewing the Skills Profile for yourself or for a direct report.
To access another user's Universal Profile - Bio page, select the user's photograph from any Universal Profile or Global Search page. From there, you can access the user's Skills Profile page by clicking the Skills tab.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Capabilities - Skills Profile - View
	Grants the ability to view an employee Skills Profile. Users with this permission may view the Skills Profile for anyone in the organization. However, individual ratings have privacy settings that control visibility within the Skills Profile. This permission cannot be constrained. This is an end user permission.
	Core Administration



	User Ratings
	For end users, this permission grants the ability to perform ratings and view ratings. For administrators, this permission is required, along with the specific user rating administration permissions to edit rating scales or templates. This permission cannot be constrained.
	Core Administration
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Sort Ratings
The following sort options are available for the Skills display:
· Overall - This displays skills with the highest overall self-ratings at the top of the list.
· Strengths - This displays skills with the highest proficiency and enjoyment at the top of the list.
· Emerging Skills - This displays skills with high interest in developing but lower proficiency at the top of the list.
· Misaligned Proficiency - This displays skills with the greatest to least difference between self-ratings and ratings from others, especially managers.
· Highest Proficiency - This displays skills with the highest to lowest proficiency rating. This is based on the self ratings.
· Highest Interest - This displays skills with the highest to lowest interest rating.
· Highest Enjoyment - This displays skills with the highest to lowest enjoyment rating.
Note: If a portal does not use certain dimensions, such as Interest or Enjoyment, the Sorts that use those dimensions are not shown.
Ratings Display
The following information is displayed for each skill in the user's Skills Profile:
· Most recent self-ratings on Enjoyment, Interest, and Proficiency
· Average of the most recent proficiency ratings from each manager
· Average of the most recent proficiency ratings from each other user (not self or managers)
The ratings displayed on this page respect the visibility settings for the associated ratings.
Ratings Options
For each skill in the table, employees can select the three-dot menu icon for a skill to view the following options:
· Feedback History - Users may select this option to view their feedback history for the selected skill. See Skills Profile - Feedback History on page 242 for additional information.
· Feedback Templates - If feedback templates are available and the Compare Skills feature connector is enabled, then users can provide feedback based on the available ratings, such as "Rate Your Proficiency" or "Rate Your Interest & Enjoyment."
· Request Feedback - Users may select this option to request feedback on the selected skill. See Skills Profile - Request Feedback for Skill Proficiency on page 267 for additional information.
[bookmark: _Ref-690922836]Skills Profile - Feedback History
The Feedback History pop-up displays all of the ratings and feedback available for the user and the selected skill. Feedback is only displayed if the user is within the visibility settings for the feedback.
The Feedback History pop-up can be accessed in the following ways:
· Compare Skills - From the Compare Skills table, select the Feedback History option for a skill in the table.
· Skill Details - When viewing your own Skills Profile, from the Skill Details flyout, select the endorsed by link.
To access the Skills Profile page, go to Home > Universal Profile. Then, select the Skills tab. Within the Skill menu, select the Compare Skills option. This option is also available within the three-dot menu in the Your Skills section. This option is only available when viewing the Skills Profile for yourself or for a direct report.
To access another user's Universal Profile - Bio page, select the user's photograph from any Universal Profile or Global Search page. From there, you can access the user's Skills Profile page by clicking the Skills tab.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Capabilities - Skills Profile - View
	Grants the ability to view an employee Skills Profile. Users with this permission may view the Skills Profile for anyone in the organization. However, individual ratings have privacy settings that control visibility within the Skills Profile. This permission cannot be constrained. This is an end user permission.
	Core Administration



	User Ratings
	For end users, this permission grants the ability to perform ratings and view ratings. For administrators, this permission is required, along with the specific user rating administration permissions to edit rating scales or templates. This permission cannot be constrained.
	Core Administration


Users can select one of the available views by selecting the appropriate view icon. The following views are available in the Feedback History pop-up:
· Ladder View [image: ]
· Comment View [image: ]
· Reporting View [image: ]
Ladder View
The Ladder View displays the proficiency ratings for the selected skill on the rating graph. Below the graph, each rating is displayed in a table with the corresponding rater's name, the rater's relationship to the user, and the date on which the rating was provided.
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Comment View
The Comment View displays all comments that have been provided for the selected skill with the corresponding rater's name, the commentator’s relationship to the user, and the date on which the comment was provided.
[image: ]
Reporting View
The Reporting View displays all ratings and endorsements across all dimensions (Proficiency, Interest, Enjoyment, Endorsement, etc.) including any comments provided.
[image: ]
[bookmark: _Ref-1088596152][bookmark: concept136]Skills Profile - Get Started Wizard
The Skills Profile enables users to select which skills they currently have and skills they want to develop.
To access the Skills Profile, go to Home > Universal Profile. Then, select the Skills tab.
When users first access their Skills Profile, they are prompted with the "Get Started" menu that guides them through the process of selecting their current skills and skills they want to develop.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Capabilities - Skills Profile - View
	Grants the ability to view an employee Skills Profile. Users with this permission may view the Skills Profile for anyone in the organization. However, individual ratings have privacy settings that control visibility within the Skills Profile. This permission cannot be constrained. This is an end user permission.
	Core Administration



	User Ratings
	For end users, this permission grants the ability to perform ratings and view ratings. For administrators, this permission is required, along with the specific user rating administration permissions to edit rating scales or templates. This permission cannot be constrained.
	Core Administration


[image: ]
Step 1 - Get Started or Skip
Note: This step is skipped if you select the Get Started button on the Skills Profile page.
When the Get Started menu opens, you are prompted to either get started or skip the wizard.
· Get Started - Select this button to begin the Get Started wizard. This wizard guides you through the process of selecting which skills you currently have, which skills you want to develop, and which skills you do not want to develop.
· Skip - Select this button to skip the Get Started wizard. Users who skip the wizard may initiate the wizard from the Skills Profile page. See Skills Profile on page 231 for additional information.
Step 2 - Select Skills You Have
In this step, select three or more skills that you already have. These can be skills in any proficiency level (e.g., novice, intermediate, expert). By default, the wizard displays a list of skills that are associated with your current position and any previous positions included in your Universal Profile Resume.
To select a skill, you may select one of the listed skills or search for a skill that is not listed. When you select a skill, it is displayed below the search field. You may remove a skill by selecting the X next to the skill.
After selecting three or more skills, select the Continue button.
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Step 3 - Select Skills to Develop
In this step, select one or more skills that you want to develop. These skills may be used to suggest learning and development paths. By default, the wizard displays a list of skills that are associated with your current position.
To select a skill, you may select one of the listed skills or search for a skill that is not listed. This may be a skill that you already have or one you do not currently have. When you select a skill, it is displayed below the search field. You may remove a skill by selecting the X next to the skill.
After selecting one or more skills, select the Continue button.
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Step 4 - Select Skills to Reduce Recommendations
Note: Administrators may disable this section via Capabilities Preferences. See Capabilities Preferences - Skills Profile.
In this step, select any skills that you do not want to develop. This step is optional. If you select skills in this step, the system will reduce recommendations for training and development for the selected skills. This helps you to focus on the skills that you do want to develop. By default, the wizard displays a list of skills that are associated with your current position.
To select a skill, you may search for the skill. When you select a skill, it is displayed below the search field. You may remove a skill by selecting the X next to the skill.
This step is optional. Select the Finish button to submit your selections. You may adjust your selections at any time via the Skills Profile page. See Skills Profile on page 231 for additional information.
[image: ]
[bookmark: _Ref-1045262835]Skills Profile - My Feedback Requests
Once a user has requested feedback for a skill, the user can view and track their requests from the My Feedback Requests page. 
Administrators with the appropriate permission are able to view the My Feedback Requests page for other users. When viewing the My Feedback Requests page of another user, the administrator can only view the page. They cannot create or edit any feedback requests. The option to create a request is not available, and the menu icon for each request is not available.
To view the My Feedback Requests page, go to Home > Universal Profile. Then, from the Skills menu, select My Feedback Requests.
From the Skills Profile page, users may be able to view their request in the following areas:
· Skills Profile: Skills You Want to Develop - In the Skills You Want to Develop section of the Skills Profile, select the menu icon in the upper-right corner of the section. Then, select My Requests.
· Skills Profile: Your Skills - In the Your Skills section of the Skills Profile, select the menu icon in the upper-right corner of the section. Then, select My Requests.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Capabilities - Skills Profile - View
	Grants the ability to view an employee Skills Profile. Users with this permission may view the Skills Profile for anyone in the organization. However, individual ratings have privacy settings that control visibility within the Skills Profile. This permission cannot be constrained. This is an end user permission.
	Core Administration



	User Ratings
	For end users, this permission grants the ability to perform ratings and view ratings. For administrators, this permission is required, along with the specific user rating administration permissions to edit rating scales or templates. This permission cannot be constrained.
	Core Administration



	User Ratings - View Ratings and Feedback about Other User
	Grants ability to view ratings history and rating details about other people regardless of the visibility settings on the ratings. Grants ability to view the My Feedback Requests page. Administrators with this permission can view all ratings and feedback about all other users, regardless of the visibility settings of the ratings. This permission cannot be constrained.
This permission does not bypass visibility ratings about yourself, which means users cannot use this permission to view ratings provided about themselves that are otherwise not visible to them. 
This permission is intended for an administrator or talent partner who needs broad access to all ratings occurring within the portal. 
	Core Administration
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Create New Request
Select the Create New Request button to initiate a new feedback request. See Skills Profile - Request Feedback for Skill Proficiency on page 267 for additional information.
Requests List
The following information is listed for each existing feedback request:
· Title - This displays the name of the request that was provided when the request was created.
· Target Users - This displays who is the target of the feedback request. When the feedback is about a specific person, that person's name is displayed.
· Format - This displays the format that was selected when the request was created.
· Skills - This displays the number of skills that were included in the request.
· Responses - This displays the number of responses that have been submitted thus far.
· Last Modified - This displays the date on which the request was last modified.
· Last Response - This displays the date on which the last feedback response was provided for the request.
View Results
To view the results of a feedback request, select the View link. This link is only available if at least one response has been provided. This opens a pop-up with each of the responses listed with their feedback.
A rater's comments appear in the feedback results, if available. Only comments that are visible to the viewer are displayed.
[image: ]
Get Sharable Link
To get a sharable link to invite or re-invite a user to provide feedback, select the menu icon on the right side of a request. Then, select Get Sharable Link. A pop-up opens and displays a URL to access the request. Select the Copy link to clipboard button to copy the link. You can then share this link with desired recipients.
[image: ]
Edit Request
To edit a feedback request, select the menu icon on the right side of the request. Then, select Edit Request. This opens the Edit Feedback Request flyout. 
The following values in the request can be edited:
· Who the feedback is about
· Who should provide feedback
· Skills
· Request Name
After updating the request, select the Update button.
Any completed requests are not impacted by the modifications. If a user is removed as an assigned rater or target user, any existing feedback actions for this person are cancelled and can still be viewed on the Feedback Actions page.
Edit Feedback Actions
To view the status of your feedback request and edit any actions, select the menu icon on the right side of the request. Then, select Edit Feedback Actions. This opens the Edit Feedback Actions page. See Skills Profile - My Feedback Requests - Edit Feedback Actions on page 255 for additional information.
[bookmark: _Ref1639165587]Skills Profile - My Feedback Requests - Edit Feedback Actions
The Edit Feedback Actions page enables the feedback requestor to view the status and results of their request, edit the request settings, and cancel any in progress or not started actions if necessary.
To edit feedback actions for your feedback request, go to Home > Universal Profile. Then, from the Skills menu, select My Feedback Requests. Select the menu icon on the right side of the request. Then, select Edit Feedback Actions.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Capabilities - Skills Profile - View
	Grants the ability to view an employee Skills Profile. Users with this permission may view the Skills Profile for anyone in the organization. However, individual ratings have privacy settings that control visibility within the Skills Profile. This permission cannot be constrained. This is an end user permission.
	Core Administration



	User Ratings
	For end users, this permission grants the ability to perform ratings and view ratings. For administrators, this permission is required, along with the specific user rating administration permissions to edit rating scales or templates. This permission cannot be constrained.
	Core Administration
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Edit Request
To edit a feedback request, select the Edit Request button. This opens the Edit Feedback Request flyout. 
The following values in the request can be edited:
· Who the feedback is about
· Who should provide feedback
· Skills
· Request Name
After updating the request, select the Update button.
Any completed requests are not impacted by the modifications. If a user is removed as an assigned rater or target user, any existing feedback actions for this person are cancelled and can still be viewed on the Feedback Actions page.
View Feedback
To view the results of any completed feedback action, select the View Feedback link. This link is only available for feedback actions in a Completed status.
The Feedback Details pop-up displays the details of the feedback action, including each of the responses and the feedback.
 
[image: ]
Cancel Action
The feedback requestor has the option to cancel any request that is Not Started or In Progress. When a request is cancelled, the cancelled request remains visible on the Feedback Actions page in a Cancelled status. The request is removed from the requestee's Actions list and any email digests.
[bookmark: _Ref-201531496]Skills Profile - Provide Skill Feedback
When a user creates a feedback request for a skill, a feedback request link is generated. This link can then be shared with others who can then enter the link in an Internet browser to access the feedback process.
When the link is opened, general instructions are displayed, and the page clearly indicates who will be able to view the feedback that is provided.
When providing feedback in response to a feedback request, the person who requested the feedback is clearly displayed on the feedback form.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Capabilities - Skills Profile - View
	Grants the ability to view an employee Skills Profile. Users with this permission may view the Skills Profile for anyone in the organization. However, individual ratings have privacy settings that control visibility within the Skills Profile. This permission cannot be constrained. This is an end user permission.
	Core Administration



	User Ratings
	For end users, this permission grants the ability to perform ratings and view ratings. For administrators, this permission is required, along with the specific user rating administration permissions to edit rating scales or templates. This permission cannot be constrained.
	Core Administration


[image: ]
When Select the Start button to begin providing feedback for the user.
If you are giving feedback about multiple people in a single feedback request, then a list of the feedback assessees are displayed once the request is started. Assessors must select the Give Feedback link for each user to provide feedback for each individual in the request. After the assessor has provided feedback for someone in the request, the Date Completed column is populated, and the assessor can select the View Feedback link to review the feedback.
[image: ]
When providing feedback in response to a feedback request, the name and avatar for the person who is being rated is displayed in the upper-left corner of the page. This helps to clearly indicate the user for whom the reviewer is providing feedback.
When providing feedback, you may have a Comments field available to you, and it may be required or optional for you to provide comments, depending on the administrator settings for the associated rating template. The character limit is 5,000.
[image: ]
Submit
Once all feedback has been provided, select the Submit button. A confirmation pop-up is displayed.
[bookmark: _Ref507201377][bookmark: concept139]Skills Profile - Rate My Interest
From the Skills Profile page, users can rate their interest with skills they possess and skills they want to develop. This process helps track your skill improvement over time and helps the system provide more personalized development recommendations and career advice.
To rate your interest in a skill, within the Your Skills or Skills You Want to Develop section of the Skills Profile page, select the menu icon on the right side of the skill button. Then, select Rate My Interest. See Skills Profile on page 231 for additional information.
The General Instructions page explains the process. Select the Start button to begin.
On the second page, select responses for the questions. Then, select the Submit button to save the selected responses.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Capabilities - Skills Profile - View
	Grants the ability to view an employee Skills Profile. Users with this permission may view the Skills Profile for anyone in the organization. However, individual ratings have privacy settings that control visibility within the Skills Profile. This permission cannot be constrained. This is an end user permission.
	Core Administration



	User Ratings
	For end users, this permission grants the ability to perform ratings and view ratings. For administrators, this permission is required, along with the specific user rating administration permissions to edit rating scales or templates. This permission cannot be constrained.
	Core Administration
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[bookmark: _Ref-1226661826][bookmark: _Ref1327039157][bookmark: concept140]Skills Profile - Rate Skill Level
From the Skills Profile page, users can rate their proficiency with skills they possess and skills they want to develop. 
Users may rate their skill level in the following ways:
· Within the Your Skills section of the Skills Profile page, select the menu icon on the right side of the skill button. Then, select Rate My Proficiency. Note: This option is only available for skills that the user has identified as a skill that they have. See Skills Profile on page 231 for additional information.
· Within the Skill Details flyout, select the Rate Myself button. Note: This button is only available if the user has not yet rated their skill level. See Skills Profile - View Skill Details on page 272 for additional information.
Within the Rate Skill Level pop-up, select the appropriate skill proficiency. Then, select the Submit button to save the selected skill proficiency.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Capabilities - Skills Profile - View
	Grants the ability to view an employee Skills Profile. Users with this permission may view the Skills Profile for anyone in the organization. However, individual ratings have privacy settings that control visibility within the Skills Profile. This permission cannot be constrained. This is an end user permission.
	Core Administration



	User Ratings
	For end users, this permission grants the ability to perform ratings and view ratings. For administrators, this permission is required, along with the specific user rating administration permissions to edit rating scales or templates. This permission cannot be constrained.
	Core Administration
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[bookmark: _Ref159986780]Skills Profile - Request Feedback for Skill Proficiency
From the Skills Profile page, users can request that others provide feedback regarding their proficiency in a skill. Users may also have permission to request others to provide feedback on a specific user.
To access the Skills Profile page, go to Home > Universal Profile. Then, click the Skills tab.
To access another user's Universal Profile - Bio page, select the user's photograph from any Universal Profile or Global Search page. From there, you can access the user's Skills Profile page by clicking the Skills tab.
Users may be able to request feedback in the following areas:
· My Feedback Requests - From the My Feedback Requests page, select the Create New Request button. See Skills Profile - My Feedback Requests on page 251 for additional information.
· Skills Profile: Skills You Want to Develop - In the Skills You Want to Develop section of the Skills Profile, select the menu icon on the right side of the skill button. Then, select Request Feedback.
· Skills Profile: Your Skills - In the Your Skills section of the Skills Profile, select the menu icon on the right side of the skill button. Then, select Request Feedback.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Capabilities - Skills Profile - View
	Grants the ability to view an employee Skills Profile. Users with this permission may view the Skills Profile for anyone in the organization. However, individual ratings have privacy settings that control visibility within the Skills Profile. This permission cannot be constrained. This is an end user permission.
	Core Administration



	User Ratings - Feedback on specific person
	Grants ability to request 360 feedback about a specific user. This permission is intended for administrators, managers, or other leadership roles. This permission can be constrained to User, OU, User's OU, User Self and Subordinates, and User's Direct Subordinates.
It is recommended to constrain this permission. Managers should be constrained to "User's Direct Reports." Administrators can constrain themselves or others to a diverse pool of potential raters.
	Core Administration



	User Ratings - Feedback Assignment
	Grants ability to assign a feedback request to a specific user. This permission can be constrained to User, OU, User's OU, User Self and Subordinates, User's Self, and User's Direct Subordinates. The constraints on this permission determine which users can be selected in the feedback assignment.
	Core Administration



	User Ratings - Request Others to Provide Feedback on Themselves
	Grants ability to request that someone rate themself. This permission is intended for administrators, managers, or other leadership roles. This permission cannot be constrained.
	Core Administration


[image: ]
Select who should provide feedback
This option is available for users who have permission to assign feedback requests. This section enables the feedback requestor to assign the feedback request to specific people, if desired.
In the Search for specific person(s) field, select one or more users to be assigned the feedback request. This is optional. You can only select users who are within your permission constraints.
Note: If the request is not assigned to any specific users, the request can be shared with anyone using the sharable link.
Who is This Feedback About?
From the drop-down, select the subject of the feedback request. The following options may be available:
· Myself - Select this option if you are requesting feedback about yourself.
· Recipient - Select this option if you are requesting that the recipient provide feedback about themself. This option is only available to users who have the appropriate permission.
· Specific Person - Select this option if you are requesting that the recipient provide feedback about a specific person. This option is only available for users who have permission to request others to provide feedback on a specific person. Users can only request feedback about users who are within their permission constraints.
The options in this drop-down are dependent upon the requestor's permissions and the available feedback templates.
Select a Format
Select one of the available format options. The selected format determines who can view the proficiency ratings that are provided.
The options in this section are dependent upon the available feedback templates. Administrators can configure these rating templates in Capabilities Administration. See Capability Rating Templates (Early Adopter) - Manage.
Select Who This Feedback is About
This option is only available if "Specific Person" is selected in the Who is this feedback about? drop-down menu.
In this field, select one or more users as the subject of the feedback request. You can only select users who are within your permission constraints.
Select Skills
Select which skills you want included in the feedback request. At least one skill must be selected. The request recipients will be asked to provide ratings for each of the selected skills.
Create a Request Name
Provide a name for the feedback request. This name is only for the reference of the requester, and it is never displayed to the request recipients. The character limit for this field is 100.
Submit and Copy Invite Link
Select the Submit button to create the request. A pop-up opens and displays a URL to access the request. Select the Copy link to clipboard button to copy the link. You can then share this link with desired recipients.
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[bookmark: _Ref-728233273][bookmark: _Ref-215147480][bookmark: concept142]Skills Profile - View Skill Details
The Skills Details flyout shows the skill ID, name, category, description, total endorsements, and proficiency rating. If the user's proficiency level has not been rated for the skill, then the user has the option to rate their proficiency level for the skill.
The avatar of the user whose skill details are being viewed is displayed below the skill description. This makes it clear whose skills profile and skill details are being viewed.
To view the Skill Details for a skill, navigate to the Skills Profile page. Then, select the skill name of a skill in your profile. See Skills Profile on page 231 for additional information.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Capabilities - Skills Profile - View
	Grants the ability to view an employee Skills Profile. Users with this permission may view the Skills Profile for anyone in the organization. However, individual ratings have privacy settings that control visibility within the Skills Profile. This permission cannot be constrained. This is an end user permission.
	Core Administration



	User Ratings
	For end users, this permission grants the ability to perform ratings and view ratings. For administrators, this permission is required, along with the specific user rating administration permissions to edit rating scales or templates. This permission cannot be constrained.
	Core Administration
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View Endorsements
When a user views the Skill Details flyout from their own Skills Profile, the user can view the number of endorsements they have received for the skill. Users can select the endorsed by link to view the Feedback History for the skill which includes all of the users who have endorsed the user for the skill. The endorsement count and list of endorsers are only displayed if the user has received at least one endorsement for the skill.
Endorsement a Skill
When a user views the Skill Details flyout from another person's Skills Profile, the user can view the number of endorsements the user has received for the skill. If the viewer has not yet endorsed the user for the skill, then they can select the + button to quickly add their endorsement.
Note: Currently, users are not able to undo or revoke endorsements or ratings they have given.
Rate My Proficiency
If a rating template is active with the feature connector "Rating Card" selected, a Rate My Proficiency button is available, allowing the user to launch a self-rating on proficiency. See Capability Rating Templates (Early Adopter) - Edit - Feature Connectors.
Select this button to rate your proficiency level for the skill. See Skills Profile - Rate Skill Level on page 264 for additional information.
Ratings
If you have a rating for the skill, then a Ratings chart is available in the flyout. This chart displays any ratings that you have provided and any other ratings that are visible to you. The proficiency levels are configurable by the system administrator.
Each rater's ratings and comments appear below the Rating History chart, if available. Only comments that are visible to the viewer are displayed.
Comments
In situations where your organization is not using scale-based ratings or the target user has not received any ratings, then the Skill Details flyout displays a preview of any feedback comments provided for this skill.
Top Rated Individuals
This section displays the top rated individuals and their ratings within the organization for the skill. Up to six top-rated individuals are displayed for a skill based on their skill proficiency. A link to the top-rated individual's Skill Profile is included to enable users to easily connect with the top rated individual.
A user will only appear as a top rated individual for a skill if they have a predicted proficiency above 80% for the skill. A user's predicted proficiency rating is an amalgamation of all declared ratings for the user (Self, Manager, and Peers) and the user's skill level that can be inferred from their job history and job title. At least one rating is required for a user to appear in this section.
If no users meet the 80% skill proficiency, then the Top Rated Individuals section is not displayed.
This section is only available if enabled by the administrator in Capabilities Preferences. See Capabilities Preferences - Skills Profile.
Learning Recommendations
For organizations using Learning, skills-based learning recommendations are available at the bottom of the Skills Details panel, which displays a carousel of relevant training. The training is presented two-at-a-time with an image in a carousel, which can be browsed using arrows with a limit of 15. Note: Arrows do not appear in this section when viewing the Skill Details on a touchscreen device.
Users can select the training tile to view the Learning Details page for that training. Users can select the Show all link above the carousel to navigate to the Learning Search page with the skill name pre-loaded as the search parameter.
[bookmark: _Ref-388668491]Skills Profile - View Critical Skills
If you belong to an organizational unit (OU) with an associated capability model, a Critical skills page can be accessed from your Skills Profile.
The Critical skills page outlines your critical skills, predicted proficiency ratings, targets, and status for the proficiency target. The highest proficiency target and the corresponding status are displayed if you are aligned to multiple competency models with different proficiency targets for the same skills.
The color associated with the skill tag indicates the skill association. Green indicates developing, blue indicates declared, white indicates suggested, and gray indicates hidden.
Your predicted proficiency rating is an amalgamation of all declared ratings for you (Self, Manager, and Peers) and your skill level that can be inferred from your job history and job title.
You can perform actions on a single skill by selecting the options menu (three dots) to the right of the skill name. You can perform bulk actions on all critical skills by selecting the options menu (three dots) in the upper-right corner of the table.
Select the heartbeat icon [image: ] to open the Critical Skills Progress Tracking flyout. This option is only available if enabled in Skills Profile Preferences. See Skills Profile - View Critical Skills Progress on page 277 for additional information.
To access the Critical skills page, go to Home > Universal Profile. Then, click the Skills tab. In the Critical skills widget, select the View critical skills link.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Capabilities - Skills Profile - View
	Grants the ability to view an employee Skills Profile. Users with this permission may view the Skills Profile for anyone in the organization. However, individual ratings have privacy settings that control visibility within the Skills Profile. This permission cannot be constrained. This is an end user permission.
	Core Administration



	Skills Profile - Critical Skills - View
	Grants the ability to view the Critical Skills table for any user. This permission cannot be constrained. This is an administrator permission.
Administrators must also have permission to access the user's Skills Profile.
	Core Administration



	User Ratings
	For end users, this permission grants the ability to perform ratings and view ratings. For administrators, this permission is required, along with the specific user rating administration permissions to edit rating scales or templates. This permission cannot be constrained.
	Core Administration
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[bookmark: _Ref-977767042]Skills Profile - View Critical Skills Progress
The Critical Skills Progress Tracking flyout displays a user's proficiency in their critical skills over time. Users and managers can view this information in chart or table format.
To view the Critical Skills Progress Tracking flyout, go to Home > Universal Profile. Then, click the Skills tab and view your skills profile. In the Critical skills widget, select the View critical skills link. Then, select the Heartbeat icon [image: ] to view proficiency progress.
To access another user's Universal Profile - Bio page, select the user's photograph from any Universal Profile or Global Search page. From there, you can access the user's Skills Profile page by clicking the Skills tab.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Capabilities - Skills Profile - View
	Grants the ability to view an employee Skills Profile. Users with this permission may view the Skills Profile for anyone in the organization. However, individual ratings have privacy settings that control visibility within the Skills Profile. This permission cannot be constrained. This is an end user permission.
	Core Administration



	User Ratings
	For end users, this permission grants the ability to perform ratings and view ratings. For administrators, this permission is required, along with the specific user rating administration permissions to edit rating scales or templates. This permission cannot be constrained.
	Core Administration


Toggle Between Formats
To toggle between the chart and table format, select the appropriate icon in the upper-right corner of the page.
Time Span
From the Time setting, configure the graph to display either 6 months or 12 months of data.
Select or Deselect Skills
By default, the user's top five critical skills are displayed.
To change which skills are included in the graph, select or deselect the appropriate skills in the Skills section on the left.
Chart Format
The key below the chart indicates which color corresponds to each skill.
Users can hover their cursor over a point on the graph to view the overall rating percentage
[image: ]
Table Format
The Skills Assessment column indicates whether the skill is strengthened, weakened, or if there is no progress over the selected time frame.
[image: ]
[bookmark: _Ref-1316080466][bookmark: _Toc161994678]People Matrix Homepage
People Matrix is a tool to help managers to visualize and better understand the qualifications of people on your team or in your organization. Managers can create multiple matrices to track various skill and employee groups.
The People Matrix Homepage displays a summary of each available people matrix.
To access the People Matrix homepage, go to Skills > People Matrix.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	People Matrix
	Grants access to the People Matrix functionality. This permission can be constrained to User, OU, User's OU, User Self and Subordinates, and User's Direct Subordinates. The constraints on this permission determine which users are available in the People Matrix. This is a manager permission.
	Core Administration



	User Ratings - View All Shared Ratings
	Grants the ability to view all ratings shared with others in addition to the rater. This permission applies anywhere the ratings are displayed, such as the People Matrix and Skills Profile. This permission is intended for indirect managers or non-managers to view rating data for users over whom they have no oversight. This permission grants access to all OU types, both standard and custom. This permission can be constrained to User, OU, User's OU, User Self and Subordinates, and User's Direct Subordinates. The constraints on this permission determine whose shared ratings the person can view. This is a manager permission.
	Core Administration
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Create a People Matrix
If no matrices exist, select the Get Started button to create a matrix.
If one or more matrices exist, select the Create New button to create a matrix. 
See People Matrix - Create on page 282 for additional information.
View Critical Skills
Select the View Critical Skills button to generate a people matrix of your subordinates and their critical skills.
Critical skills for each team member are pooled together from various models. If a skill exists in multiple models, the skill with the highest target will be shown.
The system-generated Critical Skills people matrix cannot be edited, deleted, or copied. This matrix will remain in sync with any changes made to the relevant models.
The View Critical Skills button is available to all users. If you generate this matrix as a non-manager, the matrix will be empty because you do not have subordinates.
People Matrix Summaries
The People Matrix homepage displays a summary for each of the people matrices that are available to you. The following information is displayed in the summary for each matrix:
· Matrix Name
· Skills - This displays the number of skills included in the matrix.
· Total Employees - This displays the number of users included in the matrix.
· Proficiency Targets - The proficiency target icons only appear if the matrix includes skills with proficiency targets.
· Green - The green circle with the checkmark indicates the number of users in the matrix who achieved an Overall Target Achievement score of 100%.
· Red - The red circle with the exclamation point indicates the number of users in the matrix who achieved an Overall Target Achievement score below 80%.
· Yellow - The yellow triangle with the exclamation point indicates the number of users in the matrix who achieved an Overall Target Achievement score greater than 80% but less than 100%.
· As of - This displays the date on which the data was last updated.
[bookmark: _Ref-2065549296][bookmark: _Ref-274661215]People Matrix - Create
A people matrix displays a group of users and their proficiency for a set of capabilities and retraining . Managers can configure which users and capabilities are included in the matrix.
To create a People Matrix, go to Skills > People Matrix.
· If no matrices have been created yet, then select the Get Started button.
· If at least one matrix has been created, then select the Create New button.
A People Matrix can be created in two ways:
· Create new - Build a matrix from scratch, selecting users, capabilities, and training. See People Matrix - Build from Scratch on page 284 for additional information.
· Use a template - Build a matrix using an existing capability model. See People Matrix - Create on page  for additional information.
To edit a People Matrix, go to Skills > People Matrix. Select the appropriate matrix. From the People Matrix, select the Options menu and select Edit Matrix.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	People Matrix
	Grants access to the People Matrix functionality. This permission can be constrained to User, OU, User's OU, User Self and Subordinates, and User's Direct Subordinates. The constraints on this permission determine which users are available in the People Matrix. This is a manager permission.
	Core Administration



	User Ratings - View All Shared Ratings
	Grants the ability to view all ratings shared with others in addition to the rater. This permission applies anywhere the ratings are displayed, such as the People Matrix and Skills Profile. This permission is intended for indirect managers or non-managers to view rating data for users over whom they have no oversight. This permission grants access to all OU types, both standard and custom. This permission can be constrained to User, OU, User's OU, User Self and Subordinates, and User's Direct Subordinates. The constraints on this permission determine whose shared ratings the person can view. This is a manager permission.
	Core Administration
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[bookmark: _Ref-368705082]People Matrix - Build from Scratch
A people matrix displays a group of users and their proficiency for a set of capabilities and relevant training. Managers can configure which users, capabilities, and training are included in the matrix.
To create a people matrix from scratch, go to Skills > People Matrix. Select the Get Started or Create New button. Select Create new.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	People Matrix
	Grants access to the People Matrix functionality. This permission can be constrained to User, OU, User's OU, User Self and Subordinates, and User's Direct Subordinates. The constraints on this permission determine which users are available in the People Matrix. This is a manager permission.
	Core Administration



	User Ratings - View All Shared Ratings
	Grants the ability to view all ratings shared with others in addition to the rater. This permission applies anywhere the ratings are displayed, such as the People Matrix and Skills Profile. This permission is intended for indirect managers or non-managers to view rating data for users over whom they have no oversight. This permission grants access to all OU types, both standard and custom. This permission can be constrained to User, OU, User's OU, User Self and Subordinates, and User's Direct Subordinates. The constraints on this permission determine whose shared ratings the person can view. This is a manager permission.
	Core Administration


Step 1 - Select Team
On the Select Team step, you can configure the matrix name and select which users are included in the matrix.
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The following options are available to help you configure the matrix name and the group of users displayed in the matrix:
1. Add OUs - By default, the matrix includes all of the creator's direct reports. Select this button to add users or organizational units to the matrix. The constraints on the People Matrix permission determine which users are available to add.
2. Remove Selected - To remove users from the matrix, select the checkbox next to the appropriate users, and select the Remove Selected button.
3. Include Subordinates - Select this option to include the user's subordinates in the matrix. When this option is selected, the subordinates are only included if they are within the matrix creator's permission constraints. In addition, you must have the necessary permission to view the shared ratings of users in the matrix.
After selecting the appropriate users, select Next to proceed to the Select Skills step.
Step 2 - Select Skills
On the Select Skills step, you can configure which skills are included in the matrix, the target proficiency level for each skill, and the number of employees required to have each skill and the required proficiency.
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The following options are available to help you configure the matrix skills:
1. Search and Add Skills - To add a skill, search for the skill and select Add Skill.
2. Select skills from a capability model - Search for and select a capability model from this drop-down to retrieve the skills and targets from the model and add them to the matrix. Multiple capability models can be selected. If a skill has multiple targets, the highest target is used. When a model is selected, the audience is not carried into the matrix.
3. Remove Selected - To remove skills from the matrix, select the checkbox next to the appropriate skills, and select the Remove Selected button.
4. Capability Model - This column indicates whether the skill was added from a capability model or ad hoc. If the skill was added from a capability model, the name of the capability model is displayed. If a skill is present in multiple models, the Capability Model column displays the most recently added model. The matrix is not automatically updated when a capability model is updated. When editing a matrix, an alert is displayed if the selected skills and targets do not match the capability model, and users can re-add the model to use the latest version.
5. Proficiency Target Level - From the drop-down, select the target proficiency level for each skill in the matrix. The people matrix will compare each user's skill level with this target level.
6. Employees Needed to Achieve Target - Specify the number of employees required to have each skill and the required proficiency. This field is optional, and the default value for the field is zero. The maximum value is 999. You can only set this field when a Proficiency Target Level field is set for the skill.
· This field is only available for matrices created from scratch, not those created from a capability model template.
· This field be set to a value larger than the number of users in the people matrix.
7. Team Skills - This section displays the top 10 declared skills that are shared for the people selected in the matrix. Select the plus icon for a skill to add it to the matrix.
8. Skills Your Team Might Have - This section displays the top 10 skills your team may have but the skills have not been declared on your team members' profiles. These skills are identified based on the users' positions and skills identified by other employees with the same position title. Select the plus icon for a skill to add it to the matrix.
After selecting the appropriate skills, select Next to proceed to the Default Rating Source step.
Step 3 - Select Trainings
A Select Trainings step is only available for organizations using Learning when Qualification Mode is enabled for People Matrices. This step is optional.
Select the Track latest version of the training option so that any time a learning object in the matrix is updated, reversioned, and assigned to users, the people matrix displays the completion status of the latest training version assigned to the user. This option applies to all training in the matrix. 
· The matrix is only updated if the training is reversioned and assigned to users. If the training is versioned but not assigned to the user, then the matrix is not updated. As a result, if training is reversioned and only assigned to some users, the matrix could include a user who is on target for completing version 1 of the training and another user who is off target for not completing version 2 of the same training.
· In the matrix, users can hover over the training status to view the version of the training that is currently used. If this checkbox is not selected, only the current training version will be used in the matrix, even when the training is reversioned.
On the Select Trainings step, select any training that should be tracked in the people matrix. The selected training will be displayed in the people matrix along with each person's training status. This enables managers to easily track each team member's status regarding the critical training.
Managers can only search for and select training if the manager is within the availability of the training.
The following training types can be added: Online Classes, Curriculum, Videos, Tests, Materials
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Step 4 - Add Rating Source and Title
On the Add Rating Source and Title step, you must select the default source of the ratings that should be used for the matrix and provide a title for the matrix. The rating source can be changed at any time when viewing the People Matrix.
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The following options are available to help you configure the rating source:
1. Select Rating Source - Select which rating source should be used to display ratings in the matrix. The following options are available:
1. Latest Manager Rating
2. Declarations Only
3. Predicted Proficiency Rating - This option displays each user's predicted proficiency for the skills on the matrix. A user's predicted proficiency rating is an amalgamation of all declared ratings for the user (Self, Manager, and Peers) and the user's skill level that can be inferred from their years of experience in the role. If no value is displayed, it may mean that there is no rating history for the skill or the skill is not normally associated with the role. If a rating is added, a score will be computed and displayed.
2. Add a Title to Your Matrix - Enter a name for your matrix, up to 200 characters. The matrix name should reflect the purpose of the matrix. The name will be displayed on the People Matrix Homepage and the People Matrix page.
3. Add a Description - Enter a description to explain the purpose of the matrix, up to 1,000 characters.
After selecting the rating source and providing a title, select Save. The new matrix is added to your People Matrix Homepage, and you are directed to the newly created People Matrix. Only the matrix creator can view the matrix.
· See People Matrix Homepage on page 279 for additional information.
· See People Matrix - Overview on page 295 for additional information.
People Matrix - Create from Template
Capability Models define the skills employees should have to succeed in their roles, and the ideal proficiency level they should attain.
Administrators and managers can create a People Matrix using a Capability Model as a template. This pre-populates the people matrix with the settings from the capability model, including the appropriate set of users, the relevant skills, and the corresponding ratings.
To create a people matrix from a capability model, go to Skills > People Matrix. Select the Get Started or Create New button. Select Use a template.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	People Matrix
	Grants access to the People Matrix functionality. This permission can be constrained to User, OU, User's OU, User Self and Subordinates, and User's Direct Subordinates. The constraints on this permission determine which users are available in the People Matrix. This is a manager permission.
	Core Administration



	User Ratings - View All Shared Ratings
	Grants the ability to view all ratings shared with others in addition to the rater. This permission applies anywhere the ratings are displayed, such as the People Matrix and Skills Profile. This permission is intended for indirect managers or non-managers to view rating data for users over whom they have no oversight. This permission grants access to all OU types, both standard and custom. This permission can be constrained to User, OU, User's OU, User Self and Subordinates, and User's Direct Subordinates. The constraints on this permission determine whose shared ratings the person can view. This is a manager permission.
	Core Administration
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Capability Model
From the drop-down, select the capability model to use as the template for the people matrix. This drop-down includes all active models sorted alphabetically.
Select default rating source
Select which rating source should be used to display ratings in the matrix. The following options are available:
1. Latest Manager Rating
2. Latest Peer Rating
3. Latest Self Rating
4. Declarations Only
5. Predicted Proficiency Rating - This option displays each user's predicted proficiency for the skills on the matrix. A user's predicted proficiency rating is an amalgamation of all declared ratings for the user (Self, Manager, and Peers) and their skill level that can be inferred from their years of experience in the role. If no value is displayed, it may mean there is no rating history for the skill, or the skill is not generally associated with the role. If a rating is added, a score will be computed and displayed.
Add a title to your matrix
Enter a name for your matrix, up to 200 characters. The matrix name should reflect the purpose of the matrix. The name will be displayed on the People Matrix Homepage and the People Matrix page.
Add a description
Enter a description to explain the purpose of the matrix, up to 1,000 characters.
Save/Update
After configuring the matrix, select the Save button. The matrix is populated using the settings defined in the selected competency model. You are unable to modify the users or skills displayed in the matrix. See People Matrix - Overview on page 295 for additional information.
The first 1,000 users in the competency model availability are included in the matrix.
· If the model has no defined availability, the first 1,000 users in the viewer's constraints are included.
· If the model has no defined availability and the user has no constraints, the first 1,000 users in the organization are included.
Frequently Asked Questions
What is a template, and which ones can I use?
The templates are another name for the Capability Models. Any capability model in the capability model library may be used, but your constraints will limit which users are included in the matrix.
Can the matrices I create be shared as models?
No. Currently, only capability models in the capability model library may be shared as templates. Please note that this is usually an administrator-only function.
I cannot edit the matrix I created using a template. Why is this?
Matrices created using a template are read-only; you may not add or remove skills or employees. If the criteria of a model need to be changed, please contact your system administrator.
I created a matrix using a template. How do I add training to it?
Currently, capability models do not support training; this functionality will be added in a future release. For now, you may only track training in matrices created ad-hoc.
I created a matrix using a template, but I do not see any people in it. Why is this?
Which employees you can view in a matrix depends on your constraints and the audience defined in the capability model. If your constraints do not align with the audience defined in the model, you may not be able to view any people.
Can I create a matrix using multiple templates?
No. Only one capability model may be added to a matrix for now.
I created a matrix from a template with multiple positions. Only some of the OUs have summary metrics when I access the matrix. Why?
To view metrics that enable comparison between OUs, two criteria must be met:
1. The OU must not exceed 1,000 employees. If the OU exceeds 1,000 employees, drilling into the OU will display metrics for the top 1,000 employees. An alert is displayed when this occurs.
2. The OU must have target proficiency ratings defined. If the OU does not have targets defined, the ratings will be color-coded from blue to gray. Targets must be defined for the OU to have a summary.
If a matrix exceeds 1,000 users, no summary metrics are provided. When viewing a matrix for an OU that exceeds 1,000 users, the first 1,000 users are displayed, and summary metrics are provided for that set of employees.
[bookmark: _Ref1966998067]People Matrix - Overview
The People Matrix displays all of the selected users and their ratings for the selected skills. Only the matrix creator can view the matrix.
To view a People Matrix, go to Skills > People Matrix. Then, select the appropriate matrix.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	People Matrix
	Grants access to the People Matrix functionality. This permission can be constrained to User, OU, User's OU, User Self and Subordinates, and User's Direct Subordinates. The constraints on this permission determine which users are available in the People Matrix. This is a manager permission.
	Core Administration



	User Ratings - View All Shared Ratings
	Grants the ability to view all ratings shared with others in addition to the rater. This permission applies anywhere the ratings are displayed, such as the People Matrix and Skills Profile. This permission is intended for indirect managers or non-managers to view rating data for users over whom they have no oversight. This permission grants access to all OU types, both standard and custom. This permission can be constrained to User, OU, User's OU, User Self and Subordinates, and User's Direct Subordinates. The constraints on this permission determine whose shared ratings the person can view. This is a manager permission.
	Core Administration
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Edit Matrix
To edit the matrix, select the Options menu in the upper-right corner of the page, and select Edit Matrix. See People Matrix - Create on page 282 for additional information.
Delete Matrix
To delete the matrix, select the Options menu in the upper-right corner of the page, and select Delete Matrix. This permanently deletes the matrix.
Export Matrix as CSV
To export the matrix and data to a CSV file, select the Options menu in the upper-right corner of the page, and select Export as CSV. Each row in the CSV file represents a skill for a user.
Copy Matrix
To copy the matrix, select the Options menu in the upper-right corner of the page, and select Copy Matrix. See People Matrix - Create on page 282 for additional information.
Summary View
When a People Matrix is created from a competency model that contains multiple organizational units (OUs), a Summary View is available to compare OUs with unique proficiency targets. Multiple OU types may be used in a matrix. The summary view enables viewers to compare target attainment across OUs. See People Matrix - Summary View on page 299 for additional information.
Proficiency Levels and Targets
In the upper-right corner of the page, each of the proficiency levels are displayed with their corresponding name. Viewers can hover over a proficiency level to view a description.
If proficiency targets are configured for the selected skills' capability model, then the following assessments are displayed in the matrix:
· Target Met - This indicates the user's rating is at or above the skill's proficiency target.
· Near Target - This indicates the user's rating is within 80% of the skill's proficiency target.
· Off Target - This indicates the user's rating is less than 80% of the skill's proficiency target.
Search Users
Search for a specific user in the matrix. When a search is conducted, the matrix only displays users who match the search criteria.
Rating Source
By default, the matrix uses the default rating source configured for the matrix. To view ratings from a different source, select the appropriate source from the Rating Source drop-down menu.
Note: Rating Source is determined by the rater's relation at the time of the rating, regardless of the person's current relation.
Filter Skills and Proficiency Levels
To filter the skills and proficiency levels displayed in the People Matrix, select the Filters toggle. This opens the Filters flyout. The Filters flyout displays filters based on which content is being viewed in the People Matrix.
Which filter criteria are available in the flyout is determined by which data is being viewed in the People Matrix.
· When the rating source is Declarations Only, Skill Name and Declaration Status filters are available.
· When the rating source is not Declarations Only, Skill Name and Proficiency Level filters are available.
The following filters are available:
· Skill Drop-down - Select a specific skill to display. When a skill is selected, only the selected skill is displayed.
· Declaration Status - Select one or more declaration statuses to display. When a declaration status is selected, only ratings with the selected declaration status are displayed.
· Proficiency Level - Select one or more proficiency levels to display. When a proficiency level is selected, only ratings with the selected proficiency level are displayed.
People Matrix Data
The following information is displayed in the People Matrix:
· Employee Count - The number of users included in the matrix is displayed at the top of the employee list.
· Employee Name - The first column displays each user who was configured to be included in the People Matrix. The matrix only displays users who are within the viewer's permission constraints.
· Overall Skill and Training Score - This displays the user's cumulative score, including their skill assessments and training completion. You can select this link to view the user's Summary of Skills Gaps flyout. See People Matrix - View Summary of Skill Gaps on page 302 for additional information.
Skills Tab
When the Skills tab is selected, the following information is displayed:
· Employees Needed to Achieve Target - When creating a matrix, you can specify how many employees need to have the skill and the required proficiency. If a value is set for a skill in the matrix, then the people matrix indicates how many employees are on target for the skill and how many employees are required to be on target for the skill. This information helps managers and administrators quickly identify whether the team or group has the necessary number of adequately skilled employees for each skill.
· This is displayed as [Number of employees on target]/[Number of employees needed].
· This value does not display if the Employees Needed to Achieve Target value is set to zero or is not set when creating the matrix.
· The Employees Needed to Achieve Target value may be set to a value larger than the number of users in the people matrix.
· Skills and Proficiencies - The matrix displays the user's proficiency level for each of the skills.
· The proficiencies are based on the selected Rating Source.
· If a proficiency target is configured for the skill's capability model, then the matrix displays whether the user has met the target, is near the target, or is off the target.
· On Target - This indicates the user meets or exceeds the target.
· Near Target - This indicates the user is below the target by one level.
· Off Target - This indicates the user is below the target by two or more levels.
· If no proficiency target is configured for the skill's capability model, then the rating circles are shaded to reflect the proficiency level. Higher levels are displayed with a darker color, while lower levels are displayed with a lighter color.
· When Declarations Only is selected as the rating source, a checkmark is displayed if the user has declared the skill. A proficiency assessment is not displayed.
· When Latest Peer Rating is selected as the rating source, if there are multiple ratings from peers for the skill, then the latest average rating is displayed.
· Skill Actions - An Actions menu (three dots) is available by hovering over the skill rating in the matrix. Actions are available based on the rating source and whether the People Matrix feature connector is enabled for the source. The option names may vary as they can be configured in the feedback template. The following actions may be available if configured in the feedback template:
· Request a Proficiency Rating
· View Details - Select this option to view the skill details in a flyout. See Skills Profile - View Skill Details on page 272 for additional information.
· Update Ratings - Select this to provide a new rating for the user. When a new rating is provided, the matrix displays the new rating. Updating a rating adds a new rating for the user; it does not overwrite the previous rating. See Skills Profile - Provide Skill Feedback on page 257 for additional information.
· Other options may be available.
Trainings Tab
When training is added to a People Matrix, a Training tab is available in the People Matrix.
When the Training tab is selected, the following information is displayed:
· Selected training
· User's training completion status (Completed, Not Started, Not Assigned, N/A)
· If the user has not been assigned the training, an Assign link is displayed in the corresponding column for the user. Managers can select this link to assign the training to the user.
· Managers can hover over the training status for a particular user to open the Learning Details page for the user's training.
Managers can select the menu icon for a user to access the user's Skills Profile or Transcript.
[bookmark: _Ref-2124061003]People Matrix - Summary View
When a People Matrix is created from a competency model that contains multiple organizational units (OUs), a Summary View is available to compare OUs with unique proficiency targets. Multiple OU types may be used in a matrix. The summary view enables viewers to compare target attainment across OUs.​
To create a people matrix from a capability model, go to Skills > People Matrix. Select the Get Started or Create New button. Select Use a template.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	People Matrix
	Grants access to the People Matrix functionality. This permission can be constrained to User, OU, User's OU, User Self and Subordinates, and User's Direct Subordinates. The constraints on this permission determine which users are available in the People Matrix. This is a manager permission.
	Core Administration



	User Ratings - View All Shared Ratings
	Grants the ability to view all ratings shared with others in addition to the rater. This permission applies anywhere the ratings are displayed, such as the People Matrix and Skills Profile. This permission is intended for indirect managers or non-managers to view rating data for users over whom they have no oversight. This permission grants access to all OU types, both standard and custom. This permission can be constrained to User, OU, User's OU, User Self and Subordinates, and User's Direct Subordinates. The constraints on this permission determine whose shared ratings the person can view. This is a manager permission.
	Core Administration
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The Summary View displays each OU in the competency model along with target achievement metrics for the first 1,000 users in the OU. If the matrix includes over 1,000 users, the achievement metrics are not displayed when the matrix is first accessed. When this occurs, a message indicates that the matrix row limit is exceeded. Note: If the matrix includes over 1,000 users, the Export option is unavailable on the Summary View.
Managers can select the My Team link to view only their direct subordinates. This option is only available if the viewer has subordinates. The My Team view includes overall metrics for subordinates based on the highest skill target. When calculating if users are on target, the system considers the highest target within the capability model that applies to the user.
Matrix viewers can select an OU to view the details of individuals within it, quickly identifying which employees are most qualified for their roles. If the selected OU includes over 1,000 users, only the first 1,000 users are displayed in the matrix. When this occurs, a message indicates that the matrix row limit is exceeded. This message displays each time the matrix is accessed.
[image: ]
The OU drop-down enables viewers to navigate between OUs quickly. The following options are also available in the drop-down menu:
· Summary - Viewers can select this option to return to the Summary view.
· My Team - This option is only available if the viewer has subordinates. Managers can select this option to view only their direct subordinates.
If the selected OU has multiple levels in the hierarchy, viewers can select the Filter icon to the right of the OU drop-down to select specific OUs within the OU structure. The Filter option is unavailable if the capability model is not configured to include subordinate OUs.
When a matrix from a capability model is exported, the exported file includes an Audience OU field to indicate the OU associated with each user and their data. A user may be included in multiple OUs.
[bookmark: _Ref436116000]People Matrix - View Summary of Skill Gaps
When viewing the People Matrix, matrix viewers can see how many of the skills and training in the matrix each user has. For example, if a user had four of the eight skills in the matrix, "4/8" would display. Matrix viewers can select this value to view the Summary of Skill Gaps flyout, which displays a summary of the skills and training gaps for the user.
The Summary of Skill Gaps flyout displays the user's overall target status for all skills and training and the number of skills and training not on target. The flyout also lists all skills and training that are not on target so the matrix viewer can quickly see which skills and training need action.
The matrix viewer can select the left and right arrows to view different users in the skills matrix.
To view a People Matrix, go to Skills > People Matrix. Then, select the appropriate matrix. Select the skills summary for the user, such as "4/8," to view the Summary of Skills Gaps flyout.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	People Matrix
	Grants access to the People Matrix functionality. This permission can be constrained to User, OU, User's OU, User Self and Subordinates, and User's Direct Subordinates. The constraints on this permission determine which users are available in the People Matrix. This is a manager permission.
	Core Administration



	User Ratings - View All Shared Ratings
	Grants the ability to view all ratings shared with others in addition to the rater. This permission applies anywhere the ratings are displayed, such as the People Matrix and Skills Profile. This permission is intended for indirect managers or non-managers to view rating data for users over whom they have no oversight. This permission grants access to all OU types, both standard and custom. This permission can be constrained to User, OU, User's OU, User Self and Subordinates, and User's Direct Subordinates. The constraints on this permission determine whose shared ratings the person can view. This is a manager permission.
	Core Administration
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[bookmark: _Toc161994679]Universal Profile - Snapshot Overview
The Snapshot page is part of the Universal Profile and it enables users to view and manage compensation, performance, and succession information for the user.
Note: Each Snapshot widget must be configured and enabled by the administrator in Snapshot General Preferences before it appears on the Universal Profile - Snapshot page. If no widgets are enabled, then the Snapshot page appears blank. 
To access the Snapshot page, go to Home > Universal Profile. Then, click the Snapshot tab.
To access another user's Universal Profile - Bio page, select the user's photograph from any Universal Profile or Global Search page. From there, you can access the user's Snapshot page by clicking the Snapshot tab. Users can view the Snapshot page of other users who are within their Snapshot permission constraints.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Bio About - View
	Enables user to view the Bio page for users within their permission constraints. This permission must be enabled to view the Transcript page within Universal Profile. If a user does not have this permission and they click a person's name or user photo within the Universal Profile, then the Bio page will not open.
On the Learner Home page, this permission also allows end users to view the Completions & Hours field, the training sidebar, and the Continue Learning carousel. 
This permission can be constrained by Employee Relationship, OU, User's OU, User's Direct Reports, User Self and Subordinates, and User. Note: For security purposes, this permission is constrained to User Self and Subordinates by default. However, the permission constraints can be modified to allow users to view the Bio About page for other users.
	Universal Profile



	Employee Relationships - Manage
	Grants ability to add and remove user peers and approve or deny peers that are pending approval. This access may be granted for all users or a subset of users depending on constraints. This permission also grants access to the Peers section on custom User reports. This is an administrator permission.
	Performance - Administration



	Select Peers and Reviewers
	Grants ability to select peers and reviewers in off-cycle performance reviews. This permission can be constrained by User's Corporation, OU, and User's OU. This is an end user permission.
	Performance



	Snapshot - Badges
	Enables user to view the Badges widget and subpage within the Universal Profile - Snapshot page for users within their permission constraints. Any user with this permission will always be able to view their own Badges widget when the widget is enabled. This permission also allows end users to view the Badges field on the Learner Home page.
This permission works in conjunction with the Snapshot Main - View permission. This permission can be constrained by OU, User's OU, User Self and Subordinates, User, User's Self, User's Manager, User's Superiors, User's Subordinates, User's Direct Reports, and Employee Relationship. Best Practice: For most users, this permission should be constrained by User Self and Subordinates.
	Universal Profile



	Snapshot - Compensation
	Enables user to view the Compensation widget within the Universal Profile - Snapshot page for users within their permission constraints. This permission can be constrained by Employee Relationship, OU, User's OU, User Self and Subordinates, User, User's Self, User's Manager, User's Superiors, User's Subordinates, and User's Direct Reports. Best Practice: For most users, this permission should be constrained by User Self and Subordinates.
	Universal Profile



	Snapshot - Competencies
	Enables user to view the Competencies widget and subpage within the Universal Profile - Snapshot page for users within their permission constraints. This permission can be constrained by OU, User's OU, User Self and Subordinates, User, User's Self, User's Manager, User's Superiors, User's Subordinates, User's Direct Reports, and Employee Relationship. Best Practice: For most users, this permission should be constrained by User Self and Subordinates.
	Universal Profile



	Snapshot - Development Plans
	Enables user to view the Development Plans widget and subpage within the Universal Profile - Snapshot page for users within their permission constraints. This permission can be constrained by OU, User's OU, User Self and Subordinates, User, User's Self, User's Manager, User's Superiors, User's Subordinates, User's Direct Reports, and Employee Relationship. Best Practice: For most users, this permission should be constrained by User Self and Subordinates.
	Universal Profile



	Snapshot Goals - Manage
	Enables user to manage their own goals, and others public goals, using the Goals widget and subpage within the Universal Profile - Snapshot page, for users within their permission constraints. This permission can be constrained by Employee Relationship, OU, User's OU, User Self and Subordinates, User, User's Self, User's Manager, User's Superiors, User's Subordinates, and User's Direct Reports. 
Best Practice: For most users, this permission should be constrained by User Self and Subordinates.
	Universal Profile



	Snapshot - Leaderboard
	Enables user to view the Leaderboard widget and subpage within the Universal Profile - Snapshot page for users within their permission constraints. This permission works in conjunction with the Snapshot Main - View permission. This permission can be constrained by OU, User's OU, User Self and Subordinates, User, User's Self, User's Manager, User's Superiors, User's Subordinates, User's Direct Reports, and Employee Relationship. Any user with this permission will always be able to view their own Leaderboard widget when the widget is enabled. Best Practice: For most users, this permission should be constrained by User Self and Subordinates.
	Universal Profile



	Snapshot - Peers
	Grants ability to view the Peers widget within the Universal Profile - Snapshot page. This permission can be constrained by OU, User's OU, User's Self and Subordinates, User, User's Self, User's Subordinates, and User's Direct Reports. This is an end user permission.
	Universal Profile



	Snapshot - Reviews
	Enables user to view the Reviews widget and subpage within the Universal Profile - Snapshot page for users within their permission constraints. This permission can be constrained by OU, User's OU, User Self and Subordinates, User, User's Self, User's Manager, User's Superiors, User's Subordinates, User's Direct Reports, and Employee Relationship. Best Practice: For most users, this permission should be constrained by User Self and Subordinates.
	Universal Profile



	Snapshot Main - View
	Enables user to view the Snapshot page for users within their permission constraints. This permission can be constrained by Employee Relationship, OU, User's OU, User Self and Subordinates, User, User's Self, User's Manager, User's Superiors, User's Subordinates, and User's Direct Reports. Best Practice: For most users, this permission should be constrained by User Self and Subordinates.
	Universal Profile



	Snapshot Succession – Manage
	Enables user to view the Succession widget and subpage within the Universal Profile - Snapshot page for users within their permission constraints. On this page, users can view and manage successors and successor ratings. Users cannot view their own Succession widget and subpage, regardless of permissions. This permission can be constrained by OU, User's Subordinates, User's Direct Subordinates, and Employee Relationship. 
	Universal Profile



	Snapshot Succession - View
	Enables user to view the Succession widget and subpage within the Universal Profile - Snapshot page for users within their permission constraints. On this page, users can view successors and successor ratings. Users cannot view their own Succession widget and subpage, regardless of permissions. This permission can be constrained by OU, User's Subordinates, User's Direct Subordinates, and Employee Relationship. For most users, this permission should be constrained by User Self and Subordinates.
	Universal Profile



	View Goals
	Grants ability to view own goals and (depending on role and settings) goals of others (manager's visible goals, direct subordinate's goals, company goals, division goals). This permission can be constrained by Employee Relationship, OU, User's OU, and User Self and Subordinates. This is an end user permission.
	Performance
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View Team
The View Team flyout allows managers, approvers, and custom relationships to quickly navigate between subordinates' profiles and transcripts. When enabled, the View Team flyout is available to managers and dotted line managers on all pages of their Universal Profile and the Universal Profile of their subordinates. This flyout displays the manager's reports visually.
The View Team button displays if enabled in the portal. Administrators may enable or disable this flyout via the My Team Dropdown section within Universal Profile General Preferences. See Universal Profile General Preferences on page 2 for additional information.
See Universal Profile - View Team Flyout on page 648 for additional information.
Options
An Options drop-down may be available on various pages of the Universal Profile. This menu may include options such as Assign Training and Create Goal. See Universal Profile Options Drop-down Overview on page 653 for additional information.
Widgets
Note: Each Snapshot widget must be configured and enabled by the administrator in Snapshot General Preferences before it appears on the Universal Profile - Snapshot page. If no widgets are enabled, then the Snapshot page appears blank. 
See Snapshot General Preferences on page 317 for additional information.
The following widgets may be available on the Snapshot page:
Compensation - Compensation Components
This widget is only available when enabled by the administrator in Snapshot General Preferences. In addition, this widget is only available to users with permission to view the Compensation widget on the Snapshot page.
This widget displays a snapshot of the user's most recent compensation statement. Up to four compensation components may be displayed in the widget, including bonus types, base types, and equity types. The administrator can configure which compensation components are reflected in the widget in Snapshot Preferences. In addition, the widget title can be configured by the administrator in Snapshot Preferences. See Snapshot General Preferences on page 317 for additional information.
Users can click the widget to view their own compensation statement. Managers are not able to click the widget to view the compensation statement of a direct report. See Compensation Statement for additional information.
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Competencies - Assessment Rating
This widget is only available when enabled by the administrator in Snapshot General Preferences. In addition, this widget is only available to users with permission to view the Competencies widget on the Snapshot page.
This widget displays a competency assessment rating for the user. The competency assessment title is also displayed. This widget can display the user's most recently completed standalone competency assessment rating or the rating for a specific assessment. The administrator can configure which standalone competency assessment is reflected in the widget in Snapshot Preferences. In addition, the widget title can be configured by the administrator in Snapshot Preferences.See Snapshot General Preferences on page 317 for additional information.
Note: Only standalone competency assessments can be displayed on this widget. Performance review-based competency assessments are not displayed here. They only appear on the Snapshot: Reviews page.
Users can click the widget to view the user's Competencies Snapshot page. See Snapshot - Competencies on page 326 for additional information.
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Development Plans - Plan Progress
This widget is only available when enabled by the administrator in Snapshot General Preferences. In addition, this widget is only available to users with permission to view the Development Plans widget on the Snapshot page.
This widget displays either the user's average development plan progress or the progress of the user's primary development plan. If the user's primary development plan is displayed, then the primary development plan name is displayed. Otherwise, the widget indicates that the user's average development plan progress is being displayed. The administrator can configure which development plan progress is reflected in the widget (average or primary plan) in Snapshot Preferences. In addition, the widget title can be configured by the administrator in Snapshot Preferences.See Snapshot General Preferences on page 317 for additional information.
Average Progress Calculation: If the average development plan progress is displayed, this is calculated using development plans in the following statuses: New, In Development, Approved, Past Due, Pending Acceptance Approval, Pending Cancellation Approval, Pending Completion Approval, Completion Approval Denied, and Complete. 
Users can click the widget to view the user's Development Plans Snapshot page. See Snapshot - Development Plans on page 329 for additional information.
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Documents
This widget is only available when enabled by the administrator in Snapshot General Preferences. This widget displays the number of documents within the Snapshot Documents page that are available to the user who is viewing the page. Click the widget to open the user's Documents page. See Snapshot - Documents on page 341 for additional information.
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Goals - Goal Progress
This widget is only available when enabled by the administrator in Snapshot General Preferences. In addition, this widget is only available to users with permission to view the Goals widget on the Snapshot page.
This widget displays the user's cumulative goal progress. The widget title can be configured by the administrator in Snapshot Preferences.See Snapshot General Preferences on page 317 for additional information.
Cumulative Progress Calculation: The cumulative goal progress is calculated using goals in the following statuses: Pending Approval, Pending Modification Approval, Pending Completion Approval, Denied, Modification Denied, Approved, Pending Modification Cancelled, Draft, Pending Cancellation Approval, and Complete. Goals in Deleted or Cancelled status are not included in the calculation.
Users can click the widget to view the user's Goals Snapshot page. See Snapshot - Goals on page 351 for additional information.
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Peers
When the Universal Profile - Peers functionality is enabled and the Peers widget is enabled in Snapshot General Preferences, a Peers widget appears on the Universal Profile - Snapshot page. This widget displays the number of peers that are configured for the user. The Peers widget is only available to users with the appropriate permissions.
· When a user clicks the widget on their Snapshot page, the My Peers page opens. See Peers - Create for additional information.
· When a manager clicks the widget on a subordinate's page, the Manage Employee Relationships page opens. See Manage Employee Relationships for additional information.
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Reviews
This widget is only available when enabled by the administrator in Snapshot General Preferences. In addition, this widget is only available to users with permission to view the Reviews widget on the Snapshot page.
This widget displays a performance review rating for the user. This widget can display the user's most recently completed review rating or the rating for a specific review. The administrator can configure which performance review is reflected in the widget in Snapshot Preferences. In addition, the widget title can be configured by the administrator in Snapshot Preferences. See Snapshot General Preferences on page 317 for additional information.
Users can click the widget to view the user's Reviews Snapshot page. See Snapshot - Reviews on page 364 for additional information.
If the performance review task is configured to display a text rating, then the widget displays the text rating and the review title.
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If the performance review task is configured to display a text and numeric rating or only a numeric rating, then the widget displays the numeric rating and the review title. The numeric rating is represented out of five stars. For example, a rating of four out of five is represented with four colored stars and one gray star.
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Succession - Metric Rating
This widget is only available when enabled by the administrator in Snapshot General Preferences. In addition, this widget is only available to users with permission to view the Succession widget on the Snapshot page.
This widget displays an SMP metric rating for the user. The SMP metric title is also displayed. The administrator can configure which metric is displayed in Snapshot Preferences. In addition, the widget title can be configured by the administrator in Snapshot Preferences.See Snapshot General Preferences on page 317 for additional information.
Users can click the widget to view the user's Succession Snapshot page. See Snapshot - Succession on page 377 for additional information.
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Succession - Successors
This widget is only available when enabled by the administrator in Snapshot General Preferences. In addition, this widget is only available to users with permission to view the Succession widget on the Snapshot page.
The administrator can configure the widget to display either the number of user-based or position-based potential successors. 
· If the widget is configured to display user-based potential successors, then the widget displays the number of potential successors for the selected user.
· If the widget is configured to display position-based potential successors, then the widget displays the number of potential successors for the selected user's position.
The widget title can be configured by the administrator in Snapshot Preferences.See Snapshot General Preferences on page 317 for additional information.
Users can click the widget to view the user's Succession Snapshot page. See Snapshot - Succession on page 377 for additional information.
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Badges
This widget is only available when enabled by the administrator in Snapshot General Preferences. Also, this widget is only available to users who have the Snapshot - Badges permission. This widget displays the number of badges the user has been awarded. This includes all types of badges (e.g., Feedback and Learning). Click the widget to open the user's My Badges page. See Snapshot - My Badges on page 322 for additional information.
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Leaderboard
This widget is only available when enabled by the administrator in Snapshot General Preferences. Also, this widget is only available to users who have the Snapshot - Leaderboard permission. This widget displays the total number of points the user has been awarded from completing training, receiving training badges, and receiving positive feedback badges. This is the total number of points the user has earned all time. Click the widget to view a full leaderboard of users and their point totals. See Snapshot - Leaderboard on page 360 for additional information.
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[bookmark: _Ref151485663][bookmark: _Toc161994680]Snapshot General Preferences
Use the Snapshot General Preferences page to define the order, title, and preferences for each widget that appears on the Universal Profile - Snapshot page. The visibility of widgets on the Universal Profile - Snapshot page is determined by each user's permissions. The order in which the widgets appear may be affected by widget size, so the order in which widgets appear on the Universal Profile - Snapshot page may differ from the administrator-defined order.
Note: Widgets only appear in Snapshot General Preferences if the corresponding functionality is enabled in the portal. For example, the Succession widget is only available in Snapshot Preferences if Succession is enabled for the portal.
To access the Snapshot General Preferences page, go to Admin > Tools > Core Functions > Universal Profile > Snapshot General.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Snapshot Succession – Manage
	Enables user to view the Succession widget and subpage within the Universal Profile - Snapshot page for users within their permission constraints. On this page, users can view and manage successors and successor ratings. Users cannot view their own Succession widget and subpage, regardless of permissions. This permission can be constrained by OU, User's Subordinates, User's Direct Subordinates, and Employee Relationship. 
	Universal Profile



	Snapshot Preferences – Manage
	Enables administrator to access and edit the Snapshot Preferences page. This permission can be constrained by Employee Relationship, OU, and User's OU. This is an administrator permission.
	Universal Profile
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Widget Table
The widget table displays the following:
· Widget Type - The read-only name of the widget.
· Title - Displays the following:
· Widget Title - Enter the title that should appear at the top of the widget on the Universal Profile - Snapshot page. This field is required and the character limit is 50.  If multiple languages are enabled for your portal, select the Translate icon to translate the field into other available languages. 
· Subpage Title - Enter the title that should appear at the top of the subpage when the corresponding widget is clicked. For example, when the Succession widget is clicked, the Succession subpage opens. This field is required and the character limit is 50. Subpages are not available for all widgets.  If multiple languages are enabled for your portal, select the Translate icon to translate the field into other available languages.  
· Widget Preferences - Select the appropriate options for each widget. 
· Display Widget - Select the appropriate checkbox for the widgets you want to appear on the Universal Profile - Snapshot page. Deselect a checkbox to hide a widget. 
[bookmark: -248417064]Widget Preferences
The available preferences vary for each widget type are as follows:
Documents
When enabled, the Documents widget displays the total number of documents uploaded for an employee.
Compensation
When enabled, the Compensation widget displays the user's Salary and up to four compensation components. Select the following for each component:
· Display user's current salary - Select this checkbox to display the user's current salary.
· Type - From this drop-down, select the component type that should be displayed (e.g., Base, Bonus, Equity). If a component type does not have any available components, then the component type is not available in the drop-down menu.
· Component - From this drop-down, select the specific compensation component that should be displayed. The available components correspond with the component type that is selected in the Type drop-down menu. For example, if Bonus is selected, then only bonus type components are available. 
Competencies
When enabled, the Competencies widget displays the selected option: 
· Display rating of most recently completed assessment - Select this option to display the overall rating from the user's most recently completed competency assessment.
· Display rating of the following assessment: - Select this option to display the user's overall rating for a specific competency assessment. You must click the pop-up icon [image: ] to select the competency assessment task from which the user's overall rating should be displayed. When this option is selected, a competency assessment task must be selected.
Note: When the Competencies widget is enabled in Snapshot Preferences, disable the Competency Assessment Summary page for optimal implementation.
Development Plans
When enabled, the Development Plans widget displays the selected option: 
· Display progress of primary plan only - Select this option to display the progress for the user's primary development plan.
· Display average progress of all plans - Select this option to display the average progress across all of the user's development plans.
Note: When the Development Plans widget is enabled in Snapshot Preferences, disable the Development Plans Summary page for optimal implementation.
Goals
When enabled, the Goals widget displays the total progress of all goals for the current period. 
Note: When the Goals widget is enabled in Snapshot Preferences, disable the Goals page for optimal implementation.
Review
When enabled, the Review widget displays the selected option: 
· Display rating of most recently completed review - Select this option to display the overall rating from the user's most recently completed performance review.
· Display rating of the following review: - Select this option to display the user's overall rating for a specific performance review. You must click the pop-up icon [image: ] to select the performance review task from which the user's overall rating should be displayed. When this option is selected, a performance review task must be selected.
Note: When the Reviews widget is enabled in Snapshot Preferences, disable the Performance Reviews Summary page for optimal implementation.
Succession
When enabled, the Succession widget displays the selected option: 
· Display number of User-based potential successors - Displays the number of potential successors for the user.
· Display number of Position-based potential successors - Displays the number of potential successors that have been identified for the selected user's current position.
· Display SMP Metric Fields - Displays the data from an SMP metric field. You must click the pop-up icon [image: ] to select the SMP metric field that should be displayed. When this option is selected, an SMP metric field must be selected.
Note: When the Succession widget is enabled in Snapshot Preferences, disable the My Team > Succession page for optimal implementation.
Badges
When enabled, the Badges widget displays the number of badges the user has been awarded. This includes all types of badges (e.g., Feedback and Learning). The My Badges subpage enables users, managers, and administrators to view all of the badges awarded to the user. 
Employee Compensation
When enabled, the Employee Compensation widget displays details of an employee's compensation based on assigned permissions.
Leaderboard
When enabled, the Leaderboard widget displays the number of points the user has been awarded from completing training, receiving training badges, and receiving positive feedback badges. The Leaderboard subpage displays a full leaderboard of users and their point totals.
Overwrite Settings
Select this option to overwrite custom settings for child division OUs. If you overwrite custom settings for child division OUs, the selected settings are applied to both new and existing child OUs. Any previously customized child OUs are updated with the selected settings.
· If there are no customizations to the child OU, then the parent OU customizations are applied to all child OUs.
· Overwrite custom settings checkbox setting
· If this option is selected, all child OU customizations are deleted from the database, which means the parent OU customizations will be applied to new and existing child OUs.
· If this option is unselected, all existing child OU customizations will remain unchanged, and any new child OUs will inherit the parent OU customizations by default.
· If a child OU has been customized to display any widgets, then regardless of the parent OU customizations, the child OU customizations are applied.
· If a child OU has been customized to hide all widgets, then parent OU customizations will take precedence and will be applied.
Change Widget Order
Drag and drop the widget types to determine the order in which the widgets are displayed on the Universal Profile - Snapshot page. A widget at the top of the list will appear first on the Snapshot page. Note: The order in which the widgets appear may be affected by widget size, so the order in which widgets appear on the Universal Profile - Snapshot page may differ from the administrator-defined order.
Submit/Cancel
· Click Submit to submit any unsaved changes.
· Click Cancel to discard any unsaved changes.
[bookmark: _Ref1359108930][bookmark: _Ref106705545][bookmark: _Toc161994681]Snapshot - Badges
Snapshot - My Badges
The My Badges page enables users, managers, and administrators to view all of the badges that the user has been awarded. This page displays all types of badges such as Feedback and Learning badges. This page can be filtered by badge type.
To access the My Badges page, click the Badges widget on the Universal Profile - Snapshot page.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Snapshot - Badges
	Enables user to view the Badges widget and subpage within the Universal Profile - Snapshot page for users within their permission constraints. Any user with this permission will always be able to view their own Badges widget when the widget is enabled. This permission also allows end users to view the Badges field on the Learner Home page.
This permission works in conjunction with the Snapshot Main - View permission. This permission can be constrained by OU, User's OU, User Self and Subordinates, User, User's Self, User's Manager, User's Superiors, User's Subordinates, User's Direct Reports, and Employee Relationship. Best Practice: For most users, this permission should be constrained by User Self and Subordinates.
	Universal Profile



	Snapshot Main - View
	Enables user to view the Snapshot page for users within their permission constraints. This permission can be constrained by Employee Relationship, OU, User's OU, User Self and Subordinates, User, User's Self, User's Manager, User's Superiors, User's Subordinates, and User's Direct Reports. Best Practice: For most users, this permission should be constrained by User Self and Subordinates.
	Universal Profile
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View Team
The View Team flyout allows managers, approvers, and custom relationships to quickly navigate between subordinates' profiles and transcripts. When enabled, the View Team flyout is available to managers and dotted line managers on all pages of their Universal Profile and the Universal Profile of their subordinates. This flyout displays the manager's reports visually.
The View Team button displays if enabled in the portal. Administrators may enable or disable this flyout via the My Team Dropdown section within Universal Profile General Preferences. See Universal Profile General Preferences on page 2 for additional information.
See Universal Profile - View Team Flyout on page 648 for additional information.
Filter Badges
By default, all types of badges are displayed. To filter the badges by type, select the appropriate badge type from the drop-down menu, such as Feedback or Learning.
Total Number of Badges
In the upper-right corner of the page, the total number of times a user has been awarded a badge is displayed. If the user has been awarded the same badge multiple times, then each time is counted as a separate occurrence in this total.
Earned Badges
This page displays all of the badges the user has been awarded. A number is displayed in the lower-right corner of the badge which indicates the number of times the user has received this badge.
This page displays all types of badges such as Feedback and Learning badges. Badges are displayed in the order in which they were awarded, with the most recently awarded badge displayed first.
Note: Badges and Points do not display on the Training Completion page for ILT sessions. Any earned Badges or Points will still be awarded to the user, but for ILT sessions they must be accessed from the Badges and/or Points Snapshot widgets in Universal Profile.
[bookmark: _Ref-404965223][bookmark: _Toc161994682]Snapshot - Competencies
[bookmark: concept146][bookmark: concept145]Snapshot - Competencies
The Competencies page enables users, managers, and administrators to view a summary of the user's standalone competency assessments. Note: Only standalone competency assessments are displayed on this page. Performance review-based competency assessments only appear on the Snapshot: Reviews page. 
To access the Snapshot: Competencies page, go to Home > Universal Profile. Select the Snapshot tab. Then, select the Competencies widget.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Snapshot - Competencies
	Enables user to view the Competencies widget and subpage within the Universal Profile - Snapshot page for users within their permission constraints. This permission can be constrained by OU, User's OU, User Self and Subordinates, User, User's Self, User's Manager, User's Superiors, User's Subordinates, User's Direct Reports, and Employee Relationship. Best Practice: For most users, this permission should be constrained by User Self and Subordinates.
	Universal Profile
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View Team
The View Team flyout allows managers, approvers, and custom relationships to quickly navigate between subordinates' profiles and transcripts. When enabled, the View Team flyout is available to managers and dotted line managers on all pages of their Universal Profile and the Universal Profile of their subordinates. This flyout displays the manager's reports visually.
The View Team button displays if enabled in the portal. Administrators may enable or disable this flyout via the My Team Dropdown section within Universal Profile General Preferences. See Universal Profile General Preferences on page 2 for additional information.
See Universal Profile - View Team Flyout on page 648 for additional information.
Sort By
The table of standalone competency assessments can be sorted using the following sorting options within the Sort By drop-down menu:
· Completion Date - Select this option to sort the assessments in chronological order by completion date, with the most recently completed assessment displayed first. Assessments with a completion date of "N/A" are displayed first. Assessments with a due date are listed after completed assessments, with the assessment with the soonest due date displayed first. Assessments with the same completion date are then sorted alphabetically.
· Due Date - Select this option to sort the assessments in chronological order by due date, with the assessment with the soonest due date displayed first. Assessments that are completed are listed after assessments with a due date, with the most recently completed assessment displayed first. Assessments with the same due date are then sorted alphabetically.
· Rating - Select this option to sort the assessments by rating, with the highest rated assessments displayed first. Assessments with the same rating are then sorted alphabetically.
· Status - Select this option to sort the assessments by status. Assessments with the same status are then sorted alphabetically. Assessments are sorted in the following status order:
· Not Started
· In Progress
· Completed
· Incomplete
Assessments List
Note: Only standalone competency assessments are displayed on this page. Performance review-based competency assessments only appear on the Snapshot: Reviews page.  
The following information is displayed for each assessment in the Competency Assessments list:
· Assessment Title - Users can select the assessment title to view the Assessment Details page for the assessment. See Competency Assessment - View Assessment Summary.
· Status
· Due Date - This is visible only if the assessment has not been completed.
· Completion Date - This is visible only if the assessment has been completed.
· Rating - If the assessment is complete and a rating is visible to the user, then the rating is displayed to the right of the assessment details. Note: The visibility of the rating is determined by the administrator when creating the competency assessment task.
Assessment Actions
The following assessment actions may be available from the actions drop-down menu [image: ] to the right of the review:
· View - Select this option to view the Assessment Details page for the assessment. See Competency Assessment - View Assessment Summary.
[bookmark: _Toc161994683][bookmark: _Ref458340252]Snapshot - Development Plans 
The Snapshot Development Plans page enables users to view, create, and manage their development plans.
The Snapshot Development Plans page can be accessed in the following ways:
· [bookmark: concept148]Go to Performance > Development Plans.
· Go to Home > Universal Profile. Select the Snapshot tab. Then, select the Development Plans widget.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Development Plans - Approve
	Grants ability to approve or deny development plans that are pending the user's approval. This is a manager/approver permission.
	Performance



	Snapshot - Development Plans
	Enables user to view the Development Plans widget and subpage within the Universal Profile - Snapshot page for users within their permission constraints. This permission can be constrained by OU, User's OU, User Self and Subordinates, User, User's Self, User's Manager, User's Superiors, User's Subordinates, User's Direct Reports, and Employee Relationship. Best Practice: For most users, this permission should be constrained by User Self and Subordinates.
	Universal Profile


[image: ]
Create New Plan/Create New Plan From Template
· Select the Create New Plan button to create a new development plan. See Create/Edit Development Plan (Redesign).
· Select the Create New Plan From Template button to create a new development plan using a pre-defined template. 
Permission Note: The "Snapshot - Development Plans" permission enables users to access the Development Plans page and view the Create New Plan button. However, users must also have the "Development Plans - Manage" permission to create a development plan.
This button is only available when viewing your own Snapshot: Development Plans page.
View Team
The View Team flyout allows managers, approvers, and custom relationships to quickly navigate between subordinates' profiles and transcripts. When enabled, the View Team flyout is available to managers and dotted line managers on all pages of their Universal Profile and the Universal Profile of their subordinates. This flyout displays the manager's reports visually.
The View Team button displays if enabled in the portal. Administrators may enable or disable this flyout via the My Team Dropdown section within Universal Profile General Preferences. See Universal Profile General Preferences on page 2 for additional information.
See Universal Profile - View Team Flyout on page 648 for additional information.
Options
The following options are available in the Options drop-down menu:
· Create Plan from Template - Select this option to create a development plan from a template. This option is only available if development plan templates are enabled in Development Plan Preferences and if at least one development plan template is available to the user. See Create Development Plan from Template (Redesign).
· Approve Plans - Select this option to approve development plans. This option is only available if development plans require approval. Also, this option is only available to users who are responsible for approving development plans. See Approve Development Plans (Redesign).
Primary Plan
If the user has multiple plans, the user's primary plan is displayed separately above the user's other development plans.
A read-only progress bar is displayed for the primary plan to visually and prominently show the primary plan progress. The numeric representation of the progress is displayed below the progress bar.
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Other Plans
This section displays all other development plans for the user. Plans can be sorted, and the due date, status, and creation date displays for each. Plan actions are also available in the Plan Actions menu. See the below sections for more information.
Sort By
The table of reviews can be sorted using the following sorting options within the Sort By drop-down menu at the top of the Reviews section:
· Create Date - Select this option to sort the plans in chronological order by creation date, with the oldest creation date displayed first. Plans with the same creation date are then sorted alphabetically.
· Due Date - Select this option to sort the plans in chronological order by due date, with the plan with the soonest due date displayed first. Plans that are completed are listed after plans with a due date, with the most recently completed plan displayed first. Plans with the same due date are then sorted alphabetically.
· Status - Select this option to sort the plans by status. Plans with the same status are then sorted alphabetically. Plans are sorted in the following status order:
· Not Started
· In Progress
· Completed
· Incomplete
Display Cancelled Plans
Select this option to refresh the page and include development plans with a status of Cancelled. When this option is unselected, plans with a status of Cancelled are hidden.
Hide Completed and Past Due Plans
Select this option to refresh the page and hide development plans with a status of Completed or Past Due. When this option is unselected, plans with a status of Completed or Past Due are displayed.
Plans List
Note: Development plans in a status of Deleted are not displayed on the Development Plans page 
The following information is displayed for each plan in the Development Plans list:
· Plan Title - Users can select the plan title to view the details of the development plan. See Manage/View Development Plan (Redesign).
· Status
· Date Created
· Due Date
· Primary Plan - The Primary Plan label appears below the Due Date value for the development plan that is designated as the user's primary plan. Users can designate their primary plan using the Actions drop-down menu to the right of the appropriate plan.
· Percentage Complete - This displays the completion percentage for the development plan. 
Plan Actions
Note: Actions are only available for In Progress development plans. 
The following plan actions may be available from the actions drop-down menu [image: ] to the right of the plan:
· View - Select this option to view the Development Plan Details page for the selected development plan. See Manage/View Development Plan (Redesign).
· Edit - Select this option to edit the development plan. This action is only available to users when viewing their own Development Plans page. This action is not available when viewing another user's Development Plans page. See Create/Edit Development Plan (Redesign).
If editing a completed plan that requires approval, then editing a plan in Completed status puts the plan in Pending Acceptance Approval or Pending Completion Approval status. The ability to edit a Completed development plan is controlled within Development Plan Preferences. See Development Plan Preferences (Redesign).
· Cancel - Select this option to cancel the development plan. A confirmation pop-up appears when this option is selected. This action is only available when viewing your own Development Plans page. You can cancel any of your development plans, even your primary plan. This action is not available when viewing another user's Development Plans page.
· Delete - Select this option to delete the draft development plan. This option is only available for draft development plans. A confirmation pop-up appears when this option is selected.
· Export to PDF - Select this option to export the selected development plan as a PDF. This action is only available to users when viewing their own Development Plans page. This action is not available when viewing another user's Development Plans page.
· Designate as Primary Plan - Select this option to designate the plan as the primary plan.
[bookmark: _Toc161994684]Snapshot - Documents
[bookmark: concept149]Folder Preferences
The Folder Preferences page enables administrators to create, edit, and remove the document folders that appear on the Snapshot Documents page. Administrators can also customize the availability and visibility of each folder within Snapshot Documents. This enables administrators to determine for which users a folder is available on their Snapshot Documents page and which users have access to the folder for a specific set of users.
To access the Folder Preferences page, go to Admin > Tools > Core Functions > Universal Profile > Folders.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Snapshot Folder Preferences - Manage
	Enables administrator to view the Folder Preferences Admin page and manage folder creation, access, and deletion for the Documents page within Universal Profile: Snapshot. This permission cannot be constrained. This is an administrator permission.
	Universal Profile
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Create Folder
To create a folder that may be available on the Snapshot Documents page, click the Create Folder button. See Folder Preferences - Create/Edit Folder on page 226 for additional information.
Folders Table
The Folders table displays all active and inactive folders that have been configured by the administrator. Folders are displayed in alphabetical order. The following information is displayed for each folder:
· Name - This displays the folder name. The folder title may appear on the Snapshot Documents page when the folder is active. 
· Active - This displays whether the folder is active. When active, the folder may be available to users on the Snapshot Documents page. When the folder is inactive, it is never available to users on the Snapshot Documents page.
· Options - The following options are available in the Options column:
· Edit - See the Edit Folder section below for additional information.
· Delete - See the Delete Folder section below for additional information.
Edit Folder
To edit a folder, click the Options drop-down menu, and select Edit. See Folder Preferences - Create/Edit Folder on page 226 for additional information.
Delete Folder
To delete a folder, click the Options drop-down menu, and select Delete. This opens a confirmation pop-up which informs the administrator that deleting the folder also deletes any documents users have uploaded to this folder on the Documents page. Click Yes to delete the folder, or click No to cancel the delete action.
[image: ]
Back
Click Back to return to the Universal Profile Preferences page.
[bookmark: _Ref612643724][bookmark: concept150]Folder Preferences - Create/Edit Folder
The Snapshot Documents page enables users and managers to upload and store documents. For example, a user can store project documents in their own Snapshot Documents page. Also, managers can store performance or compliance documents for a subordinate within the subordinate's Snapshot Documents page within Universal Profile. When enabled, users can access the Snapshot Documents page by clicking the Documents widget on the Universal Profile Snapshot page.
The Folder Preferences page enables administrators to create, edit, and remove the document folders that appear on the Snapshot Documents page. Administrators can also customize the availability and visibility of each folder within Snapshot Documents. This enables administrators to determine for which users a folder is available on their Snapshot Documents page and which users have access to the folder for a specific set of users.
To create a Snapshot Documents Folder, go to Admin > Tools > Core Functions > Universal Profile > Folders. Then, click the Create Folder button.
To edit a Snapshot Documents folder, go to Admin > Tools > Core Functions > Universal Profile > Folders. Then, select Edit from the Options drop-down [image: ] for the appropriate folder.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Snapshot Folder Preferences - Manage
	Enables administrator to view the Folder Preferences Admin page and manage folder creation, access, and deletion for the Documents page within Universal Profile: Snapshot. This permission cannot be constrained. This is an administrator permission.
	Universal Profile
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Enter the following information for the new folder:
· Folder Title - Enter the folder title up to 1,000 characters. This is required. The folder title may appear on the Snapshot Documents page when the folder is active.  If multiple languages are enabled for your portal, select the Translate icon to translate the field into other available languages. 
· Active - Select this option to make the folder active. When active, the folder may be available to users on the Snapshot Documents page. When the folder is inactive, it is never available to users on the Snapshot Documents page.
Folder Preferences
This section enables administrators to configure which users have the folder on their Snapshot Documents page within Universal Profile and which users can access the folder. Administrators can also configure what level of access the selected users have for the folder.
Folder Preferences Sections
Folder Preferences for a folder can be configured using multiple segments, which enables administrators to configure different visibility settings and different levels of access depending on whose folder is being accessed. For example, if you are creating a Performance Review folder that is enabled for all sales representatives, then this folder may be owned by the Performance Manager role. However, if you are creating a Performance Review folder that is enabled for the Executive team, then this folder may be owned only by the CEO since the data may be more sensitive.
Sections can be expanded or collapsed by clicking the section's arrow icon. This enables administrators to manage how much information is displayed on the page.
Add Section
To add an additional Folder Preferences section, click the Add Section button. A new section is added to the bottom of the page. 
When a new section is added, the section header displays "New Criteria." Once the page is saved, the section header displays the section's availability settings. Displaying a relevant section header enables administrators to quickly identify a section when editing the section.
Remove Section
To remove a Folder Preferences section, click the Remove icon [image: ] in the upper-right corner of the section. A confirmation pop-up opens to confirm the section removal.
Removing a section removes all availability and visibility within the section. Users who are affected by the change in availability and visibility will notice the change as soon as the folder is saved. When availability and visibility are removed, the documents that are stored within the folder are not affected.
Availability
The Availability settings determine for which users the folder is available on their Snapshot Documents page within Universal Profile. If a folder is available for a user, this does not mean that the folder is visible to the user. The ability to view and upload documents to the folder is configured in the Visibility settings.
The Availability settings determine for which users the folder is available on their Snapshot Documents page within Universal Profile. If a folder is available for an organizational unit (OU), this means that documents can be stored on the Snapshot Documents page of users within the selected OU. Availability, in this instance, does not dictate who can access the folder; the ability to access the folder, for the set of users defined in the Availability section, is defined in the Visibility section. For more clarity, see the Use Case section below.
To add users to the folder's availability, select the appropriate option from the drop-down menu. Then, click the Select icon [image: ] to select the appropriate organizational unit (OU), group, or user. Alternatively, administrators can also enter the OU, group, or user name in the field.
Select the Include Subordinates option to include any subordinate OUs, groups, or users in the availability.
To remove a selection from the Availability section, click the Remove icon [image: ] to the left of the selection.
Visibility
The Visibility settings determine which users have access to the folder for the set of users who are selected in the Availability section. These settings also determine what level of access the selected users have for the folder. Note: The visibility settings are always enforced, even if a link to a folder or document is shared with another user. 
Visibility can be configured by employee relationship (e.g., Manager, Indirect Manager, Subordinates) or OU criteria (i.e., OU, group, or user). From the drop-down menu, select whether you are selecting an employee relationship or an OU, group, or user.
· When selecting an employee relationship, click the Select icon [image: ] to select the appropriate relationship. Alternatively, administrators can also enter the relationship name in the field.
· When selecting an OU, group, or user, select the appropriate option from the drop-down menu. Then, click the Select icon [image: ] to select the appropriate OU, group, or user. Alternatively, administrators can also enter the OU, group, or user name in the field.
Select the Include Subordinates option to include any subordinate OUs, groups, or users in the visibility.
In the Action Group column, select which level of access the selected OU, group, or user should have for the folder. The following options are available:
· Viewer - Users in this group can view all files within the folder.
· Contributor - Users in this group can view all files within the folder, upload files to the folder, and remove any files that they have uploaded to the folder.
· Owner - Users in this group can view all files within the folder, upload files to the folder, and remove any files within the folder. Note: Forms saved in folders cannot be deleted by the folder owner.
To remove a selection from the Visibility section, click the Remove icon [image: ] to the left of the selection.
Availability and Visibility Use Case
1. A folder is created for storing PDF performance reviews. All users participate in performance reviews, and only an employee's manager and HR should be able to access this content.
2. The Availability can be set to All Employees.
3. The HR Manager employee relationship is added to the Visibility as an Owner so that the HR managers can upload and delete performance review documents.
4. The Manager employee relationship is added to the Visibility as a Contributor so that managers can upload performance review documents and delete any documents that they have uploaded.
Save/Cancel
Click Save to save the folder configuration, or click Cancel to discard any unsaved changes to the folder.
When a new section is added, the section header displays "New Criteria." Once the page is saved, the section header displays the section's availability settings. Displaying a relevant section header enables administrators to quickly identify a section when editing the section.
[bookmark: _Ref871762506]Snapshot - Documents
The Documents page enables users, managers, and administrators to attach and view files that supplement the user's profile. The availability of certain functionality is determined by the user's permissions.
To access the Documents page, click the Documents widget on the Universal Profile - Snapshot page.
Note: The folders that display on the Documents page are created by the administrator in Documents Preferences. In addition, the Documents widget only displays if enabled in Snapshot General Preferences. Additionally, based on the folders created by the administrator, documents such as offer letters and resumes may be automatically uploaded. 
The availability of this functionality is controlled by backend settings.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Snapshot Documents - View
	Grants ability to view the Documents widget and subpage within the Universal Profile - Snapshot page. This permission can be constrained by Employee Relationship, OU, User's OU, User's Self and Subordinates, User, User's Self, User's Manager, User's Superiors, User's Subordinates, and User's Direct Reports. This is an end user permission.
	Universal Profile



	Snapshot Main - View
	Enables user to view the Snapshot page for users within their permission constraints. This permission can be constrained by Employee Relationship, OU, User's OU, User Self and Subordinates, User, User's Self, User's Manager, User's Superiors, User's Subordinates, and User's Direct Reports. Best Practice: For most users, this permission should be constrained by User Self and Subordinates.
	Universal Profile
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View Team
The View Team flyout allows managers, approvers, and custom relationships to quickly navigate between subordinates' profiles and transcripts. When enabled, the View Team flyout is available to managers and dotted line managers on all pages of their Universal Profile and the Universal Profile of their subordinates. This flyout displays the manager's reports visually.
The View Team button displays if enabled in the portal. Administrators may enable or disable this flyout via the My Team Dropdown section within Universal Profile General Preferences. See Universal Profile General Preferences on page 2 for additional information.
See Universal Profile - View Team Flyout on page 648 for additional information.
Search Documents and Folders
To search for a document or folder, enter the document or folder title in the Search field, and either press the [Enter] key or click the magnifying glass icon [image: ]. Matching folders are displayed before documents, and the newest folders and documents are displayed first. Note: If multiple languages are enabled for the portal, then a folder is only included in the search results if the folder title matches the search query for the user's configured language. The folder is also included if a non-default translation matches the search query and a translation is not defined for the user's configured language.
To clear a search and display all available folders, delete the text within the Search field, and either press the [Enter] key or click the magnifying glass icon [image: ].
To open a folder to view the Folder Details page, click the folder title.
The following actions may be available in the Actions drop-down [image: ] for documents in the search results:
· Open - Select this option to open the document. This action can also be performed by clicking the document title.
· Delete - Select this option to delete the document. This option is only available if the user has permission to delete documents and is either an Owner or a Contributor for the folder in which the document exists.
· If a user is designated as a Contributor for the document's folder, then the user can only delete the document if they added the document to the folder.
· Note: Only uploaded documents can be deleted. Forms cannot be deleted.
For additional information on the Search functionality, see the Search Results Example section below.
Documents
The Snapshot - Documents page displays all of the administrator-defined folders that are configured to be visible to the user who is viewing the page. Folders are displayed in alphabetical order.
For each folder, the folder title and the number of files within the folder are displayed.
Depending on the configuration of the folder, users, managers, and administrators with the appropriate permissions may be able to add, view, and delete documents from the Folder Details page. To open a folder to view the Folder Details page, click the folder title. See Snapshot - Documents - Folder Details on page 344 for additional information.
Search Results Example
A user with a configured language of English (US) enters "pro" in the Search field and presses [Enter]. 
The following results are displayed:
· “Project Management” folder - Default translation is English (US), and no other translations are defined.
· “My Projects” folder - Default translation is English (US), and Spanish (Latin America) and French (France) translations are defined.
· “Program Management” folder - An English (US) translation is defined for the folder, and the default language is French (France).
· “Vision du produit” - The default translation is French (France), and no English (US) translation is defined.
The following results are not returned:
· “Software Engineer” folder - The English (US) translation does not match the search criteria. The default translation (“Programador”) matches the search criteria, but it is Spanish, which is not the user's configured language.
[bookmark: _Ref1526503279]Snapshot - Documents - Folder Details
The Documents - Folder Details page enables users, managers, and administrators to attach, view, and delete files that supplement the user's profile. The availability of functionality is determined by the user's permissions.
To access the Folder Details page, click the Documents widget on the Universal Profile - Snapshot page. Then, click a folder title.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Bio About - View
	Enables user to view the Bio page for users within their permission constraints. This permission must be enabled to view the Transcript page within Universal Profile. If a user does not have this permission and they click a person's name or user photo within the Universal Profile, then the Bio page will not open.
On the Learner Home page, this permission also allows end users to view the Completions & Hours field, the training sidebar, and the Continue Learning carousel. 
This permission can be constrained by Employee Relationship, OU, User's OU, User's Direct Reports, User Self and Subordinates, and User. Note: For security purposes, this permission is constrained to User Self and Subordinates by default. However, the permission constraints can be modified to allow users to view the Bio About page for other users.
	Universal Profile



	Documents - Delete
	Enables user to delete a file that has been uploaded to the Snapshot - Documents page. The constraints on this permission determine which documents the user can delete. This permission can be constrained by Employee Relationship, OU, User's OU, User Self and Subordinates, Self and Direct Reports, User's Self, User's Manager, User's Superiors, User's Subordinates, and User's Direct Reports.
	Universal Profile



	Snapshot Documents - View
	Grants ability to view the Documents widget and subpage within the Universal Profile - Snapshot page. This permission can be constrained by Employee Relationship, OU, User's OU, User's Self and Subordinates, User, User's Self, User's Manager, User's Superiors, User's Subordinates, and User's Direct Reports. This is an end user permission.
	Universal Profile



	Snapshot Main - View
	Enables user to view the Snapshot page for users within their permission constraints. This permission can be constrained by Employee Relationship, OU, User's OU, User Self and Subordinates, User, User's Self, User's Manager, User's Superiors, User's Subordinates, and User's Direct Reports. Best Practice: For most users, this permission should be constrained by User Self and Subordinates.
	Universal Profile
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The Folder Details page displays all of the documents that have been uploaded to the folder. The documents are displayed in alphabetical order.
Note: Based on the folders created by the administrator and added here, documents such as offer letters and resumes may be automatically uploaded. 
The following information is displayed for each document:
· Document Type Icon - The icon to the left of the document title displays the document type (e.g., PDF, DOC).
· Document Title - The document title is displayed to the right of the document type icon. Users can click the document title to download the file.
· Upload Date - This displays the date on which the document was uploaded.
· Uploaded By - This displays the name of the user who uploaded the document.
· Attachments - When a user completes a form and adds one or more attachments to a User Attachment field within the form, then the number of files attached to the form is displayed.
· Effective Date - If a completed form has effective dating enabled, then the completed form's effective date is displayed. If the completed effective dated form is opened, the form's effective date is displayed at the top of the form.
· Actions - The following actions may be available in the Actions drop-down [image: ] to the right of the document information:
· Open - Select this option to open the document. This action can also be performed by clicking the document title.
· Delete - Select this option to delete the document. This option is only available to users with the appropriate permissions. See the Delete File section for additional information.
Note: For form documents that are e-signed, the form cannot be deleted.
View Team
The View Team flyout allows managers, approvers, and custom relationships to quickly navigate between subordinates' profiles and transcripts. When enabled, the View Team flyout is available to managers and dotted line managers on all pages of their Universal Profile and the Universal Profile of their subordinates. This flyout displays the manager's reports visually.
The View Team button displays if enabled in the portal. Administrators may enable or disable this flyout via the My Team Dropdown section within Universal Profile General Preferences. See Universal Profile General Preferences on page 2 for additional information.
See Universal Profile - View Team Flyout on page 648 for additional information.
Add File
To add a file to the folder, click the Add File button in the upper-right corner of the document list. This button is only available for users who are designated as Contributors or Owners for the folder. This button is not available for users who are designated as Viewers for the folder.
You can add a file by dragging and dropping a file into the Select a File area. You can also attach a file by clicking the Select a file button and select a file from your computer. Note: The drag-and-drop functionality is not supported by Internet Explorer browsers.
After a file is selected, the progress bar displays as the file is uploaded. After the file has loaded, the file appears below the Select a File box. See the File Restrictions section for additional information.
After the file has loaded, click Add to add the files, or click Cancel to cancel the add action.
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Open File
A file can be opened in the following manners:
· Click the document title.
· From the Actions drop-down [image: ] to the right of the document information, click the Open option.
Note: When viewing a form that contains encrypted fields, the data entered in the encrypted short text box fields is encrypted and displays as *****. For the user who completed the form and any other user who can access the form, the original data entered in the field is not visible and is encrypted. Even if the form is returned to the user for approval, the data that was originally entered into the field is encrypted. In addition, the field is only visible on the form if the user is within the availability criteria defined for the custom field in Custom Field Administration and the field is active in Custom Field Administration.
Forms with Approval Workflows
When a user submits a form that requires approval, the user can view the form's approval status by opening the submitted form from their Universal Profile > Snapshot Documents folder. The top of the form will display one of the following approval statuses:
· Approved - This status indicates that the submitted form has been approved. The form is now considered completed. A form that requires approval is not considered completed until the form is approved or denied.
· Denied - This status indicates that the submitted form has been denied. The approver may have included comments to explain why the form was denied. When a form is denied, the user cannot make changes to the form and resubmit it for approval. A form that requires approval is not considered completed until the form is approved or denied.
· Denied and Returned - This status indicates that the submitted form has been denied and returned to the user. The user can access the returned form from the Universal Profile > Actions tab, where they can make changes to the form and resubmit it for approval. See Form - Approve or Deny on page 103 for additional information.
· Pending Approval - This status indicates that the submitted form is pending action from the approver to approve, deny, or deny and return the form.
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Print Form to PDF
A Print to PDF option displays in the options drop-down for the form. Clicking the option opens the form as a PDF. From the form, click the Print to PDF button at the bottom of the form to save it as a PDF for printing at a later time.
The questions and response options display on the PDF. If an e-signature was used, then the e-signature also displays. If the form title includes special characters, then the special characters are replaced with an underscore.
Forms are downloaded as "[Form Title]_[User Full Name].pdf".
Use Case
1. Laura onboards new hires and ensures they fill out all their new hire forms. After the forms are completed, she needs to print their forms and place them in the employee's file.
2. Laura opens the Universal Profile Snapshot Document folder for a user who has new hire forms she would like to view.
3. For forms that only required an e-signature to complete, Laura simply clicks Print to PDF in the options drop-down to save the form as a PDF to print at a later time.
4. For forms that have question responses that she would like to view, Laura opens the completed form. Then, she clicks the Print to PDF button at the bottom of the form to save it as a PDF for printing at a later time.
Delete File
To delete a file, from the Actions drop-down [image: ] to the right of the document information, click the Delete option. This opens the Delete confirmation pop-up. 
· If a user is designated as an Owner for the folder and has permission to delete documents, then the Delete option in the Actions drop-down is available for all files in the folder. Users must have the Documents - Delete permission, and they can only delete documents that were uploaded by users who are within the constraints on this permission.
· If a user is designated as a Contributor for the folder and has permission to delete documents, then the Delete option in the Actions drop-down is available for all files that the user added to the folder. The Contributor cannot delete any files that were added by another user. If multiple people are adding files to a folder, then it is possible that the user can delete some files within the folder but not others.
· If a user is designated as a Viewer for the folder and has permission to delete documents, then the Delete option is not available for any files within the folder.
Click Delete to confirm the document deletion, or click Cancel to cancel the deletion.
Note: Forms that are stored in a folder cannot be deleted.
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File Restrictions
The following file restrictions apply:
· The maximum file size is 20 MB.
· The file name cannot exceed 50 characters.
· Executable files cannot be uploaded.
· Files cannot have a hidden extension or no extension.
The following file types are allowed:
	File Type
	Extension

	Audio
	· mid
· m4a
· mp3
· wav

	Compressed
	· zip

	Data
	· xls/xlsx

	Image
	· bmp
· gif
· jpeg/jpg
· png

	Presentation
	· pps/ppsx
· ppt/pptx

	Project
	· mpp

	Recording
	· arf

	Text
	· doc/docx
· dot/dotx
· htm/html - The ability to upload htm/html files is controlled by the system administrator.  This limit is controlled by a backend setting,. Organizations may choose to disable the ability to upload HTML files because malicious HTML files may be uploaded, which is a potential security risk.
· pdf
· txt

	Vector Graphic
	· vsd

	Video
	· avi
· flv
· m4v
· mpeg/mpg
· mp4
· rm - This file type is not supported when attaching a video.
· swf - This file type is not supported when attaching a video.
· wma/wmv
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[bookmark: concept153]Snapshot - Goals
The Snapshot Goals page enables users, managers, and administrators to view a summary of the user's goals. Users can also create goals, view goal details, and update goal progress. Goals created in the Goal Planning section are visible in read only status. The availability of certain functionality is determined by the user's permissions.
In addition to your personal goals, you can access the following goals in the Universal Profile Snapshot Goals:
· Goals you are given access to because you have Snapshot Goals - View and Snapshot Goals - Manage permissions. 
· Goals where the user is manager or approver, based on how the following preferences are set up:
· Preference 1: Allow manager/approver to edit an employee’s goal
· Goal owner’s manager/approver may access the goal even if they don’t have the appropriate permissions.
· Who is the approver, based on the role selected in Preference 2.
· Preference 2: Goal creation and cancellation approval is required from <role>
Administrator Note: A preference in Corporate Preferences determines whether the goal owner/assignee's Goal Preferences and Goal Configurations are applied in Universal Profile Snapshot, Goals, and Goal Rating steps within performance reviews. Shared goals respect the goal owner's preferences and configurations.
To access the Snapshot Goals page, go to Home > Universal Profile. Click the Snapshot tab. Then, click the Goals widget.
Notes About Goal Permissions:
· If the logged in user has “Snapshot Goals – Manage” permission on the target user’s goals, the logged in user can view and manage the goals even if the "Allow other users to see and align" option is checked.
· If the logged in user has “Snapshot Goals – View” permission on the target user’s goals, and the “Allow other users to see and align” option is checked on the target User’s Goal attribute , the logged-in user can view the target User’s Goal in read only mode.
· Logged-in users can manage their own goals from the Snapshot Goals page if they have “Snapshot Goals – Manage” or “Snapshot Goals – View” permission, regardless of constraints. 
· Managers can assign the Snapshot Goals - View permission to select subordinates when they are away from the office for an extended period.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Snapshot Goals - Manage
	Enables user to manage their own goals, and others public goals, using the Goals widget and subpage within the Universal Profile - Snapshot page, for users within their permission constraints. This permission can be constrained by Employee Relationship, OU, User's OU, User Self and Subordinates, User, User's Self, User's Manager, User's Superiors, User's Subordinates, and User's Direct Reports. 
Best Practice: For most users, this permission should be constrained by User Self and Subordinates.
	Universal Profile



	Snapshot Goals - View
	Enables user to view their own goals, and others’ public goals, using the Goals widget and subpage within the Universal Profile - Snapshot page, for users within their permission constraints. This permission can be constrained by Employee Relationship, OU, User's OU, User Self and Subordinates, User, User's Self, User's Manager, User's Superiors, User's Subordinates, and User's Direct Reports.
Best Practice: For most users, this permission should be constrained by User Self and Subordinates.
Note: Managers can assign this permission to select subordinates when they are away from the office for an extended period.
	Universal Profile



	Company Goals - Create
	Grants access to create goals that appear to all users as "company goals." This permission cannot be constrained. This is an administrator permission.
	Performance - Administration



	Dashboard - View
	Grants the ability to view dashboards created by self or shared by others. User must also have permission to view the standard, custom or Reporting 2.0 reports that are included in any shared dashboards. If a user does not have permission to view a report type, the user cannot view that report type within the dashboard. This is an end user permission.
	Reports - Dashboards



	Goals - Create
	Grants ability for user to create goals for self, direct reports, and indirect reports only. Any constraint on this permission is operating as an "AND" function. This permission can be constrained by Employee Relationship, OU, User's OU, and User Self and Subordinates. This is an end user permission.
	Performance



	Goal Status Report
	Grants access to the Goal Status Report, which summarizes the status of all goals for specific users during a specified date range.
	Reports - Performance



	Goal Target Report
	Grants access to the Goal Target report, which summarizes all goal targets for specific users during a specific time period, regardless of the goal to which they belong. This report can be run on multiple users, but is always grouped by user. This permission can be constrained by OU, User's OU, User Self and Subordinates, and User.
	Reports - Performance



	Goal Tasks Summary Report
	Grants access to Goal Tasks Summary Report, which summarizes all goal tasks for specific users during a specific time period, regardless of the goal to which each task belongs. This permission can be constrained by OU, User's OU, User Self and Subordinates, and User.
	Reports - Performance



	Snapshot Goals - Manage
	Enables user to manage their own goals, and others public goals, using the Goals widget and subpage within the Universal Profile - Snapshot page, for users within their permission constraints. This permission can be constrained by Employee Relationship, OU, User's OU, User Self and Subordinates, User, User's Self, User's Manager, User's Superiors, User's Subordinates, and User's Direct Reports. 
Best Practice: For most users, this permission should be constrained by User Self and Subordinates.
	Universal Profile



	View Goals
	Grants ability to view own goals and (depending on role and settings) goals of others (manager's visible goals, direct subordinate's goals, company goals, division goals). This permission can be constrained by Employee Relationship, OU, User's OU, and User Self and Subordinates. This is an end user permission.
	Performance


 
Emails
	EMAIL NAME
	EMAIL DESCRIPTION
	ACTION TYPE



	Request Goal Approval
	This email is a batch type email that includes a notification for each situation in which a goal owner does the following:
· Creates and submits a goal for themselves when approval is required. 
· Edits and resubmits a goal that has already been approved.
· Attempts to cancel a goal that has been approved when approval is required.
This email is triggered when a user clicks the Send Approval Request button on the My Goals or Snapshot Goals page.
The email is sent to the user in the Approver role. If no approver is set or if goal approval is not required, the goal is automatically approved and no email is sent.
The email can contain a link to the Pending Goals page.
	Performance Management
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Create Goal
Click the Create button. This option is only available if you have permission to create a goal. See Goal - Create/Edit.
View Team
The View Team flyout allows managers, approvers, and custom relationships to quickly navigate between subordinates' profiles and transcripts. When enabled, the View Team flyout is available to managers and dotted line managers on all pages of their Universal Profile and the Universal Profile of their subordinates. This flyout displays the manager's reports visually.
The View Team button displays if enabled in the portal. Administrators may enable or disable this flyout via the My Team Dropdown section within Universal Profile General Preferences. See Universal Profile General Preferences on page 2 for additional information.
See Universal Profile - View Team Flyout on page 648 for additional information.
Options
The following options are available in the Options drop-down menu:
· View Hierarchy - Select this option to view the goal hierarchy, which displays the relationship of your goals to the goals of others. This option is only available if the administrator has enabled users to view goal hierarchy in Goal Preferences. See View Goals - Hierarchy.
· Download PDF - Select this option to export the goals on the page to a PDF document. This option is only available if there are goals available on the Snapshot Goals page.
· View Reports - Select this option to view the goal reports dashboard. This option is only available if the user has permission to view dashboards as well as one of the following reports: Goal Status Report, Goal Target Report, Goal Tasks Summary Report. See Goal Reports Dashboard.
Overall Goal Progress and Weight
The user's overall goal progress is displayed at the top of the page. This represents the user's total progress for all goals that are within the selected date range. The overall goal progress accounts for goal weights. 
The Total Weight represents the cumulative weight of all individual goals that are within the selected date range. 
Goals in Draft, Deleted, or Cancelled status are not included in goal progress and total weight.
Note: The Total Complete section is only displayed when Goal Progress is enabled by administrators. Total Weight is only displayed when Goal Weight is enabled by administrators. 
If Goal Progress is disabled, but Goal Weight is enabled, then the Goal Weight is displayed without the progress gauge.
Search and Filter Goals
Use the search filters to determine which goals are displayed.
Select a specific time period, then, click the Search button to update the display. All goals within the selected time frame display. The following date filters are available:
· Goal Period - From the drop-down menu, select a defined date range.
· Date Range - Using the Calendar tools, select a specific start date and end date.
Use the status filters to determine which goals are displayed. The following status filters are available:
· Display Cancelled - Display goals that are cancelled. By default, cancelled goals are not displayed.
· Hide Completed - Hide goals that are completed. By default, all active goals are displayed, including Completed goals. You can hide Completed goals so that the page only displays goals that are still in progress. This allows you to view goal progress that is not completed.
Send Approval Request
Users can now request approval for their goals from the Snapshot Goals page. Previously, this was only available on the Goals main page.
The Send Approval Request button is available in the upper-right corner of the page if you have goals that are pending approval. Click this button to send an email to your goal approver if the Request Goal Approval email is enabled. Once the request is sent, the button text is updated to "Request Sent" until the page is refreshed.
If goal approval is not required or if a goal approver is not set, then goals are automatically approved when they are created, edited, or cancelled.
Goal Summary
To view the full details for a goal, either click the goal title or the Right arrow [image: ] to the right of the goal.
To hide a goal's details, either click the goal title or the Down arrow [image: ].
Goals are listed in alphabetical order by title. The following information may be displayed for each goal:
· Progress - Goal progress as a percentage. The color of the progress bar is determined by the goal status. Users may have the option to update goal progress using a progress slider. The goal progress is automatically saved as the progress slider is moved. The goal progress slider is only available if the following is true:
· Administrators have enabled goal progress. If goal progress is not displayed, then users are not able to update goal progress.
· Administrators prevented goal progress from exceeding 100%. If goal progress is allowed to exceed 100%, then goal progress is updated via a Progress field above the Description field.
· The goal does not contain tasks or targets. If the goal contains tasks or targets, then goal progress is updated by updating the progress of the task or target.
· The goal is not in Draft status.
· Title - Name of the goal. If the goal is a shared goal, an asterisk appears before the title. 
· Status - Overall standing of the goal. This can be determined by goal, task, and target progress and can also factor in the amount of time remaining for completion. The status is also reflected in the progress color. For example, if a user has satisfied a goal, the status is Completed and the progress bar may be blue. The names, colors, and the criteria for each status can be modified by the system administrator.
· Target Date - Date the goal is due. 
· Perspective - Which aspect of the company the goal relates.
· Weight - Prioritizes goals and places additional value on certain goals.
· Aligned To - Owner of the goal to which the direct report's goal is aligned. Only displays if the goal is aligned to another goal.
· Owner - For shared goals, this displays the name of the goal owner.
Goals created in the Goal Planning section of a performance review are visible in read-only status. 
· Owner - For shared goals, this displays the name of the goal owner.
Note: Perspective, Weight, Status, and Progress can be disabled by the system administrator. If they are disabled, the fields will not appear. For all fields except the Weight field, the field name is configurable by the administrator. As a result, fields may be named differently in your portal. Further, some fields can be configured to not display.
Lock Goal Results
The ability to lock a goal is only available when viewing the Snapshot Goals page as a manager for a direct report or as an administrator.
Based on the configuration of the portal, a Lock icon may appear to the right of a direct report's goal. Managers can click this icon to lock or unlock the goal. The following statuses are available:
· Locked [image: ] - The goal is locked. Click this icon to unlock the goal. Users cannot update the goal progress or edit the goal. Managers may lock a goal at the end of the goal period or at the beginning of a review period. This prevents any miscommunication between the manager and employee. Note: This does not prevent users from advancing the goal. 
· Unlocked [image: ] - The goal is unlocked. Click this icon to lock the goal. Users can update the goal progress and edit the goal. 
Administrative Note: To disable the Lock Goal Results functionality, contact Global Customer Support.
Manage Goal
To update goal progress, add comments or attachments, or view goal details, click the goal title or click the right arrow [image: ] to the right of the goal. A details drop-down opens. See Goal - Manage.
You are only able to manage goals for which you have Snapshot Goals - View and Snapshot Goals - Manage permissions. Clicking the title of a shared goal opens a read-only version of the goal. Note: Only users with permission to create company goals can update the progress of a company goal and add attachments to a company goal.
There is no limit to the number of comments that can be added to a goal.
Goal Actions
The following actions may be available from the Options drop-down menu [image: ] to the right of the goal:
· Edit - Select this option to edit the goal. This option is only available if enabled by the system administrator and the goal is not locked. See Goal - Create/Edit.
· Shared goals cannot be edited by anyone other than the goal owner. 
· Copy - Select this option to copy the goal. All of the goal details are copied to the new goal except for the Assignment, Alignment, Attachments, and Comments. Also, the Start Date and End Date are set to the default values. This option is only available if you have permission to create goals and the goal is not expired. Also, this option is not available if goals are locked. See Goal - Create/Edit.
· Cancel - Select this option to cancel the goal. A confirmation pop-up opens to confirm the cancellation. This option is only available if enabled by the system administrator. Also, this option is only available for unlocked, non-draft goals.
· If cancellation approval is not required, then the goal's status becomes Canceled.
· If cancellation approval is required, then the goal's status becomes Pending Cancellation Approval, and the Request Goal Approval email is triggered if it is enabled.
· Shared goals cannot be canceled by anyone other than the goal owner.
· Advance - Select this option for an expired goal to copy the details of the goal and set the Start Date and End Date to the next goal period. The goal progress is reset for the new goal. For example, if the expired goal had a start and end date of 01/01/15-12/31/15, once you advance the goal, the new start and end date will be 01/01/16-12/31/16 and the goal progress is set to zero. This action is intended to help save time creating goals for the new goal period if they are similar to the previous period. This option is only available if you have permission to create goals and the goal is expired. Note: This option is not available if goals are locked at the portal level in Corporate Preferences. 
· View History - View the history of the goal. The name of the user who updated the goal is included with the type of update and the date and time of the update. Also shows the modification history for goals created in a goal planning task. See View Goals - History.
· Approve - Users with appropriate permissions can select this option to approve this goal. A confirmation pop-up appears.
· Deny - Users with appropriate permissions can select this option to deny this goal. A confirmation pop-up appears. 
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Snapshot - Leaderboard
A user may receive points for completing training. Also, a user may be awarded a badge by completing training or receiving positive feedback from another user. When a user receives a badge, they are also awarded any points that are associated with the badge.
The Leaderboard page enables users to view their total number of points, their overall points ranking within their organizational unit, and the top 10 users who have the most points. Note: Total number of points is calculated by adding their training points (points earned from completing trainings) and their badge points (both learning badges and feedback badges).
If multiple users have the same number of points, then they are ranked alphabetically by first name. Also, if the user is not in the top 10 ranking, then the user is displayed at the bottom of the page with the user who ranks above them and the user who ranks below them.
This page can be filtered by organizational unit (OU) and by time frame.
To access the Leaderboard page, click the Leaderboard widget on the Universal Profile - Snapshot page.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Snapshot - Leaderboard
	Enables user to view the Leaderboard widget and subpage within the Universal Profile - Snapshot page for users within their permission constraints. This permission works in conjunction with the Snapshot Main - View permission. This permission can be constrained by OU, User's OU, User Self and Subordinates, User, User's Self, User's Manager, User's Superiors, User's Subordinates, User's Direct Reports, and Employee Relationship. Any user with this permission will always be able to view their own Leaderboard widget when the widget is enabled. Best Practice: For most users, this permission should be constrained by User Self and Subordinates.
	Universal Profile



	Snapshot Main - View
	Enables user to view the Snapshot page for users within their permission constraints. This permission can be constrained by Employee Relationship, OU, User's OU, User Self and Subordinates, User, User's Self, User's Manager, User's Superiors, User's Subordinates, and User's Direct Reports. Best Practice: For most users, this permission should be constrained by User Self and Subordinates.
	Universal Profile
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View Team
The View Team flyout allows managers, approvers, and custom relationships to quickly navigate between subordinates' profiles and transcripts. When enabled, the View Team flyout is available to managers and dotted line managers on all pages of their Universal Profile and the Universal Profile of their subordinates. This flyout displays the manager's reports visually.
The View Team button displays if enabled in the portal. Administrators may enable or disable this flyout via the My Team Dropdown section within Universal Profile General Preferences. See Universal Profile General Preferences on page 2 for additional information.
See Universal Profile - View Team Flyout on page 648 for additional information.
Filter by User's OUs
By default, the Leaderboard includes all users within the user's division. However, the user can also filter the Leaderboard by their Position, Location, or custom OU type. This enables the user to see how they rank within each of these OUs. Note: Only the user's OUs are available in the drop-down. The user cannot select an OU to which they do not belong. Also, the administrator can configure which filter options are available within Badge & Points Preferences. See Badge & Point Preferences - Points.
To filter the Leaderboard by a particular OU, select the appropriate OU type from the drop-down menu.
Filter by Time
By default, the Leaderboard includes points that have been awarded within the calendar month. For example, on April 15, this only includes points that have been awarded from April 1 through April 15. However, the user can filter the Leaderboard by calendar year or include all historical points. This enables the user to see how they rank over different periods of time. Note: The time filter follows UTC (Coordinated Universal Time).
To filter the Leaderboard by a particular time frame, select the appropriate option from the drop-down menu.
Overall Points and Rank
In the upper-right corner of the page, the user's total number of points and their overall ranking is displayed based on the selected time and OU filter.
Top 10 Ranking
The top 10 users who have the most amount of points are displayed based on the selected time and OU filter. Also, the top three users are displayed more prominently at the top of the list. If multiple users have the same number of points, then they are ranked alphabetically by first name. 
The user whose Snapshot is being viewed is always displayed in the Leaderboard. If the user is not in the top 10 ranking, then the user is displayed below the top 10 with the user who ranks above them and the user who ranks below them.
Users can click another user's photo or name within the Leaderboard to view the user's Universal Profile: Bio page.
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[bookmark: concept155]The Reviews page enables users, managers, and administrators to view a summary of the user's performance reviews. The availability of certain functionality is determined by the user's permissions.
To access the Snapshot: Reviews page, go to Home > Universal Profile. Select the Snapshot tab. Then, select the Reviews widget.
Permissions
The availability of this functionality is controlled by backend settings.
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Snapshot - Reviews
	Enables user to view the Reviews widget and subpage within the Universal Profile - Snapshot page for users within their permission constraints. This permission can be constrained by OU, User's OU, User Self and Subordinates, User, User's Self, User's Manager, User's Superiors, User's Subordinates, User's Direct Reports, and Employee Relationship. Best Practice: For most users, this permission should be constrained by User Self and Subordinates.
	Universal Profile



	Launch Off-Cycle Performance Review Task
	Enables a user to launch an off-cycle performance review task. Having this permission does not guarantee that the user can launch an off-cycle review, only that they will have access to the Launch Performance Review page. A task must still be configured properly for the user to successfully launch an off-cycle review task. This permission works only if user has been designated to launch at least one currently active off-cycle performance review task. This permission can be constrained by OU, User's Subordinates, and Employee Relationship. This is an end user permission and does not apply to an administrator role.
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View Team
The View Team flyout allows managers, approvers, and custom relationships to quickly navigate between subordinates' profiles and transcripts. When enabled, the View Team flyout is available to managers and dotted line managers on all pages of their Universal Profile and the Universal Profile of their subordinates. This flyout displays the manager's reports visually.
The View Team button displays if enabled in the portal. Administrators may enable or disable this flyout via the My Team Dropdown section within Universal Profile General Preferences. See Universal Profile General Preferences on page 2 for additional information.
See Universal Profile - View Team Flyout on page 648 for additional information.
Options
The following options are available in the Options drop-down menu:
· Launch Review - Select this option to launch an off-cycle performance review for the user whose Universal Profile page you are viewing. This option is only available if you have permission to launch off-cycle reviews, and an off-cycle review is available for the user. See Universal Profile - Options - Launch Review on page 676 for additional information.
Sort By
The table of reviews can be sorted using the following sorting options within the Sort By drop-down menu at the top of the Reviews section:
· Due Date - Select this option to sort the reviews in chronological order by due date, with the incomplete review with the soonest due date displayed first. 
· All incomplete reviews are displayed before all completed reviews.
· Completed reviews are listed after incomplete reviews, with the most recently completed review displayed first.
· Reviews with the same due date are then sorted alphabetically.
· Completion Date - Select this option to sort the reviews in chronological order by completion date, with the most recently completed review displayed first. Reviews with a completion date of "N/A" are displayed first. Reviews with a due date are listed after completed reviews, with the review with the soonest due date displayed first. Reviews with the same completion date are then sorted alphabetically.
· Start Date - Select this option to sort the reviews in chronological order by start date, with the reviews with the most recent start date displayed first. Reviews with the same start date are then sorted alphabetically.
· Status - Select this option to sort the reviews by status. Reviews with the same status are then sorted alphabetically. Reviews are sorted in the following status order:
· Not Started
· In Progress
· Completed
· Expired
· Incomplete
Display completed tasks
This option is selected by default. This ensures that users see historical performance review information as soon as they navigate to the page.
When this option is selected, the page includes reviews with a status of Completed. When this option is unselected, reviews with a status of Completed are hidden.
Reviews List
Note: A review task is only displayed on the Reviews page if it is visible to the reviewee. Administrators can configure whether a review task is visible to the reviewee when creating the performance review task. Administrators cannot hide a performance review task from a reviewee if the user is assigned a review step for the performance review. 
The following information is displayed for each review in the Performance Reviews list:
· Review Title - Users can select the review title to launch the review. See Performance Review - Overview.
· Status - The current status of the review.
· Review Period - The dates for the review period.
· Start Date - The review start date.
· Due Date - The review end date.
· Completion Date - This is visible only if the review has been completed.
· Rating - If the review is complete and a numeric rating has been configured to display for the review, then the value is displayed to the right of the review details. Note: The visibility of the rating is determined by the administrator when creating the performance review task.
Review Actions
The following review actions may be available from the actions drop-down menu [image: ] to the right of the review:
· Launch Review - Select this option to launch the review. The review opens to the step that is assigned to the user who is performing the action. Note: This option is not available for completed performance reviews. See Performance Review - Overview.
· Print Review - Select this option to download a PDF of the reviewee version of the review.
· Print Review - Manager Version - Select this option to download a PDF of all sections of the performance review, including all submitted responses. Note: This option is only available when viewing a subordinate's Snapshot.
· Print Review - Reviewee Version - Select this option to download a PDF of only the sections that are visible to the reviewee. Note: This option is only available when viewing a subordinate's Snapshot.
· Attachments - Select this option to view the attachments for the review. This opens the Attachments pop-up, in which users can select an attachment to view it. This option is only available if attachments are enabled for the performance review task and if the performance review has at least one attachment.
· Work Offline - Select this option to download the review to Excel. This enables the user to complete the review offline. See Complete/Upload Offline Review Task.
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[bookmark: concept156]Snapshot Succession Preferences
Use the Snapshot Succession Preferences page to set the preferences for the My Team > Succession page and the Universal Profile > Snapshot > Succession page.
To access Snapshot Succession Preferences, go to Admin > Tools > Core Functions > Universal Profile > Snapshot Succession.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Succession Management Preferences
	Enables administrators to view and edit the Snapshot Succession Preferences page. This permission can be constrained by OU and User's OU. This is an administrator permission.
	Talent/Succession - Administration
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Sections
Set the preferences for the following sections:
· Succession - See Snapshot Succession Preferences - Succession on page 371 for additional information.
· Successor and User Succession Sections - See Snapshot Succession Preferences - Successor and User Succession Sections on page 375 for additional information.
· Successor and User Succession Information - See Snapshot Succession Preferences - Successor and User Succession Information on page 373 for additional information.
· Color Code - See Snapshot Succession Preferences - Color Code on page 370 for additional information.
Overwrite Settings
Select this option to overwrite custom settings for child division OUs. If you overwrite custom settings for child division OUs, the selected settings are applied to both new and existing child OUs. Any previously customized child OUs are updated with the selected settings.
· If there are no customizations to the child OU, then the parent OU customizations are applied to all child OUs.
· Overwrite custom settings checkbox setting
· If this option is selected, all child OU customizations are deleted from the database, which means the parent OU customizations will be applied to new and existing child OUs.
· If this option is unselected, all existing child OU customizations will remain unchanged, and any new child OUs will inherit the parent OU customizations by default.
· If a child OU has been customized to display any widgets, then regardless of the parent OU customizations, the child OU customizations are applied.
· If a child OU has been customized to hide all widgets, then parent OU customizations will take precedence and will be applied.
Submit
After selecting the appropriate preferences, click Submit.
[bookmark: _Ref-1300339399]Snapshot Succession Preferences - Color Code
Use the Color Code section of the Snapshot Succession Preferences page to define which rating scale metric is used to color code potential successors in My Team and Snapshot. Potential successors are colored based upon the rating scale metric rating. 
Changes to this panel apply to both My Team > Succession and Snapshot > Succession. This section applies to user and position successors. 
To access Snapshot Succession Preferences, go to Admin > Tools > Core Functions > Universal Profile > Snapshot Succession.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Succession Management Preferences
	Enables administrators to view and edit the Snapshot Succession Preferences page. This permission can be constrained by OU and User's OU. This is an administrator permission.
	Talent/Succession - Administration
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Successors
From the Successors drop-down list, select the rating scale metric that should be used to color code potential successors. When a rating scale metric is selected, administrators can click the Preview icon to the right of the drop-down list to view a preview of the corresponding color code.
[bookmark: _Ref-806023598][bookmark: _Ref-1647888482]Snapshot Succession Preferences - Succession
Use the Succession section of the Snapshot Succession Preferences page to configure which fields are available on the My Team: Succession and Snapshot: Succession pages.
To access Snapshot Succession Preferences, go to Admin > Tools > Core Functions > Universal Profile > Snapshot Succession.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Succession Management Preferences
	Enables administrators to view and edit the Snapshot Succession Preferences page. This permission can be constrained by OU and User's OU. This is an administrator permission.
	Talent/Succession - Administration
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Add Field
Click the plus icon to the right of the Succession heading to add an SMP metric field, short text box succession custom field, or scrolling text box succession custom field to the Succession display. A list of available fields and metrics is displayed. All of the newly added metrics are added to Column 1, unless that column already has the maximum number of fields. You can add up to 10 SMP fields in each column.
Organize Fields
The administrator can reorganize the fields by dragging and dropping the fields into the desired column or position within the column.
Make Field Editable
An Editable option is available for each field. When this option is selected, manager, indirect managers, and custom relationships can update these fields in My Team and on the Snapshot: Succession page. If a field is selected as editable and the field is moved to a different column, the Editable option remains selected for the field. Note: Metric Grid Fields cannot be edited in My Team or Snapshot, so N/A appears in the Editable column for these fields.
· Within the Succession section, selected Rating Scale Metrics may be editable in My Team or Snapshot. Selected Metric Grids will appear in the grid drop-down for the Helicopter View, and selected Rating Scale Metrics are used as filters and color codes in Helicopter View.
Use Original or Calibrated Criteria
If a grid metric field is selected, the administrator has the option to use the original data from the metric or the calibrated data. This selection affects the data that is displayed to the manager. The SMP metric grid displays the name of the box in which the user is saved.
Delete Field
To delete a field, click the Remove icon to the left of the field name.
Include a link to view the succession plan for the selected user
This link points to the current succession management plan completed by that employee.
Note: This feature is unavailable for organizations that have enabled Universal Profile.
[bookmark: _Ref-263381569]Snapshot Succession Preferences - Successor and User Succession Information
Use the Successor and User Succession Information section of the Snapshot Succession Preferences page to select which User fields and SMP Metric fields display for each of the user's successors and for each incumbent and position for which the user has been named a potential successor. Only fields that are set as Read-Only will be displayed in the Succession Information - Incumbent and Succession Information - Position sections. Also, the Succession Information - Incumbent and Succession Information - Position sections are only included on the Succession Snapshot page if they are enabled in the Successor and User Succession Sections section.
· Values that are displayed in the Succession Information - Incumbent and Succession Information - Position sections are pulled from the most recently saved SMP tasks. If there is no value configured for the field in any saved SMP task, then N/A is displayed for the field.
Changes to this panel apply to both My Team > Succession and Snapshot > Succession. Any fields that are added are applied to user and position successors.
To access Snapshot Succession Preferences, go to Admin > Tools > Core Functions > Universal Profile > Snapshot Succession.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Succession Management Preferences
	Enables administrators to view and edit the Snapshot Succession Preferences page. This permission can be constrained by OU and User's OU. This is an administrator permission.
	Talent/Succession - Administration
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Add Field
Click the plus icon to the right of the Successor Information section heading to add User or SMP Metric fields.
Configure Fields Table
· Field - The type of section.
· Display Name - Enter the field name that will be displayed on the My Team > Succession and Snapshot > Succession pages.  If multiple languages are enabled for your portal, select the Translate icon to translate the field into other available languages. 
· Type - They type of field.
· Response - The response type. For metric fields, the administrator can select one of the following response options for the field:
· Read Only - The field is read-only and the user cannot enter a response for the field.
· Response Optional - The user has the option to update a successor's metric rating, but the user is not required to provide a rating.
· Response Required - The user is required to provide a rating for the metric field.
· Remove - Click the delete icon to delete the selected field. 
Reorder Fields
Fields can be reordered by dragging and dropping the fields into the desired order. Fields can be deleted from the section by clicking the Delete icon in the Remove column.
[bookmark: _Ref1997964118]Snapshot Succession Preferences - Successor and User Succession Sections
Use the Successor and User Succession Sections section of the Snapshot Succession Preferences to determine what information is displayed on the Snapshot Succession page. This section also enables administrators to configure what options are available to managers on the Snapshot Succession page.
Changes to this panel apply to both My Team > Succession and Snapshot > Succession.
To access Snapshot Succession Preferences, go to Admin > Tools > Core Functions > Universal Profile > Snapshot Succession.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Succession Management Preferences
	Enables administrators to view and edit the Snapshot Succession Preferences page. This permission can be constrained by OU and User's OU. This is an administrator permission.
	Talent/Succession - Administration
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The Successors subsection contains the following options:
· Succession Information by Incumbent - When this option is selected, a Succession Information - Incumbent section is available on the Succession Snapshot page, and this section displays all of the incumbents for which the user has been named a potential successor.
· Succession Information by Position - When this option is selected, a Succession Information - Position section is available on the Succession Snapshot page, and this section displays all of the positions for which the user has been named a potential successor. In addition, the current incumbents for the positions are also displayed.
· User Successors - List potential successors for the selected user - Select this option to display a selected employee's potential successors on the My Team > Succession and Snapshot > Succession pages.
· Position Successors - List potential successors for the selected user's position - When this option is selected, the Snapshot - Succession page displays successors for the user's current position. These successors are listed in the Successors - Position section on the Snapshot - Succession page. The Maximum Successors field determines the maximum number of successors that can be added via the Snapshot - Succession page. However, there is no limit to the number of users that can appear on the Snapshot - Succession page who are added via job pool tasks. For example, if the Maximum Successors value is set to three and three potential successors have already been identified, then additional potential successors cannot be added from the Snapshot - Succession page. However, additional potential successors can still be identified in a job pool task, and these additional potential successors will appear in the Potential Successors - Position section. 
· Maximum Successors - Enter the maximum number of successors a user can select for an employee on the My Team > Succession and Snapshot > Succession pages. The default value is three.
· Recommended Successors - Select this option to allow a user to search for recommended successors on the My Team > Succession and Snapshot > Succession pages. This option applies to user and position successors. 
· Talent Search for Successors - Select this option to allow a user to conduct a talent search for potential successors on the My Team > Succession and Snapshot > Succession pages. This option applies to user and position successors. Note: When utilizing competency ratings in Career Profile or Talent Search, competency ratings from competency assessment tasks and Competency Assessment performance review sections are available because they both use the rating scale from the competency model. However, competency ratings from Competency Rating performance review sections are not available because they use the performance review section rating scale. 
· External Successors - Select this option to allow a user to add external successors to an employee on the My Team > Succession and Snapshot > Succession pages. This option applies to user and position successors. 
· Rate External Successors - Select this option to allow a user to rate external successors on metrics included in the Succession Information subsection. This option applies to user and position successors. 
· User Search for Successors - When this option is selected, an option to add a successor using the User Search functionality is available on the My Team > Succession and Snapshot > Succession pages. This option applies to user and position successors. 
[bookmark: _Ref1843611833]Snapshot - Succession
The Succession page enables the users with the appropriate permissions to view the user's succession information. Note: The Succession page is only available to the manager of a user and administrators.
Administrators can configure the Snapshot - Succession page to display user-based potential successors, position-based potential successors, and incumbents and positions for which the user is named as a potential successor. 
· User-based potential successors appear in the Potential Successors - User section.
· Position-based potential successors appear in the Potential Successors - Position section.
· Incumbents for whom the user is named as a potential successor appear in the Succession Information - Incumbent section.
· Positions for which the user is named as a potential successor appear in the Succession Information - Position section.
Note: If any potential successor becomes Inactive in the system, then they no longer appear on the Snapshot - Succession page. 
The Snapshot > Succession page has the same functionality as the My Team > Succession page. The functionality on this page is controlled by the administrator in Succession Preferences.
To access the Succession Snapshot page, go to Home > Universal Profile. Then, click the Snapshot tab. Then, click the Succession widget.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Snapshot Succession – Manage
	Enables user to view the Succession widget and subpage within the Universal Profile - Snapshot page for users within their permission constraints. On this page, users can view and manage successors and successor ratings. Users cannot view their own Succession widget and subpage, regardless of permissions. This permission can be constrained by OU, User's Subordinates, User's Direct Subordinates, and Employee Relationship. 
	Universal Profile



	Snapshot Succession - View
	Enables user to view the Succession widget and subpage within the Universal Profile - Snapshot page for users within their permission constraints. On this page, users can view successors and successor ratings. Users cannot view their own Succession widget and subpage, regardless of permissions. This permission can be constrained by OU, User's Subordinates, User's Direct Subordinates, and Employee Relationship. For most users, this permission should be constrained by User Self and Subordinates.
	Universal Profile
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View Team
The View Team flyout allows managers, approvers, and custom relationships to quickly navigate between subordinates' profiles and transcripts. When enabled, the View Team flyout is available to managers and dotted line managers on all pages of their Universal Profile and the Universal Profile of their subordinates. This flyout displays the manager's reports visually.
The View Team button displays if enabled in the portal. Administrators may enable or disable this flyout via the My Team Dropdown section within Universal Profile General Preferences. See Universal Profile General Preferences on page 2 for additional information.
See Universal Profile - View Team Flyout on page 648 for additional information.
Add Successors
On the Snapshot - Succession page, the Add Successors drop-down menu enables users to add potential successors for the user. This drop-down menu is only available to users who have permission to manage succession information on the Snapshot - Succession page. See Snapshot - Succession - Add Successors on page 381 for additional information.
Ratings
The Ratings section displays the user's succession information and ratings. Administrators can configure the content and layout of the Ratings section in Succession Preferences. See Snapshot Succession Preferences - Succession on page 371 for additional information.
The succession ratings that are displayed are automatically updated with the results of each Succession Management Planning (SMP) task. For example, if a succession rating is updated during a SMP task, then the latest rating is displayed on the Snapshot - Succession page.
When viewing the Succession page for a user, managers may be able to edit their subordinate's succession information and ratings by clicking the Edit icon [image: ] in the Ratings section. This option is only available to users who have permission to manage succession information on the Snapshot Succession page. See Snapshot - Succession - Edit Ratings on page 392 for additional information.
Potential Successors
The Potential Successors section of the Snapshot: Succession page displays the potential successors who have been identified for the user. Managers can toggle between the Users and Position tabs within this section to view successors that are specific to the incumbent or to the incumbent's position.
· User tab - This tab displays all internal and external users who have been identified as potential successors for the user.
· Position tab - This tab displays all internal and external users who have been identified as potential successors for the user's position.
The potential successors who are displayed are automatically updated with the results of each Succession Management Planning (SMP) task. For example, if a potential successor is removed from a position during a SMP task, then the potential successor is also removed from the appropriate Snapshot - Succession pages.
See Snapshot - Succession - Potential Successors on page 383 for additional information.
Succession Information
The Potential Successor for section of the Snapshot: Succession page displays all positions and incumbents for which the user has been identified as a potential successor. Managers can toggle between the Incumbents and Position tabs within this section.
· Incumbents tab - This tab displays all users for whom the user has been identified as potential successors.
· Position tab - This tab displays all positions for which the user has been identified as a potential successor.
See Snapshot - Succession - Succession Information on page 386 for additional information.
Succession Log
This section displays the user's succession log, which is a log of succession-related comments that have been added for the user from various locations in the system. See Succession Log.
Modification History
On the Snapshot - Succession page, the Modification History section displays a log of any updates to the Succession Snapshot page. This section is only available to users with permission to manage succession on the Succession Snapshot page. See Snapshot - Succession - Modification History on page 388 for additional information.
[bookmark: _Ref-797449654][bookmark: _Ref1267312123]Snapshot - Succession - Add Successors
On the Snapshot - Succession page, the Add Successors drop-down menu enables users to add potential successors for the user. This drop-down menu is only available to users who have permission to manage succession information on the Snapshot - Succession page.
Note: Adding or removing potential successors from a position impacts the Potential Successors section for all users in the corresponding position. Also, any ratings that are applied to a position-based potential successor are applied to the Snapshot - Succession page of all users in the position.
To access the Succession Snapshot page, go to Home > Universal Profile. Then, click the Snapshot tab. Then, click the Succession widget.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Snapshot Succession - View
	Enables user to view the Succession widget and subpage within the Universal Profile - Snapshot page for users within their permission constraints. On this page, users can view successors and successor ratings. Users cannot view their own Succession widget and subpage, regardless of permissions. This permission can be constrained by OU, User's Subordinates, User's Direct Subordinates, and Employee Relationship. For most users, this permission should be constrained by User Self and Subordinates.
	Universal Profile



	Snapshot Succession – Manage
	Enables user to view the Succession widget and subpage within the Universal Profile - Snapshot page for users within their permission constraints. On this page, users can view and manage successors and successor ratings. Users cannot view their own Succession widget and subpage, regardless of permissions. This permission can be constrained by OU, User's Subordinates, User's Direct Subordinates, and Employee Relationship. 
	Universal Profile



	Succession - Successor User Search
	Grants ability to search for potential successors in a succession task or in Succession Snapshot within Universal Profile. Users who do not have this permission cannot search for potential successors. The constraints that are applied to this permission limit the users who can be searched and added as potential successors. This permission can be constrained by OU, User's OU, Subordinates, Direct Reports, User, and User Self and Subordinates. This is an end user permission.
Note: This permission is not dynamically assigned to users who are designated as a co-planner. This permission must be added to the relevant security role in order for the co-planner to search for potential successors. 
	Talent/Succession


Depending on which tab (Users or Position) is selected when successors are added, the potential successor is added to the corresponding section. For example, if the Add Successors drop-down menu is selected when the Position tab is selected, then any potential successors that are added are position-based potential successors. Similarly, if the Add Successors drop-down menu is selected when the Users tab is selected, then any potential successors that are added are user-based potential successors.
Users must have the appropriate permissions to search for a potential successor.
The following options may be available in the Add Successors drop-down menu:
· Advanced Search - Select this option to add a potential successor using the Advanced Search functionality. After a potential successor is selected, the potential successor is added to the Potential Successors section. Note: When utilizing competency ratings in Career Profile or Talent Search, competency ratings from competency assessment tasks and Competency Assessment performance review sections are available because they both use the rating scale from the competency model. However, competency ratings from Competency Rating performance review sections are not available because they use the performance review section rating scale. See SMP Task - Succession Chart Step - Recommended Successors and Advanced Search.
· Recommended Successors - Select this option to view recommended successors and use the Advanced Search to search for successors. After a potential successor is selected, the potential successor is added to the Potential Successors section. See SMP Task - Succession Chart Step - Recommended Successors and Advanced Search.
· Add External - Select this option to name an external user as a successor for the user whose Universal Profile page you are viewing. After a potential successor is selected, the potential successor is added to the Potential Successors section.
· Select User - Select this option to add a potential successor for the user whose Universal Profile page you are viewing by searching for a specific user within the system. After a potential successor is selected, the potential successor is added to the Potential Successors section.
[bookmark: _Ref-19932819]Snapshot - Succession - Potential Successors
The Potential Successors section of the Snapshot: Succession page displays the potential successors who have been identified for the user. Managers can toggle between the Users and Position tabs within this section to view successors that are specific to the incumbent or to the incumbent's position.
· User tab - This tab displays all internal and external users who have been identified as potential successors for the user.
· Position tab - This tab displays all internal and external users who have been identified as potential successors for the user's position.
The potential successors who are displayed are automatically updated with the results of each Succession Management Planning (SMP) task. For example, if a potential successor is removed from a position during a SMP task, then the potential successor is also removed from the appropriate Snapshot - Succession pages.
Note: If any potential successor becomes Inactive in the system, then they no longer appear on the Snapshot - Succession page. 
To access the Succession Snapshot page, go to Home > Universal Profile. Then, click the Snapshot tab. Then, click the Succession widget.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Snapshot Succession - View
	Enables user to view the Succession widget and subpage within the Universal Profile - Snapshot page for users within their permission constraints. On this page, users can view successors and successor ratings. Users cannot view their own Succession widget and subpage, regardless of permissions. This permission can be constrained by OU, User's Subordinates, User's Direct Subordinates, and Employee Relationship. For most users, this permission should be constrained by User Self and Subordinates.
	Universal Profile



	Snapshot Succession – Manage
	Enables user to view the Succession widget and subpage within the Universal Profile - Snapshot page for users within their permission constraints. On this page, users can view and manage successors and successor ratings. Users cannot view their own Succession widget and subpage, regardless of permissions. This permission can be constrained by OU, User's Subordinates, User's Direct Subordinates, and Employee Relationship. 
	Universal Profile
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Potential Successors - User
The User tab displays all internal and external users who have been identified as potential successors for the user.
Potential Successors - Position
The Position tab displays all internal and external users who have been identified as potential successors for the user's position.
Note: Adding or removing potential successors from a position impacts the Potential Successors section for all users in the corresponding position. Also, any ratings that are applied to a position-based potential successor are applied to the Snapshot - Succession page of all users in the position.
The administrator can configure the maximum number of successors that can be added using the Add Successors drop-down menu. However, there is no limit to the number of users that can appear in the Potential Successors - Position tab. For example, if the administrator has set the maximum number of successors for the Potential Successors - Position tab to three and three potential successors have already been identified, then additional potential successors cannot be added from the Snapshot - Succession page. However, additional potential successors can still be identified in a job pool task, and these additional potential successors will appear in the Potential Successors - Position tab. 
Successors from multiple job pool tasks can appear in this section. If a potential successor is added multiple times, the potential successor only appears in the Potential Successors - Position tab once and the most recent SMP metric rating values are applied.
Add Successors
On the Snapshot - Succession page, the Add Successors drop-down menu enables users to add potential successors for the user. This drop-down menu is only available to users who have permission to manage succession information on the Snapshot - Succession page.
Note: Adding or removing potential successors from a position impacts the Potential Successors section for all users in the corresponding position. Also, any ratings that are applied to a position-based potential successor are applied to the Snapshot - Succession page of all users in the position.
See Snapshot - Succession - Add Successors on page 381 for additional information.
Edit Successors
Managers can edit or delete their subordinate's position's potential successors by clicking the Edit icon [image: ] in the Potential Successors section. This option is only available to users who have permission to manage succession information on the Snapshot Succession page. 
See Snapshot - Succession - Edit Potential Successors on page 390 for additional information.
Potential Successor Information
The following information is displayed for each potential successor:
· User's Photograph
· User's Name
· User's Position
· Additional Successor Information - Additional information about the potential successor may be displayed, including user and SMP metric fields. Administrators can configure the information that is displayed in the Successor Information section in Succession Preferences.
[bookmark: _Ref-913359849]Snapshot - Succession - Succession Information
The Potential Successor for section of the Snapshot: Succession page displays all positions and incumbents for which the user has been identified as a potential successor. Managers can toggle between the Incumbents and Position tabs within this section.
· Incumbents tab - This tab displays all users for whom the user has been identified as potential successors.
· Position tab - This tab displays all positions for which the user has been identified as a potential successor.
To access the Succession Snapshot page, go to Home > Universal Profile. Then, click the Snapshot tab. Then, click the Succession widget.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Snapshot Succession - View
	Enables user to view the Succession widget and subpage within the Universal Profile - Snapshot page for users within their permission constraints. On this page, users can view successors and successor ratings. Users cannot view their own Succession widget and subpage, regardless of permissions. This permission can be constrained by OU, User's Subordinates, User's Direct Subordinates, and Employee Relationship. For most users, this permission should be constrained by User Self and Subordinates.
	Universal Profile



	Snapshot Succession – Manage
	Enables user to view the Succession widget and subpage within the Universal Profile - Snapshot page for users within their permission constraints. On this page, users can view and manage successors and successor ratings. Users cannot view their own Succession widget and subpage, regardless of permissions. This permission can be constrained by OU, User's Subordinates, User's Direct Subordinates, and Employee Relationship. 
	Universal Profile


Potential Successor for Incumbents
The Incumbents tab displays all users for whom the user has been identified as a potential successor. To the right of the tab name, the number of incumbents for whom the user has been identified as a potential successor is displayed.
The following information is displayed for each incumbent:
· User's Photograph
· User's Name
· User's Position
· User's Manager
· Color Strip - This color indicates the user's rating as a potential successor for the corresponding incumbent. No color is displayed if the user has not been rated or if no fields are available. The colors are configured by the administrator in Snapshot Succession Preferences.
All incumbents can be expanded to view additional information by clicking the expand magnifying glass icon [image: ] in the upper-right corner of the section. This displays any additional fields that were configured to display by the administrator in Snapshot Succession Preferences.
Potential Successor for Positions
The Positions tab displays all positions for which the user has been identified as a potential successor. To the right of the tab name, the number of positions for which the user has been identified as a potential successor is displayed.
Each position is segmented so that each position is clearly distinguishable. The color strip for the position indicates the user's rating as a potential successor for the corresponding position. No color is displayed if the user has not been rated or if no fields are available. The colors are configured by the administrator in Snapshot Succession Preferences.
All positions can be expanded to view additional information by clicking the expand magnifying glass icon [image: ] in the upper-right corner of the section. This displays any additional fields that were configured to display by the administrator in Snapshot Succession Preferences.
Within each position segment, all current incumbents for the position are displayed. If the position is vacant, then "Vacant Position" is displayed. The following information is displayed for each incumbent:
· User's Photograph
· User's Name
· User's Position
· User's Manager
[bookmark: _Ref-1677454300]Snapshot - Succession - Modification History
On the Snapshot - Succession page, the Modification History section displays a log of any updates to the Succession Snapshot page. This section is only available to users with permission to manage succession on the Succession Snapshot page.
To access the Succession Snapshot page, go to Home > Universal Profile. Then, click the Snapshot tab. Then, click the Succession widget.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Snapshot Succession - View
	Enables user to view the Succession widget and subpage within the Universal Profile - Snapshot page for users within their permission constraints. On this page, users can view successors and successor ratings. Users cannot view their own Succession widget and subpage, regardless of permissions. This permission can be constrained by OU, User's Subordinates, User's Direct Subordinates, and Employee Relationship. For most users, this permission should be constrained by User Self and Subordinates.
	Universal Profile



	Snapshot Succession – Manage
	Enables user to view the Succession widget and subpage within the Universal Profile - Snapshot page for users within their permission constraints. On this page, users can view and manage successors and successor ratings. Users cannot view their own Succession widget and subpage, regardless of permissions. This permission can be constrained by OU, User's Subordinates, User's Direct Subordinates, and Employee Relationship. 
	Universal Profile
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The following updates to the Succession Snapshot page are captured in the Modification History table:
· SMP rating is modified via a SMP task or the Succession Snapshot page. A SMP rating modification is only captured if the SMP field is displayed on the Succession Snapshot page. Note: Modifications to User Rating fields in the Snapshot - User and Snapshot - Position fields are not tracked in the Modification History section. 
· User or position successor is added via a SMP task or the Succession Snapshot page.
· User or position successor is removed via a SMP task or the Succession Snapshot page.
· User is identified as a potential successor for an incumbent or position via a SMP task or the Succession Snapshot page.
· User is removed as a potential successor for an incumbent or position via a SMP task or the Succession Snapshot page.
· Note: Modifications that are made via the Succession Snapshot page are not displayed in the Modification History section until the page is saved.
The following information is displayed for each entry in the Modification History table:
· Action - Displays the specific action that was performed, such as adding a successor or modifying a rating.
· Changed From - Displays the original value of the SMP rating. This value is only populated when a SMP rating is modified.
· Changed To - Displays the updated value of the SMP rating. This value is only populated when a SMP rating is modified.
· User - When a successor is added or removed, this displays the name of the successor. When a SMP rating is modified, this column is blank.
· Changed By - Displays the name of the user who performed the modification.
· Task - Displays the name of the SMP task in which the action was performed. This value is only populated with the action was performed within a SMP task.
· Date - Displays the date on which the action was performed. Modifications are displayed in chronological order with the most recent modification displayed first.
[bookmark: _Ref1213400053]Snapshot - Succession - Edit Potential Successors
When viewing the Succession page for a user, managers can edit their subordinate's potential successors and their subordinate's position's potential successors by clicking the Edit icon [image: ] in the Potential Successors section. This option is only available to users who have permission to manage succession information on the Snapshot Succession page.
Note: Adding or removing potential successors from a position impacts the Potential Successors section for all users in the corresponding position. Also, any ratings that are applied to a position-based potential successor are applied to the Snapshot - Succession page of all users in the position.
To access the Succession Snapshot page, go to Home > Universal Profile. Then, click the Snapshot tab. Then, click the Succession widget.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Snapshot Succession - View
	Enables user to view the Succession widget and subpage within the Universal Profile - Snapshot page for users within their permission constraints. On this page, users can view successors and successor ratings. Users cannot view their own Succession widget and subpage, regardless of permissions. This permission can be constrained by OU, User's Subordinates, User's Direct Subordinates, and Employee Relationship. For most users, this permission should be constrained by User Self and Subordinates.
	Universal Profile



	Snapshot Succession – Manage
	Enables user to view the Succession widget and subpage within the Universal Profile - Snapshot page for users within their permission constraints. On this page, users can view and manage successors and successor ratings. Users cannot view their own Succession widget and subpage, regardless of permissions. This permission can be constrained by OU, User's Subordinates, User's Direct Subordinates, and Employee Relationship. 
	Universal Profile
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Modify Successor Information
Additional information about the potential successor may be displayed, including user and SMP metric fields. Some fields can be edited, while others are read-only. Note: User record fields cannot be edited. In addition, some fields may require a selection, while a response is optional for others. Administrators can configure which fields are available and which fields are read-only, optional, or required in the Successor Information section in Succession Preferences. Note: If none of the fields are configured to be editable, then the Edit icon is not available.
Changes to successor information are not saved until the Save button is clicked. 
Delete a Potential Successor
When editing the Potential Successors section, managers can delete potential successors. To delete a potential successor, click the Delete icon [image: ] to the right of the appropriate successor.
If a potential successor is deleted, the deletion is not saved until the Save button is clicked. 
Save or Cancel
Click Save to commit any changes. Or, click Cancel to discard any unsaved changes.
[bookmark: _Ref1827304242]Snapshot - Succession - Edit Ratings
When viewing the Succession page for a user, managers may be able to edit their subordinate's succession information and ratings by clicking the Edit icon [image: ] in the Ratings section. This option is only available to users who have permission to manage succession information on the Snapshot Succession page. Note: If none of the fields are configured to be editable, then the Edit icon is not available.
The fields that can be edited by the manager become editable. Administrators can configure which ratings display in this section and which ratings are editable in Succession Preferences. See Snapshot Succession Preferences - Succession on page 371 for additional information.
Note: Changes that are saved on this page do NOT impact ratings within succession tasks. To report on the most recent changes to an SMP metric field from the Helicopter View, Succession Snapshot, or Succession Task, create a custom Succession report. Ratings that are associated with the Task Name of "Current" represent the most recently saved ratings from any of all possible methods of updating succession ratings.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Snapshot Succession – Manage
	Enables user to view the Succession widget and subpage within the Universal Profile - Snapshot page for users within their permission constraints. On this page, users can view and manage successors and successor ratings. Users cannot view their own Succession widget and subpage, regardless of permissions. This permission can be constrained by OU, User's Subordinates, User's Direct Subordinates, and Employee Relationship. 
	Universal Profile



	Snapshot Succession - View
	Enables user to view the Succession widget and subpage within the Universal Profile - Snapshot page for users within their permission constraints. On this page, users can view successors and successor ratings. Users cannot view their own Succession widget and subpage, regardless of permissions. This permission can be constrained by OU, User's Subordinates, User's Direct Subordinates, and Employee Relationship. For most users, this permission should be constrained by User Self and Subordinates.
	Universal Profile


[image: ]
Metric Ratings
When a metric rating value is editable, the manager can select a metric rating from the drop-down menu within the widget. After any changes are saved, the graphics are updated to match the selected ratings.
Changes to metric ratings are not saved until the Save button is clicked. 
[image: ]
Grids
Grids cannot be edited. When the Ratings section is in Edit mode, the grid widgets remain in read-only mode.
[image: ]
Custom Fields
Short text box or scrolling text box succession custom fields may be available to view or edit.
Save or Cancel
Click Save to commit any changes. Or, click Cancel to discard any unsaved changes.
Note: Changes that are saved on this page do NOT impact ratings within succession tasks. To report on the most recent changes to an SMP metric field from the Helicopter View, Succession Snapshot, or Succession Task, create a custom Succession report. Ratings that are associated with the Task Name of "Current" represent the most recently saved ratings from any of all possible methods of updating succession ratings.
[bookmark: _Toc161994689]Universal Profile - Transcript Overview
[bookmark: concept175]The Transcript page is a part of the Universal Profile.
Every user has a personalized transcript which enables the user to manage their training. The transcript displays the status of each learning object (LO) requested by, assigned to, or required of the user, which allows the user to determine if the training is pending, approved, denied, or many other potential statuses. Depending on the training status, users can register, launch, and perform a variety of other training functions directly from the transcript.
To access the Transcript page, go to Home > Universal Profile. Then, click the Transcript tab. Note: The location of this link is configurable by your system administrator. Note: The Employee Transcripts - Manager/Approver Access permission does not grant access to this page. 
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Bio About - View
	Enables user to view the Bio page for users within their permission constraints. This permission must be enabled to view the Transcript page within Universal Profile. If a user does not have this permission and they click a person's name or user photo within the Universal Profile, then the Bio page will not open.
On the Learner Home page, this permission also allows end users to view the Completions & Hours field, the training sidebar, and the Continue Learning carousel. 
This permission can be constrained by Employee Relationship, OU, User's OU, User's Direct Reports, User Self and Subordinates, and User. Note: For security purposes, this permission is constrained to User Self and Subordinates by default. However, the permission constraints can be modified to allow users to view the Bio About page for other users.
	Universal Profile



	Employee Transcripts - Manager/Approver Access
	Grants access to transcript (training record) screen of those for whom user is designated manager, approver or cost center approver. System administrators can access all user transcripts from this page. Link to this screen appears under Standard Reports/Track Employees. This is a manager/approver permission. This permission can be constrained by Employee Relationship and User's Direct Subordinates.
Note: The Employee Relationship constraint allows administrators to constrain the permission to a user’s custom employee relationship. For example, an administrator can select to restrict the Matrix Manager relationship to viewing user data for users who have that Matrix Manager indicated on their user record.
Note: The User's Direct Subordinates constraint allows administrators to constrain the data that a user can view to only the data for their direct reports. The user will not be able to view their own data with this constraint.
Note: By design, for any Track Employees report permission that is included in the Manager default security role, all of the manager's direct and indirect reports are included in the constraints, even if they are not selected in the permission constraints for the role.
	Reports - Track Employee



	External Training - Add
	Grants a user the ability to add or edit their own external training. When viewing another user's transcript, the user must also have permission to edit transcript items in order to add or edit the user's external training. This permission cannot be constrained. This is an end user permission.
	Learning



	Local Network Player - File Download Link - View
	Grants access to the Download Network Player link in Course Catalog and on the Transcript. Users must also have permission to access the Course Catalog. This permission cannot be constrained. This permission is recommended for local trainers who deliver course content remotely. This is an end user and local trainer permission. If the user no longer needs to view the download link after installation, this permission can be removed for those users.
	Learning



	Local Network Player - Launch Courses Offline Through the Network Player
	Enables users to see the Launch Locally link on their transcript for courses that have been downloaded and can be launched through the local network. This permission cannot be constrained. This permission is recommended for end users of the LMS.
	Learning



	Mark Training Complete
	Grants ability to mark learning objects complete for other users, via the training details page when viewing the learning object from the user's transcript. This permission does not grant ability to mark a user's learning object complete from their Transcript page. This permission can be constrained by OU, User's OU, User, User's Self, and User Self and Subordinates. This is an administrator permission.
	Learning - Administration



	Mark Transcript Exempt
	Grants ability to exempt users from a learning object, using the "Mark Exempt" link on the top right corner of the target user's Transcript/Training details page. This permission can be constrained by OU, User's OU, and User's Subordinates. This is an administrator permission.
With the May '17 release, this permission also applies to prerequisites, pre-work, and post-work. Users without this permission cannot mark any training type exempt for a user. 
	Learning - Administration



	Old Offline Player
	Enables the user to access to the old offline player functionality. Users with this permission can download courses to the old offline player as well as upload training results from the old offline player. Without the permission, users cannot see the link on the transcript page to retrieve the offline player key, they cannot log in to the offline player, and no uploaded results are accepted. This permission cannot be constrained. This is an end user permission.
	Learning



	Remove Training
	Grants ability to remove training from other users' transcripts (training records) when viewing their transcript. This permission can be constrained by OU, User's OU, User's Corporation, User Self and Subordinates, User's Self, User's Direct Subordinates, and User. This is an administrator permission.
	Learning - Administration



	User View “Add SF-182” link on Transcript
	Grants ability to view the "Add SF-182 External Training" link to complete the form for requesting an external course (Governmental clients). This is an end user permission.
Note: If a user does not have this permission but has the Edit Transcript Items permission, the Add SF-182 External Training link will also appear.
	Limited Use/Obsolete



	View Transcript Item
	Grants ability to view details of learning objects that appear on the transcript (training record), by clicking on the name of the learning object. Users must also have the Bio About - View permission in order to access the transcript within Universal Profile. This permission can be constrained by OU, User's OU, User Self and Subordinates, User, or User's Self. This is an end user permission.
	Learning - Administration



	Withdraw Users from Sessions
	Allows administrators and managers to withdraw users from sessions on their behalf. This is done from the user's Transcript page. Note: There is a setting in the Session Defaults for an event that may prevent users from being able to withdraw from sessions. When this option is selected, users, managers, and administrators are prevented from withdrawing from sessions for themselves or on behalf of other users. This permission can be constrained by OU, User's OU, User's Self and Subordinates, User, User's Subordinates, and User's Direct reports. This is a manager or administrator permission.
	Learning


[image: ]
Troubleshooting Information
The Transcript page title and instructions can be configured by the system administrator in Transcript Preferences.
The following page contains an administrator's guide for configuring the Universal Profile:
· See Configuration Guide - Universal Profile.
Course Troubleshooting Guide
In certain cases, users may have issues receiving a Completed status for their online course even if they have launched the course and completed the assessment within the course. See Course Troubleshooting Guide on page 585 for additional information.
View Team
The View Team flyout allows managers, approvers, and custom relationships to quickly navigate between subordinates' profiles and transcripts. When enabled, the View Team flyout is available to managers and dotted line managers on all pages of their Universal Profile and the Universal Profile of their subordinates. This flyout displays the manager's reports visually.
The View Team button displays if enabled in the portal. Administrators may enable or disable this flyout via the My Team Dropdown section within Universal Profile General Preferences. See Universal Profile General Preferences on page 2 for additional information.
See Universal Profile - View Team Flyout on page 648 for additional information.
Options
The following options are available in the Options drop-down menu:
· Assign Training - Select this option to assign training to a direct or indirect report. This option is only available if the user has permission to assign training and when viewing the Universal Profile page of a direct or indirect report. See Universal Profile - Options - Assign Training on page 671 for additional information.
· Add External Training - Select this option to add external training to your transcript. This option is only available for users with permission to add external training. Also, the availability of this option is controlled by backend settings. See Universal Profile - Options - Add External Training on page 654 for additional information. Note: In order to add external training to a certification, users must first add the external training to their transcript. Then, they must add it from their transcript to the certification or add the external training via the certification's Training Details page.
· Add SF-182 External Training - Select this option to add external training using an SF-182 form. This option is only available for users with permission to add external training via the SF-182 form and if an SF-182 form has been configured by the administrator. Also, the availability of this option is controlled by a backend setting. See SF-182 Form - Overview on page 658 for additional information.
· Download Network Player - Select this option to download the Network Player. The installation dialog varies based on the user's Internet browser settings. This option is only available if the user has permission to download the Network Player. Also, the availability of this option is controlled by a backend setting. See Network Player Transcript Options on page 470 for additional information.
· Export to PDF - Select this option to print the current view of the transcript page to PDF. Only the training that is currently displayed is included in the printed transcript. If there are multiple pages, then only the current page is printed. The PDF file name is "[User First Name] [User Last Name] - Transcript - MM/DD/YYYY." This option is available to any user who can view the Transcript page.
· Print Transcript - Select this option to view an HTML printable version of your transcript. Depending on which training category is selected when you select this option (Active, Archived, Removed), a printable version of the corresponding transcript training category is generated. This option is available to any user who can view the Transcript page. See Transcript - Print Transcript Pop-up on page 475 for additional information.
· Register Offline Device - Select this option to register an offline device, which enables you to log in to the Cornerstone mobile application using a unique PIN, rather than your username and password. This option opens the Mobile Devices tab of My Account. See My Account - Devices. Note: My Account is redesigned with the June 2014 release. If enabled, this option takes the user to the redesigned My Account page, rather than the old My Account page.
· Run Transcript Report - Select this option to run the Transcript Report. This option is available to any user who can view the Transcript page. See Transcript - Transcript Report on page 580 for additional information.
· Request Exemption - The Request Exemption option is available in the Actions drop-down for training items, if applicable to both the training item and the user. If a user clicks this option, the Request Exemption pop-up appears. Using this pop-up, the user must select a reason for the exemption request and enter a comment. The user can click Confirm to complete the request or click Cancel to cancel the request. See Exemption - Request on page 534 for additional information.
· Mark Exempt - The Mark Exempt option is available to administrators in the Actions drop-down for training items, if applicable to both the training item and the user. If an administrator clicks this option, the Mark Exempt pop-up appears. Using this pop-up, the administrator must select a reason for the exemption and enter a comment. The administrator can click Confirm to complete the exemption or click Cancel to cancel the exemption.
Fiscal Year Training Overview
In Define Fiscal Year Preferences, the system administrator can configure the fiscal year and whether the aggregate training information is displayed on the Transcript.
If enabled, the following fiscal year training information is displayed at the top of the transcript:
· Aggregate Training Completed - This displays the total number of hours of all completed training for the fiscal year that has hours associated with it. Removed training will be deducted from this total.
· Fiscal Year - This displays the fiscal year for which the aggregate training and cost are calculated. 
· Cost - This displays the total cost of all completed training for the fiscal year that has an associated cost.
[image: ]
Training Category Filter
From the Training Category filter, users can filter the training based on whether the training in the transcript is active, completed, archived, or removed from the transcript. The Active filter option is selected by default. See Transcript - Training Category Statuses on page 496 for additional information.
Transcript Sort
To the right of the Training Category filter, the sort option allows users to determine the order in which transcript items are displayed on the page. The default sort order for the transcript can be configured by the system administrator via Transcript Preferences. The following options are available:
· By Title - This option sorts the transcript alphabetically by title in ascending or descending order, depending on how sorting preferences are configured within Transcript Preferences.
· By Completion Date - This option sorts the transcript by completion date with the most recent dates appearing first. This option is not available when viewing the Active transcript category. Note: This sort option does not apply to certifications, so certifications appear at the bottom of the list when this sort option is selected.
· By Status - This option sorts the transcript by status. The statuses are sorted alphabetically in ascending order.
· By Training Purpose - This option sorts the transcript by training purpose. The training purposes are sorted in ascending numeric order, which is configured in Training Purpose Administration. The Training Purpose sort option is only available if training purpose is enabled. Note: This sort option does not apply to certifications, so certifications appear at the bottom of the list when this sort option is selected.
· By Date Added - This option sorts the transcript by the date on which the item was added to the transcript. The items that were most recently added are displayed first. If the training item is a recurrence, then the most recent date associated with the item is used.
· By Training Type - This option sorts the transcript by training type. The training types are sorted in alphabetical order.
· By Due Date - This option sorts the transcript by due date with the soonest due dates appearing first.
· By Family - This option sorts the transcript by certification family. This option is only available when Certification is selected from the LO Type filter.
· By Category - This option sorts the transcript by certification category. This option is only available when Certification is selected from the LO Type filter.
· By Expiration Date - This option sorts the transcript by certification expiration date. This option is only available when Certification is selected from the LO Type filter.
When a training item does not contain the field by which the transcript is sorted, those items appear at the bottom of the list sorted alphabetically.
LO Type Filter
To the right of the Transcript Sort option, the LO Type filter enables users to filter the items within their transcript by a specific LO type, such as online course, cohort, or certification. Only a single LO type can be selected at a time.
The LO Type filter only displays the LO types that are currently displayed on the user's transcript. For example, if the user only has certifications, online classes, and sessions on their transcript, then the user can only select those LO types from the filter. By default, all LO types are displayed on the transcript.
The LO Type filter is available for all training categories (i.e., Active, Completed, Archived, and Removed).
Transcript Search
Users can search for training items within the selected category of the transcript using the Search functionality. To search for a training item, enter the appropriate keywords in the Search for training field and then press the [Enter] key or click the Search icon [image: ]. 
The training items that match the search are displayed. The number of search results is displayed at the top of the list. 
· Only the selected transcript category is searched. For example, if the Completed category filter is selected, then only items within the Completed category are searched.
· When searching for a LO that is on the user's transcript as part of a curriculum, the following is true:
· Search returns the curriculum, but not the individual LO unless the LO is also on the Transcript as an individual item.
· If the LO is not activated, it will not appear in the search results. LOs that are Registered or In Progress will appear in search results.
· The child LO only appears in the search results if the child LO's training category status (i.e., Active, Completed, Archived) matches the parent LO's training category status.
· The transcript search also supports searching for learning object(s) by pre-work and post-work titles. To search for a learning object by its associated pre-work, the pre-work must have been activated. Entering the title or a text string from the pre-work title will return the associated learning object(s) on the Active and Completed tab. Entering the pre-work string in the Search field on the Archived or Removed tab will NOT return the associated learning object(s). Similarly, if post-work is used and the post-work has been activated and the learning object is pending post-work or has been completed, entering the title of the post-work in the search box will display the learning object(s) associated with the post-work on the Active and Completed tab. Post-work searches on the Archived or Removed transcript tabs will NOT return the associated learning object(s).
To clear the search filter, click the Remove icon [image: ] in the Search for training field.
Hide Certified Certifications
This option is only available when viewing the Active training category and when certifications exist on the user's transcript.
When this option is selected, the transcript only displays incomplete certifications for the user. Any certifications in which the user is currently certified are hidden. If the LO Type filter is set to a specific training type other than certifications, then this option is not available.
Transcript Items
By default, new users do not have any training on their transcript until training is assigned, requested, or loaded to their transcript.
The following information is displayed for each training item in the transcript:
· Color Strip - The left edge of the LO is color coded to represent the proximity to the due date of the LO. For example, if the LO due date is past due, then the color strip is red to indicate that LO is due immediately. If a LO due date is not eminent, then the color strip is green to indicate that LO is not due immediately. See the Color Strip Key section below for additional information.
· LO icon - The icon that is displayed corresponds with the LO type (e.g., certification, curriculum, event, library, online course). Hover the computer cursor over the icon to view the LO type.
· LO title - When a user clicks the title of a training item on their transcript, they are navigated to an actionable page, which in most cases is the Learning Details page, where the user is allowed to launch and take other action on the training. See below for the different actionable pages to which the user may be directed, depending on the training type:
· Learning Details - The user will be directed to the Learning Details page when they click the title of any of the following training types from their transcript:
· Material
· Online course
· Test
· Video
· Posting
· Event
· Curriculum
· Certification
· Cohort
· Event Learning Details - The user will be directed to the Event Learning Details page with the Session flyout expanded if they click the title of a session from their transcript.
· External Content - The external content will launch when the user clicks the title of an external training item from their transcript.
· External Training - The user will still be directed to the Transcript Details page if they click the title of an external training item.
Note: For session LOs, the session start date is appended to the LO title (e.g., Session Title Starts 12/01/2014). If the session is configured to Display in User's Timezone, the session start time will appear in addition to the session start date and LO title.
Note: For curriculum LOs, the curriculum expiration date is appended to the LO title (e.g., Curriculum Title Expires on 12/01/2014).
· LO Due Date or Completion Date - For training that is active, archived, or removed, the LO due date is displayed, if available. For training that is completed, the LO completion date is displayed.
· Status - The LO status is displayed. Note: For SCORM 1.2 and 2004 online courses that have SSL security enabled, the Transcript page refreshes automatically to show the most up to date status.
· Training Type - This displays the type of training, such as Online Class, Material, etc.
· LO Expiration - For LO's that are associated with a subscription, an expiration date displays to the right of the Status field for transcript items.
· The expiration date is the date on which the training will no longer be available for the user to complete at no cost. The subscription will need to be renewed for the user to have access to the LO for no cost, or the user can alternatively purchase the training at this point.
· When an LO is available to a user in multiple subscriptions, the subscription with the latest date will apply.
· If the administrator edits the end date of the subscription at any point, a user who has already consumed the LO will maintain the settings that were active at the time of their consumption. The new dates will only apply to users who have not yet consumed the LO.
· Training Purpose - The training purpose only displays when training purpose is enabled for the transcript and if the LO has an associated training purpose.
· Actions drop-down - This drop-down enables users to perform actions on the LO. Click the left side of the drop-down to perform the displayed action. Or, click the drop-down arrow to select a secondary action. By default, the Action drop-down displays the primary action for the LO. See Transcript (Universal Profile) - Status and Options on page 477 for additional information.
· When a LO is inactive, "Inactive" appears as the first action in the Action drop-down menu. This option is not clickable. The only other option available in the Action drop-down menu is the View Details option, which opens the Training Details page.
Color Strip Key
The following colors are available:
· Red - Due today or past due
· Orange - Due within the next seven days, not including today
· Green - Due after seven days
[bookmark: _Ref-431043599][bookmark: _Ref89809845][bookmark: _Toc161994690]Transcript Preferences
[bookmark: concept176]Use the Transcript Preferences page to define the default sort order of all training on user transcripts. In addition, administrators can define specifically when training items are automatically moved from one Transcript training category to another. Note: These preferences only apply to the Training Transcript.
The default sort order and archive settings that are selected in Transcript Preferences also affect how training items appear on the Transcripts report.
· The sort order that is used is based on the Transcript Preferences for the user viewing the report.
· Training items appear on the various transcript tabs based on the Training Preferences for the transcript owner, not the user viewing the report.
Use Case: Default Sorting 
A system administrator feels that users are not completing the appropriate training in the allotted time because of the course visibility on their transcript. In an attempt to remedy this, the administrator sets a default sort preference for courses displayed on users' transcripts.
Use Case: Archive Completed Courses
A system administrator feels that users are not completing the appropriate training in the allotted time because of the course visibility on their transcript. In an attempt to remedy this, the administrator sets an automatic archive process where courses that have been on a user's transcript for more than a year are automatically moved to the Archived training category in order to draw user attention to current courses that they are required to complete.
To access Transcript Preferences:
· Go to Admin > Tools > Learning > Learning Preferences > Transcript.
· Go to Admin > Tools > Core Functions > Universal Profile > Transcript.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Transcript Preferences - Manage
	Grants ability to set Transcript Preferences. This permission can be constrained by OU and User's OU. This is an administrator permission.
	Learning - Administration


[image: ]
Transcript Page Title
Enter the title that should appear at the top of the Transcript page, up to 100 characters. This field is optional. If no text is entered, then no title appears at the top of the page.  If multiple languages are enabled for your portal, select the Translate icon to translate the field into other available languages. 
Transcript Page Description
Enter the description that should appear at the top of the Transcript page, up to 1,000 characters. This field is optional. If no text is entered, then no description appears at the top of the page.  If multiple languages are enabled for your portal, select the Translate icon to translate the field into other available languages. 
Default Text (when no training is in the Transcript)
Enter the text that should appear on the Transcript page when the user has no training in their transcript. This text appears in addition to the page description. This text should inform the user that they do not have any training on their transcript and may instruct them on how to browse or search for training within the system. The character limit for this field is 500 characters. This field is optional. If no text is entered, then no message is displayed to users when they do not have any training on their transcript.  If multiple languages are enabled for your portal, select the Translate icon to translate the field into other available languages. 
Default Text: You currently have no training on your transcript. Check out Learner Home to start learning today!
Sort Training
This section enables administrators to define the default sort order for all training categories. The settings defined in this section are applied based on the organizational unit (OU) of the user viewing the transcript. For example, when a user views their own transcript, the sort order is dependent on the settings applied to the user's OU. If an administrator views a user's transcript, the sort order is dependent on the settings applied to the administrator's OU. Note: Updates to the Sort Training preferences are applied five minutes after the preferences are saved.
From the Sort By drop-down list, select the sort method for the corresponding transcript training categories. The following sort options are available for each transcript training category:
· None
· By Date Added - This is the default sort option for the Active training category.
· Title
· Training Type
· Training Due Date - Note: If sorting by Training Due Date, training without due dates will appear before or after training with due dates depending on whether the list is sorted in descending or ascending order, respectively.
· Training Purpose - This option is only available if Training Purpose is included on the transcript in the Training Purpose section below.
· Training Status
· Training Completion Date - This option is not available for the Active training category. This is the default sort option for the Completed training category.
· Training Removal Date - This option is only available for the Removed training category. This is the default sort option for the Removed training category.
Click the Ascending/Descending Order icon [image: ] to change whether the sort order is ascending [image: ] or descending [image: ]. 
· If the sort order is set to Ascending (A > Z) and the training category is sorted by Date added to transcript, then training items appear with the earliest added transcript items first (i.e., an item added to the transcript on May 2, 2022 would appear above an item added on July 2, 2022). 
· If the sort order is set to Descending (Z > A) and the training category is sorted by Date added to transcript, then training items appear with the most recent (latest) added transcript items first (i.e., an item added to the transcript on July 2, 2022 would appear above an item added on May 2, 2022.
To apply the current sort preferences of the Active training category to all other training categories, click the Apply All button. This copies the current sort preferences of the Active training category to all other training categories. This includes the ascending/descending specification. However, if the Active training category sort preferences are modified, you must click the Apply All button again to re-copy the modified settings to all training categories.
Automatic Movement of Training Items
This section enables administrators to define specifically when training items are automatically moved from one Transcript training category to another. The settings defined in this section are applied based on the OU of the transcript owner. For example, when an administrator views a user's transcript, the learning objects (LOs) appear in the training categories associated with any rules that apply to the user's OU in addition to any manual movements that were applied.
When a user changes OUs, any changes in settings between the two OUs apply to future movements of training items. Any training that has already been moved remains there.
Automatic movements are set individually, but they all work in conjunction. By default, all organizations have an automatic movement configured so that an LO is automatically moved from the Active training category to the Completed training category of the transcript upon completion. This automatic movement cannot be removed.
Important: Once the rule is saved, it will retroactively move past items that apply to the rule in addition to items that apply to the rule in the future.
Set the following fields to configure an automatic movement of training items:
· Move trainings from - Select the transcript training category from which the training should be moved.
· Move trainings to - Select the transcript training category to which the training should be moved.
· Move trainings once they have been in the specified status for - Select the number of days, months, or years a training item should be in the selected status before it is moved. This is calculated using calendar days, rather than business days. The numeric field accepts up to three digits.
· Move trainings after the defined amount of time when they are in a status of - Select the statuses that will trigger the automatic movement. Multiple statuses can be selected. If multiple statuses are selected for a rule, a separate rule is created for each status.
· The multi-select drop-down only displays the remaining available statuses. For example, if a rule is generated using the Registered status to move courses from the Active to Archived training category, then the Registered status does not appear when Active is selected in the Move trainings from field and Archived is selected in the Move trainings to field.
· Once all statuses have been applied to rules, the administrator can no longer create new rules because all statuses are removed from the drop-down list. If a rule is deleted, the statuses associated with the rule are repopulated in the drop-down list.
· When the Active or Completed training category is selected in the Move trainings from field, the Completed, Exempt, and Completed (Equivalent) statuses do not appear in the drop-down list.
· Submit - After selecting the appropriate options for the automatic movement rule, click Submit to save the rule. The new rule appears at the bottom of the list of rules.
Examples:
· Move trainings from Completed to Archived 30 days after they have been in a status of Exempt.
· Move trainings from the Completed to the Archived 30 days after they have been in a status of Completed.
· Move trainings from Active to Archived 6 months after they have been in a status of Withdrawn.
Below the automatic movement rule options, the list of existing automatic movement rules is displayed. Aside from the default LO completion rule, all other rules can be deleted by clicking the Delete icon [image: ] to the right of the rule. Deleting a rule does not affect training that has already been moved from one transcript training category to another; these training items remain in the training category they are in at the time of the deletion. However, the deleted rule does not apply going forward.
Note: Automatic Movement of Training Items does not apply to Certifications. For the display of Certifications, please refer to the Certification Display Preferences section below.
Note: Automatic Movement of Training Items does not apply to items that are inside a curriculum. The curriculum can be moved to Archived, by you cannot move items from within the curriculum to the archived tab with this function.
Certification Display Preferences
When viewing the Active training category on the Universal Profile: Transcript page, users have the option to hide any certifications in a Certified status. 
This option enables administrators to configure the default setting for the Transcript option. When this option is selected, the Transcript page automatically hides any certified certifications. However, the user is able to display or hide certified certifications from the Transcript page.
Training Plan Settings
Add 'From Training Plan?' field in Training Details - When this option is checked, a From Training Plan? field appears on the Training Details page for all learning objects. The From Training Plan? field displays whether the course was assigned to the user from a training plan. This option is unchecked by default. This option is only available to organizations using the Training Plans functionality.
Training Purpose
Note: This section is only available if Training Purpose is enabled for the portal. 
Include Training Purpose column on transcript - Select whether the Training Purpose column is included on the transcript. When the Training Purpose column is included on the transcript, then Training Purpose is available as a sort option in the Sort Training section for all transcript tabs.
Overwrite Settings
Select this option to overwrite custom settings for child division OUs. If you overwrite custom settings for child division OUs, the selected settings are applied to both new and existing child OUs. Any previously customized child OUs are updated with the selected settings.
· If there are no customizations to the child OU, then the parent OU customizations are applied to all child OUs.
· Overwrite custom settings checkbox setting
· If this option is selected, all child OU customizations are deleted from the database, which means the parent OU customizations will be applied to new and existing child OUs.
· If this option is unselected, all existing child OU customizations will remain unchanged, and any new child OUs will inherit the parent OU customizations by default.
· If a child OU has been customized to display any widgets, then regardless of the parent OU customizations, the child OU customizations are applied.
· If a child OU has been customized to hide all widgets, then parent OU customizations will take precedence and will be applied.
Save/Cancel
Click Save to save all unsaved changes. Any changes made to the sort options or any rules that are added are not saved until the Save button is clicked.
Click Cancel to discard all unsaved changes.
[bookmark: _Ref-1118568692][bookmark: _Toc161994691]Universal Profile - Transcript Overview
[bookmark: concept177]The Transcript page is a part of the Universal Profile.
Every user has a personalized transcript which enables the user to manage their training. The transcript displays the status of each learning object (LO) requested by, assigned to, or required of the user, which allows the user to determine if the training is pending, approved, denied, or many other potential statuses. Depending on the training status, users can register, launch, and perform a variety of other training functions directly from the transcript.
To access the Transcript page, go to Home > Universal Profile. Then, click the Transcript tab. Note: The location of this link is configurable by your system administrator. Note: The Employee Transcripts - Manager/Approver Access permission does not grant access to this page. 
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Bio About - View
	Enables user to view the Bio page for users within their permission constraints. This permission must be enabled to view the Transcript page within Universal Profile. If a user does not have this permission and they click a person's name or user photo within the Universal Profile, then the Bio page will not open.
On the Learner Home page, this permission also allows end users to view the Completions & Hours field, the training sidebar, and the Continue Learning carousel. 
This permission can be constrained by Employee Relationship, OU, User's OU, User's Direct Reports, User Self and Subordinates, and User. Note: For security purposes, this permission is constrained to User Self and Subordinates by default. However, the permission constraints can be modified to allow users to view the Bio About page for other users.
	Universal Profile



	Employee Transcripts - Manager/Approver Access
	Grants access to transcript (training record) screen of those for whom user is designated manager, approver or cost center approver. System administrators can access all user transcripts from this page. Link to this screen appears under Standard Reports/Track Employees. This is a manager/approver permission. This permission can be constrained by Employee Relationship and User's Direct Subordinates.
Note: The Employee Relationship constraint allows administrators to constrain the permission to a user’s custom employee relationship. For example, an administrator can select to restrict the Matrix Manager relationship to viewing user data for users who have that Matrix Manager indicated on their user record.
Note: The User's Direct Subordinates constraint allows administrators to constrain the data that a user can view to only the data for their direct reports. The user will not be able to view their own data with this constraint.
Note: By design, for any Track Employees report permission that is included in the Manager default security role, all of the manager's direct and indirect reports are included in the constraints, even if they are not selected in the permission constraints for the role.
	Reports - Track Employee



	External Training - Add
	Grants a user the ability to add or edit their own external training. When viewing another user's transcript, the user must also have permission to edit transcript items in order to add or edit the user's external training. This permission cannot be constrained. This is an end user permission.
	Learning



	Local Network Player - File Download Link - View
	Grants access to the Download Network Player link in Course Catalog and on the Transcript. Users must also have permission to access the Course Catalog. This permission cannot be constrained. This permission is recommended for local trainers who deliver course content remotely. This is an end user and local trainer permission. If the user no longer needs to view the download link after installation, this permission can be removed for those users.
	Learning



	Local Network Player - Launch Courses Offline Through the Network Player
	Enables users to see the Launch Locally link on their transcript for courses that have been downloaded and can be launched through the local network. This permission cannot be constrained. This permission is recommended for end users of the LMS.
	Learning



	Mark Training Complete
	Grants ability to mark learning objects complete for other users, via the training details page when viewing the learning object from the user's transcript. This permission does not grant ability to mark a user's learning object complete from their Transcript page. This permission can be constrained by OU, User's OU, User, User's Self, and User Self and Subordinates. This is an administrator permission.
	Learning - Administration



	Mark Transcript Exempt
	Grants ability to exempt users from a learning object, using the "Mark Exempt" link on the top right corner of the target user's Transcript/Training details page. This permission can be constrained by OU, User's OU, and User's Subordinates. This is an administrator permission.
With the May '17 release, this permission also applies to prerequisites, pre-work, and post-work. Users without this permission cannot mark any training type exempt for a user. 
	Learning - Administration



	Old Offline Player
	Enables the user to access to the old offline player functionality. Users with this permission can download courses to the old offline player as well as upload training results from the old offline player. Without the permission, users cannot see the link on the transcript page to retrieve the offline player key, they cannot log in to the offline player, and no uploaded results are accepted. This permission cannot be constrained. This is an end user permission.
	Learning



	Remove Training
	Grants ability to remove training from other users' transcripts (training records) when viewing their transcript. This permission can be constrained by OU, User's OU, User's Corporation, User Self and Subordinates, User's Self, User's Direct Subordinates, and User. This is an administrator permission.
	Learning - Administration



	User View “Add SF-182” link on Transcript
	Grants ability to view the "Add SF-182 External Training" link to complete the form for requesting an external course (Governmental clients). This is an end user permission.
Note: If a user does not have this permission but has the Edit Transcript Items permission, the Add SF-182 External Training link will also appear.
	Limited Use/Obsolete



	View Transcript Item
	Grants ability to view details of learning objects that appear on the transcript (training record), by clicking on the name of the learning object. Users must also have the Bio About - View permission in order to access the transcript within Universal Profile. This permission can be constrained by OU, User's OU, User Self and Subordinates, User, or User's Self. This is an end user permission.
	Learning - Administration



	Withdraw Users from Sessions
	Allows administrators and managers to withdraw users from sessions on their behalf. This is done from the user's Transcript page. Note: There is a setting in the Session Defaults for an event that may prevent users from being able to withdraw from sessions. When this option is selected, users, managers, and administrators are prevented from withdrawing from sessions for themselves or on behalf of other users. This permission can be constrained by OU, User's OU, User's Self and Subordinates, User, User's Subordinates, and User's Direct reports. This is a manager or administrator permission.
	Learning


[image: ]
Troubleshooting Information
The Transcript page title and instructions can be configured by the system administrator in Transcript Preferences.
The following page contains an administrator's guide for configuring the Universal Profile:
· See Configuration Guide - Universal Profile.
Course Troubleshooting Guide
In certain cases, users may have issues receiving a Completed status for their online course even if they have launched the course and completed the assessment within the course. See Course Troubleshooting Guide on page 585 for additional information.
View Team
The View Team flyout allows managers, approvers, and custom relationships to quickly navigate between subordinates' profiles and transcripts. When enabled, the View Team flyout is available to managers and dotted line managers on all pages of their Universal Profile and the Universal Profile of their subordinates. This flyout displays the manager's reports visually.
The View Team button displays if enabled in the portal. Administrators may enable or disable this flyout via the My Team Dropdown section within Universal Profile General Preferences. See Universal Profile General Preferences on page 2 for additional information.
See Universal Profile - View Team Flyout on page 648 for additional information.
Options
The following options are available in the Options drop-down menu:
· Assign Training - Select this option to assign training to a direct or indirect report. This option is only available if the user has permission to assign training and when viewing the Universal Profile page of a direct or indirect report. See Universal Profile - Options - Assign Training on page 671 for additional information.
· Add External Training - Select this option to add external training to your transcript. This option is only available for users with permission to add external training. Also, the availability of this option is controlled by backend settings. See Universal Profile - Options - Add External Training on page 654 for additional information. Note: In order to add external training to a certification, users must first add the external training to their transcript. Then, they must add it from their transcript to the certification or add the external training via the certification's Training Details page.
· Add SF-182 External Training - Select this option to add external training using an SF-182 form. This option is only available for users with permission to add external training via the SF-182 form and if an SF-182 form has been configured by the administrator. Also, the availability of this option is controlled by a backend setting. See SF-182 Form - Overview on page 658 for additional information.
· Download Network Player - Select this option to download the Network Player. The installation dialog varies based on the user's Internet browser settings. This option is only available if the user has permission to download the Network Player. Also, the availability of this option is controlled by a backend setting. See Network Player Transcript Options on page 470 for additional information.
· Export to PDF - Select this option to print the current view of the transcript page to PDF. Only the training that is currently displayed is included in the printed transcript. If there are multiple pages, then only the current page is printed. The PDF file name is "[User First Name] [User Last Name] - Transcript - MM/DD/YYYY." This option is available to any user who can view the Transcript page.
· Print Transcript - Select this option to view an HTML printable version of your transcript. Depending on which training category is selected when you select this option (Active, Archived, Removed), a printable version of the corresponding transcript training category is generated. This option is available to any user who can view the Transcript page. See Transcript - Print Transcript Pop-up on page 475 for additional information.
· Register Offline Device - Select this option to register an offline device, which enables you to log in to the Cornerstone mobile application using a unique PIN, rather than your username and password. This option opens the Mobile Devices tab of My Account. See My Account - Devices. Note: My Account is redesigned with the June 2014 release. If enabled, this option takes the user to the redesigned My Account page, rather than the old My Account page.
· Run Transcript Report - Select this option to run the Transcript Report. This option is available to any user who can view the Transcript page. See Transcript - Transcript Report on page 580 for additional information.
· Request Exemption - The Request Exemption option is available in the Actions drop-down for training items, if applicable to both the training item and the user. If a user clicks this option, the Request Exemption pop-up appears. Using this pop-up, the user must select a reason for the exemption request and enter a comment. The user can click Confirm to complete the request or click Cancel to cancel the request. See Exemption - Request on page 534 for additional information.
· Mark Exempt - The Mark Exempt option is available to administrators in the Actions drop-down for training items, if applicable to both the training item and the user. If an administrator clicks this option, the Mark Exempt pop-up appears. Using this pop-up, the administrator must select a reason for the exemption and enter a comment. The administrator can click Confirm to complete the exemption or click Cancel to cancel the exemption.
Fiscal Year Training Overview
In Define Fiscal Year Preferences, the system administrator can configure the fiscal year and whether the aggregate training information is displayed on the Transcript.
If enabled, the following fiscal year training information is displayed at the top of the transcript:
· Aggregate Training Completed - This displays the total number of hours of all completed training for the fiscal year that has hours associated with it. Removed training will be deducted from this total.
· Fiscal Year - This displays the fiscal year for which the aggregate training and cost are calculated. 
· Cost - This displays the total cost of all completed training for the fiscal year that has an associated cost.
[image: ]
Training Category Filter
From the Training Category filter, users can filter the training based on whether the training in the transcript is active, completed, archived, or removed from the transcript. The Active filter option is selected by default. See Transcript - Training Category Statuses on page 496 for additional information.
Transcript Sort
To the right of the Training Category filter, the sort option allows users to determine the order in which transcript items are displayed on the page. The default sort order for the transcript can be configured by the system administrator via Transcript Preferences. The following options are available:
· By Title - This option sorts the transcript alphabetically by title in ascending or descending order, depending on how sorting preferences are configured within Transcript Preferences.
· By Completion Date - This option sorts the transcript by completion date with the most recent dates appearing first. This option is not available when viewing the Active transcript category. Note: This sort option does not apply to certifications, so certifications appear at the bottom of the list when this sort option is selected.
· By Status - This option sorts the transcript by status. The statuses are sorted alphabetically in ascending order.
· By Training Purpose - This option sorts the transcript by training purpose. The training purposes are sorted in ascending numeric order, which is configured in Training Purpose Administration. The Training Purpose sort option is only available if training purpose is enabled. Note: This sort option does not apply to certifications, so certifications appear at the bottom of the list when this sort option is selected.
· By Date Added - This option sorts the transcript by the date on which the item was added to the transcript. The items that were most recently added are displayed first. If the training item is a recurrence, then the most recent date associated with the item is used.
· By Training Type - This option sorts the transcript by training type. The training types are sorted in alphabetical order.
· By Due Date - This option sorts the transcript by due date with the soonest due dates appearing first.
· By Family - This option sorts the transcript by certification family. This option is only available when Certification is selected from the LO Type filter.
· By Category - This option sorts the transcript by certification category. This option is only available when Certification is selected from the LO Type filter.
· By Expiration Date - This option sorts the transcript by certification expiration date. This option is only available when Certification is selected from the LO Type filter.
When a training item does not contain the field by which the transcript is sorted, those items appear at the bottom of the list sorted alphabetically.
LO Type Filter
To the right of the Transcript Sort option, the LO Type filter enables users to filter the items within their transcript by a specific LO type, such as online course, cohort, or certification. Only a single LO type can be selected at a time.
The LO Type filter only displays the LO types that are currently displayed on the user's transcript. For example, if the user only has certifications, online classes, and sessions on their transcript, then the user can only select those LO types from the filter. By default, all LO types are displayed on the transcript.
The LO Type filter is available for all training categories (i.e., Active, Completed, Archived, and Removed).
Transcript Search
Users can search for training items within the selected category of the transcript using the Search functionality. To search for a training item, enter the appropriate keywords in the Search for training field and then press the [Enter] key or click the Search icon [image: ]. 
The training items that match the search are displayed. The number of search results is displayed at the top of the list. 
· Only the selected transcript category is searched. For example, if the Completed category filter is selected, then only items within the Completed category are searched.
· When searching for a LO that is on the user's transcript as part of a curriculum, the following is true:
· Search returns the curriculum, but not the individual LO unless the LO is also on the Transcript as an individual item.
· If the LO is not activated, it will not appear in the search results. LOs that are Registered or In Progress will appear in search results.
· The child LO only appears in the search results if the child LO's training category status (i.e., Active, Completed, Archived) matches the parent LO's training category status.
· The transcript search also supports searching for learning object(s) by pre-work and post-work titles. To search for a learning object by its associated pre-work, the pre-work must have been activated. Entering the title or a text string from the pre-work title will return the associated learning object(s) on the Active and Completed tab. Entering the pre-work string in the Search field on the Archived or Removed tab will NOT return the associated learning object(s). Similarly, if post-work is used and the post-work has been activated and the learning object is pending post-work or has been completed, entering the title of the post-work in the search box will display the learning object(s) associated with the post-work on the Active and Completed tab. Post-work searches on the Archived or Removed transcript tabs will NOT return the associated learning object(s).
To clear the search filter, click the Remove icon [image: ] in the Search for training field.
Hide Certified Certifications
This option is only available when viewing the Active training category and when certifications exist on the user's transcript.
When this option is selected, the transcript only displays incomplete certifications for the user. Any certifications in which the user is currently certified are hidden. If the LO Type filter is set to a specific training type other than certifications, then this option is not available.
Transcript Items
By default, new users do not have any training on their transcript until training is assigned, requested, or loaded to their transcript.
The following information is displayed for each training item in the transcript:
· Color Strip - The left edge of the LO is color coded to represent the proximity to the due date of the LO. For example, if the LO due date is past due, then the color strip is red to indicate that LO is due immediately. If a LO due date is not eminent, then the color strip is green to indicate that LO is not due immediately. See the Color Strip Key section below for additional information.
· LO icon - The icon that is displayed corresponds with the LO type (e.g., certification, curriculum, event, library, online course). Hover the computer cursor over the icon to view the LO type.
· LO title - When a user clicks the title of a training item on their transcript, they are navigated to an actionable page, which in most cases is the Learning Details page, where the user is allowed to launch and take other action on the training. See below for the different actionable pages to which the user may be directed, depending on the training type:
· Learning Details - The user will be directed to the Learning Details page when they click the title of any of the following training types from their transcript:
· Material
· Online course
· Test
· Video
· Posting
· Event
· Curriculum
· Certification
· Cohort
· Event Learning Details - The user will be directed to the Event Learning Details page with the Session flyout expanded if they click the title of a session from their transcript.
· External Content - The external content will launch when the user clicks the title of an external training item from their transcript.
· External Training - The user will still be directed to the Transcript Details page if they click the title of an external training item.
Note: For session LOs, the session start date is appended to the LO title (e.g., Session Title Starts 12/01/2014). If the session is configured to Display in User's Timezone, the session start time will appear in addition to the session start date and LO title.
Note: For curriculum LOs, the curriculum expiration date is appended to the LO title (e.g., Curriculum Title Expires on 12/01/2014).
· LO Due Date or Completion Date - For training that is active, archived, or removed, the LO due date is displayed, if available. For training that is completed, the LO completion date is displayed.
· Status - The LO status is displayed. Note: For SCORM 1.2 and 2004 online courses that have SSL security enabled, the Transcript page refreshes automatically to show the most up to date status.
· Training Type - This displays the type of training, such as Online Class, Material, etc.
· LO Expiration - For LO's that are associated with a subscription, an expiration date displays to the right of the Status field for transcript items.
· The expiration date is the date on which the training will no longer be available for the user to complete at no cost. The subscription will need to be renewed for the user to have access to the LO for no cost, or the user can alternatively purchase the training at this point.
· When an LO is available to a user in multiple subscriptions, the subscription with the latest date will apply.
· If the administrator edits the end date of the subscription at any point, a user who has already consumed the LO will maintain the settings that were active at the time of their consumption. The new dates will only apply to users who have not yet consumed the LO.
· Training Purpose - The training purpose only displays when training purpose is enabled for the transcript and if the LO has an associated training purpose.
· Actions drop-down - This drop-down enables users to perform actions on the LO. Click the left side of the drop-down to perform the displayed action. Or, click the drop-down arrow to select a secondary action. By default, the Action drop-down displays the primary action for the LO. See Transcript (Universal Profile) - Status and Options on page 477 for additional information.
· When a LO is inactive, "Inactive" appears as the first action in the Action drop-down menu. This option is not clickable. The only other option available in the Action drop-down menu is the View Details option, which opens the Training Details page.
Color Strip Key
The following colors are available:
· Red - Due today or past due
· Orange - Due within the next seven days, not including today
· Green - Due after seven days
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[bookmark: _Ref-1104160123]Certifications
[bookmark: concept178]Certification Item - Launch
Users can launch certifications from their transcript. 
To launch a certification, go to Learn > View My Transcript. Select the View Training Details option for the certification. In the Certification section, click the appropriate link to activate or launch the certification.
Note: Access to Certification Details from the transcript is controlled at the portal level, and is based on the Certification - User View security object. If the value is active, certifications are visible for all users of the portal. There is currently no permission that controls an individual user's ability to view their certifications via the transcript.
[image: ]
Observation Checklists within Certification
· To view an observation checklist that is part of a certification, users may be required to first request and register for the observation checklist.
· If an observation checklist is inside a curriculum that is part of the certification, then users must click the Manage link in the Options column for the curriculum. This opens either the Curriculum Details page or the Curriculum Player, depending on how the administrator configured the curriculum.
· Observation checklists that are part of a certification only recur if there are certification periods with recurrence configured. Further, the final completion date of the checklist is used to calculate the rules of the validity period.
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[bookmark: _Ref1247589686]External Training - Add to Certification from Details Page
From the Certification Details page, users can submit external training to fulfill a certification requirement. Users can also add external training to a certification from their Transcript. See External Training - Add to Certification from Transcript on page 426 for additional information.
The ability for users to submit external training is determined by the administrator during the certification creation. The User is allowed to submit external training option must be selected. If this option is not selected, users do not have the option to submit external training.
Add External Training to Certification
To add external training to the certification, click the Add External Training link in the Details section. The External Training pop-up appears. Enter the following information for the external training:
· Training Title - This title is displayed on the certification report as the training title. This field is limited to 200 characters.
· Language - The associated language for the training
· Training Description - The description of the training, which is visible to the administrator upon submission. This field is limited to 1000 characters.
· Institution - The institution associated with the training. This field is limited to 200 characters.
· Training Dates - The dates on which the training occurred.
· Apply Training to - Select the certification section to which the external training is applied. As an option, administrators may create an empty section titled External Training for the purpose of allowing users to complete and submit external training.
· Request Credits - Enter the number of credits you feel the external training is worth. The value must be an integer between 0 and 999. Administrators and certification owners can later modify this value upon review.
· Upload Attachment - To upload a supporting document related to the external training, including diplomas, transcripts, and certifications, click the Browse button and locate the file on your computer. One attachment is allowed and the maximum file size is 1 MB.
Click the Submit button to finalize the external training request. The request is submitted to the administrator or certification owner as a pending request. The Certification External Training Credit Submission Confirmation email is triggered, if enabled.
[image: ]
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[bookmark: _Ref1748023755][bookmark: _Ref1298675694]External Training - Add to Certification from Transcript
[bookmark: concept180]From the Certification Details page, users can submit external training from their transcript to fulfill a certification requirement.
The ability for users to submit external training is determined by the administrator during the certification creation. The User is allowed to submit external training option must be selected when the certification is created. If this option is not selected, users do not have the option to submit external training.
If a validity period is set for external training within the certification, then when adding external training to a certification from your transcript, you will only receive credit for external training that is completed within the external training validity period. The validity period can be set by the administrator who created the certification.
· The external training dates can be edited even after the training is added to the certification. If an update to the training date causes the training to be outside the validity period, the user does not receive credit for the training. Once the external training reaches a Completed status, the training dates applied at that time are set for the certification. Any changes to the external training afterward do not affect the certification.
To add external training to a certification from your transcript, go to Learning > View Your Transcript. Select the View Training Details option for the certification.
· In the upper section, click the Add External Training from Transcript link. This opens the Submit External Training from Transcript pop-up. Note: This link only appears if the Allow users to add external training option is selected when creating the certification.
[image: ]
Submit External Training from Transcript
The Submit External Training From Transcript pop-up only displays external training that can be added to the selected section within the certification. This applies to both training that is already a part of the section to which the user is adding external training and to training that is outside the validity period. However, the external training items that are outside the validity period appear in gray and cannot be added to the certification.
1. The Select a Section drop-down list includes all parent and child sections within the current period of the certification. Select the section to which you are adding the external training. This is required.
2. The list of training items displays all of the external training that is submitted through the transcript. The Status is pulled from the transcript status and the Credits values are pulled from the number of credits that were entered when the external training was added. Click the Select option to the left of the appropriate training items to add them to the certification. If you have submitted the external training in the selected area previously, the training cannot be selected.
3. In the Credits field to the right of the external training item, enter the number of credits that were earned for the item. 
4. Click OK to submit the training for approval. If multiple training items are selected, each item is submitted as a separate request to the certification owner, even though they are submitted at the same time.
An external training item can be submitted to multiple periods in different sections.
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[bookmark: _Ref1210706251][bookmark: concept181]Historical Certifications - Print
Historical certifications may be printed from the Transcript Details Page for the certification if allowed by the administrator.
To print a historical certification from prior periods, go to Learning > View Your Transcript. 
Select the View Training Details option for the certification. In the History section, click the Print Certificate link for the appropriate period.
[image: ]
Note: Depending on whether an administrator has configured a custom certificate for the system, either default or custom certificate will be printed. For information about configuring a custom certificate: See Certification Administration.
Revoked Certifications
When a user's certification is revoked, the Certification Transcript page reflects the Revoked status in the Status column. The Manage link is still available in the Options column, which directs the user to the Certification Details page. However, only the following options are available on the Certification Details page:
· View the details of a learning object
· Print certificates associated with previously completed certification periods
· View the Progress Report
· Archive the certification
In addition, certifications in a Revoked status do not proceed to renewal periods if renewal periods are associated with the certification.
If the user would like to become re-certified, they must re-request the certification or it must be reassigned. Note: The user must be removed from the certification by the certification owner before they can re-request the certification. When re-requested, the Approval History section displays the approval history data of all previous instances of the certification in the user's transcript, regardless of the number of times the certification has been revoked. Progress from the previous certification carries over to the new instance of the certification request/assignment if the learning objects are still valid. Further, the History section does not display for new instances of a certification that was in a Revoked status.
Note: The option to print certificates is not available for certification periods that are in a Revoked status.
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Training Details Page - Certification
From the Training Details Page for certifications, users can view and launch the training associated with the certification, view the certification history, and print any past certificates.
To view the Training Details Page for a certification, navigate to the Transcript and click the Certifications tab on the left navigation. Then, click the title of a certification. Note: This is not available if certifications are not enabled for the portal.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Certification - Update Credit
	Grants administrator ability to update the number of acquired credits on a user's certification progress report page. This also enables administrators or users to "certify" users by adjusting the number of credits received. This is an administrator permission.
	Learning - Administration



	Withdraw Users from Sessions
	Allows administrators and managers to withdraw users from sessions on their behalf. This is done from the user's Transcript page. Note: There is a setting in the Session Defaults for an event that may prevent users from being able to withdraw from sessions. When this option is selected, users, managers, and administrators are prevented from withdrawing from sessions for themselves or on behalf of other users. This permission can be constrained by OU, User's OU, User's Self and Subordinates, User, User's Subordinates, and User's Direct reports. This is a manager or administrator permission.
	Learning


[image: ]
Certification Details
In the Details section, view the details of the certification. Note: For portals with multiple languages enabled, the Current Period field displays in the language of the user viewing the Training Details page. If the user's language is not available, the field displays in the default language of the certification. The name and localization of this field is managed on the Scheduling step when creating, editing, or copying a certification. The value in the Certification Period Title field on the Configure Training Period pop-up displays in the Current Period on the Training Details page.
In the Certification section, the training associated with the certification is displayed. You can select the appropriate View option to view All Training, Activated Training, or Not Activated Training. By default, All Training is selected. Note: For certifications that are configured not to override the availability settings defined in Course Catalog for a LO, the only LOs that are visible to the user are the LOs for which the user meets the availability criteria defined in Course Catalog for the LO. See Create Certification - General for additional information.
Parent and child sections can be expanded or collapsed by using the Expand and Collapse icons to the left of the section title. By default, the parent section is expanded and the child section is collapsed.
For each training item, the following information displays:
· [bookmark: concept183]Title - The section of the certification displays, as well as the number of required and acquired credits. Each time a learning object within then section achieves a status of Completed, the number of credits acquired accumulates for both the parent and child sections. If a learning object has zero credits, the number of acquired credits does not change.
· The point at which credits accumulate in the parent section is dependent on the certification's configuration in Certification Administration. If the certification is configured to require users to complete the minimum number of credits for all child sections before the credits are counted toward the parent section, then credits only begin to accumulate in the parent section once the child sections have accumulated the minimum number of required credits. 
· Below the section, the title of the training item displays. Click the arrow to the left of the training title to view a description of the training item.
· Type - The training item type (e.g., online class, test, section, external training)
· Credits - The number of credits towards the certification that is granted for completing the training item. For portals with multiple languages enabled, the name of the Credits column appears in the language of the user viewing the Training Details page. If the user's language is not available, the column displays in the default language of the certification.Note: The name and localization of this column is managed on the General step when creating, editing, or copying a certification. The value in the Change tracking unit from credit to field displays as the column name on the Training Details page.
· Status - The current status of the training item. For users who are enrolled as certified, this is set to Not Activated.
If a user is in the Certified status for a certification, the system displays the due date and expiration date for the next certification period, if available.
You can manage the training items by selecting the appropriate option from the Options column. See Certification Item - Launch on page 422 for additional information. For administrators, if an observation checklist is added to a certification, you can validate the checklist by clicking the Validate Checklist link in the Options column. This opens the checklist and allows you to validate the items. If the checklist is part of a curriculum that is inside the certification, then click the Manage link in the Options column. This opens either the Curriculum Details page or the Curriculum Player, depending on how the administrator configured the curriculum.
Note: Administrators can also access the Validate Checklist link from the Training Details page of the checklist. Additionally, managers can validate a checklist if the checklist is configured by the administrator to allow managers to validate. Managers can access the checklist from either the Certification Details page or the Training Details page, but the link that appears is View Checklist instead of Validate Checklist.
To view the training details for an active training item, click the View Details icon in the Details column. This option is only available once the user is approved for the training item. Note: If the training was removed by an administrator, the user will receive a "Restricted Area" message, as removed training is inaccessible to end users.
To add external training to the certification, click the Add External Training link in the Details section. See External Training - Add to Certification from Details Page on page 424 for additional information.
To add an external training item to the certification that already exists on your transcript, click the Add External Training from Transcript link in the Details section. See External Training - Add to Certification from Transcript on page 426 for additional information.
Fields for Certifications in Certified Status
The following fields apply to certifications in a Certified status only. These fields do NOT apply to certifications in any other status, including the Certified (Renewal in Progress) status.
· The Current Period field displays the title of the certification period, along with the date the user completed the period requirements (dates will be shown in UTC time zone). 
· The Next Period field displays the title of the next certification period, along with the date the next period will begin (dates will be shown in UTC time zone).
· The Next Version field displays the certification version number the user will receive during the next certification period. 
· The Expiration Date field has been updated to Next Period Expiration Date, which indicates when the user's next certification period will expire (dates will be shown in UTC time zone).
· The Due Date field has been updated to Next Period Due Date, which displays the due date for the user's next certification period (dates will be shown in UTC time zone).
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History
The History section displays all of the past certification periods for the certification, if applicable. For each period, the following information displays:
· Period - The certification period number.
· Credits Required - The number of credits required for the period.
· Credits Acquired - The number of credits that were earned for the period.
· Carry Over - If carry over is allowed, this displays the number of credits that were carried over to the next period.
· Completion Date - The date the period was completed. For ILT sessions, the session completion date is used, rather than the roster upload date.
· Expiration - The date the certification period was completed. For Past Periods, the Expiration column will display the previous Period Completion Date.
Print Certificate
To print a past certificate, in the History section, click the Print Certificate link next to the appropriate certification. This option is only available if enabled by the administrator. See Historical Certifications - Print on page 428 for additional information.
Certification Requirements
If the certification you are viewing is also within another certification, a Certifications Requirement section displays the requirements for that certification.
Approval History
The certification approval history is displayed in the Approval History section. This includes all approvals related to the certification. If a user is enrolled as certified, this is displayed in this section. If comments were included when the certification was approved or denied, an indication is made here, as well as stating the type of request for which comments were provided (i.e., Initial, Completion, Exception, or Renewal request).
Modification History
For certifications with external training added, a Modification History section is available at the bottom of the Certification Training Details page. This section tracks all updates that are made to the certification. 
· If a training section or credits are updated, this is logged.
· If a field is updated, the specific field is logged, including the updated value.
· If multiple fields are updated, a line item is added for each change.
Approval or denial of external training towards the certification continues to be tracked in the Approval History section.
Revoke
To revoke a certification, click the Revoke button. When a user's certification is revoked, the Certification Transcript page reflects the Revoked status in the Status column. In addition, certifications in a Revoked status do not proceed to renewal periods if renewal periods are associated with the certification.
If the user would like to become re-certified, they must re-request the certification or it must be reassigned. Note: The user must be removed from the certification by the certification owner before they can re-request the certification. When re-requested, the Approval History section displays the approval history data of all previous instances of the certification in the user's transcript, regardless of the number of times the certification has been revoked. Progress from the previous certification carries over to the new instance of the certification request/assignment if the learning objects are still valid. Further, the History section does not display for new instances of a certification that was in a Revoked status.
Note: The option to print certificates is not available for certification periods that are in a Revoked status.
Place On Hold
From the Certification Details page, you can place a certification on hold by clicking the Place On Hold button. After clicking the Place On Hold button, a Certification On Hold pop-up window appears. In the pop-up, you can provide a comment explaining why the certification is being placed on hold in the Comments box. After entering a comment, click the Submit button to place the certification on hold. Note: Certifications in any transcript status can be placed on hold.
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When the user views the certification on their transcript, the status for the displays with "(On Hold)" following the status the certification was in prior to being placed on hold. For example, if the certification was in a Certified status prior to being placed on hold, when the certification has been placed on hold, the status reads, "Certified (On Hold)."
The "(On Hold)" addendum appears in any system location where the certification status may display, including:
· Transcript
· Certification Details
· Action steps
· Cohort
· Manage Employee Learning
· Certification Management
· Certification Approval page
Reinstate Certification
To reinstate a certification that is on hold, click the Reinstate button on the Certification Details page. A Reinstate Certification pop-up window appears. Enter a comment explaining the reinstatement in the Comments field, and click the Submit button.
The certification returns to its previous transcript status on the user's transcript page, and the reinstatement appears in the Approval History section of the Certification Details page along with the name of the user who reinstated the certification, the time stamp of the reinstatement, and any comments provided during the reinstatement process.
Progress Report
To view the progress report for the certification, click the Progress Report link in the upper-right corner of the page. You can then select the period from the drop-down list and print the report by clicking the Print icon. From the Progress Report, administrators with the appropriate permission can update the user's number of acquired credits. Note: Acquired credits can still be updated when the transcript lockdown feature is enabled. See the Transcript Lockdown section below for additional information.
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The following information displays for the report:
· Title - The certification title displays at the top of the report.
· Certification Period - This field displays the certification period. By default, the report shows the progress for the period the user is currently in.
· Options - The Options drop-down displays the option to print the report. Click the Print link to print the report.
· Period - This displays the certification period.
· Due - This displays when the certification is due.
· Relative Due Date - For certifications with a relative due date defined, the Due field displays the time frame from the start date (i.e., "2 days from start date," or "1 year from start date").
· Fixed Due Date - For certifications with a fixed due date defined, the Due field displays the actual date.
· Duration - This displays for renewal periods and shows the duration of the renewal period.
· Required Credits - This displays the number of credits required to be completed in order to complete the certification.
· Expand/Collapse - An Expand/Collapse option displays in the upper-right corner of the period. Click the icons to view or close the information in the period. By default, all certification periods are expanded.
· Requirements - This column displays the sections for the certification and lists the LOs defined for each section.
· If the certification is configured to override the Course Catalog LO availability settings, then all LOs display for the user regardless of whether or not the user meets the availability criteria for the LOs.
· If the certification is not configured to override the Course Catalog LO availability settings, then the only LOs that display are the LOs for which the user meets the availability criteria.
· LO Type - An icon displays to the left of each LO to indicate the LO type for the training item. Hover over the icon to view the name of the LO type.
· Earned - This column displays information about the credits earned for the certification. If the certification is configured not to override LO availability, then the number of credits is dependent upon the availability of the LOs in the certification.
· Min/Max - This displays the minimum and maximum number of credits to be completed for a section.
· Number of Credits - The number of credits defined for a LO displays in the Credits column for each LO.
Modify Period Expiration Date 
Only certification owners have the ability to adjust the end date or expiration date for the current certification period. For certification owners, an Edit icon appears to the right of the Expiration Date field. Modifying the expiration date for the period affects the renewal periods in the following manner:
· Fixed Date
· Only the current period is affected. All future periods retain their expiration date.
· The updated expiration date must occur prior to the due date of the subsequent period.
· Relative Date and Relative Date with Rolling Renewal
· If the expiration date for a period is changed, the expiration date and past due date for all future periods are updated based on the change. For example, if the expiration date is pushed back by three months, the expiration date and past due date for all subsequent periods is also pushed back by three months.
· There is no maximum adjustment for the expiration date.
· The Past Due date for the current period is not affected.
Transcript Lockdown
If the transcript lockdown functionality is enabled for the portal, then the data that is related to a learning object (LO) on the Certification Transcript Details page and the Progress Report is locked once the LO is completed. Once the LO is completed, the data on the Transcript Details page will not change for the LO. This applies even if the LO is moved to the Archived or Removed tabs of the transcript. This functionality applies to all LO types.
Note: The lockdown functionality does not include custom fields. Custom fields are not locked upon course completion.
Considerations
· If the Transcript Lockdown functionality is disabled and was not enabled at the time the user completed the LO, then the Transcript Details page and Progress Report display the LO information based on the current values in the Course Catalog.
· If the Transcript Lockdown functionality is enabled or was enabled at the time the user completed the LO, then the Transcript Details page and Progress Report always displays the LO information from the time the user completed the LO. 
· If the Transcript Lockdown functionality was disabled at the time the user completed the LO and was enabled after the user completed the LO, then the Transcript Details page and Progress Report displays the LO information from the time the Transcript Lockdown functionality is enabled.
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Transcript - Curriculum Subscriptions
When curriculum subscriptions are available, the transcript page is updated to reflect subscription options. Users can renew their curricula from their transcript.
The subscription options set in Curriculum Administration determine the expiration behavior and options available on the transcript:
· If subscription renewal is not available for a curriculum, when the curriculum expires, there is no renewal option. The curriculum remains Expired. Users must purchase a new instance of the curriculum in order to access the curriculum.
· If subscription renewal is available for a curriculum, but not automatic:
· The expiration date displays after the title.
· Once the curriculum expires, Renew Subscription is an option available in the Options column. Upon renewal, the expiration date is extended by a full subscription period, which is set in the LO Expiration Date. For example, if the LO expiration date is set to 120 days, when the LO is renewed, the expiration date is extended by 120 days.
· When the user clicks the Renew Subscription link, the LO is added to the shopping cart for the user to purchase.
· If you want to restart the curriculum and erase your progress, search for the LO using Global Search or Learning Search and purchase a new instance, provided that recurrence is available for the LO.
· If auto-renewal is set for a curriculum:
· The expiration date is displayed after the title and "Auto-Renew" is displayed after the expiration date.
· On the expiration date, the curriculum subscription is automatically renewed and the user is billed with the same payment method that was originally used.
· Auto-renewal can be turned on or off from the Transcript Details Page, which is reached by clicking the curriculum title.
· If auto-renew is turned off, "Auto-Renew" is no longer displayed after the expiration date and the Renew Subscription option appears in the Options column.
· If you want to restart the curriculum and erase your progress, search for the LO using Global Search or Learning Search and purchase a new instance, provided that recurrence is available for the LO.
Transcript - Events and Sessions
When a user navigates to the Transcript page, events on the transcript display with the Select Session option until a session is selected. However, when a session is selected, the event is no longer visible on the Transcript page. The session is still visible on the transcript.
The event training details can be viewed by selecting the View Training Details option for the session and then clicking the event title.
· If a user has completed multiple sessions for the same event, administrators and users can view all past sessions of an event on the event's Training Details page.
· The event's Training Details page displays all previous sessions that are in a status of Completed in addition to any current sessions for the user. Click the session locator number to view the Training Details page for the corresponding session.
Only the training details for the latest session are available directly from the transcript. All previous sessions must be viewed by navigating to the event's Training Details page from the session's Training Details page.
Workflow
1. A user requests or is assigned an event. The event appears on their transcript and the user can click the event title to open the event's Training Details page. The Select Session option is available.
2. The user selects a session in the event. The event is replaced with the session information on the Transcript page. The user must click the event title inside the session's Training Details page to view the event's Training Details page.
3. The user registers for an additional session in the same event. Both sessions that are requested appear on the user's transcript and both sessions are displayed on the event's Training Details page with the same event registration number (reg num).
4. The user completes one of the sessions in the event. The completed session moves to the Completed training status. The session that is still in a Registered status is still in the Active training status and is associated with the next sequential event reg num. Each completed session is also listed in the Assignment History section.
· The event reg num is dependent on the point in time that a session is moved to a status of Completed. This is independent of the session date and time. Thus, session dates and times may not be displayed in chronological order if they were not moved to a status of Completed in chronological order.
5. The user withdraws from a session. That session is listed on the event's Training Details page associated with the latest event reg num available. If another session is completed, this session moves with any others to the next sequential event reg num. Users can update the status of this session at any time by re-requesting the same session.
6. The user is denied from a session. That session is listed on the event's Training Details page associated with the latest event reg num available. If another session is completed, this session moves with any others to the next sequential event reg num.
7. If the user is waitlisted for a session, the session is listed on the event's Training Details page associated with the latest event reg num available. If another session is completed, this session moves with any others to the next sequential event reg num.
8. The user requests a session from within an event and completes it. The session is moved to the Completed training category and the event is no longer visible on the transcript. To view the event on the transcript, users must request it again or be assigned it again.
9. The user requests or is directly assigned a session. The session appears on their transcript and is moved to the Completed training category upon completion. No instance of the associated event is present in the Active training category. If additional sessions associated with the event to which the session belonged are assigned or requested, they are assigned the next sequential event reg num.
· If the session was directly registered and the event or another session associated with the same event was already on the user's transcript, this session is assigned the same event reg num as any other registered sessions or the next sequential event reg num if all other sessions associated with the same event are in the Completed training category.
Events within Curricula
If an event is included in a curriculum, the first completed session will be mapped to the event completion in the curriculum. If a user registers for multiple sessions, the first completed session will satisfy the event completion requirements within the curriculum.
The other session(s) will then be mapped to the next sequential reg num for the event, and will display as standalone on the user’s transcript.
Example:
Curriculum A contains
· Online Course 1
· Event X
· Material Y
A user is assigned Curriculum A and completes Online Course 1. He then registers for Session 1 and Session 2 under Event X. Both sessions are mapped to Event X reg num 1. The user then attends Sessions 1 and completes it, which completes Event X reg num 1 within the curriculum.
Session 2 will then display as standalone under Event X reg num 2. After the user completes Material Y, Curriculum A will be completed.
Recurrence Example:
If the event recurs or is assigned with the Assign New Occurrence option enabled, the progress will be reset within the curriculum.
Curriculum A contains
· Online Course 1
· Event X
· Material Y
A user is assigned Curriculum A and completes a session from Event X. If a learning assignment is processed to assign a new occurrence of Event X, the user will receive another registration of Event X and progress within the curriculum will be reset. This also applies if a manager directly assigns a new registration of Event X.
Universal Profile: 
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[bookmark: _Ref-659935014]Session - Register
When a user navigates to the Transcript page, event training items appear with the Select Session option until a session is selected. However, when a session is selected, the event is no longer visible on the Transcript page. The session is still visible in the Active training category.
To register for a session, go to Learning > View Your Transcript. Select the Select Session option for the session. Note: You are not listed in the roster for a session until you register for the session. The Select Session option does not display if the event is configured by the administrator to restrict users from selecting sessions. You can still view the details of the event by clicking the event title but cannot select a session. 
1. System automatically processes the registration and the Withdraw becomes available for the session.
2. The session status remains Registered until you attend the session, at which point it will chang to Completed.
3. After the registration start date, an administrator can still request a session for a user. For non-administrator users, however, registration will be closed.
Universal Profile: 
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Session - Withdraw
Users can withdraw from a session they are registered for via the Transcript page.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Withdraw Users from Sessions
	Allows administrators and managers to withdraw users from sessions on their behalf. This is done from the user's Transcript page. Note: There is a setting in the Session Defaults for an event that may prevent users from being able to withdraw from sessions. When this option is selected, users, managers, and administrators are prevented from withdrawing from sessions for themselves or on behalf of other users. This permission can be constrained by OU, User's OU, User's Self and Subordinates, User, User's Subordinates, and User's Direct reports. This is a manager or administrator permission.
	Learning


To withdraw from a session, go to Learning > View Your Transcript. Select the Withdraw option for the session. 
1. Select reason from drop-down list.
2. Enter comments.
3. Click Submit. If any Withdraw penalties exist, they are charged to the user. See Session Withdrawal Penalties on page 444 for additional information.
4. Status changes to Withdrawn and the Select Session option is available.
[image: ]
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[bookmark: _Ref1149374919]Session Withdrawal Penalties
Withdrawal penalties are charged in the following situations:
	Situation
	Penalty is Charged?

	User withdraws from a session (not inventory-assigned). There must be a transaction record at the time of the withdrawal. Note: If the session was never registered (user only requests session or is waitlisted), the withdrawal penalty is not charged.
	Yes

	User withdraws from a session that is part of an event within a curriculum, and a withdrawal penalty is configured for the session.
	Yes

	A session is removed from user's transcript by an administrator.
	No

	User's status becomes inactive in the system.
	No

	A session with Pending Requisite status is withdrawn when the session starts.
	Yes

	A session is substituted by the administrator.
	No

	Administrator removes user from the roster.
	Administrator can decide whether to charge the withdrawal penalty.

	An inventory-assigned session is withdrawn by user.
	No


External Training - Add Overview
External training allows users to capture training taken outside the system, such as conferences, external online courses, books, etc. on their learning transcript. 
External Training - Add from Transcript
Users with the related permission can add external training to their learning transcript.
[bookmark: concept190]To add external training to your transcript, go to Learning > View Your Transcript. Then, select the Add External Training option from the Options drop-down menu.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	External Training - Add
	Grants a user the ability to add or edit their own external training. When viewing another user's transcript, the user must also have permission to edit transcript items in order to add or edit the user's external training. This permission cannot be constrained. This is an end user permission.
	Learning


Clicking the Add External Training link opens the Add External Training page.
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The instructions and field names that appear on this page are configurable by the system administrator in Configure External Training Preferences. Also, the system administrator can configure which fields and options are available and required in Configure External Training Preferences. See Configure External Training by Division for additional information.
Populate the following fields for the external training.
· Language - Select language if applicable.
· Title - Enter the external training title.
· Training Description - Enter the training description.
· Provider/Institution - Enter the provider or institution providing the external training.
· Training Dates - Use the Calendar icon to select a training start date (From) and end date (To).
· Schedule - Enter a schedule.
· Cost - Enter a training cost.
· Credits - Enter the credits earned.
· Training Hours - Enter the number of training hours.
· Course Syllabus - Enter the course syllabus, if applicable.
· Attachments - Click the Attachments link to add attachments to the external training. Each attachment can be up to 1 MB in size, and a maximum of 15 attachments can be added to an external training. They are limited to ppt, pptx, doc, docx, pdf, jpg, jpeg, jpe, png, txt, gif, xls, xlsx, and rtf file types. After selecting the appropriate attachments, click the SAVE button to save the attachments to the review.
Click Submit to submit the form after all the required fields have been populated.
Troubleshooting
Upon clicking Submit, you may receive an error message next to a field, indicating that the value you entered in the field is not valid. This error occurs if an administrator has configured the field to only accept certain values. If the value you entered does not meet the criteria configured by the administrator, an error message displays. The value must re-entered and calculated as valid before the external training can be submitted successfully. Note: For portals with multiple languages enabled, the custom validation message appears in the user's display language, if available. If the user's language is not available, the error message appears in its default language.
Only one error message displays at a time. This means that if there are multiple invalid values, the error message displays for the first invalid value until the value in that field is valid. Once the value is valid and the Submit or Calculate button clicked, the error message for the next invalid field displays.
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NOTE: When loading a large set of External Training transcript records with Edge, there is a limit of two million records per portal.
SF-182 Form - Overview
When requesting external training, users can use the SF-182 request form if the functionality is available in the portal. 
To request SF-182 external training, select the Add SF-182 External Training option from the Options drop-down menu on the Transcript page.
When SF-182 functionality is available in the portal, the Add External Training option on the Transcript page is changed to Add Regular External Training. Also, an SF-182 filter option is available in the Training Type drop-down at the top of the transcript. When this is selected and the Search icon is clicked, only external training that was requested using the SF-182 request form displays. The results also display in-progress SF-182 requests.
Note: The Add SF-182 External Training and Add Regular External Training options must be configured in SF-182 Preferences in order for the links to display on the Transcript page.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Edit Transcript Items
	Grants ability to modify training due dates, statuses, and scores on other user's transcripts (training records) when viewing training details for particular learning objects on the transcript. User must also have permission to add external training in order to add or edit another user's external training. This permission can be constrained by OU, User's OU, User Self and Subordinates, User, and User's Self.
Note: Users with this permission also will also see the Add SF-128 link on the transcript.
	Learning - Administration



	SF-182 Administration
	Grants ability to view SF-182 requests for populations of users (based on constraints), approve SF-182 forms at any step of the process, and view the link for managing SF-182 specific vendors for their organization. (Governmental clients). This is an administrator permission.
	Limited Use/Obsolete



	SF-182 Requests - Manage
	Grants ability to view SF-182 requests for a population of users based on constraints.
If this permission is added to the dynamic Manager security role, the permission will automatically be constrained to self and subordinates. If the SF-182 approver is a manager and should not be constrained to just self and subordinates, please create a separate security role and add the SF-182 Requests Manage permission to that role with any needed constraints. 
	Limited Use/Obsolete



	User View “Add SF-182” link on Transcript
	Grants ability to view the "Add SF-182 External Training" link to complete the form for requesting an external course (Governmental clients). This is an end user permission.
Note: If a user does not have this permission but has the Edit Transcript Items permission, the Add SF-182 External Training link will also appear.
	Limited Use/Obsolete


Note: The Add SF-182 External option will appear if the user has any one or more of the above security permissions.
When using the SF-182 form to request external training, there are four steps to completing the form:
1. Training
2. Costs and Billing
3. Personal Details
4. Confirm
Form Instructions
To view instructions for completing the form, click the Download Instructions link in the upper-right corner of any step. Note: The Download Instructions link only appears if instructions are created by the administrator. If the link does not appear, then an instructions document is not available.
Required, Read-only, and Pre-configured Fields
Some fields may be required or read-only, depending on how the administrator has configured the form. In addition, some fields may already contain a default value that is configured by the administrator. Pre-configured fields may be editable or read-only, depending on how the administrator has configured the form. Note: An SF-182 request cannot be edited if the vendor is set to inactive.
In-Progress Forms
Forms that are in progress can be saved and completed at a later time. Only the Course Title field is required in order to save the form. Click Save at the bottom of any step to save the form. The form appears on your transcript under the course title with a status of Not Submitted.
To return to an in-progress form, select the Edit option on the Transcript page. This opens the form and allows you to continue completing it. Note: An SF-182 request cannot be edited if the vendor is set to inactive. To delete an in-progress form, select the Withdraw option on the Transcript page. This opens the Withdraw pop-up. Click Submit to delete the form from your transcript.
Status Workflow
When the user submits the form, the external training is added to their transcript. The following is the workflow of the status process once a form is submitted:
	User Action
	SF-182 Form Request Status
	External Training Transcript Status
	External Training Options Available On Transcript

	Saves SF-182
	Not Submitted
	Not Submitted
	Edit, Remove

	Submits SF-182 and SF-182 approvals are required
	Pending Approval Step "<current approval step no.>" (e.g., Pending Approval Step 3)
	Pending SF-182 Form Approval 
	None

	 Edits SF-182 that is currently pending approval
	Pending Approval Step "<current approval step no.>" (e.g., Pending Approval Step 3)
	Not Started
	Edit

	LO approval is also required for user
	Approved
	Pending Approval
	 

	LO approval denied
	Approved
	Denied
	None

	SF-182 approval denied
	Denied
	SF-182 Form Denied
	None

	Exempted
	Same status that the form had at the time of exemption
	Exempt
	None

	Gained all approvals for SF-182 and Register upon Approval is unchecked 
	Approved
	Approved
	Withdraw

	Gained all approvals for SF-182 and Register upon Approval is checked for portal 
	Approved
	Registered
	Withdraw

	User withdraws from training 
	Same status as the form was at the time of withdrawal
	Withdrawn
	None

	Training end date has passed
	Approved
	Registered
	Mark Complete

	User marks complete; External Training and Completion Approvals are required for user
	Approved
	Pending Completion Approval
	None

	Completion approval is granted or external training is completed
	Completed
	Completed
	None


Note: The Register Upon Approval option is configured in Default Approval Requirements (by Division) preferences.
Create SF-182 Request - Step 1 - Training
The Training step is the first step of the SF-182 request process, and it includes the following sections:
· Training Information
· Training and Vendor Location
· Advanced
Some fields may be pre-populated if enabled by the administrator in Configure External Training preferences. The following table shows which fields on the Training step may be pre-populated if their corresponding external training field is enabled by the administrator:
	External Training Field
	SF-182 Field

	Language
	N/A in SF-182. Use end user's language

	Title
	Course Title

	Training Description
	Training Objective

	Training Provider
	Name of Vendor

	Training Dates
	Start and End Date

	Schedule
	N/A

	Cost
	Total direct costs + Total indirect costs

	Credits earned
	Training Credit

	Training Hours
	Training Duty Hours + Training Non-duty hours

	Grade
	N/A

	Comments
	N/A


Training Information
· Course Title - Enter the course title, up to 400 characters.
· Course Number Code - Enter the course number code, up to 250 characters.
· Training Start Date - Enter the start date or click the Calendar icon to select a date from the calendar feature.
· Training End Date - Enter the end date or click the Calendar icon to select a date from the calendar feature.
· Training Duty Hours - Enter the number of duty hours.
· Training Non-Duty Hours - Enter the number of non-duty hours.
· Training Objective - Enter the objective or purpose of taking the training, up to 1000 characters.
Training and Vendor Location
· Name of Training Vendor - Click the Select icon to open the Choose a Vendor pop-up. Select a vendor by clicking the plus sign in the Add column next to the vendor name. This closes the Choose a Vendor pop-up and enters the vendor name in the field.
· Vendor Contact Information - Enter the vendor's street address, city, state, zip, phone number, and email address.
· Training Location Address - Check this option to indicate that the training is located at the same address as the vendor. This populates the address fields with the information in the Vendor Contact area. If the address is not the same, enter the street address, city, state, and zip.
Advanced
· Training Purpose Type Code
· Training Type Code
· Training Sub Type Code
· Training Delivery Type Code
· Training Designation Type Code
· Training Credit Type Code
· Training Credit
· Training Source Type Code
· Training Accreditation Indicator
· Continued Service Agreement Required - This indicates whether you are required to complete the Continued Service Agreement form, and this is configured by the administrator.
· If this option is set to Yes, you are required to download and complete the Continued Service Agreement form, and then attach the completed form to the request. Enter the form's expiration date in the Continued Service Agreement Expiration Date field. Note: The completed Continued Service Agreement form appears in the printable view of the request.
· If the Continued Service Agreement Required toggle is set to Yes and an attachment has not been included, the SF-182 printable form will display a value of Yes but the transcript view will display a value of No to indicate no form was attached.
· If the Continued Service Agreement Required toggle is set to Yes and an attachment has been included, the SF-182 printable form will display a value of Yes AND the transcript view will display a value of Yes.
· If this option is set to No, you are not required to complete the form or enter an expiration date.
· If the Continued Service Agreement Required toggle is set to No then it will display No on both the SF-182 printable form and the transcript view.
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· Click Cancel to cancel the form.
· Click Save to save the form without submitting it. Note: The Course Title field must be completed before you can save the form.
· Click Next to go to Step 2. See Create SF-182 Request - Step 2 - Costs and Billing on page 666 for additional information.
[bookmark: _Ref-1127446142]Create SF-182 Request - Step 2 - Costs and Billing
The Costs and Billing step is the second step of the SF-182 request process, and allows the user to enter cost information about the training. This step includes the following sections:
· Direct Cost and Appropriation/Fund Chargeable
· Indirect Cost and Appropriation/Fund Chargeable
· Other
Direct Cost and Appropriation/Fund Chargeable
To enter costs for tuition, fees, books, or materials:
1. Enter the tuition/fees and books/material costs in the Amount column. The total appears in the Total field at the bottom of the column.
2. Enter the fund information in the Appropriation Fund column. The system automatically calculates the total and populates it in the Total field at the bottom of the column.
Indirect Cost and Appropriation/Fund Chargeable
To enter related travel and per diem costs:
1. Enter the travel and per diem cost in the Amount column. The total appears in the Total field at the bottom of the column.
2. Enter the travel and per diem fund information in the Appropriation Fund column. The system automatically calculates the total and populates it in the Total field at the bottom of the column.
Other
Enter other relevant cost information, including:
· Total Training Non-Government Contribution Cost
· Document/Purchasing Order/Registration Number
· 8-Digit Station Symbol
· Billing Instructions - Enter billing instructions.
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· Click Back to return to Step 1.
· Click Cancel to cancel the form.
· Click Save to save the form without submitting it. Note: The Course Title field must be completed before you can save the form.
· Click Next to go to Step 3. See Create SF-182 Request - Step 3 - Personal Details on page 668 for additional information.
[bookmark: _Ref-453171403]Create SF-182 Request - Step 3 - Personal Details
The Personal Details step is the third step in the SF-182 request process, and it includes the following sections:
· Personal Information
· Advanced
Personal Information
In this section, enter your name and personal contact information, as well as work contact information.
Advanced
· Position Level - Select your position level from the drop-down menu.
· Position Title - Enter your job title.
· Special Accommodation - Use this option to indicate if special accommodations are needed. If Yes is selected, describe the accommodations in the text field.
Navigation
· Click Back to go to Step 2.
· Click Cancel to cancel the form.
· Click Save to save the form without submitting it. Note: The Course Title field must be completed before you can save the form.
· Click Next to go to Step 4. See Create SF-182 Request - Step 4 - Confirm on page 669 for additional information.
[bookmark: _Ref-2136694556]Create SF-182 Request - Step 4 - Confirm
The Confirm step is the fourth and final step of the SF-182 request process, and allows the user to review the request for accuracy and submit the request.
Review the information entered on each step and click Submit. This triggers the SF-182 Form Submitted email, if enabled. Once submitted, the SF-182 request is added to your transcript. If the form requires approval, the status of the form is Pending Approval <Current Approval Step>. Note: The approval step is dependent upon the current step in the approval process.
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· Click Back to go to Step 3.
· Click Cancel to cancel the form.
· Click Save to save the form without submitting it. Note: The Course Title field must be completed before you can save the form.
[bookmark: _Ref467001576]SF-182 Form - Overview
When requesting external training, users can use the SF-182 request form if the functionality is available in the portal. 
To request SF-182 external training, select the Add SF-182 External Training option from the Options drop-down menu on the Transcript page.
When SF-182 functionality is available in the portal, the Add External Training option on the Transcript page is changed to Add Regular External Training. Also, an SF-182 filter option is available in the Training Type drop-down at the top of the transcript. When this is selected and the Search icon is clicked, only external training that was requested using the SF-182 request form displays. The results also display in-progress SF-182 requests.
Note: The Add SF-182 External Training and Add Regular External Training options must be configured in SF-182 Preferences in order for the links to display on the Transcript page.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Edit Transcript Items
	Grants ability to modify training due dates, statuses, and scores on other user's transcripts (training records) when viewing training details for particular learning objects on the transcript. User must also have permission to add external training in order to add or edit another user's external training. This permission can be constrained by OU, User's OU, User Self and Subordinates, User, and User's Self.
Note: Users with this permission also will also see the Add SF-128 link on the transcript.
	Learning - Administration



	SF-182 Administration
	Grants ability to view SF-182 requests for populations of users (based on constraints), approve SF-182 forms at any step of the process, and view the link for managing SF-182 specific vendors for their organization. (Governmental clients). This is an administrator permission.
	Limited Use/Obsolete



	SF-182 Requests - Manage
	Grants ability to view SF-182 requests for a population of users based on constraints.
If this permission is added to the dynamic Manager security role, the permission will automatically be constrained to self and subordinates. If the SF-182 approver is a manager and should not be constrained to just self and subordinates, please create a separate security role and add the SF-182 Requests Manage permission to that role with any needed constraints. 
	Limited Use/Obsolete



	User View “Add SF-182” link on Transcript
	Grants ability to view the "Add SF-182 External Training" link to complete the form for requesting an external course (Governmental clients). This is an end user permission.
Note: If a user does not have this permission but has the Edit Transcript Items permission, the Add SF-182 External Training link will also appear.
	Limited Use/Obsolete


Note: The Add SF-182 External option will appear if the user has any one or more of the above security permissions.
When using the SF-182 form to request external training, there are four steps to completing the form:
1. Training
2. Costs and Billing
3. Personal Details
4. Confirm
Form Instructions
To view instructions for completing the form, click the Download Instructions link in the upper-right corner of any step. Note: The Download Instructions link only appears if instructions are created by the administrator. If the link does not appear, then an instructions document is not available.
Required, Read-only, and Pre-configured Fields
Some fields may be required or read-only, depending on how the administrator has configured the form. In addition, some fields may already contain a default value that is configured by the administrator. Pre-configured fields may be editable or read-only, depending on how the administrator has configured the form. Note: An SF-182 request cannot be edited if the vendor is set to inactive.
In-Progress Forms
Forms that are in progress can be saved and completed at a later time. Only the Course Title field is required in order to save the form. Click Save at the bottom of any step to save the form. The form appears on your transcript under the course title with a status of Not Submitted.
To return to an in-progress form, select the Edit option on the Transcript page. This opens the form and allows you to continue completing it. Note: An SF-182 request cannot be edited if the vendor is set to inactive. To delete an in-progress form, select the Withdraw option on the Transcript page. This opens the Withdraw pop-up. Click Submit to delete the form from your transcript.
Status Workflow
When the user submits the form, the external training is added to their transcript. The following is the workflow of the status process once a form is submitted:
	User Action
	SF-182 Form Request Status
	External Training Transcript Status
	External Training Options Available On Transcript

	Saves SF-182
	Not Submitted
	Not Submitted
	Edit, Remove

	Submits SF-182 and SF-182 approvals are required
	Pending Approval Step "<current approval step no.>" (e.g., Pending Approval Step 3)
	Pending SF-182 Form Approval 
	None

	 Edits SF-182 that is currently pending approval
	Pending Approval Step "<current approval step no.>" (e.g., Pending Approval Step 3)
	Not Started
	Edit

	LO approval is also required for user
	Approved
	Pending Approval
	 

	LO approval denied
	Approved
	Denied
	None

	SF-182 approval denied
	Denied
	SF-182 Form Denied
	None

	Exempted
	Same status that the form had at the time of exemption
	Exempt
	None

	Gained all approvals for SF-182 and Register upon Approval is unchecked 
	Approved
	Approved
	Withdraw

	Gained all approvals for SF-182 and Register upon Approval is checked for portal 
	Approved
	Registered
	Withdraw

	User withdraws from training 
	Same status as the form was at the time of withdrawal
	Withdrawn
	None

	Training end date has passed
	Approved
	Registered
	Mark Complete

	User marks complete; External Training and Completion Approvals are required for user
	Approved
	Pending Completion Approval
	None

	Completion approval is granted or external training is completed
	Completed
	Completed
	None


Note: The Register Upon Approval option is configured in Default Approval Requirements (by Division) preferences.
Universal Profile: 
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External Training Request - Mark Complete
To mark an external training item complete, go to Learning > View Your Transcript. 
Once the external training is approved and the external training date has passed, a Mark Complete option is available for the external training. Select the Mark Complete option for the external training.
If the Grade and Submitted Paperwork options are enabled by the administrator, you are prompted to provide responses for these fields on a separate page after the external training is marked complete.
1. Grade - If applicable, Enter the grade that was earned for this external training, up to 100 characters.
2. Submitted Paperwork - Select whether or not paperwork has been submitted for the external training.
If external training required completion approval by your approver, status will be Pending Completion Approval until your manager or approver approves completion. Upon approval, the training status will be Completed.
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[bookmark: _Ref-1711473411]Library - Manage
The Library training type will be deprecated with the November 2022 release!
A library is a collection of online courses. A user can manage a library assigned to them via their transcript. 
[bookmark: concept198]To manage a training library, go to Learning > View Your Transcript. Then, select the Manage option for the library to review the library training details.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	View Transcript Item
	Grants ability to view details of learning objects that appear on the transcript (training record), by clicking on the name of the learning object. Users must also have the Bio About - View permission in order to access the transcript within Universal Profile. This permission can be constrained by OU, User's OU, User Self and Subordinates, User, or User's Self. This is an end user permission.
	Learning - Administration


To search for a specific item in the library, enter key words in the Search field, and click the Search button.
1. View the Search results and locate the appropriate training within the library.
2. Click the Expand icon [image: ] to see the course description.
The following options may be available in the Options column:
· Activate - Click to activate a specific training course in the library. Note: If a training item within a library is already activated outside the library, the Activate link does not work. If you experience the Activate link not working within a library, search for the training item on your transcript and access it directly.
· Register - Click to register for the course in the library.
· Launch - Click to launch the course within the library.
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[bookmark: _Ref-336011842][bookmark: _Ref1216339647]Network Player Transcript Options
If the Network Player is enabled and if an online course has been downloaded to a local network, users have the option to launch the course locally or online from their transcript.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Local Network Player - Launch Courses Offline Through the Network Player
	Enables users to see the Launch Locally link on their transcript for courses that have been downloaded and can be launched through the local network. This permission cannot be constrained. This permission is recommended for end users of the LMS.
	Learning



	Local Network Player - File Download Link - View
	Grants access to the Download Network Player link in Course Catalog and on the Transcript. Users must also have permission to access the Course Catalog. This permission cannot be constrained. This permission is recommended for local trainers who deliver course content remotely. This is an end user and local trainer permission. If the user no longer needs to view the download link after installation, this permission can be removed for those users.
	Learning


Download Network Player
The Download Network Player option appears in the Options drop-down menu for users who have permission to download the local network course player.
Launch Locally and Launch Online
The Launch Locally and Launch Online options appear for an online course if the following is true:
· The user has permission to launch courses offline via the Network Player.
· The course is a SCORM 1.2 or SCORM 2004 course that was tagged as available for download when it was published.
· At least one course network path was set for the user's organizational unit (OU).
· The Launch Locally option is only available if the course is already downloaded to at least one network path that was set for the user's OU.
Users can click the Launch Online option to launch the course online or the Launch Locally option to launch the course from the local network. When the Launch Locally option is clicked, the system verifies that the course exists on a local network using the network paths set by the administrator in Set Network Player Download Paths preferences.
· If the course does not exist on a local network, an error message is displayed, indicating that the course can only be launched online.
· If the course does exist on a local network, the system then checks to see if the local network player is installed on the user's computer.
· If the local network player is installed, then the course is launched in the player from the local network.
· If the local network player is not installed, then the user is not able to launch the course. The user can save the course file to their computer, which can be launched after the local network player is installed, provided that the user is still authenticated within the system.
After the course is launched locally and the user closes or completes the course, the network player submits the appropriate user progress information back to the system.
If the online version of the course is out of sync with the downloaded version of the course, then a warning icon is displayed to the left of the Launch Locally option. Users can hover the mouse over the icon to view the warning message, which alerts the user that they should launch the online version of the course. The Warning icon appears if new course files are uploaded or if the course is modified in Course Publisher or Course Builder.
Launch
If the course is not available offline or if the user does not have permission to launch courses offline, then the Launch option appears, as the functionally previously existed.
Observation History
The Observation Attempts History page displays various read-only information about previously recorded On the Job Training (OJT) completion attempts. It is accessible to both users and associated observers. 
A View link is available on the Transcript Details page for OJT items, which allows users to view any previous completion attempts for the OJT item. This link becomes available for the OJT item after the user has made at least one completion attempt, if the user has the appropriate permission. Click the View link to access the Observation Attempts History page.
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Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	On the Job Training - Observation History From Transcript
	Grants access for users to view On the Job Training Observation History from Transcript Details. This permission cannot be constrained. This is an end user permission.
	Learning - Administration
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Observation History
The header of the Observation History page contains the following information:
· Profile Photo - The evaluated user’s profile photo
· Name - The evaluated user’s full name
· Training Name - The title of the attempted OJT
· Completed - The date the OJT was marked complete
· Score - The numeric score awarded for the user’s OJT attempt (if provided)
Each individual OJT completion attempt displays below the Observation History page header, from most recent to least recent. If provided by the observer at the time the attempt record was submitted, the following information displays for each attempt:
· Result - Displays whether the observer marked the user as Completed or as Failed for the observation attempt
· Date - The date the user's OJT attempt was recorded
· Training Hours - The number of training hours earned through the completion of the OJT, if applicable
· Score - Displays the numeric score the user achieved on the OJT, if applicable
· Comment - Any comments regarding the OJT completion attempt, if provided by the observer
· Attachments - Any attachments related to the OJT completion attempt, if uploaded by the observer
Close
To exit the Observation Attempts History page, click the Close button.
[bookmark: _Ref2001563606]Transcript - Print Transcript Pop-up
Users are able to print their transcript from the Universal Profile - Transcript page. To print the transcript from the Universal Profile - Transcript page, select the Print Transcript option from the Options drop-down menu.
At the top of the pop-up, the training category that is selected on the Transcript page is displayed (e.g., Active, Completed, Archived), along with the user's name.
The following information displays for each learning object (LO):
· Title - This displays the full LO title.
· Type - This displays the LO type. If the LO is a posting, the specific posting type displays. If the LO is a material, the specific material category displays.
· Due Date - This displays the LO due date. If no due date is configured, "None" displays. When printing the Completed training category, this is not included.
· Completion Date - This displays the LO completion date. This is only included when printing the Completed training category.
· Score - This displays the LO score for tests and online courses, if available. This column is blank if no score is available.
· Status - This displays the LO status.
The transcript items are sorted in the same manner they were sorted on the Transcript page when the Print Transcript option was selected.
To print the transcript, click the Print button. Or, click Cancel to return to the Universal Profile - Transcript page. See Universal Profile - Transcript Overview on page 411 for additional information.
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[bookmark: _Ref846261609][bookmark: _Ref1944028386]Transcript (Universal Profile) - Status and Options
The transcript contains numerous statuses and options, which are automatically updated as a result of user, manager, and administrator actions, and based on the type of learning object (LO). See Transcript - Curriculum Subscriptions to view how the transcript behaves when curriculum subscriptions are enabled.
Course Status Update
The automation of the system enables course statuses and options to be automatically updated. For example:
· When a manager approves a course:
· The transcript status is automatically changed to Approved.
· The transcript option changes to allow the user to register.
·  When you register for a course:
· The status changes to Registered.
· A Launch option is available if the LO is an online course.
Course Troubleshooting Guide
In certain cases, users may have issues receiving a Completed status for their online course even if they have launched the course and completed the assessment within the course. See Course Troubleshooting Guide on page 585 for additional information.
Training Statuses
When a LO is inactive, "Inactive" appears as the first action in the Action drop-down menu. This option is not clickable. The only other option available in the Action drop-down menu is the View Details option, which opens the Training Details page. 
The following statuses and options are available for each LO type on the Universal Profile - Transcript page:
Cohort
	Status
	Options

	Approved
	Register

	
	View Training Details

	Approved / Past Due
	Register

	
	View Training Details

	Completed
	View Training Details

	
	View Certificate

	Completion Approval Denied
	Request Completion Approval

	
	View Training Details

	Completion Approval Denied / Past Due
	Request Completion Approval

	
	View Training Details

	Denied
	Request Again

	
	View Training Details

	Denied / Past Due
	Request Again

	
	View Training Details

	Exempt
	View Training Details

	
	Launch

	Inactive
	View Training Details

	In Progress
	Launch - When a cohort LO is launched, the Main tab of the cohort community is opened. See Cohort Community - Main for additional information.

	
	View Training Details

	In Progress / Past Due
	Launch - When a cohort LO is launched, the Main tab of the cohort community is opened. See Cohort Community - Main for additional information.

	
	View Training Details

	Pending Acknowledgment
	Acknowledge

	
	View Training Details

	Pending Acknowledgment / Past Due
	Acknowledge 

	
	View Training Details

	Pending Approval
	View Training Details

	Pending Approval / Past Due
	View Training Details

	Pending Completion Approval
	View Training Details

	Pending Completion Approval / Past Due
	View Training Details

	Pending Completion Signature
	Sign 

	
	View Training Details

	Registered
	None

	
	View Training Details

	Registered / Past Due
	None

	
	View Training Details


Curriculum
	Status
	Options

	Approved
	Register

	
	Manage

	
	Renew License

	Completed
	Subscription Renew

	
	Open

	
	Renew License

	
	Evaluate

	
	View Details

	
	View Certificate

	Completed Equivalent
	Manage

	
	Evaluate

	
	Subscription Renew

	
	Renew License

	Completion Approval Denied
	Manage

	
	Request Completion Approval

	Denied
	Request Again

	
	Renew License

	Exempt
	View Completion Page

	
	View Training Details

	Expired
	Subscription Renew

	
	Renew License

	In Progress
	Manage

	
	Subscription Renew

	
	Evaluate

	
	Renew License

	Not Activated
	Activate - This option is available if the administrator does not check the Auto-Register option when configuring the LO within the curriculum.

	Payment Denied
	Repurchase

	Payment Refunded
	Repurchase

	Pending
	Manage

	
	Renew License

	Pending Acknowledgment
	Acknowledge

	
	Manage

	
	Subscription Renew

	
	Renew License

	Pending Completion Approval
	Manage

	
	Renew License

	Pending Completion Signature
	Sign

	
	Subscription Renew

	
	Manage

	
	Renew License

	
	Evaluate

	Pending Evaluation
	Manage

	
	Evaluate

	
	Subscription Renew

	
	Renew License

	
	View Details

	Pending Payment
	Manage

	Pending Post Work
	Manage

	
	Subscription Renew

	
	Renew License

	Pending Prerequisite
	Manage

	
	Subscription Renew

	
	Renew License

	Registered
	Manage

	
	Subscription Renew

	
	Renew License

	
	Evaluate

	Registered Not Available
	Manage

	
	Evaluate

	
	Renew License


Event
	Status
	Options

	Approved
	Select Session

	
	Evaluate

	
	Manage

	
	Renew License

	Denied
	Request Again

	
	Renew License

	Exempt
	View Training Details

	Not Started
	Select Session

	
	Evaluate

	
	Renew License

	Payment Denied
	Repurchase

	Payment Refunded
	Repurchase

	Pending Acknowledgment
	Acknowledge

	
	Evaluate

	
	Renew License

	Pending Completion Signature
	Sign

	
	Manage

	
	Renew License

	
	Evaluate

	Pending Evaluation
	Renew License

	
	Evaluate


External Training
	Status
	Options

	Approved
	Register

	
	Renew License

	Completion Approval Denied
	Request Completion

	Denied
	Renew License

	Exempt
	View Training Details

	Not Started
	SF-182 Edit

	
	SF-182 Remove

	Payment Denied
	Repurchase

	Payment Refunded
	Repurchase

	Pending Completion Signature
	Sign

	
	Renew License

	Registered
	Withdraw

	
	Mark Complete

	
	Renew License


File
	Status
	Options

	Approved
	Register

	
	Renew License

	Exempt
	View Training Details

	In Progress
	Launch

	
	Mark Complete

	
	Renew License

	Pending Completion Signature
	Sign

	
	Launch

	
	Renew License

	Registered
	Launch

	
	Mark Complete

	
	Renew License


Library
	Status
	Options

	Approved
	Register

	
	Manage

	
	Renew License

	Completion Approval Denied
	Manage

	
	Request Completion Approval

	Denied
	Request Again

	
	Renew License

	Exempt
	View Completion Page

	
	View Training Details

	In Progress
	Manage

	
	Evaluate

	
	Renew License

	Payment Denied
	Repurchase

	Payment Refunded
	Repurchase

	Pending
	Manage

	
	Renew License

	Pending Acknowledgment
	Acknowledge

	
	Manage

	
	Renew License

	Pending Completion Approval
	Renew License

	Pending Completion Signature
	Sign

	
	Manage

	
	Renew License

	
	Evaluate

	Pending Evaluation
	Launch

	
	Manage - See Library - Manage on page 468 for additional information.

	
	Renew License

	
	Evaluate

	
	View Details

	Pending Payment
	Manage

	
	Renew License

	Pending Prerequisite
	Manage

	
	Renew License

	Registered
	Manage

	
	Renew License

	
	Evaluate

	Registered Not Available
	Manage

	
	Evaluate

	
	Renew License


Material
	Status
	Options

	Approved
	Register

	
	Manage

	
	Renew License

	Completed
	Launch

	
	Manage

	
	Evaluate

	
	View Details

	
	View Certificate

	Completion Approval Denied
	Manage

	
	Request Completion Approval

	Denied
	Manage

	
	Renew License

	Exempt
	View Completion Page

	
	View Training Details

	In Progress
	Launch

	
	Manage

	
	Upload and Verify

	
	Mark Complete

	
	Renew License

	Payment Denied
	Repurchase

	Payment Refunded
	Repurchase

	Pending
	Manage

	
	Renew License

	Pending Acknowledgment
	Launch

	
	Acknowledge

	
	Manage

	
	Renew License

	Pending Completion Approval
	Launch

	
	Manage

	
	Evaluate

	
	Renew License

	
	View Details

	Pending Completion Signature
	Sign

	
	Manage

	
	Renew License

	
	Evaluate

	Pending Evaluation
	Launch

	
	Manage

	
	Renew License

	
	Evaluate

	
	View Details

	Pending Payment
	Manage

	
	Renew License

	Pending Post Work
	View Post Work

	
	Launch

	
	Manage

	
	Renew License

	Pending Prerequisite
	View Prerequisite

	
	Renew License

	Pending Prework
	View Prework

	Registered
	Launch

	
	Mark Complete

	
	Manage

	
	Renew License

	
	Evaluate

	Registered Not Available
	Manage

	
	Evaluate

	
	Renew License


Online Course
	Status
	Options

	Approved
	Register

	
	Manage

	
	Renew License

	Completed
	Launch Locally

	
	Launch

	
	Manage

	
	Renew License

	
	Evaluate

	
	View Details

	
	View Certificate

	Completed Equivalent
	 

	
	 

	
	Manage

	
	Renew License

	
	Evaluate

	Completion Approval Denied
	Request Completion Approval

	
	Manage

	Denied
	Request Again

	
	Manage

	
	Renew License

	Exempt
	View Completion Page

	
	View Training Details

	Failed
	Retake Test

	
	Renew License

	In Progress
	Launch Locally

	
	Launch

	
	Unlock

	
	Manage

	
	Renew License

	Payment Denied
	Repurchase

	Payment Refunded
	Repurchase

	Pending
	Manage

	
	Renew License

	Pending Acknowledgment
	Launch Locally

	
	Launch

	
	Acknowledge

	
	Manage

	
	Evaluate

	
	Renew License

	Pending Completion Approval
	Launch Locally

	
	Launch

	
	Manage

	
	Renew License

	
	Evaluate

	
	View Details

	Pending Completion Signature
	Launch Locally

	
	Launch

	
	Sign

	
	Manage

	
	Renew License

	
	Evaluate

	
	View Details

	Pending Evaluation
	Launch Locally

	
	Launch

	
	Manage

	
	Renew License

	
	Evaluate

	
	View Details

	Pending Payment
	Manage

	
	Renew License

	Pending Post Work
	View Post Work

	
	Launch Locally

	
	Launch

	
	Manage

	
	Renew License

	Pending Prerequisite
	View Prerequisite

	
	Renew License

	Pending Prework
	View Prework

	Registered
	Launch Locally

	
	Launch

	
	Unlock

	
	Manage

	
	Renew License

	
	Evaluate

	Registered Not Available
	Manage

	
	Evaluate

	
	Renew License


Note: The Failed status can be enabled by contacting Global Customer Support. If not activated, a failed Online Content displays "In Progress" status.
Quick Course
	Status
	Options

	Approved
	Register

	
	Manage

	
	Renew License

	Completed
	Launch

	
	Manage

	
	View Certificate

	Completion Approval Denied
	Manage

	
	Request Completion Approval

	Denied
	Request Again

	
	Manage

	
	Renew License

	Exempt
	View Completion Page

	
	View Training Details

	In Progress
	Launch

	
	Manage

	
	Renew License

	Payment Denied
	Repurchase

	Payment Refunded
	Repurchase

	Pending
	Manage

	
	Renew License

	Pending Acknowledgment
	Launch

	
	Acknowledge

	
	Manage

	
	Renew License

	Pending Completion Approval
	Launch

	
	Manage

	
	Renew License

	Pending Completion Signature
	Launch

	
	Sign

	
	Manage

	
	Renew License

	
	Evaluate

	Pending Evaluation
	Launch

	
	Manage

	
	Renew License

	
	Evaluate

	Pending Payment
	Manage

	
	Renew License

	Pending Post Work
	View Post Work

	
	Launch

	
	Manage

	
	Renew License

	Pending Prerequisite
	View Prerequisite

	
	Renew License

	Pending Prework
	View Prework

	Registered
	Launch

	
	Manage

	
	Renew License

	
	Evaluate

	Registered Not Available
	Manage

	
	Evaluate

	
	Renew License


Session
Evaluation Availability: With most learning objects (LOs), the evaluation is available to the user after the LO is completed. However, when an evaluation is used with an event session, the evaluation is only available to the user at the session start time. In the case of a multi-part session, the evaluation is only available at the session start time of the final part.
For troubleshooting information regarding Level 1 evaluations: See Troubleshooting Guide - Level 1 Evaluations. 
	Status
	Options

	Approved
	Register

	
	Withdraw

	
	Renew License

	
	View Details

	Canceled
	Select Session

	
	Renew License

	Completion Approval Denied
	Request Completion Approval

	
	Manage

	Denied
	Select Session

	
	Renew License

	Exception Requested
	Withdraw

	
	Renew License

	
	View Details

	Exempt
	View Completion Page

	
	View Training Details

	In Progress
	Withdraw

	
	Manage

	
	Launch WebCast Session

	
	Renew License

	
	Evaluate

	
	View Details

	No Show
	Select Session

	
	Renew License

	Payment Denied
	Repurchase

	Payment Refunded
	Repurchase

	Pending
	Withdraw

	
	Manage

	
	Renew License

	
	View Details

	Pending Acknowledgment
	Evaluate

	
	Acknowledge

	
	Manage

	
	Renew License

	Pending Completion Approval
	Manage

	
	Renew License

	Pending Completion Signature
	Sign

	
	Manage

	
	Renew License

	
	Evaluate

	Pending Evaluation
	Manage

	
	Renew License

	
	Evaluate

	Pending Payment
	Manage

	Pending Pre-work
	View Pre-work

	Pending Post-work
	View Post-work

	
	Renew License

	Pending Prerequisite
	Manage

	
	Withdraw

	
	Renew License

	Pending Prework
	View Prework

	Registered
	View Training Details

	
	Withdraw

	
	Manage

	
	Launch WebCast Session

	
	Renew License

	
	Evaluate

	Registered Not Available
	Manage

	
	Evaluate

	
	Renew License

	Registration Pending
	Register

	
	Withdraw

	
	Renew License

	
	View Details

	Waitlisted
	Withdraw

	
	Renew License

	
	View Details

	Waitlist Expired
	Register

	
	Select Session

	
	Renew License

	Withdrawn
	Select Session

	
	Renew License


Test
	Status
	Options

	Approved
	Register

	
	Manage

	
	Renew License

	Completed
	Review

	
	Renew License

	
	Manage

	
	Evaluate

	
	View Certificate

	Completion Approval Denied
	Manage

	
	Request Completion Approval

	Denied
	Request Again

	
	Renew License

	Exempt
	View Completion Page

	
	View Training Details

	Failed
	Retake Test

	
	Renew License

	In Progress
	Take Test

	
	Manage

	
	Renew License

	Payment Denied
	Repurchase

	Payment Refunded
	Repurchase

	Pending
	Manage

	
	Renew License

	Pending Acknowledgment
	Acknowledge

	
	Manage

	
	Renew License

	Pending Completion Approval
	Manage

	
	Renew License

	Pending Completion Signature
	Sign

	
	Manage

	
	Renew License

	
	Evaluate

	Pending Evaluation
	Manage

	
	Renew License

	
	Evaluate

	Pending Payment
	Manage

	
	Renew License

	Pending Post Work
	View Post Work

	
	Renew License

	Pending Prerequisite
	View Prerequisite

	Pending Prework
	View Prework

	Registered
	Take Test

	
	Manage

	
	Renew License

	
	Evaluate

	Registered Not Available
	Manage

	
	Evaluate

	
	Renew License


Video
	Status
	Options

	Approved
	Register

	
	Renew License

	Completed
	Launch Video

	
	Manage

	
	Renew License

	
	Evaluate

	
	View Details

	
	View Certificate

	Completed Equivalent
	Manage

	
	Evaluate

	
	Launch Video

	
	Renew License

	Completion Approval Denied
	Manage

	
	Request Completion Approval

	Denied
	Request Again

	
	Renew License

	Exempt
	View Completion Page

	
	View Training Details

	Payment Denied
	Repurchase

	Payment Refunded
	Repurchase

	Pending
	Manage

	
	Renew License

	Pending Acknowledgment
	Launch Video

	
	Manage

	
	Acknowledge

	
	Renew License

	Pending Completion Approval
	Launch Video

	
	Manage

	
	Renew License

	Pending Completion Signature
	Launch Video

	
	Sign

	
	Manage

	
	Renew License

	
	Evaluate

	Pending Evaluation
	Launch Video

	
	Manage

	
	Renew License

	
	Evaluate

	
	View Details

	Pending Payment
	Manage

	Pending Prerequisite
	View Prerequisite

	
	Renew License

	Pending Prework
	View Prework

	Registered
	Launch Video

	
	Mark Complete

	
	Manage

	
	Renew License

	
	Evaluate

	Registered Not Available
	Manage

	
	Evaluate

	
	Renew License


[bookmark: _Ref-447376920]Transcript - Training Category Statuses
The Transcript page can be filtered by training category. The following categories are available: Active, Completed, Archived, and Removed.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Remove Training
	Grants ability to remove training from other users' transcripts (training records) when viewing their transcript. This permission can be constrained by OU, User's OU, User's Corporation, User Self and Subordinates, User's Self, User's Direct Subordinates, and User. This is an administrator permission.
	Learning - Administration


Active
The Active category displays training items that are in the following statuses and do not qualify for the Completed, Archived, or Removed category:
· Approved
· Approved/Past Due
· Cancelled
· Canceled/Past Due
· Completion Approval Denied
· Completion Approval Denied/Past Due
· Denied
· Denied/Past Due
· Discontinued
· Discontinued/Past Due
· Equivalent
· Exception Requested
· Exception Requested/Past Due
· Exception Requested/Waitlisted
· Exempt
· Expired
· Expired/Past Due
· Failed
· Failed/Past Due
· Incomplete
· Incomplete/Past Due
· In Progress
· In Progress/Past Due
· Not Activated
· Not Available
· Not Started
· Not Started/Past Due
· No Show
· No Show/Past Due
· Old Version
· Past Due
· Payment Denied
· Payment Denied/Past Due
· Payment Refunded
· Payment Refunded/Past Due
· Pending Acknowledgment
· Pending Acknowledgment/Past Due
· Pending Approval
· Pending Approval/Past Due
· Pending Approval/Waitlisted
· Pending Approval/Waitlisted/Past Due
· Pending Completion Approval
· Pending Completion Signature
· Pending Completion Signature/Past Due
· Pending Completion/Past Due
· Pending Evaluation
· Pending Evaluation/Past Due
· Pending Grade
· Pending Grade/Past Due
· Pending Payment
· Pending Payment/Past Due
· Pending Post-Work
· Pending Post-Work/Past Due
· Pending Prerequisite
· Pending Prerequisite/Past Due
· Pending Pre-Work
· Pending Pre-Work/Past Due
· Pending Prior Training
· Pending SF-182 Form Approval
· Registered
· Registered/Not Available
· Registered/Not Available/Past Due
· Registered/Past Due
· Registration Pending
· Registration Pending/Past Due
· SF-182 Form Denied
· Waitlisted
· Waitlisted/Past Due
· Waitlist Expired
· Waitlist Expired/Past Due
· Withdrawn
· Withdrawn/Past Due
Completed
The Completed category displays training items that are in a Completed or Completed (Equivalent) status. Once a training item is in a Completed status, the training is automatically moved to the Completed category.
For training items that are configured to allow re-requests, when a user completes the first instance of the training, it moves to the Completed category. When re-requested, the training item moves back to the Active category.
For training items that require pre-work, post-work, or prerequisites, the training item is not moved to the Completed category until all pre-work, post-work, and prerequisites are also in a Completed status.
Archived
The Archived category includes training items that have been archived by the end user, their manager, or an administrator. Training can be archived from the Training Details page for the learning object.
Removed
The Removed category displays training items that are removed. This category is only available to managers and administrators with permission to remove training from a user's transcript. Also, managers or administrators can never view the Removed category on their own transcript.
[bookmark: _Ref1212086283]Training Completion Page
A Training Completion page is a page that is available to a user when they complete the training. Depending on the configuration of the training and the portal, the Training Completion page may display any points or badges that were awarded and provide opportunities to rate and review the training, view their certificate of completion, evaluate the training.
If a Training Completion page is available for a training item, then users can always manually navigate to the page via the Transcript Details page once the training is completed. Automatic redirection to the Training Completion page only occurs for select trainingtypes in certain scenarios.See the Training Completion Page Availability & Redirection section below for additional information.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Learning Badge - View
	Grants ability to view the Badge field on the Learning Details page and the Training Completion page. This permission cannot be constrained.
	Learning



	Learning Points - View
	Grants ability to view the Points field on the Learning Details page and the Training Completion page. This permission cannot be constrained.
	Learning



	Snapshot - Leaderboard
	Enables user to view the Leaderboard widget and subpage within the Universal Profile - Snapshot page for users within their permission constraints. This permission works in conjunction with the Snapshot Main - View permission. This permission can be constrained by OU, User's OU, User Self and Subordinates, User, User's Self, User's Manager, User's Superiors, User's Subordinates, User's Direct Reports, and Employee Relationship. Any user with this permission will always be able to view their own Leaderboard widget when the widget is enabled. Best Practice: For most users, this permission should be constrained by User Self and Subordinates.
	Universal Profile


[image: ]
Completion Message
A completion message is displayed at the top of the Training Completion Page. This is intended to inform the user that they have successfully completed the training. This message may also provide the user a directive regarding next steps, such as how to rate the course or print a certificate of completion.
If the training title is included in the completion message, then the Training Completion page always displays the training's title at the time the training was completed. If the training title is updated in the future, the Training Completion page is not impacted.
Earned Badges and Points
The user may be awarded a badge and training points by completing the training:
· Badge - If the user is awarded a badge by completing the training, then this badge is displayed. If the user has the Snapshot - Badges permission, they can click the badge title to view the Snapshot - My Badges page. See Snapshot - My Badges on page 322 for additional information.
· If there is no badge associated with the LO, then this information is hidden. Also, this information is only visible if the user has permission to view Learning Badges.
· Points - If the user earned points by completing the training, then the number of points that were earned is displayed. If the user has the Snapshot - Leaderboard permission, they can the View Leaderboard link to view the Snapshot - Leaderboard page. See Snapshot - Leaderboard on page 360 for additional information.
· If no points were earned, then this information is hidden. Also, this information is only visible if the user has permission to view Learning Points.
Note: Badges and Points do not display on the Training Completion page for ILT sessions. Any earned Badges or Points will still be awarded to the user, but for ILT sessions they must be accessed from the Badges and/or Points Snapshot widgets in Universal Profile.
Rate and Review the Training
To rate the training, click the Rate this Training link. This opens a pop-up, in which the user is able to assign a star rating and provide a review of the training. See LO Details Page - Rate this Training.
The option to rate the training is available if the following are true:
· Course ratings are enabled
· The user is able to view and apply course ratings for the selected LO
Edit/Delete My Review
If the user has already rated the training, then the user's rating is displayed and an Edit My Review link is displayed. Users can click this link to edit their rating and review.
Also, an Options drop-down [image: ] is available in the upper-right corner of the widget. The following options are available:
· Edit - Select this option to edit your review, including the rating and review text.
· Delete - Select this option to delete your review. The review will no longer be available on the Training Completion page or the LO Details page.
View Certificate of Completion
The user may be awarded a certificate of completion if the following are true:
· A certificate is associated with the training type or training item via Certificate Preferences. See Certificates Preferences Overview.
· The training has a status of Complete or Completed Equivalent.
To view and print the certificate of completion, click the View My Certificate link. This enables the user to instantly view their certificate, and they can choose to print it if necessary.
Recommended Training
This section is only available when Course Recommendations are enabled for the portal via the Training Completion Page Preferences and for the completed course via the Course Catalog.
This section displays training that is recommended to the user based on what other users with similar course histories have completed. For example, if there is a user who has completed similar training, then the system will recommend other training that the similar user has completed.
Only the latest version of training that is active, available to the user, and eligible for course recommendations is included in the recommendations. This section does not include any course that is on the user's transcript. Also, sessions and cohorts are not included in the recommendations.
For each available training item, the following information is displayed:
· Image - An image is displayed to represent the training or training type. If the training does not have a set image, then a randomly selected default image is displayed. Click the image to view the LO Details page.
· Training Type - In the lower-right corner of the image, the training type is displayed.
· Title - Below the image, the training title is displayed. Click the title to view the LO Details page.
· Rating - If ratings are enabled, then the training's rating is displayed. Click the rating to view the Ratings tab of the LO Details page.
· Cost - If pricing is enabled, then the training's price is displayed.
Up to four LOs are displayed at once. To view additional LOs, click the arrow to the right of the section. This displays the next four LOs. A maximum of 12 recommendations may be available. Note: If the user does not have 12 recommended courses, only the number of available recommended courses displays. If no recommendations are available, a message displays informing the user they do not have any recommendations.
Recommended Training - No Results
If no course recommendations display for a user on their Training Completion page after they complete an LO, the following message will display to the user:
[image: ]
Clicking the Want to browse for more training? Click here. link navigates the user to the Browse for Training landing page. Note: If no Browse for Training landing page has been configured in the portal, the user is navigated to the Browse for Training page.
If the user does not have any course recommendations, one of the following scenarios may have occurred:
· No results were returned because the system did not have enough user data for the user to provide recommendations.
· No results were returned because service is down.
Navigation Buttons
The following navigation buttons are available at the bottom of the Training Completion page:
Continue to Learner Home - The user can click this button to be redirected to the Learner Home page, where they can continue their learning journey and discover more training. Note: Learner Home must be active in the portal in order for this button to display, and the Learner Home link must be available to the user in a navigation tab in order for them to access Learner Home via the Training Completion page.
Continue to Transcript - The user can click this button to be redirected to their learning transcript, where they can continue managing their training.
Training Completion Page Availability & Redirection
If a Training Completion page is available for a training item, then users can always manually navigate to the page via the Transcript Details page once the training is completed. Automatic redirection to the Training Completion page only occurs for select trainingtypes in certain scenarios.
Automatic Redirection
Automatic redirection only applies to the following LO types:
· Online Course
· Material
· Test
· Video
Automatic redirection occurs for the specified LO types in the following scenarios:
· User completes the LO (see exceptions below)
· User marks the LO Complete from their Transcript
· User marks the LO Complete from their Action Items
· User completes a recurrence of the LO
· User completes another version of the LO
· Test Only: The test is submitted and passed
Automatic redirection does NOT occur for the specified LO types in the following scenarios:
· Admin marks the LO Complete from the Transcript Details Page
· Admin marks the user Exempt from the LO from the Transcript Details page - Note: While Exempt users will not be automatically redirected to the Training Completion Page, the Training Completion page will remain accessible.
· User completes the LO as an associated LO in the following scenarios:
· Prerequisite
· Pre-work
· Post-work
· Within cohort structure
· Within curriculum structure
· Within library structure
· LO is a Training Equivalent or Language Equivalent - Only the LO that is completed will redirect
· When a LO is in a pre-completion status due to a required action:
· Pending Signature
· Pending Evaluation
· Pending Acknowledge
· Pending Post Work
· Upon completing required pre-completion work:
· Pending Signature
· Pending Evaluation
· Pending Acknowledge
· Pending Post Work
· When completing a LO launched from the following:
· Welcome Page Widget
· Deep Link
· LO Details Page - This only applies to Online Courses
· Learner Home - This only applies to Online Courses
· The system is in Low Bandwidth mode - This is controlled by a backend setting.
· Test Only:
· Test is submitted and failed
· Test contains free-form questions
Manual Redirection
User's can manually navigate to the Training Completion page from the Transcript Details page for the following LO types:
· Online Course
· Event
· Quick Course
· Curriculum
· Test
· Library
· Materials
· Video
· Cohort
[bookmark: _Ref2017552836]Training Details - View
[bookmark: concept204]To view the Training Details page, follow these steps:
1. Click the View Transcript link, which can be accessed from the Home or the Learner Home page.
2. Click the training title to view the training details.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Attachments in Transcript - Manage
	Grants ability to upload new attachments and delete existing attachments for LOs on a user's transcript. Users with this permission are automatically granted permission to view attachments. This permission can be constrained by OU, User's OU, User Self and Subordinates, User, User's self, User's ILT Provider, ILT Provider, and Instructor.
	Learning Administration



	Attachments in Transcript - View
	Grants ability to view attachments that have been uploaded for LOs on a user's transcript. This permission can be constrained by OU, User's OU, User Self and Subordinates, User, User's self, User's ILT Provider, ILT Provider, and Instructor.
	Learning



	Cohort Roster - Manage
	Grants ability to manage cohort rosters. A variety of other features are available depending upon additional roster permissions. This permission works in conjunction with Cohorts - Manage or Cohorts - Edit permissions and the Cohort Roster - View permission. This permission cannot be constrained. This is an administrator permission.
	Learning - Administration



	Cohort Roster - View
	Grants view-only access to cohort rosters. This permission works in conjunction with the Cohorts - Manage or Cohorts - Edit permissions. This permission cannot be constrained. This is an administrator permission.
	Learning - Administration



	Display all Training Custom Fields
	Enables display of all training custom field values including blank fields when viewing details of training on transcript. Without this permission, the custom field will only appear if it is populated with a value. This is an end user permission.
	Learning



	Edit Transcript Items
	Grants ability to modify training due dates, statuses, and scores on other user's transcripts (training records) when viewing training details for particular learning objects on the transcript. User must also have permission to add external training in order to add or edit another user's external training. This permission can be constrained by OU, User's OU, User Self and Subordinates, User, and User's Self.
Note: Users with this permission also will also see the Add SF-128 link on the transcript.
	Learning - Administration



	Mark Training Complete
	Grants ability to mark learning objects complete for other users, via the training details page when viewing the learning object from the user's transcript. This permission does not grant ability to mark a user's learning object complete from their Transcript page. This permission can be constrained by OU, User's OU, User, User's Self, and User Self and Subordinates. This is an administrator permission.
	Learning - Administration



	Mark Transcript Exempt
	Grants ability to exempt users from a learning object, using the "Mark Exempt" link on the top right corner of the target user's Transcript/Training details page. This permission can be constrained by OU, User's OU, and User's Subordinates. This is an administrator permission.
With the May '17 release, this permission also applies to prerequisites, pre-work, and post-work. Users without this permission cannot mark any training type exempt for a user. 
	Learning - Administration



	Request Exemption from Training
	Grants ability to request Exemption from completing an assigned learning object, via the "Request Exemption" link on the top right corner of the Training details page for any transcript item. The request is sent to the persons allowed to approve Exemption requests of the submitting user. This permission cannot be constrained. This is an end user permission.
	Learning



	Session Details - View Student Roster
	Allows user to view student roster for a given ILT session via a link on ILT session details screen when searching for training, and from transcript details screen after a session has been added to the user's transcript. This is an end user permission.
	Learning



	Training Certificate - Admin
	Grants access for administrators to view and print training certificates of completion on behalf of users. The link appears on the Transcript Details page for a user's completed learning objects. This is an administrator permission.
	Learning - Administration



	Training Certificate - Self
	Grants access for users to view and print training certificates of completion for learning objects they have completed. The link appears on the Transcript Details page for the user's completed learning objects. This is an end user permission.
	Learning - Administration



	Training Purpose - Edit User's Purpose
	Grants access to edit the training purpose and category on the user's transcript details. Admin must have access to user's transcript. This is an administrator permission.
	Learning - Administration



	View Transcript Item
	Grants ability to view details of learning objects that appear on the transcript (training record), by clicking on the name of the learning object. Users must also have the Bio About - View permission in order to access the transcript within Universal Profile. This permission can be constrained by OU, User's OU, User Self and Subordinates, User, or User's Self. This is an end user permission.
	Learning - Administration


Edit Transcript Details
When the user has permission to edit the transcript details, the Edit Transcript Details link appears below the LO title for all LO types. See Training Details - Edit Transcript Details on page 530 for additional information.
Generate Audit PDF
Select the Generate Audit PDF link to generate an audit PDF. This is only available to administrators. See Generate Audit PDF.
Note: The Generate Audit PDF link is not available if the Transcript Lockdown functionality is enabled in your portal. Also, this link is not available when administrators view training details for their own training.
Training Detail Fields
Training detail fields vary depending on the type of training. Click each section below to see training detail fields and descriptions:
General Training Details
Depending on the type of training selected, some fields may not appear:
· Title - The training title is provided at the top of the page.
· Training Type - This is the type of training, such as online course, curriculum, material, etc.
· Version - If the training item has multiple versions, the version number is displayed here.
· Provider - This is the vendor that provides the training.
· Training Hours - This is the total number of hours of the training.
· Description - This is a description of the training.
· Schedule - This indicates the days and time the training is offered.
· Institution - This is the institution that offers the external training.
· Grade - This is the grade received for external training.
· Submitted Paperwork - This is the status of required paperwork for an external training course, which user must submit for a complete status
· Cost - This is the cost of the external training.
· Resources - This section displays any documents that have been attached to the learning object (LO) and are visible to the user. The attachments are only visible if the administrator selected the Registered Users visibility option for the attachment and if the user has permission to view or manage LO attachments. Users can click the attachment title to open the attachment.
· Status - The user's status with regards to the training item. 
· View Completion Page - This link is available if the user has completed the training and the training has a Training Completion page enabled. This link enables users to view their Training Completion page. See Training Completion Page on page 499 for additional information.
· Mark Complete - This link is available for administrators with the appropriate permissions when viewing the Training Details page for another user. This link allows the administrator to mark the user's training Complete.
· Training Purpose - This field displays the training purpose, as defined when the training was requested or assigned. The field label will display by default for Curriculum, Cohort, Library, Material, Online Course, Video, Test, Event, and External Training training items even if training purpose is not in use or not defined.
· Available Date - This field displays the date on which the training is available for the user. This field is only visible to users with permission to manage the available date setting for learning assignments and only appears if the user was assigned the LO via a standard learning assignment. Note: This field does not display for events. In addition, the field does not display if the LOs in the learning assignment are configured to be available immediately upon processing of the proxy enrollment.
· Due Date - The date by which the user must complete the training item. Managers and administrators may have permission to edit the due date of a subordinate's LO. See Training Details - Edit Due Date on page 528 for additional information.
· Start Date - This is only available for material LOs. If the material does not have a start date, then the field does not display.
· End Date - This is only available for material LOs. If the material does not have a end date, then the field does not display.
· Expiration Date - The date on which the user is no longer available to launch the training item. Note: This expiration date is different from a license expiration date.
· From Training Plan? - This field displays whether the course was assigned to the user from a training plan. This field is only available if training plans are enabled and if the field is enabled by the administrator in Transcript Preferences.
· If the learning object (LO) is assigned to the user from a training plan, then "Yes" is displayed.
· If the LO is not assigned to the user from a training plan, then "No" is displayed.
· If the LO is assigned to the user from a training plan and the LO replaces an existing LO on the user's transcript, then "Replaced" is displayed. Whether a LO can replace an existing LO on a user's transcript is dependent on whether the Force initial enrollment for users who already have the training option is checked when creating the training plan.
· Auto Renewal - When viewing a curriculum, if auto-renewal is enabled, this displays whether or not auto-renewal is currently on or off.
· If the Auto Renewal value is On, click the On link to turn it off. The Renew Subscription option is now available on the Transcript page.
· If the Auto Renewal value is Off, click the Off link to turn it on.
· Highest Score - This is the user's highest score
· Attempts Left - This is the total number of attempts remaining
· Roster - This option is only available to users who have permission to view or manage the cohort roster.
· Student Roster - This is the list of users currently registered in this session. This is only available for users with permission to view the student roster for the cohort or session. Note: For sessions, if you select the View Student Roster link, the list displays up to 500 users. If there are more than 500 users, they will not display.
· Course Rating - If course ratings are enabled for a portal, in the upper-right corner of the Training Details section, the overall course rating is displayed. The rating is displayed visually with a star rating. Also displayed is the number of ratings that are available for the course. Users can click the "XX Reviews" link to view the Course Ratings page for the course. Note: Course ratings are not displayed if the Course Ratings functionality is not enabled.
Training Progress Details
· Progress - This is the percentage of course units completed.
· Last Accessed - This is when the user last viewed the course.
· Total Views - This is the number of times the user opened the course.
· View Time - This is the length of time the user remained in the course.
· Status - The status indicates whether the course is in progress, completed, etc. 
· Modules - This displays the segmented scores on particular modules .
· Attendance - The attendance lists each part of the session with "N/A" if the session has not started yet and either "Absent" or "Attended" depending on whether the instructor marked that person as attending within that part on the Attendance and Scoring sheet from the roster.
Attachments
The Attachments section is only available for instructor led training (ILT) sessions and it is only available if the user or administrator has permission to view or manage attachments in the transcript. Attachments are displayed in the order in which they were uploaded, with the oldest attachments displayed first. 
Click the attachment name to open the attachment.
See Training Details - Attachments on page 523 for additional information.
Scoring Details
· Attempts - This field displays the attempt number for the user.
· Date - This field displays the date completed.
· Score - This field shows the score received for that attempt. For online courses, if the course is configured by the administrator to have a maximum possible score, then the score is calculated as a percentage of correct answers: [Number of Correct Answers] x 100 / [Max Score]. For example, if the maximum possible score is 30 and the user answers 21 out of 30 questions correctly, their score is 70%. Note: When creating a new course or publication in which a score is calculated, in order for the system to calculate and display a score on the Training Details page, both the maximum score and the user score must be set. If the Score field does not appear on the Training Details page, then the maximum score is not defined (greater than zero) in the SCORM wrapper (max_score). If the Score label does appear, but there is no value, then the user's score is not defined (not equal to null).
· Test Time - This provides the amount of time user took to complete the test.
Pre-work
· Title - This is the pre-work training object title.
· Type - This is the pre-work training object medium (online training, event, quick course, etc.).
· Due Date - This is the date by which the pre-work must be competed.
· Required - This states whether the pre-work is required.
· Exempted - This states whether the user is exempt from completing pre-work.
· Option - This provides the status of the pre-work completion.
Post-work
· Title - This is the post-work training object title.
· Type - This is the post-work training object medium (online training, event, quick course, etc.).
· Due Date - This is the date by which post-work must be completed.
· Required - This states whether the post-work is required.
· Exempted - This states whether the user is exempt from completing post-work.
· Option - This provides the status of the post-work completion.
Prerequisites
· Title - This is the prerequisite training object title.
· Type - This is the prerequisite training object medium (online training, event, quick course, etc.).
· Exempted - This states whether the user is exempt from completing the prerequisite.
· Status - This provides the status of the prerequisite completion.
Session Details
· Title - This provides the session name.
· Locator Number - This provides the assigned locator number for reference.
· Provider - This is the vendor providing the training.
· Description - This is a description of the session. 
· Subjects - This displays the training subjects in which session can be searched. If the selected subject is a child subject, then the entire hierarchy is displayed.
· Training Hours - This shows the duration of the training.
· Credits - This shows the number of credits a user will receive for completing training.
· Price - This shows the cost of the training. The price displays with the following considerations, depending on the percentage of the price the user is required to pay to register for the training.
· If User Payment Preferences are configured so that User Pays is set to 0% (i.e., User's Cost Center is set to 100% and pays 100% of the price), the Price field does not display in the Training Details.
· If User Payment Preferences are configured so that User Pays is set to 100% (i.e., User's Cost Center is set to 0%, then the following occurs:
· Before the payment, the Price field displays the total price of the training.
· After the payment, the Total Price and Registration fields both display total price of the training.
· If User Payment Preferences are configured so that User Pays is set to a percentage between 0% and 100% (e.g., User Pays is set to 50% and User's Cost Center is set to 50%), then the following occurs:
· Before the payment, the Price field displays the total price of the training (i.e., the user portion plus the cost center portion).
· After the payment, the Total Price and Registration fields both display the part of the price that the user paid to register for the training (i.e., only the user portion).
· Schedule - This shows the day, time, location and instructor for the training.
· Prerequisites - This shows the prerequisites required for the training.
· Pre-work - This shows the pre-work required for the training.
· Post-work - This shows the post-work required for the training.
· Penalty for Withdrawal - This displays the amount of the penalty withdrawal as well as the number of days prior to event a user must withdraw
· Penalty for No-Show - This displays the amount of the penalty for a no-show.
· Registration Deadline - This displays the last day a user can register for an event.
Note: Custom fields must have a value in order to be displayed in the session transcript on the Training Details page.
Print Certificate
Link displays after the training is completed for an online course, quick course, session, curricula and certification. Click to view or print certificate. Note: If training is a curriculum, the Print Certificate link will display when all training items are completed inside the curriculum and the status of the curriculum is Completed.
Print Training Details
When a completion signature is required, you also have the option to print the Training Details page. To print the Training Details page, click the Print Details icon in the upper-right corner of the page. Note: This option is only available when the training completion signature is required for the item. If completion signature is disabled for the item, the Print Details option is removed, no matter the completion status. See Training Details - Print Preview on page 543 for additional information. The following sections are included in the printable version:
· Training Details
· Custom Training Fields
· Acknowledge Completion
· History
Assignment and Version History
On the Training Details page for a training item on a user's transcript, an Assignment and Version History section displays. Each occurrence of training displays as a separate line item in this section. The following information displays in this section, if available:
· Registration Number - This column shows the registration number for each assignment of the training. This field can be reported on using a custom transcript report.
· Latest Registration? - In the Latest Registration column, a Yes/No value displays, indicating whether or not the training registration is the latest active registration on the user's transcript.
· Delivery - This column displays the method by which the training was assigned to the user, the user who assigned the training, and the date and time the training was assigned.
· Transcript Delivery Method - In the Transcript Delivery Method section, the method by which the training registration was delivered to the user's transcript displays. Possible values include:
· Self Requested
· System Assignment (LAT)
· Direct Assignment (From a manager or via ILT roster submission)
· Express Class
· Assignment
· Other
· Version - This column displays which version of the training is on the user's transcript.
· Effective Date - This column displays the date the training is effective in the Course Catalog.
· Start Date - This column displays the Start Date specified for the training assignment, if available.
· End Date - This column displays the End Date specified for the training assignment, if available.
· Due Date - This column displays the Due Date specified for the training assignment, if available.
· Status - This column indicates what status the training is in on the user's transcript (i.e. Registered, In Progress, Completed, etc.)
· Options - The following options are available for line items in the Assignment and Version History section:
· View Details - Click this icon to view the Training Details page for a specific assignment on the user's transcript. The top of the page reads, "Previous Assignment Information" to alert the viewer that they are viewing the training details for a previous instance of the training on the user's transcript. See the below section for more information.
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· Transcript Delivery Method - In the Transcript Delivery Method section, the method by which the training registration was delivered to the user's transcript displays. Possible values include:
· Self-Requested
· System Assignment (LAT)
· Direct Assignment
· Training was assigned directly (for example by a manger to a user)
· Training was submitted via ILT Roster Submission
· Express Class
· Assignment* (This category is representative of historical data records prior to the Feb '19 release which are not reliable and therefore have been contained separately to preserve data quality. Over time, this category will be deprecated.
Other
· The Other status appears for all other miscellaneous transcript delivery cases, including:
· Assignment via Inventory
· Added by Training Plan
· Historical Data Loads (except in certain cases described in above values)
· Data Load Wizard
Considerations
· The Assignment and Version History section is called "Assignment History" if the training has not yet been versioned. This is preexisting functionality.
· There may be multiple entries within the Assignment and Version History section that are considered the Latest Registration. This is preexisting functionality that occurs when a training is versioned using Append versioning.
Acknowledge Completion
If a completion signature is required for a learning object, the user must submit an electronic signature on the Transcript Details page for the LO. See Training Details - Acknowledge Completion on page 519 for additional information.
Cohort Structure
For cohort LOs, the cohort structure is displayed in the Cohort Structure section. This section displays all of the training that is contained in the cohort structure. See unTraining Details - Cohort Structure on page 526 for additional information.
Session Details Table
See Training Details - Session Details Table on page 545 for additional information.
Curriculum Details Table
See Training Details - Curriculum Details Table on page 527 for additional information.
Approval History
Lists each step in the approval process and the history of the training item.
· Comments entered by Managers assigning training are displayed under the Approval History.
· Exemption requests, approvals, and denials are recorded under Approval History.
· Sessions for which the Completed status has been reversed are recorded under the Approval History and appear as "Reverted by <(user name) (user ID) on (M/D/YYYY)." The original timestamp recorded for the Completed status is unchanged.
· Time zone specified here under the Approval History area is set based upon the location of the host server. Historical transactions times (such as these) are listed in Pacific Time Zone.
Assignment and Version History
See Training Details - Assignment and Version History on page 520 for additional information.
Move to Archived Transcript
Click the Move to Archived Transcript link in the upper-right corner to move a training course from your active transcript to your archived transcript.
Back
Click Back button from the Training Details window to return to your Transcript.
Pending Approval/Pending Completion Approval Panel
See Training Details - Pending Approval/Completion Approval Panel on page 541 for additional information.
Online Course
[image: ]
Curriculum
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Session
Only the training details for the latest session are available directly from the transcript. All previous sessions must be viewed by navigating to the event's Training Details page from the session's Training Details page.
Note: If the administrator configures the session to display the start and end times in the user's time zone, then the session start and end time displays in the user's time zone.
Note: Daylight saving time (DST) time zones are supported for ILT for events or sessions.
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Event 
The event's Training Details page displays all previous sessions that are in a status of Completed in addition to any current sessions for the user. Click the session locator number to view the Training Details page for the corresponding session.
The event's Training Details page can be accessed by clicking the event title in the upper-left corner of the session's Training Details page.
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External Training Requested via SF-182 Form
See Training Details - External Training Requested via SF-182 Form on page 538 for additional information.
Learning Details Redesign
With the February 2019 release, a redesigned Learning Details page was released as an Early Adopter project. As of the August 2020 release, this project is no longer in an Early Adopter status and is now generally available. The Learning Details page is available for the following training types if enabled by your system administrator:
· Curricula
· Events and Sessions
· External Content
· Materials
· Online Content
· Online Courses
· Tests
· Videos
More features will be added to the Learning Details page in future releases. For more information about the redesigned Learning Details page: See Learning Details Page .
[bookmark: _Ref708402345]Training Details - Acknowledge Completion
If a completion signature is required for a learning object (LO), the user must submit an electronic signature on the Transcript Details page for the LO. Note: If an electronic signature is not required, the electronic signature section does not appear.
The name of the electronic signature section is customizable in the Training Completion Signature Preferences, but the default section name is Acknowledge Completion. The electronic signature section is always located above the Approval History section and is available as soon as the item is added to the user's transcript. However, the ability to sign is not available until the LO is in a status of Pending Completion Signature. 
The administrator is able to determine the signature type and signature font in Training Completion Electronic Signature Preferences. 
· If the signature is pre-populated, then the system displays a read-only view of the user's signature in the selected signature font. Users must click the Sign button in order to electronically sign the completed LO.
· If the signature must be entered manually, then the user must manually enter their full name and click the Sign button in order to electronically sign the completed LO. After the LO is electronically signed, the user's electronic signature appears in the selected signature font.
Clicking the Sign button serves as your acknowledgment that you have completed the training item. Only the user can provide an electronic signature for training that is on their transcript. Managers and Administrators are unable to provide an electronic signature for a user. This character limit for this field is 600.
Once an electronic signature is applied, the user's name appears in place of the input box and cannot be edited. Also, a history stamp is displayed to the right of the signature, including the date and time on which the electronic signature is provided. The learning object status is changed to Complete.
User Authentication
If the User Authentication option is selected in the Training Completion Signature Preferences, when the user clicks the Sign button, an authentication pop-up appears. The user must authenticate the electronic signature by entering their user ID and system password and click Submit. This authentication must occur before the learning object is considered Complete.
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[bookmark: _Ref-988555659][bookmark: concept206]Training Details - Assignment and Version History
On the Training Details page for a training item on a user's transcript, an Assignment and Version History section displays. Each occurrence of training displays as a separate line item in this section. The following information displays in this section, if available:
· Registration Number - This column shows the registration number for each assignment of the training. This field can be reported on using a custom transcript report.
· Latest Registration? - In the Latest Registration column, a Yes/No value displays, indicating whether or not the training registration is the latest active registration on the user's transcript.
· Delivery - This column displays the method by which the training was assigned to the user, the user who assigned the training, and the date and time the training was assigned.
· Transcript Delivery Method - In the Transcript Delivery Method section, the method by which the training registration was delivered to the user's transcript displays. Possible values include:
· Self Requested
· System Assignment (LAT)
· Direct Assignment (From a manager or via ILT roster submission)
· Express Class
· Assignment
· Other
· Version - This column displays which version of the training is on the user's transcript.
· Effective Date - This column displays the date the training is effective in the Course Catalog.
· Start Date - This column displays the Start Date specified for the training assignment, if available.
· End Date - This column displays the End Date specified for the training assignment, if available.
· Due Date - This column displays the Due Date specified for the training assignment, if available.
· Status - This column indicates what status the training is in on the user's transcript (i.e. Registered, In Progress, Completed, etc.)
· Options - The following options are available for line items in the Assignment and Version History section:
· View Details - Click this icon to view the Training Details page for a specific assignment on the user's transcript. The top of the page reads, "Previous Assignment Information" to alert the viewer that they are viewing the training details for a previous instance of the training on the user's transcript. See the below section for more information.
[image: ]
· Transcript Delivery Method - In the Transcript Delivery Method section, the method by which the training registration was delivered to the user's transcript displays. Possible values include:
· Self-Requested
· System Assignment (LAT)
· Direct Assignment
· Training was assigned directly (for example by a manger to a user)
· Training was submitted via ILT Roster Submission
· Express Class
· Assignment* (This category is representative of historical data records prior to the Feb '19 release which are not reliable and therefore have been contained separately to preserve data quality. Over time, this category will be deprecated.
Other
· The Other status appears for all other miscellaneous transcript delivery cases, including:
· Assignment via Inventory
· Added by Training Plan
· Historical Data Loads (except in certain cases described in above values)
· Data Load Wizard
Considerations
· The Assignment and Version History section is called "Assignment History" if the training has not yet been versioned. This is preexisting functionality.
· There may be multiple entries within the Assignment and Version History section that are considered the Latest Registration. This is preexisting functionality that occurs when a training is versioned using Append versioning.
[bookmark: _Ref-444824189][bookmark: concept207]Training Details - Attachments
The Attachments section is only available for instructor led training (ILT) sessions and it is only available if the user or administrator has permission to view or manage attachments in the transcript. Attachments are displayed in the order in which they were uploaded, with the oldest attachments displayed first. 
Click the attachment name to open the attachment.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Attachments in Transcript - Manage
	Grants ability to upload new attachments and delete existing attachments for LOs on a user's transcript. Users with this permission are automatically granted permission to view attachments. This permission can be constrained by OU, User's OU, User Self and Subordinates, User, User's self, User's ILT Provider, ILT Provider, and Instructor.
	Learning Administration



	Attachments in Transcript - View
	Grants ability to view attachments that have been uploaded for LOs on a user's transcript. This permission can be constrained by OU, User's OU, User Self and Subordinates, User, User's self, User's ILT Provider, ILT Provider, and Instructor.
	Learning


Attachment - Add
The maximum number of attachments that can be added for a single session per attendee is five.
To add an attachment to the Transcript Details page for an ILT session, follow these steps:
1. In the Attachments section, click the Add Attachment link. This opens the Upload File pop-up. 
2. Click the Browse button.
3. Browse for and select the appropriate file on your computer. The following file types are accepted: Word, Excel, PowerPoint, pdf, txt, rtf, gif, and jpg.
4. Once a file is selected, it is displayed in the Upload File pop-up. Click the Upload button, or click the Browse button to select a different file.
5. Once a file is uploaded, it appears in the Attachments section.
[image: ]
Attachment - Edit
If an attachment is added to the Attachments section of the Transcript Details page, the display name can be edited.
To edit the display name for an attachment, follow these steps:
1. Next to the appropriate attachment in the Attachments section, click the Edit icon [image: ]. The display name becomes editable.
2. In the Display Name field, modify the display name, as necessary. The character limit for this field is 300.
3. After editing the display name, click the Save icon [image: ] to save the changes, or click the Cancel icon [image: ] to discard the changes.
[image: ]
Attachment - Remove
To remove an attachment, next to the appropriate attachment in the Attachments section, click the Remove icon [image: ].
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[bookmark: concept208]Training Details - Audit History Stamps
The following statuses and actions are tracked in the Audit History for the Transcript Details page:
· Requested
· Exception Requested
· Assigned
· Requested Waitlist
· Canceled
· Expired
· Denied
· Deferred
· Approved
· Registered
· Started
· Completed
· Granted
· Granted Waitlist
· Withdrawn
· Discontinued
· Marked Incomplete
· Reset Attempts
· Failed
· Edited
· Score Updated
· Removed
· Removed from Transcript
· Restored to Transcript
· Archived
· Unarchived
· Rolled Back
· Due Date Edited
The Electronic Signature history stamp is included in the Audit History, if applicable. When a user submits an electronic signature, a history stamp appears, detailing the signer's full name, user ID, signature date and time, and any signature message that is associated with the signature. Please note that the signature message on transcript history is limited to 250 characters. If the signature message exceeds 250 characters, the message will be truncated within the transcript history section.
All history stamps in the transcript include the user ID following the user's name (i.e., "<Last Name, First Name><User ID>").
[bookmark: _Ref1094304477]unTraining Details - Cohort Structure
For cohort LOs, the cohort structure is displayed in the Cohort Structure section. This section displays all of the training that is contained in the cohort structure. The following information is displayed for each training item in the cohort structure:
· Section Title
· Title - Click the arrow to the left of the training title to view the training description.
· Type
· Due Date
· Status
· Details - If the corresponding training item is on the user's transcript, then this column contains a link that opens the Transcript Details page for the training.
[bookmark: _Ref1163422922]Training Details - Curriculum Details Table
For curricula, the curriculum details table on the Training Details page displays the following columns and options:
· View - The following viewing options are available:
· All Training - This option displays both activated and not activated training.
· Activated Training - This option displays activated training.
· Not Activated Training - This option displays training that is not yet activated.
· Title  - This field displays the training title. You can click the arrow next to the title to view the training description. 
· Type - This field displays the training type.
· Due Date - This field displays the due date of the training if a due date is configured; shows "None" if a due date is not configured.
· Excused - This field displays whether or not a user is excused from the training. Note: Excused is not a transcript status and therefore does not prevent the user from being required to complete the LO if it is required in another curriculum, cohort, or somewhere else on the transcript. It only excuses the user from the version of the LO that is active in the curriculum or cohort in which it has been marked excused. If the LO is later reversioned, it will no longer be Excused. This is different from Exempt, which is a transcript status and exempts the LO anywhere it is required on the transcript.
· [bookmark: concept210]Status - This field displays the status of the learning object.
· Options - This field displays the options available, such as Launch, which allows you to launch a training item, View Checklist, which allows you to view an observation checklist, or Request Exemption. If there are no options are available, then "None" displays in grayed out text.
For administrators, if an observation checklist is added to a curriculum, you can validate the checklist by clicking the Validate Checklist link in the Options column. This opens the checklist and allows you to validate the items. Note: Administrators can also access the Validate Checklist link from the Training Details page of the checklist. Additionally, managers can validate a checklist if the checklist is configured by the administrator to allow managers to validate. Managers can access the checklist from either the Curriculum Details page or the Training Details page, but the link that appears is View Checklist instead of Validate Checklist.
· For administrators, it is possible to exempt a learner from a specific training item in the curriculum if this training is in one of the following statuses (as described on the Curriculum Details page): 
· Pending Prior Training
· Activation Allowed
· None (“None” corresponds to a Completed, Withdrawn, Denied or No Show training status)
· Details - This field displays the View Details icon. If details are not available to view, "None" displays in grayed out text.
[bookmark: _Ref900815801][bookmark: _Ref-1033821093][bookmark: concept211]Training Details - Edit Due Date
Managers can edit a learning object's (LO) due date for a subordinate from the Transcript Details page or the Edit Transcript Details pop-up if the LO status is not Completed and the LO is active. When a manager is viewing the Transcript Details page or the Edit Transcript Details pop-up for a subordinate's LO, an Edit icon [image: ] appears to the right of the Due Date in the Training Details section. This opens the Edit Due Date pop-up. 
Select the new due date and enter comments to explain why the change was made. These comments will appear on the Transcript Details page.
After selecting the new due date and entering comments, click Save to save the new due date. Or, click Cancel to cancel the due date change.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Edit Transcript Items
	Grants ability to modify training due dates, statuses, and scores on other user's transcripts (training records) when viewing training details for particular learning objects on the transcript. User must also have permission to add external training in order to add or edit another user's external training. This permission can be constrained by OU, User's OU, User Self and Subordinates, User, and User's Self.
Note: Users with this permission also will also see the Add SF-128 link on the transcript.
	Learning - Administration



	View Transcript Item
	Grants ability to view details of learning objects that appear on the transcript (training record), by clicking on the name of the learning object. Users must also have the Bio About - View permission in order to access the transcript within Universal Profile. This permission can be constrained by OU, User's OU, User Self and Subordinates, User, or User's Self. This is an end user permission.
	Learning - Administration
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Helpful Hints
· Because it is possible to define a due date for a session or event via proxy enrollment, it is possible to edit a due date for a session or event.
· Reporting only references a user's LO due date as it exists on their transcript. It is not possible to report on changes to a due date.
· Editing a due date may change or impact when a user may receive an email related to the LO. For example, if you extend a due date for an item that is past due, and now it is no longer past due, the user will not receive Training is Past Due email, but may receive a reminder email that training is due.
[bookmark: _Ref1182275921]Training Details - Edit Transcript Details
The Edit Transcript Details pop-up allows administrators to edit certain fields from the Training Details page. Which fields are visible in the pop-up is dependent upon the learning object type. Which fields you have the ability to edit is dependent upon your permissions. 
Administrators can edit the transcript details from the Transcript Details page by clicking the Edit Transcript Details link at the top of the page. This opens the Edit Transcript Details pop-up.The due date can be edited by clicking the Edit icon [image: ] to the right of the Due Date. This opens the Edit Due Date pop-up. See Training Details - Edit Due Date on page 528 for additional information.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Edit Transcript Items
	Grants ability to modify training due dates, statuses, and scores on other user's transcripts (training records) when viewing training details for particular learning objects on the transcript. User must also have permission to add external training in order to add or edit another user's external training. This permission can be constrained by OU, User's OU, User Self and Subordinates, User, and User's Self.
Note: Users with this permission also will also see the Add SF-128 link on the transcript.
	Learning - Administration



	Training Purpose - Edit User's Purpose
	Grants access to edit the training purpose and category on the user's transcript details. Admin must have access to user's transcript. This is an administrator permission.
	Learning - Administration



	View Transcript Item
	Grants ability to view details of learning objects that appear on the transcript (training record), by clicking on the name of the learning object. Users must also have the Bio About - View permission in order to access the transcript within Universal Profile. This permission can be constrained by OU, User's OU, User Self and Subordinates, User, or User's Self. This is an end user permission.
	Learning - Administration


Note: If Training Purposing is active in the portal and a user has indicated a training purpose when assigning or requesting training, the administrator can edit the Training Purpose and Category fields in the Edit Transcript Details pop-up. The category field only displays for purposes that require a two-step process. 
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[bookmark: concept213]Exempt Prerequisites/Pre-Work/Post-Work
[bookmark: concept214]Administrators can exempt pre or post work and override a prerequisite requirement from the Training Details page.
To exempt prework, post work, or override a prerequisite, go to Admin > Tools > Core Functions > Users. Then, select the View Transcript option in the Options drop-down menu for the appropriate user.
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1. From the user's transcript, select the appropriate training item to view the Training Details page. See Training Details - View on page 505 for additional information.
2. Exempt:
· Prerequisites - Select the Exempt link to allow the user to register for the associated training without having to complete the prerequisite. The user will see "Yes" under the Exempt column. 
· Pre-Work - Select the Exempt link to bypass the pre-work requirement.
· Post-Work - Select the Exempt link to bypass the post-work requirement.
User Workflow
[image: ]
Helpful Hints
Catalog Management (Register upon Approval) - If a training item is set to Register on Approval and the training item has a prerequisite, the prerequisite will be ignored and the user will be registered for the training. The Training Details page will show the prerequisite as not exempt for the user, even though the user was able to bypass the prerequisite due to the Register upon Approval setting.
Learning Assignment (Assign, Approve & Enroll employees directly into Training) - If a training item has a prerequisite, and is assigned using a learning assignment with the option to Assign, Approve, & Enroll employees, the prerequisite will be ignored, and the user will be registered into the training. The Training Details page will show the prerequisite as not exempt for the user, even though the user was able to bypass the prerequisite due to the learning assignment option.
Universal Profile: 
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[bookmark: _Ref354950626]Exemption - Request
Exemption from a training item can be requested by the user from either the Training Details page or the Curriculum Player.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Launch Curriculum Player
	Grants users the ability to launch a curriculum in the curriculum player view if the curriculum player option is enabled for the particular curriculum. This is an end user permission.
	Learning - Administration



	Request Exemption from Training
	Grants ability to request Exemption from completing an assigned learning object, via the "Request Exemption" link on the top right corner of the Training details page for any transcript item. The request is sent to the persons allowed to approve Exemption requests of the submitting user. This permission cannot be constrained. This is an end user permission.
	Learning


To request training exemption from the transcript, click the Options drop-down next to the training on the transcript page and click the Request Exemption option. Then, follow these steps:
1. [bookmark: concept215]The Exemption Request pop-up opens. Select a reason for the exemption in the Indicate Reason field and enter comments in the Comments box (character limit of 100). Note: Other is available by default in the Indicate Reason field. Additional reasons are available if configured for the portal. Only one exemption request can be made at a time for a learning object.
[image: ]
1. Click Submit. The Request Exemption link on the Training Details page changes to Exemption Request Pending and cannot be clicked. The Approval History section records the exemption request.
2. Click Cancel to cancel the Exemption Request action.
To request exemption via the Training Details page from curriculum that is not yet activated:
1. Click the Request Exemption link in the upper-right corner to request exemption from an entire curriculum. Or, click the Request Exemption link under the Options column to request exemption from an LO within a curriculum.
[image: ]
2. The Exemption Request pop-up opens. Select a reason for the exemption in the Indicate Reason field and enter comments in the Comments box (character limit of 100). Note: Other is available by default in the Indicate Reason drop-down. Additional reasons are available if configured for the portal. Only one exemption request can be made at a time for a learning object.
[image: ]
1. Click Submit. If requesting exemption for an entire curriculum, clicking Submit changes the Request Exemption link in the upper-right corner of the Training Details page to Exemption Request Pending and cannot be clicked. If requesting exemption from an LO within a curriculum, clicking Submit changes the value in the Options column on the Training Details page to Exemption Request Pending and cannot be clicked. The Approval History section records the exemption request. Note: If an LO has a Launch value in the Options column prior to submitting the request, the value in the Options column remains unchanged. You can verify that your exemption request was submitted by opening the View Details page and seeing that the Exemption Request Pending link is grayed out.
2. Click Cancel to cancel the Exemption Request action.
To request exemption from a curriculum item that has been activated:
1. Click the View Details icon in the Details column on the Training Details page.
2. The View Details page opens. The Request Exemption link displays in the upper-right corner.
[image: ]
3. Click the Request Exemption link.
4. The Exemption Request pop-up opens. You must select a reason for the exemption in the Indicate Reason field and enter comments in the Comments box (character limit of 100). Note: Other is available by default in the Indicate Reason drop-down. Additional reasons are available if configured for the portal. Only one exemption request can be made at a time for a learning object.
1. Click Submit. The Request Exemption link on the Training Details page changes to Requested Exemption and cannot be clicked. The Approval History section records the exemption request.
2. Click Cancel to cancel the Exemption Request action.
Transcript Status for Exempted Learning Objects
If your exemption request is granted, the LO's status changes to Exempt on your transcript. If the LO is configured to allow users to request it more than once and you select the Request Again link, the LO with the Exempt status displays in the Assignment History section of the Training Details page. 
To see actions available for Exempt LOs and other statuses: See Transcript (Universal Profile) - Status and Options on page 477 for additional information.
Considerations for Events and Sessions
· If you are exempted from an event, the status of the LO on your transcript changes to Exempt. The event's status does not affect the session's status; you must be exempted from a session separately.
· If you are already exempted from an event and are subsequently exempted from a session, the exemption does not change the event's status.
· If you complete a session within an event that has an Exempt status, the status remains Exempt and does not change to Completed.
· When a user registers for an event that is not associated with a session, then only the event is displayed in the Completed (if exempted) and Removed tabs of the user's transcript.
· When a user registers for an event that is associated with a session, only the session is displayed in the Completed (if exempted) and Removed tabs of the user's transcript.
[bookmark: _Ref1254744427]Training Details - External Training Requested via SF-182 Form
When external training is requested with the SF-182 form, the Training Details page displays an SF-182 Request Details section. Only the fields that are configured to display in SF-182 Preferences appear. If the user completed the Conditional Service Agreement form, a link to download the form appears in the Conditional Service Agreement Form field.
Additionally, users can select an approver for each applicable step in the approval process by clicking the Add Approver link in the Options column. The user can select from any active user in the portal, and the approver is added to the approval queue for that step. The link remains available even after an approver is selected.
Print
The Print option displays a printable view of the SF-182 form. Custom fields appear at the bottom of each applicable section. The Approval section appears at the bottom of the printable view window.
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Approval History
The Approval History section tracks SF-182 approval actions and the initial submission of the request.
Note: The SF-182 functionality must be available in your portal in order to request external training using the SF-182 request form. See SF-182 Form - Overview on page 463 for additional information.
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[bookmark: _Ref-34850653]Training Details - Pending Approval/Completion Approval Panel
For learning objects (LO) that require approval or completion approval, a Pending Approval or Pending Completion Approval panel displays. The panel displays the approver who is required to approve the user's LO, as well as the approver's associated OU.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Pending (Completion) Approval Training Details
	Grants ability to view the Approvals section of the Training Details page. This permission can be constrained by OU, User's OU, and Training Type. This is an end user permission.
	Learning


Panel Approval/Completion Approval Panel
The following information displays:
· Current Approval Step - "Approval currently pending from [OU Name]: [Name of user required to approve]"
· Single Approver - "Approval Required by [OU Name]: [Name of user required to approve]"
· Two Approvers - "Approval Required by [OU Name]: [Name of user required to approve] or [Name of user required to approve]"
· Three Approvers - "Approval Required by [OU Name]: [Name of user required to approve], [Name of user required to approve], or [Name of user required to approve]"
· Four or More Approvers - "Approval Required by [OU Name]: [Name of user required to approve], [Name of user required to approve], [Name of user required to approve], etc." Note: In order to ascertain the remaining approvers that are not visible in the row, contact the appropriate training contact for the LO.
· Multiple OUs in One Approval Step - In this setup, either OU can record an approval decision:
· "Approval Required by [OU Name]: [Name of user required to approve] OR"
"Approval Required by [OU Name]: [Name of user required to approve]"
· Multiple OUs in One Approval Step - In this setup, both OUs are required to record an approval decision:
· "Approval Required by [OU Name]: [Name of user required to approve] AND"
"Approval Required by [OU Name]: [Name of user required to approve]"
Note: When an approval step has two or more approvers, approval for the step is achieved as soon as one of the approvers approves the step.
Note: The approval process for an LO is configured by the administrator.
Once an approval step is completed, the step is removed from the panel, and the Approval History section displays the approval decision.
[image: ]
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[bookmark: _Ref1793061918]Training Details - Print Preview
When a learning object requires an electronic signature for completion, the user, manager, and administrator have the option to view a printable version of the Transcript Details page. This page includes a section for the electronic signature whether or not it has been signed and completed.
Only the following sections will appear in the print out:
· Training Details
· Acknowledge Completion
· Approval History
If the electronic signature has not yet been provided, the print preview indicates that this is not yet complete.
[image: ]
Once the electronic signature is provided, the print preview displays the signature as well as a history stamp indicating the date and time at which the signature occurred.
[image: ]
[bookmark: _Ref140730427]Training Details - Session Details Table
For sessions, the session details table displays the following for each session part:
· Day - This column displays the day on which the part occurs.
· Part Name - This column displays the name of the part.
· Description - This column displays the part description.
· Starts - This column displays the part's start date and time. Note: If the administrator configures the session to display the start and end times in the user's time zone, then the start time displays in the user's time zone.
· Ends - This column displays the part's end date and time. Note: If the administrator configures the session to display the start and end times in the user's time zone, then the end time displays in the user's time zone.
· Add to Calendar - This column displays the Add to Calendar option. The Add to Calendar option enables users to add the session to their Outlook or Google calendar. This option is especially helpful for users who register for a session for which no emails are configured or who decline the initial meeting invite but decide later that they would like to add the session to their calendar. The option appears for each part instance. See the Add Part to Calendar section below for additional information.
· Training Hours - This column displays the number of training hours for the part.
· Instructor - This column displays the instruction for the part.
· Location - This column displays the part's location.
Add Part to Calendar
To add the part to your calendar:
1. Click Add to Calendar. This opens the File Download pop-up.
2. Click Open. This opens a security pop-up.
3. Click Allow. This downloads the file and opens an appointment email. The subject is the name of the event, and the location is the session location. However, the Sender field and message body of the email is blank. Note: The appointment may have a default reminder time set. The reminder time can be changed using the options in your calendar tool.
4. Click Save & Close to add the session to your calendar. If you do not wish to add the session to your calendar, click Delete. This prompts you to select Yes or No to delete the email. Click Yes. This prompts you to confirm your response. Click Yes. This closes the email and does not add the session to your calendar.
Once a user adds a part to their calendar, any updates related to the part are made to their calendar via email, if configured by the administrator. If the part is cancelled or removed from the session, this triggers a session cancellation email for the part, if configured by the administrator. The cancellation email contains the standard email options for cancelled appointments.
If the part is not cancelled but the user no longer wishes to have the part appear on their calendar, then they must manually remove it from their calendar.
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Training Details Page - Certification
From the Training Details Page for certifications, users can view and launch the training associated with the certification, view the certification history, and print any past certificates.
To view the Training Details Page for a certification, navigate to the Transcript and click the Certifications tab on the left navigation. Then, click the title of a certification. Note: This is not available if certifications are not enabled for the portal.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Certification - Update Credit
	Grants administrator ability to update the number of acquired credits on a user's certification progress report page. This also enables administrators or users to "certify" users by adjusting the number of credits received. This is an administrator permission.
	Learning - Administration



	Withdraw Users from Sessions
	Allows administrators and managers to withdraw users from sessions on their behalf. This is done from the user's Transcript page. Note: There is a setting in the Session Defaults for an event that may prevent users from being able to withdraw from sessions. When this option is selected, users, managers, and administrators are prevented from withdrawing from sessions for themselves or on behalf of other users. This permission can be constrained by OU, User's OU, User's Self and Subordinates, User, User's Subordinates, and User's Direct reports. This is a manager or administrator permission.
	Learning


[image: ]
Certification Details
In the Details section, view the details of the certification. Note: For portals with multiple languages enabled, the Current Period field displays in the language of the user viewing the Training Details page. If the user's language is not available, the field displays in the default language of the certification. The name and localization of this field is managed on the Scheduling step when creating, editing, or copying a certification. The value in the Certification Period Title field on the Configure Training Period pop-up displays in the Current Period on the Training Details page.
In the Certification section, the training associated with the certification is displayed. You can select the appropriate View option to view All Training, Activated Training, or Not Activated Training. By default, All Training is selected. Note: For certifications that are configured not to override the availability settings defined in Course Catalog for a LO, the only LOs that are visible to the user are the LOs for which the user meets the availability criteria defined in Course Catalog for the LO. See Create Certification - General for additional information.
Parent and child sections can be expanded or collapsed by using the Expand and Collapse icons to the left of the section title. By default, the parent section is expanded and the child section is collapsed.
For each training item, the following information displays:
· [bookmark: concept220]Title - The section of the certification displays, as well as the number of required and acquired credits. Each time a learning object within then section achieves a status of Completed, the number of credits acquired accumulates for both the parent and child sections. If a learning object has zero credits, the number of acquired credits does not change.
· The point at which credits accumulate in the parent section is dependent on the certification's configuration in Certification Administration. If the certification is configured to require users to complete the minimum number of credits for all child sections before the credits are counted toward the parent section, then credits only begin to accumulate in the parent section once the child sections have accumulated the minimum number of required credits. 
· Below the section, the title of the training item displays. Click the arrow to the left of the training title to view a description of the training item.
· Type - The training item type (e.g., online class, test, section, external training)
· Credits - The number of credits towards the certification that is granted for completing the training item. For portals with multiple languages enabled, the name of the Credits column appears in the language of the user viewing the Training Details page. If the user's language is not available, the column displays in the default language of the certification.Note: The name and localization of this column is managed on the General step when creating, editing, or copying a certification. The value in the Change tracking unit from credit to field displays as the column name on the Training Details page.
· Status - The current status of the training item. For users who are enrolled as certified, this is set to Not Activated.
If a user is in the Certified status for a certification, the system displays the due date and expiration date for the next certification period, if available.
You can manage the training items by selecting the appropriate option from the Options column. See Certification Item - Launch on page 422 for additional information. For administrators, if an observation checklist is added to a certification, you can validate the checklist by clicking the Validate Checklist link in the Options column. This opens the checklist and allows you to validate the items. If the checklist is part of a curriculum that is inside the certification, then click the Manage link in the Options column. This opens either the Curriculum Details page or the Curriculum Player, depending on how the administrator configured the curriculum.
Note: Administrators can also access the Validate Checklist link from the Training Details page of the checklist. Additionally, managers can validate a checklist if the checklist is configured by the administrator to allow managers to validate. Managers can access the checklist from either the Certification Details page or the Training Details page, but the link that appears is View Checklist instead of Validate Checklist.
To view the training details for an active training item, click the View Details icon in the Details column. This option is only available once the user is approved for the training item. Note: If the training was removed by an administrator, the user will receive a "Restricted Area" message, as removed training is inaccessible to end users.
To add external training to the certification, click the Add External Training link in the Details section. See External Training - Add to Certification from Details Page on page 424 for additional information.
To add an external training item to the certification that already exists on your transcript, click the Add External Training from Transcript link in the Details section. See External Training - Add to Certification from Transcript on page 426 for additional information.
Fields for Certifications in Certified Status
The following fields apply to certifications in a Certified status only. These fields do NOT apply to certifications in any other status, including the Certified (Renewal in Progress) status.
· The Current Period field displays the title of the certification period, along with the date the user completed the period requirements (dates will be shown in UTC time zone). 
· The Next Period field displays the title of the next certification period, along with the date the next period will begin (dates will be shown in UTC time zone).
· The Next Version field displays the certification version number the user will receive during the next certification period. 
· The Expiration Date field has been updated to Next Period Expiration Date, which indicates when the user's next certification period will expire (dates will be shown in UTC time zone).
· The Due Date field has been updated to Next Period Due Date, which displays the due date for the user's next certification period (dates will be shown in UTC time zone).
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History
The History section displays all of the past certification periods for the certification, if applicable. For each period, the following information displays:
· Period - The certification period number.
· Credits Required - The number of credits required for the period.
· Credits Acquired - The number of credits that were earned for the period.
· Carry Over - If carry over is allowed, this displays the number of credits that were carried over to the next period.
· Completion Date - The date the period was completed. For ILT sessions, the session completion date is used, rather than the roster upload date.
· Expiration - The date the certification period was completed. For Past Periods, the Expiration column will display the previous Period Completion Date.
Print Certificate
To print a past certificate, in the History section, click the Print Certificate link next to the appropriate certification. This option is only available if enabled by the administrator. See Historical Certifications - Print on page 428 for additional information.
Certification Requirements
If the certification you are viewing is also within another certification, a Certifications Requirement section displays the requirements for that certification.
Approval History
The certification approval history is displayed in the Approval History section. This includes all approvals related to the certification. If a user is enrolled as certified, this is displayed in this section. If comments were included when the certification was approved or denied, an indication is made here, as well as stating the type of request for which comments were provided (i.e., Initial, Completion, Exception, or Renewal request).
Modification History
For certifications with external training added, a Modification History section is available at the bottom of the Certification Training Details page. This section tracks all updates that are made to the certification. 
· If a training section or credits are updated, this is logged.
· If a field is updated, the specific field is logged, including the updated value.
· If multiple fields are updated, a line item is added for each change.
Approval or denial of external training towards the certification continues to be tracked in the Approval History section.
Revoke
To revoke a certification, click the Revoke button. When a user's certification is revoked, the Certification Transcript page reflects the Revoked status in the Status column. In addition, certifications in a Revoked status do not proceed to renewal periods if renewal periods are associated with the certification.
If the user would like to become re-certified, they must re-request the certification or it must be reassigned. Note: The user must be removed from the certification by the certification owner before they can re-request the certification. When re-requested, the Approval History section displays the approval history data of all previous instances of the certification in the user's transcript, regardless of the number of times the certification has been revoked. Progress from the previous certification carries over to the new instance of the certification request/assignment if the learning objects are still valid. Further, the History section does not display for new instances of a certification that was in a Revoked status.
Note: The option to print certificates is not available for certification periods that are in a Revoked status.
Place On Hold
From the Certification Details page, you can place a certification on hold by clicking the Place On Hold button. After clicking the Place On Hold button, a Certification On Hold pop-up window appears. In the pop-up, you can provide a comment explaining why the certification is being placed on hold in the Comments box. After entering a comment, click the Submit button to place the certification on hold. Note: Certifications in any transcript status can be placed on hold.
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When the user views the certification on their transcript, the status for the displays with "(On Hold)" following the status the certification was in prior to being placed on hold. For example, if the certification was in a Certified status prior to being placed on hold, when the certification has been placed on hold, the status reads, "Certified (On Hold)."
The "(On Hold)" addendum appears in any system location where the certification status may display, including:
· Transcript
· Certification Details
· Action steps
· Cohort
· Manage Employee Learning
· Certification Management
· Certification Approval page
Reinstate Certification
To reinstate a certification that is on hold, click the Reinstate button on the Certification Details page. A Reinstate Certification pop-up window appears. Enter a comment explaining the reinstatement in the Comments field, and click the Submit button.
The certification returns to its previous transcript status on the user's transcript page, and the reinstatement appears in the Approval History section of the Certification Details page along with the name of the user who reinstated the certification, the time stamp of the reinstatement, and any comments provided during the reinstatement process.
Progress Report
To view the progress report for the certification, click the Progress Report link in the upper-right corner of the page. You can then select the period from the drop-down list and print the report by clicking the Print icon. From the Progress Report, administrators with the appropriate permission can update the user's number of acquired credits. Note: Acquired credits can still be updated when the transcript lockdown feature is enabled. See the Transcript Lockdown section below for additional information.
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The following information displays for the report:
· Title - The certification title displays at the top of the report.
· Certification Period - This field displays the certification period. By default, the report shows the progress for the period the user is currently in.
· Options - The Options drop-down displays the option to print the report. Click the Print link to print the report.
· Period - This displays the certification period.
· Due - This displays when the certification is due.
· Relative Due Date - For certifications with a relative due date defined, the Due field displays the time frame from the start date (i.e., "2 days from start date," or "1 year from start date").
· Fixed Due Date - For certifications with a fixed due date defined, the Due field displays the actual date.
· Duration - This displays for renewal periods and shows the duration of the renewal period.
· Required Credits - This displays the number of credits required to be completed in order to complete the certification.
· Expand/Collapse - An Expand/Collapse option displays in the upper-right corner of the period. Click the icons to view or close the information in the period. By default, all certification periods are expanded.
· Requirements - This column displays the sections for the certification and lists the LOs defined for each section.
· If the certification is configured to override the Course Catalog LO availability settings, then all LOs display for the user regardless of whether or not the user meets the availability criteria for the LOs.
· If the certification is not configured to override the Course Catalog LO availability settings, then the only LOs that display are the LOs for which the user meets the availability criteria.
· LO Type - An icon displays to the left of each LO to indicate the LO type for the training item. Hover over the icon to view the name of the LO type.
· Earned - This column displays information about the credits earned for the certification. If the certification is configured not to override LO availability, then the number of credits is dependent upon the availability of the LOs in the certification.
· Min/Max - This displays the minimum and maximum number of credits to be completed for a section.
· Number of Credits - The number of credits defined for a LO displays in the Credits column for each LO.
Modify Period Expiration Date 
Only certification owners have the ability to adjust the end date or expiration date for the current certification period. For certification owners, an Edit icon appears to the right of the Expiration Date field. Modifying the expiration date for the period affects the renewal periods in the following manner:
· Fixed Date
· Only the current period is affected. All future periods retain their expiration date.
· The updated expiration date must occur prior to the due date of the subsequent period.
· Relative Date and Relative Date with Rolling Renewal
· If the expiration date for a period is changed, the expiration date and past due date for all future periods are updated based on the change. For example, if the expiration date is pushed back by three months, the expiration date and past due date for all subsequent periods is also pushed back by three months.
· There is no maximum adjustment for the expiration date.
· The Past Due date for the current period is not affected.
Transcript Lockdown
If the transcript lockdown functionality is enabled for the portal, then the data that is related to a learning object (LO) on the Certification Transcript Details page and the Progress Report is locked once the LO is completed. Once the LO is completed, the data on the Transcript Details page will not change for the LO. This applies even if the LO is moved to the Archived or Removed tabs of the transcript. This functionality applies to all LO types.
Note: The lockdown functionality does not include custom fields. Custom fields are not locked upon course completion.
Considerations
· If the Transcript Lockdown functionality is disabled and was not enabled at the time the user completed the LO, then the Transcript Details page and Progress Report display the LO information based on the current values in the Course Catalog.
· If the Transcript Lockdown functionality is enabled or was enabled at the time the user completed the LO, then the Transcript Details page and Progress Report always displays the LO information from the time the user completed the LO. 
· If the Transcript Lockdown functionality was disabled at the time the user completed the LO and was enabled after the user completed the LO, then the Transcript Details page and Progress Report displays the LO information from the time the Transcript Lockdown functionality is enabled.
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Training - Archive
[bookmark: concept221]Training can be archived from the training's Training Details page.
To archive training, go to Learning > View Your Transcript. Select the View Training Details option for the training. In the upper-right corner, click the Move to Archived Transcript link.
· Archiving training removes training from the Active or Completed transcript and moves it into the Archive transcript.
· From the Transcript page, at the top of the Transcript section, click the Archive tab to view all archived training.
· Training can be made Active again or moved back to the Completed tab by clicking the Training Title and then on the Activate button.
When a certification is archived, the due date is removed from all of the training items associated with the certification. Also, the certification and the certification child training items are archived and moved to the Archived section of the certification transcript. Automatic Movement of Training Items (Auto-Archival) does not apply to certifications. For the display of certifications refer to the Certification Display Preferences section of the Transcript Preferences help topic: See Transcript Preferences on page 405 for additional information.
By default, certification reporting excludes archived users. However, administrators may choose to include archived users when running the reports.
Note: If a certification is in a status of Certified and on the Archived tab of a user's transcript, and an administrator attempts to reassign the certification to this user, the certification will remain on the Archived tab.
[image: ]
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Training - Remove from Transcript
Administrators may have the option to remove training from a user's transcript. Any type of training that has not been completed can be removed. The removal of a training item is a reversible action. No records are actually deleted, just hidden from a user. With the exception of sessions, the original transcript status of the item is not changed; the transcript status of a removed session is changed to Withdrawn.
From the user's perspective, the process of requesting training that once existed on their transcript and was removed is exactly the same as requesting it for the first time, except that once it is requested, the transcript status of the item may be different. For example, if the item was previously approved, the user will not need to get the training approved again.
· Requesting a removed training item restores it to the user's transcript.
· Assigning a removed training item restores it to the assigned user's transcript.
· The Request button will appear if the user has the item on their transcript but the item has been Removed. Clicking the button will add the training item back to the user's active transcript. 
· The transcript status of the item will not change, unless the item was a withdrawn session, in which case it is requested again.
Note: LOs marked exempt from the Training Details page cannot be removed from the user's transcript. The Options column on the Transcript page displays N/A for LOs with an Exempt status.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Edit Transcript Items
	Grants ability to modify training due dates, statuses, and scores on other user's transcripts (training records) when viewing training details for particular learning objects on the transcript. User must also have permission to add external training in order to add or edit another user's external training. This permission can be constrained by OU, User's OU, User Self and Subordinates, User, and User's Self.
Note: Users with this permission also will also see the Add SF-128 link on the transcript.
	Learning - Administration



	Refund Training
	Grants ability to issue a refund for a training item while removing it from the user's transcript. This is an administrator permission.
	eCommerce - Administration



	Remove Training
	Grants ability to remove training from other users' transcripts (training records) when viewing their transcript. This permission can be constrained by OU, User's OU, User's Corporation, User Self and Subordinates, User's Self, User's Direct Subordinates, and User. This is an administrator permission.
	Learning - Administration



	Transaction Manager - Manage
	Grants ability to access the Manage Transaction page and also create and edit transactions. On the Order History Details page, the administrator can edit the order status, adjust prices, issue refunds, or enter comments. This permission can be constrained by User's OU. This is an administrator permission.
	eCommerce - Administration



	Users - View
	Grants the ability to search for and view summary information about users in the portal via the Admin/Users screen. This permission can be constrained by OU, User's OU, User Self and Subordinates, and Users. If multiple constraints are added, these constraints are considered OR statements. This is an administrator permission.
	Core Administration



	View Transcript Item
	Grants ability to view details of learning objects that appear on the transcript (training record), by clicking on the name of the learning object. Users must also have the Bio About - View permission in order to access the transcript within Universal Profile. This permission can be constrained by OU, User's OU, User Self and Subordinates, User, or User's Self. This is an end user permission.
	Learning - Administration


Emails
	EMAIL NAME
	EMAIL DESCRIPTION
	ACTION TYPE



	Training Removed from Transcript
	If enabled, this email is triggered when an administrator removes a training item from a user's transcript. This email is also triggered when a training item is dynamically removed because the user was dynamically removed from a dynamic learning assignment.
	Training


Training can be removed from the user's transcript from the Users page, My Team, or Track Employees based on access and permissions assigned to administrator.
Access Transcript
A user's transcript can be accessed in the following ways:
· Users page - Admin > Users. Search for user. Then, select the View Transcript option in the Options drop-down menu.
· Reports page - Reports > Track Employees > Transcripts. Click the View link for the user
· My Team - My Team > User ID Card > Profile > Transcript
· Universal Profile > Search for and select a user using Global Search. Click the Transcript tab.
Remove LO
To remove a LO, go to Learning > View Your Transcript. From the Action drop-down menu, click Remove, if available.
Remove Training Pop-up
Clicking the Remove option opens the Remove Training pop-up.
Select Reason - Select the reason for removing the LO. This is required. Note: Reasons appear in the user's display language, when available. If the user's display language is not available, then the reason appears in the reason's default language.
Comments - In the field, enter additional comments regarding the LO removal. Depending on the selected reason, this may be required.
Refund training item to user - If refunds are enabled, this option allows you to initiate a refund for the user. The original payment method is refunded the training cost less any fees. Note: This functionality is only available for items purchased with training units or a credit card. Also, refunds are not available if the item was purchased entirely by the user's cost center.
· If the administrator has permission to manage transactions, but not remove training from a user's transcript, they can only issue refunds from the Manage Transactions page.
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Remove all instances of this training
Select this option to remove all instances of the training.
· All instances of the training are moved from the Active or Archived training category to the Removed training category.
Remove the current instance only and revert training details to display the previous instance
Select this option to only remove the current instance of the training.
· The removed instance of the training appears on the Training Details page as Cancelled.
· The previous instance of the training becomes the current instance and appears in the Active training category on the transcript.
· The removal is documented in the History section on the Training Details page.
· The removed instance cannot be restored.
Remove Child LOs from within a Curriculum
If the selected LO is a curriculum, an additional option is available on the Training Removal page. Check the Remove training within the Curriculum option to ensure that when the curriculum is removed from the user's transcript, the child LOs contained within the curriculum are also removed from the transcript. If this option is left unchecked, when the curriculum is removed, the child LOs will remain on the user's transcript. This option is disabled by default. Note: The entire curriculum, including its child training, remains intact when removed via the Training Removal Tool, Learning Assignment Tool, or by manual transcript removal. This preserves the structure of the removed curriculum and eliminates the need for transcript cleanup. Upon reassignment, the intact curriculum moves to the Active tab of the user's transcript. Important: This behavior only applies to curriculum child training items which are in a non-completed status. In other words, if a curriculum child training is in a Completed, Completed Equivalent, or Exempt status, it will not remain intact within the curriculum; it will remain as a standalone completed training item on the Completed tab of the user's transcript. Similarly, upon reassignment of the curriculum, these completed training items will remain as standalone items on the Completed tab.
Note: If the child training contained within a curriculum cannot be removed from the user's transcript due to an exception in this scenario, it remains as a standalone LO on the user’s transcript, and the due date for the child LO, if any, is removed. If the LO is within another curriculum on the User’s transcript and left as standalone, it will then inherit the Due Date set for the LO in the curriculum structure.
The due date behaviors for LOs that cannot be removed are:
· If the LO has no parent LO, the due date is set to “No Due Date.”
· If the LO has one or more parent LOs:
· If the LO has one parent, the due date is set as the parent’s due date. If the parent LO has no due date, the child LO due date is set to “No Due Date.”
· If the LO has multiple parent LOs, due date is set as the minimum due date from the parent. For example, if the due date of Parent 1 is 3/1/2017 and the due date of Parent 2 is 1/1/2017, then the due date for the child LO is 1/1/2017).
Note: If an Administrator has the Remove Training Permission but does not have the Remove Training - Directly Assigned or the Remove Training - Self-Requested permission, then the administrator cannot remove Sessions with the following statuses from user transcripts.
· Completed
· Incomplete
· Pending Completion Approval
· Failed
· Pending Evaluation
· Pending Prerequisite
· No Show
· Pending Acknowledgement
· Pending Post-Work
· Pending Pre-Work
· Pending Completion Signature
Directly Assigned sessions in the statuses listed above cannot be removed from the transcript using the Remove Training permission and Remove Training - Directly assigned permissions unless the remover is the user who directly assigned the session. Administrators should use the Training Removal Tool to remove sessions in those statuses. Administrators will need Training Removal - Remove Completed training permission to remove sessions in a Completed status. For self-requested sessions in the statuses above, if an Administrator has both the Remove Training Permission and the Remove Training – Self-Requested, then the administrator can remove non-completed sessions requested by users.
Q: Can you revert an instance of a course to its previous registration?
A: Yes, as long as the following are true:
· There are more registrations for the training in the transcript.
· The previous registration is the same version number
However, if there is only one registration or the previous instance is a different version number, you will be navigated to a different page on which you can only move all instances to the user's Removed tab.
Save or Cancel
After selecting the appropriate option, click Save to remove the training. Or, click Cancel to cancel the removal action and return to the Transcript page.
Removing a training item will trigger any active emails for the Training Removed from Transcript email trigger.
Removed Training
· Removed training is still recognized by the system as part of the user's transcript when checking for prerequisite training.
· When an administrator or manager removes a training item from a user's transcript that is part of a certification, the following occurs: 
· If the training item has already been credited, the credit will not be rolled back.
· If sequencing is available for the certification sections and the user has completed the training item, thus enabling a section later in the sequence, the later section continues to be available. For example, LO1 is in section A and you must complete section A prior to accessing section B. If LO1 is completed and thus completes section A, if LO1 is removed, the user can still access section B.
· If an administrator removes a session for which the user is on the roster, waitlist, or exception request list, the user will automatically be withdrawn from the session and the transcript status will update accordingly (the user will be withdrawn and the session will be removed).
· Removed users will appear on the roster if the instructor chooses to view Withdrawn users.
· These users will also appear on the Session Withdrawal report if they were previously registered.
· Sessions with Completed status cannot be removed.
· Any related training or pre/post work that is activated is added to the main transcript page.
· Removing a training item from the transcript does not change the transcript status of that item (it only changes the value of the Removed flag for that item).
· Removing training items that are in a Pending Approval status removes the training from the Approvers inbox, and it can no longer be approved
· If the item is a curriculum that contains training items which have been activated, then any items within that curriculum that have been activated will be moved to the main transcript page as standalone items (if they are not there already). 
· Any items that were Not Activated will be removed with the curriculum.
· The curriculum details page for the removed curriculum, accessed from the Removed Transcript Items page, will list all of the items that were originally there regardless of whether they were also moved to the main transcript page.
· Training Unit Approval History displays the date the item was removed, the administrator that performed the action, and the comments entered. If training item is restored, the entry includes the date the item was restored and the name of the administrator that performed the action. 
Restore Training
See Training - Restore to Transcript on page 562 for additional information.
Reporting
· Removed Training that is Pending Approval or Pending Completion Approval will not appear on the Employee Pending Requests page.
· Removed training items do not count towards to the Training Hours completed for that user that year (which is displayed on the transcript).
· Removed Status (Transcript section), Removal Comments, Removal Date and Remover (Transaction section) fields available for reporting in custom reports.
· The transcript record will not appear in any training reports that do not have the filter set to include removed training items. 
· The registration costs are not reimbursed when a training item is removed. The records for removed training items will still appear in the Enterprise billing and Cost Center billing reports. 
· Removed training items do not appear in any reports except the Enterprise Billing Report, Cost Center Billing Report, Session Withdrawal Report, Enterprise Training Report, and Analytics reports.
[bookmark: _Ref-181998565]Training - Restore to Transcript
There are two methods to restore removed training to a user's transcript.
Note: When restoring an online course for which a new version has been created, the new version automatically replaces the previous version if the course is not in an In Progress status on the Removed tab when the course is restored. If the course is in an In Progress status, the version of the course that was current at the time the course was removed from the user's transcript is the version that is restored. In this case, the new version would need to be added to the user's transcript, or the user would need to request the new version.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Universal Profile - User Record - View Users
	Grants ability to view user records in the system. Administrators can view the Modification History page for user records within their constraints. The administrator must have additional permissions to view specific fields on the user record. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission.
	Core Administration



	Users - View
	Grants the ability to search for and view summary information about users in the portal via the Admin/Users screen. This permission can be constrained by OU, User's OU, User Self and Subordinates, and Users. If multiple constraints are added, these constraints are considered OR statements. This is an administrator permission.
	Core Administration



	View Transcript Item
	Grants ability to view details of learning objects that appear on the transcript (training record), by clicking on the name of the learning object. Users must also have the Bio About - View permission in order to access the transcript within Universal Profile. This permission can be constrained by OU, User's OU, User Self and Subordinates, User, or User's Self. This is an end user permission.
	Learning - Administration


Manual
A manual restoration of a training item results in the Due Date remaining the same as the Due Date that was defined by the original assignment or request of that training. 
1. On the user's transcript, select Removed from the Training Category filter.
2. Click the Restore to Transcript link to reverse action and move the training item back to the users active transcript
Automated
Learning Assignment, Inventory Assignment, User Request Training or License Management. 
1. Learning Assignment - If an LO was removed from a user's transcript via training removal tool, dynamic removal, or manually removal by an administrator, and then that same LO is assigned via a learning assignment and the user meets the assignment criteria, the LO will be restored. Whatever due date previously existed will be replaced by the assignment's defined due date/no due date.
2. Assign Subordinate - If an LO was removed from a user's transcript, via dynamic removal or manual removal, if that same LO is assigned by the user's manager from the Assign Training page, the LO will be restored with a new due date or no due date as defined by the manager.
3. User Requests - If an LO was removed from a user's transcript and the user later requests the same training, the LO will be restored and replaced with No Due Date. (The Catalog does not define Due Dates for requested training.)
· If a user has requested training and that training has no due date, the user can still be assigned that training via proxy, inventory, or manager assignment. If assignment occurs after a request and the training is in any status before Complete that LO will be refreshed with a Due Date as defined by the assignment. Assignment Due Dates override requested training lack of due dates.
4. Inventory Assignment (Pre-Purchases training) - If a user requested training, and then is given training via Inventory assignment, any Due Date defined by the Inventory Assignment will apply. 
5. License Management - When a removed item is being restored though license management and a due date is entered, all restored items due dates get updated. Note: When a removed item is restored though license management and there is NO due date, all restored items will have their due dates removed or replaced.
Transcript - Download Offline Learning
Users with the permission for downloading Offline Learning can download the Offline Learning application from their learning transcript page.
To download the Offline Learning application, go to Learning > View Your Transcript.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Offline Learning - Download application file from Transcript
	Grants ability to view the Download Offline Learning link on the transcript. This is an end user permission.
	Learning - Administration


[image: ]
Download Offline Learning
After navigating to the transcript, click the Options drop-down menu. Click the Download Offline Learning link. The Offline Learning application will begin downloading. Once finished downloading, the application can be installed, and users can use the application to download courses which can then be completed offline. See Offline Player Application Overview for more information on using the application.
Use Case
Rita works in sales at ABC Corporation. As part of her role, Rita frequently travels to meet with potential clients. Rita spends many hours on flights, where no or very poor internet connectivity is available, but she wishes she could take training during this time.
Rita opens the company portal and accesses to her transcript. From the Options menu, she downloads the Offline Learning application to her laptop and installs it. She can download relevant courses and make them available for offline consumption and optimize the time she spends flying.
Transcript - On the Job Training
Material learning objects can be configured as On the Job Training (OJT) items by administrators, which provides end users with additional options for managing On the Job Training from the learning transcript. A Pending Observer Completion transcript status is available for OJT material LOs, and a new Notify Observer option is available to users for managing their OJT items. 
Permissions 
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	On the Job Training - Notify Observers
	Grants access for users to select On The Job Training Observers. This is an end user permission.
	Learning - Administration


Notify Observer
After becoming registered for an OJT material LO, the OJT displays to the user in a Pending Observer Completion status. A new Notify Observer option also displays for the OJT. When the user feels confident in their knowledge and experience with the skills taught by the OJT, the user can click the Notify Observer option to notify a qualified instructor that they are ready to be observed and evaluated on the OJT skills. This triggers the Observer Notification email trigger, if enabled, but this step is optional. Regardless of whether the user chooses to notify the observers, as soon as the OJT is in a status of Pending Observer Approval, ALL observers associated with the OJT are able to observe the user for any part of the OJT.
Note: The In Progress status usually available for material LOs is NOT available for OJT material LOs.
The Pending Observer Completion status and the Notify Observer option are available for OJT accessed from the following system areas:
· Learning Transcript (New)
· Learning Transcript (Old)
· Curricula
· Curricula Details
· Cohorts
· Welcome Page Widgets
· Custom Page Widgets
· Universal Profile - Action Items
[image: ]
Select Observer
Clicking the Notify Observer option opens the Select Observer pop-up window. Using this window, users can search for and select the name of the specific qualified observer by whom they wish to be evaluated. After selecting the name of an observer, a confirmation message appears to confirm their selection. Note: The observer most recently selected by the user is saved as the observer so the user can quickly notify the same observer in the future, if needed.
[image: ]
On The Job Training Completion
If the observer marks the user as completed for the OJT, the OJT item moves to a status of Completed on the user’s transcript. If the observer marks the user as failed for the OJT, the OJT item remains in a status of Pending Observer Completion. The user can select the Notify Observer option again when they are ready to make another completion attempt. Note: The Mark Complete option normally available to users for material LOs is NOT available for OJT material LOs.
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[bookmark: concept228]Training - Open Overview
Training can be opened by the user in multiple ways.
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Training - Open from LO Details Page
Certain learning object (LO) types may be launched from the LO Details page without navigating to the Transcript page.
To enable this functionality, contact Global Customer Support.
See LO Details Page - LO Actions.
Learning Details Redesign
With the February 2019 release, a redesigned Learning Details page was released as an Early Adopter project. As of the August 2020 release, this project is no longer in an Early Adopter status and is now generally available. The Learning Details page is available for the following training types if enabled by your system administrator:
· Curricula
· Events and Sessions
· External Content
· Materials
· Online Content
· Online Courses
· Tests
· Videos
More features will be added to the Learning Details page in future releases. For more information about the redesigned Learning Details page: See Learning Details Page .
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Training - Open from Transcript
[bookmark: concept230]To open a training item from your transcript:
1. Click the View Your Transcript link. This link can be accessed from the Home page or the Learner Home page.
2. Select the appropriate option to the right of the training item. Depending on the training type and the current status of the training item, the name of the link to initiate the item will vary. Online courses open in a new window. If the Network Player is enabled, you may have the option to Launch Locally or Launch Online. See Network Player Transcript Options on page 470 for additional information.
[image: ]
· Note: For events within the Curriculum Player, the Select Session link does not display if restricted by the administrator. You can still view the details of the event by clicking the View Details icon but cannot select a session.
· Note: If a training item within a library is already activated outside the library, the Activate link does not work. If you experience the Activate link not working within a library, search for the training item on your transcript and access it directly. 
· Loading Note: For issues with opening a training item, such as an online course, that continues to remain in a loading state, contact the system administrator for your organization for help with troubleshooting the issue.
Webex Virtual Sessions
For Webex virtual sessions, you can launch multiple active parts as they become available based on the learning object's approval status on the transcript. The date of the session for which you are registered displays in parentheses next to the event title and is followed by the date of the next upcoming part. 
Depending on the Webex settings, the part may not be accessible until a certain number of minutes prior to the start time. If the host has not yet started the meeting, the following notification displays:
[image: ]
[bookmark: concept231]New Online Course Version Available - Notifications
If desktop notifications are enabled in your portal, users can opt to allow desktop notifications from the system to display, when available. Regardless of whether desktop notifications are enabled, a Javascript notification will always appear to users in the online course window if they are assigned a new version of the training while they are viewing the course. See Notifications Preferences for information about enabling desktop notifications.
Allow or Block Notifications
After notifications have been enabled in the portal, the first time the user accesses either the Welcome page or their Transcript page in the portal, they receive a pop-up requesting permission to display notifications. The pop-up reads, "Cornerstone wants to show notifications." The user can choose from the following options:
· Allow - If the user clicks the Allow button, they will see any available desktop notifications from the system. For example, if a new course version becomes available while they are currently viewing the course, the user will receive a desktop notification that a new course version is available.
· Block - If the user clicks the Block button, the will not see any available desktop notifications from the system. The user will not be shown the pop-up again. If they later wish to enable these notifications, they can do so via their browser settings. 
The user can close out of the pop-up without selecting either option by clicking the X icon in the upper-right corner of the pop-up.
[image: ]
Course Updated Notification
When a user has opted to allow notifications, if a new online course version is assigned to them while they are viewing the online course, a desktop notification appears. The notification alerts the user that a new version of the training is available and provides the user with a link that redirects them to the page from which they launched the course so they can access the new version.
[image: ]
If desktop notifications are NOT enabled, a Javascript notification appears in the upper-right corner of the online course window, which alerts the user that a new version of training is available and provides the user with a link to the page from which they launched the course. This notification appears regardless of whether or not the user opted to allow desktop notifications. This Javascript notification cannot be disabled or configured.
Note: If the user continues to complete the older version of the online course, they will NOT receive completion credit for the course. On their transcript, only the progress they made on the course prior to receiving the new version notification is saved.
New Version Available
When the user is redirected to the page from which they launched the online course, a notification displays, informing the user that a new version of the online course is available. The notification also instructs them to launch the new version that was assigned to them. To close the notification, the user can click the OK button.
[image: ]
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Training - Register from Transcript
To register for online training, go to Learning > View Your Transcript. Select the Register option for the training. The system automatically processes the registration and the Launch option becomes available. Click the Launch option to launch the course.
This process differs when registering for an instructor led session. See Session - Register on page 442 for additional information.
Transcript Lockdown - Administrator Overview
Organizations have the option to lock the data that is related to a training course on a user's transcript and certification transcript once the course is completed. Once a course is completed, the transcript data and the data on the Training Details page will not change for the course. This applies even if the course is moved to the Archived or Removed tabs or training categories of the transcript. This prevents administrators from changing information related to a course (e.g., title, description), which would, in turn, update a user's transcript even after the course is completed. This enhancement enables organizations to better maintain compliance with 21 CFR Part 11 regulations. This functionality applies to all learning object (LO) types.
The Transcript Lockdown functionality is effective as soon as the functionality is enabled. This functionality cannot capture course data prior to the date on which the functionality is enabled.
This functionality is controlled by a backend setting and is disabled by default, so organizations can choose to not lock course data. To enable this functionality, contact Global Customer Support.
Considerations
· This functionality does not include custom fields. Custom fields are always locked upon course completion, regardless of enablement of Transcript Lockdown.
· New Connect does not currently support the Transcript Lockdown functionality. This tool currently displays the current or updated LO details.
· If the Transcript Lockdown functionality is enabled, the Edit Transcript Items permission is disabled. Users with this permission are not able to edit transcript items.
· For recurring LOs, each recurrence is locked upon completion. If an LO is reverted to a previous instance, the details at the time of completion for the previous instance are available and are displayed on the user's transcript. The instance that is removed is no longer available in the system.
· If data is updated in the system from the backend, any course completion data is not captured as a result of the backend changes. When data loads populate completed course data into the system via the Training Update Tool, the system captures the course information at the time the course is loaded to the system.
· When a user is assigned a course via a learning assignment with a Completed status, the course information is captured at the time the assignment is processed. 
· When an administrator marks a course as Completed, the course information is captured at the time the administrator marks the course as Completed.
· LO attachment information is locked only if the attachment is visible to registered users. Attachments that are limited to administrators, owners, or instructors are not locked.
· When both the Print to PDF option and the Transcript Lockdown feature are enabled, the PDF print output contains the locked course data that is visible on the Certification Training Details page.
· When the Data Merge feature merges completed training information that has been locked from one user’s account to another user’s account, the locked Certification training details are carried over as part of the merge.
Certifications
Support
· When viewing the details for a completed LO in a current certification period, the locked transcript details are displayed.
· LOs completed in the previous period for a certification are included in the Completed tab of a user's transcript. Clicking the LO title displays the locked transcript details.
· The locked information for LOs in previous periods are stored in the database if Transcript Lockdown is enabled at the time the course is completed. These details can be retrieved, if necessary.
Considerations
· Completed LOs in completed certification periods display the real-time course title in the transcript.
· When a certification is printed or when the progress is viewed, the real-time course information is displayed.
Use Case - Transcript
An organization needs to be compliant with 21 CFR Part 11 regulations. Because of this, the organization needs to be sure that the training information that displays on a user's transcript does not change after the user has completed the course. This organization enables the Transcript Lockdown functionality.
· On December 1, 2013, User 1 completes an online course titled Effective Listening Skills.
· On March 1, 2014, an administrator updates the course description in the course catalog for Effective Listening Skills.
· On March 2, 2014, User 2 completes Effective Listening Skills.
For User 1, the original description displays on the Training Details page for the Effective Listening Skills course.
For User 2, the updated course description displays on the Training Details page for the Effective Listening Skills course.
Scenarios
Scenario 1:
· On July 1, 2013, the Transcript Lockdown functionality is enabled.
· On July 4, 2013, a user completes a test titled Independence Day Test 2013.
· On July 5, 2013, an administrator updates the name of the test to Independence Day Test 2014.
· Result: The user's transcript displays the test title as Independence Day Test 2013.
Scenario 2:
· On July 1, 2013, a user completes a test titled Independence Day Test 2013.
· On July 4, 2013, the Transcript Lockdown functionality is enabled.
· On July 5, 2013, an administrator updates the name of the test to Independence Day Test 2014.
· Result: The user's transcript displays the test title as Independence Day Test 2014.
Scenario 3:
· On July 1, 2013, a user completes a test titled Independence Day Test 2013.
· On July 4, 2013, the Transcript Lockdown functionality is disabled.
· On July 5, 2013, an administrator updates the name of the test to Independence Day Test 2014.
· Result: The user's transcript displays the test title as Independence Day Test 2014.
Scenario 4:
· On July 1, 2013, the Transcript Lockdown functionality is disabled.
· On July 4, 2013, a user completes a test titled Independence Day Test 2013.
· On July 5, 2013, an administrator updates the name of the test to Independence Day Test 2014.
· Result: The user's transcript displays the test title as Independence Day Test 2014.
Use Cases - Certification Transcript
Use Case 1
An organization needs to be compliant with 21 CFR Part 11 regulations. They need to ensure that training information that displays on a user’s Certification transcript does not change after the user has completed the certification. To achieve compliance, they enabled the new Transcript Lockdown functionality.
Use Case 2
1. On December 1, 2013, User 1 completes an online course that is a required training item in his Leadership Certification.
2. On March 1, 2014, an administrator updates the course title in Course Catalog.
3. On March 2, 2014, User 2 completes the same online course.
4. On the Certification transcript for User 1, the original title for the online course displays.
5. On the Certification transcript for User 2, the updated course title displays.
Scenarios
Scenario 1:
· On July 1, 2013, the Transcript Lockdown functionality is enabled.
· On July 4, 2013, a user completes a test titled Independence Day Test 2013.
· On July 5, 2013, an administrator updates the name of the test to Independence Day Test 2014.
· Result: The user's transcript displays the test title as Independence Day Test 2013.
Scenario 2:
· On July 1, 2013, a user completes a test titled Independence Day Test 2013.
· On July 4, 2013, the Transcript Lockdown functionality is enabled.
· On July 5, 2013, an administrator updates the name of the test to Independence Day Test 2014.
· Result: The user's transcript displays the test title as Independence Day Test 2014.
Scenario 3:
· On July 1, 2013, a user completes a test titled Independence Day Test 2013.
· On July 4, 2013, the Transcript Lockdown functionality is disabled.
· On July 5, 2013, an administrator updates the name of the test to Independence Day Test 2014.
· Result: The user's transcript displays the test title as Independence Day Test 2014.
Scenario 4:
· On July 1, 2013, the Transcript Lockdown functionality is disabled.
· On July 4, 2013, a user completes a test titled Independence Day Test 2013.
· On July 5, 2013, an administrator updates the name of the test to Independence Day Test 2014.
· Result: The user's transcript displays the test title as Independence Day Test 2014.
Security
The following permission is disabled when the Transcript Lockdown functionality is enabled. This prevents users from editing transcript details by disabling the Edit Transcript Details link and the Edit icon on the Training Details page.
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Edit Transcript Items
	Grants ability to modify training due dates, statuses, and scores on other user's transcripts (training records) when viewing training details for particular learning objects on the transcript. User must also have permission to add external training in order to add or edit another user's external training. This permission can be constrained by OU, User's OU, User Self and Subordinates, User, and User's Self.
Note: Users with this permission also will also see the Add SF-128 link on the transcript.
	Learning - Administration


User Transcript - Completed Tab/Training Category
Organizations can lock the data related to a training course on a user's transcript once the course is completed. Once a course is completed, the transcript data will not change for the course. This applies even if the course is moved to the Archived or Removed tabs or training categories of the transcript. This functionality applies to all learning object (LO) types.
· If the Transcript Lockdown functionality is disabled and was not enabled at the time the user completed the LO, then the user's transcript displays the LO information based on the current values in the Course Catalog.
· If the Transcript Lockdown functionality is enabled or was enabled at the time the user completed the LO, then the user's transcript always displays the LO information from the time the user completed the LO. 
Training Details Page - Completed Learning Object
Organizations can lock the data related to a training course on the Training Details page once the course is completed. Once a course is completed, the data on the Training Details page will not change for the course. This applies even if the course is moved to the Archived or Removed tabs of the transcript. This functionality applies to all learning object (LO) types. Note: This enhancement does not include custom fields. Custom fields are always locked upon course completion, regardless of enablement of Transcript Lockdown..
· If the Transcript Lockdown functionality is enabled, the Edit Transcript Items permission is disabled. Users with this permission are not able to edit transcript items from the Transcript Details page. This includes the Edit Transcript Details link and the Edit icon that appears next to the Due Date.
· If the Transcript Lockdown functionality is disabled and was not enabled at the time the user completed the LO, then the Training Details page displays the LO information based on the current values in the Course Catalog.
· If the Transcript Lockdown functionality is enabled or was enabled at the time the user completed the LO, then the Transcript Details page always displays the LO information from the time the user completed the LO. 
[bookmark: _Ref-1666199996]Transcript - Transcript Report
Users are able to run the Transcript Report from the Universal Profile - Transcript page.
To run the Transcript Report from the Universal Profile - Transcript page, select the Run Transcript Report option from the Options drop-down menu.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	View Transcript Item
	Grants ability to view details of learning objects that appear on the transcript (training record), by clicking on the name of the learning object. Users must also have the Bio About - View permission in order to access the transcript within Universal Profile. This permission can be constrained by OU, User's OU, User Self and Subordinates, User, or User's Self. This is an end user permission.
	Learning - Administration
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Training Criteria
The Training section enables users to filter the report results by learning object (LO) type, training title, or one or more subjects. These filters apply to top-level (standalone) training only.
	Filter Name
	Filter Description

	Type
	From the drop-down menu, select each of the training types that should appear in the Transcript Report. At least one training type must be selected. All training types are checked by default. Unselecting an option removes it from the report output. In the report output, training types are sorted in alphabetical order. Events are only included when they are standalone training items.

	Title
	Enter a training title to filter the report by a specific training title. The report only contains training items that have a title that matches the search keywords.

	Subject(s)
	Click the Select icon [image: ]
 to open the Select Subject pop-up, which is a Single Item Select pop-up. See Single Item Select Pop-up for additional information. Select one or more subjects with which to filter. Once a subject is selected, it appears in the Subject(s) field. Additional subjects can be added by clicking the Select icon again. On the report output, subjects display in alphabetical order.


Date Criteria
The Date section enables users to filter the report based on a date range.
	Filter Name
	Filter Description

	Date Field
	Select one of the following options:
· Date Added to Transcript - Select this option to filter the results by the date on which the training was added to the user's transcript. When selected, the report output displays training items in the order in which they were added to the transcript.
· Training Start Date - Select this option to filter the results by the date on which a training item started. Note: The Date Range field is required when this option is selected. Also, the Include Completed Training Only option is checked by default and not editable. The start date is configured as follows:
· Event/Session - The date on which the session starts.
· External Training - The date on which the external training starts.
· Material - The date on which the user registers for the material.
· Test - The date on which the user clicks Start to begin the test. For multiple instances of a test, the start date is configured as each subsequent instance that the Start button is clicked.
· Online Course, Quick Course, Curriculum, Library, Posting - The date on which the training achieves a status of In Progress.
· Training Completion Date (Session and External training will use End Date) - Select this option to filter the results by the date on which a training item ended. Note: The Date Range field is required and the Include Completed Training Only option is checked by default and not editable when this option is selected. Also, training items must be in a status of Completed in order to appear in the report output when this option is selected. The end date is configured as follows:
· Event/Session - The date on which the session ended; not the date on which the roster was submitted.
· External Training - The date on which the external training ended; not the date on which the training was marked complete.
· Material - The date on which the material was marked complete.
· Online Course, Quick Course, Curriculum, Library, Posting, Test - The date on which the training achieved a status of Completed.

	Date Range
	Click on Calendar icon [image: ] to select a Start and End Date, or enter a date range to filter the report by date. The End Date cannot be before the Start Date and it cannot be after today's date. 
· If the Start Date is left blank, then the report returns all records that occurred at any point before the End Date.
· If the End Date is left blank, then the report returns all records that occurred at any point after the Start Date.


Advanced Criteria
The Advanced section enables users to define additional criteria to include in the report results.
	Filter Name
	Filter Description

	Include Associated Training (Curriculum Training and Pre or Post Work)
	Select this option to include training details from curricula or pre and post work from an event.

	Include Archived Training
	Select this option to include training that has been archived.

	Include Required Training Information
	Select this option to include a Required and Requirements column in the report. The Required column displays whether the training is required. The Requirements column displays what requirements are covered by the assigned training.
This option is only available if Required Training Tagging is activated in Feature Activation Preferences.

	Include Completed Training Only
	Select this option to include only completed training. When this option is selected, the following additional options are available:
· Show most recent completion - Selecting this option displays only the most recently completed LO. If selected, on the report output, the Completed Training Only field displays "Yes, Show only the most recent instance of completion."
· Show all completions if the user has completed more than one instance - Selecting this option displays all LOs that are in a status of Completed. This includes training items on the Completed and Archived tabs. If selected, on the report output, the Completed Training Only field displays "Yes, Show all historical instances of completion if user has completed more than one instance." 

	Include Training Detail Information
	Select this option to include training detail information. When checked standard and training custom field filters appear. The following standard field filters may appear:
· Credits - This option displays the number of credits associated with the LO. 
· Price - This option is only available if pricing is enabled in the portal. This option displays the price associated with the LO.
· If the user has not yet registered for the Learning Object, then this value is the price as it is defined for the LO.
· If the user has a status of registered or a status after registered, then this value displays what the user was charged for the training.
· Provider (Vendor) - This option displays the LO provider or vendor, if applicable.
· Training Hours - This option displays the LO training hours. A value does not display if the training hours have not been defined for the LO. 
· Version - This option displays the LO version, if the LO can be versioned. A value does not display for a LO if the LO cannot have multiple versions. 
· Custom Fields - Custom fields also display in alphabetical order.


Back or Run Report
Click Back to return to the Universal Profile - Transcript page. Or, click Run Report to generate the report in Excel in a new window.
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[bookmark: _Ref1438416438]Course Troubleshooting Guide
Cornerstone's Learning Management System (LMS) provides organizations with comprehensive functionality for uploading and allowing access to online courses. Due to the complexities of online course and LMS workflows and processes, sometimes unexpected issues may arise. In this document, we will review some of the more common problems that can occur and what can be done to avoid or fix them.
Common Bugs
In most cases, the root cause for content defects is course file-related issues. The first step is to test your courses in SCORM Cloud in Frameset mode, using the Rustici website, to ensure your course functions as expected. This is an industry standard online course testing platform available to everyone that emulates a LMS.
The following types of issues may be prevented by testing your course in SCORM Cloud prior to publishing it within the Cornerstone LMS:
1. Content issues affecting user experience
2. Administrator is not familiar with LMS/SCORM guidelines and practices
Course Completion Issues
Most course completion issues (where a user believes they have completed the course but the course is not showing as "Completed" on their transcript) arise from the course being architected or published out of the authoring tool incorrectly. Since there are so many different authoring tools available commercially, troubleshooting this particular issue can be problematic. However, there are a few rules of thumb that clients can follow to avoid this issue:
1. LMS Reporting - When publishing a course from the authoring tool, many tools provide a choice of “reporting status” to the LMS. For example, a course building tool may provide options for LMS reporting, such as “Passed/Incomplete,” “Passed/Failed," "Completed/Incomplete," and “Completed/Failed.” We have found that options which include the terms "Passed" and "Failed" could introduce completion issues on users' transcripts, so in this instance we recommend the use of the "Passed/Incomplete" option.
2. Course Architecture - There will be cases where the authoring tool being used doesn’t provide insight into when exactly course/LMS communication will occur. With tools like Articulate Presenter, Articulate Storyline, Adobe Presenter, and other rapid development tools, the black-box nature of the tool does not give visibility into the LMS calls that are triggered from the course. In these situations, organizations need to be careful to build the course in such a way as to ensure these communications take place. Since doing this is so dependent on the course structure and tool used, there isn’t a standard way of implementing proper communication. However, we can provide the following guidance:
1. Test the course using SCORM Cloud in Frameset mode to ensure your course functions as expected. 
2. Always provide a way for the user to easily exit the course. This is usually implemented in the form of an Exit button or link that's always available in the course shell.
3. Ensure that any actions or triggers on the current page in the course occur when the user exits the course. For example, if you've built a page in the course that takes user input which subsequently gets stored in the LMS, you want to make sure you provide a mechanism, such as a "Next Page" action or a suspend call to the LMS, that reads that data before the course is exited.
4. Ensure you are marking the correct method for tracking progress and completion in the course reporting and tracking options. Whether using a number or percentage of slides viewed or using the results of a quiz within the course, make it clear to your users what is expected from them to complete the course.
Note: The below image is an example of some tracking options, but your tool's options may be different depending on the tool and the version being used. Be sure to review the documentation and support provided by your tool's vendor.
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3. Completion Criteria - Even if a course is built correctly, the course still relies on the user to interact with it properly in order for the course to be completed and for the completion to be passed to the LMS and register on the user's transcript. It is important that users are aware of what they need to do to complete the course. For example, if there is a minimum amount of time that the user must spend viewing each slide or a minimum quiz score that must be obtained in order to complete the course, then the user should be aware of these criteria. Otherwise, the user may think there is an issue with the course and contact their manager or system administrator.
4. Leverage Your Tool's Support - The information provided in this guide includes general guidelines. For the most up-to-date information related to your tool, please leverage the documentation and support provided by your content authoring tool's vendor. This will provide you with information that is specific to the tool and version that you are using. Some examples of course authoring tool vendors include Articulate, Adobe, Lectora, and Captivate.
Additional Resources
How Cornerstone Learning Handles Completion and Success Statuses Sent from Courses
[bookmark: _Toc161994692]Universal Profile - User Record - View
The User Record page enables administrators or managers with the proper permissions to view the core information about a user. When in view mode, the User Record cannot be modified.
A user's record can be viewed in the following manners:
· Go to Admin > Tools > Core Functions > Users. Then, select the name of the user in the search results.
· Select the user's photograph from any page within Universal Profile or from Global Search. Then, select the User Record tab.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Grades - View
	Grants ability to view the Grade Organizational Unit throughout the system, such as in availability drop down selectors, when editing users, etc. Those without this permission do not see the Grade OU on any screen. This is primarily an administrator permission, although organizational policy should determine whether the Grade OU should be visible to end users on reporting screens, etc.
	Core Administration



	Universal Profile - User Record - Edit Users
	Grants ability to edit user records in the system. The administrator must have additional permissions to edit specific fields on the user record. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission. Note: This permission DOES NOT grant the ability to view user records in the system. Administrators must have the Universal Profile - User Record - View Users permission in order to view user records.
	Core Administration



	Universal Profile - User Record - View Users
	Grants ability to view user records in the system. Administrators can view the Modification History page for user records within their constraints. The administrator must have additional permissions to view specific fields on the user record. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission.
	Core Administration



	Users – Edit Custom Field Information
	Grants ability to view and edit the custom fields on a user record. Administrators are only able to edit a custom field on a user's user record if the user is within their permission constraints and the administrator is within the availability of the custom field. This permission works in conjunction with the Users - View permission. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission.
	Core Administration



	Users – Edit General Information
	Grants ability to edit the general fields on a user record, including first name, last name, username, assigned OUs, and custom relationships. This permission works in conjunction with the Users - View permission. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission.
	Core Administration



	Users - Edit Middle Name
	Grants ability to modify the middle name for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission. This is an administrator permission.
	Core Administration



	Users - Edit Mobile Phone
	Grants ability to modify the Mobile Phone number for a user via the Admin/Users screen. The availability of this permission is controlled by a backend setting. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Prefix
	Grants ability to modify the prefix for a user's name via the admin/users screen. This permission only works when used in conjunction with the Users - View permission. This is an administrator permission.
	Core Administration



	Users - Edit Sensitive Information: Unmasked
	Grants ability to view and edit unmasked Sensitive Personally Identifiable Information (SPII) fields on the user record. Administrators with this permission have the option to view and edit the actual data on the user record. This permission can be constrained by OU, User's OU, User's Self, User's Subordinates, User's Direct Subordinates, User, and Employee Relationship. This is an administrator permission.
	Core Administration



	Users - Edit Signature
	Grants ability to modify the signature font for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission. This is an administrator permission.
	Core Administration



	Users - Edit Suffix
	Grants ability to modify the suffix for a user's name via the admin/users screen. This permission only works when used in conjunction with the Users - View permission. This is an administrator permission.
	Core Administration



	Users - Edit User ID
	Enables administrator to modify the User ID for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Absent Status
	Enables administrator to modify the Absent status for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Active Status
	Enables administrator to modify the Active status for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Address
	Enables administrator to modify the address for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Approver
	Enables administrator to modify the specified Approver for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Email
	Enables administrator to modify the Email Address for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Fax
	Enables administrator to modify the Fax number for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Language
	Enables administrator to modify the portal display language for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Last Hire Date
	Enables administrator to modify the Last Hire Date for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Manager
	Enables administrator to modify the assigned Manager for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Original Hire Date
	Enables administrator to modify the Original Hire Date for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Phone
	Enables administrator to modify the Phone number for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Photo
	Enables administrator to upload a photo for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Reconciliation
	Enables administrator to modify the Reconciliation status for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Required Approvals
	Enables administrator to modify the number of required training approvals for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Time Zone
	Enables administrator to modify the portal time zone for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users – Effective Dating: Manage
	Enables administrator to make effective dated changes to the user record. This permission only works when used in conjunction with the Users - Edit General Information permission. This permission cannot be constrained. This is an administrator permission.
	Core Administration



	Users - View
	Grants the ability to search for and view summary information about users in the portal via the Admin/Users screen. This permission can be constrained by OU, User's OU, User Self and Subordinates, and Users. If multiple constraints are added, these constraints are considered OR statements. This is an administrator permission.
	Core Administration



	Users – View Custom Field Information
	Grants ability to view the custom fields on a user record. Administrators are only able to view a custom field on a user's user record if the user is within their permission constraints and the administrator is within the availability of the custom field. This permission works in conjunction with the Users - View permission. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission.
	Core Administration



	Users – View General Information
	Grants ability to view the general fields on a user record, including first name, last name, username, assigned OUs, and custom relationships. This permission works in conjunction with the Universal Profile - User Record - View Users permission. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission.
	Core Administration



	Users - View Middle Name
	Grants ability to view the middle name for a user via the Admin/Users screen. This permission only works when used in conjunction with the Universal Profile - User Record - View Users and Users - View General Information permissions. This is an administrator permission.
	Core Administration



	Users - View Mobile Phone
	Grants ability to view the Mobile Phone number for a user via the Admin/Users screen. The availability of this permission is controlled by a backend setting. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - View Modification Details
	Grants ability to view the Modification Details on the User Record and view User Audits fields when creating a Reporting 2.0 report. This permission only works when used in conjunction with the Users - View permission. This is an administrator permission.
	Core Administration



	Users - View Prefix
	Grants ability to view the prefix for a user's name via the Admin/User screen. This permission only works when used in conjunction with the Universal Profile - User Record - View Users and Users - View General Information permissions. This is an administrator permission.
	Core Administration



	Users - View Sensitive Information: Masked
	Grants ability to view masked Sensitive Personally Identifiable Information (SPII) fields on the user record. Administrators with this permission cannot view the actual data. This permission can be constrained by OU, User's OU, User's Self, User's Subordinates, User's Direct Subordinates, User, and Employee Relationship. This is an administrator permission.
	Core Administration



	Users - View Sensitive Information: Unmasked
	Grants ability to view unmasked Sensitive Personally Identifiable Information (SPII) fields on the user record. Administrators with this permission have the option to view the actual data on the user record. This permission can be constrained by OU, User's OU, User's Self, User's Subordinates, User's Direct Subordinates, User, and Employee Relationship. This is an administrator permission.
	Core Administration



	Users - View Signature
	Grants ability to view the signature font for a user via the Admin/Users screen. This permission only works when used in conjunction with the Universal Profile - User Record - View Users permission. This is an administrator permission.
	Core Administration



	Users - View Suffix
	Grants ability to view the suffix for a user's name via the Admin/Users screen. This permission only works when used in conjunction with the Universal Profile - User Record - View Users permission.
	Core Administration



	Users - View User ID
	Enables administrator to view the User ID for a user via the Admin/Users screen. This permission only works when used in conjunction with the Universal Profile - User Record - View Users permission.
	Core Administration



	Users - View Users Absent Status
	Enables administrator to view the Absent status for a user via the Admin/Users screen. This permission only works when used in conjunction with the Universal Profile - User Record - View Users permission.
	Core Administration



	Users - View Users Active Status
	Enables administrator to view the Active status for a user via the Admin/Users screen. This permission only works when used in conjunction with the Universal Profile - User Record - View Users permission.
	Core Administration



	Users - View Users Address
	Enables administrator to view the address for a user via the Admin/Users screen. This permission only works when used in conjunction with the Universal Profile - User Record - View Users permission.
	Core Administration



	Users - View Users Approver
	Enables administrator to view the specified Approver for a user via the Admin/Users screen. This permission only works when used in conjunction with the Universal Profile - User Record - View Users permission.
	Core Administration



	Users - View Users Email
	Enables administrator to view the Email Address for a user via the Admin/Users screen. This permission only works when used in conjunction with the Universal Profile - User Record - View Users permission.
	Core Administration



	Users - View Users Fax
	Enables administrator to view the Fax number for a user via the Admin/Users screen. This permission only works when used in conjunction with the Universal Profile - User Record - View Users permission.
	Core Administration



	Users - View Users Language
	Enables administrator to view the portal display language for a user via the Admin/Users screen. This permission only works when used in conjunction with the Universal Profile - User Record - View Users permission.
	Core Administration



	Users - View Users Last Hire Date
	Enables administrator to view the Last Hire Date for a user via the Admin/Users screen. This permission only works when used in conjunction with the Universal Profile - User Record - View Users permission.
	Core Administration



	Users - View Users Manager
	Enables administrator to view the assigned Manager for a user via the Admin/Users screen. This permission only works when used in conjunction with the Universal Profile - User Record - View Users permission.
	Core Administration



	Users - View Users Original Hire Date
	Enables administrator to view the Original Hire Date for a user via the Admin/Users screen. This permission only works when used in conjunction with the Universal Profile - User Record - View Users permission.
	Core Administration



	Users - View Users Phone
	Enables administrator to view the Phone number for a user via the Admin/Users screen. This permission only works when used in conjunction with the Universal Profile - User Record - View Users permission.
	Core Administration



	Users - View Users Photo
	Enables administrator to view a photo for a user via the Admin/Users screen. This permission only works when used in conjunction with the Universal Profile - User Record - View Users permission.
	Core Administration



	Users - View Users Reconciliation
	Enables administrator to view the Reconciliation status for a user via the Admin/Users screen. This permission only works when used in conjunction with the Universal Profile - User Record - View Users permission.
	Core Administration



	Users - View Users Required Approvals
	Enables administrator to view the number of required training approvals for a user via the Admin/Users screen. This permission only works when used in conjunction with the Universal Profile - User Record - View Users permission.
	Core Administration



	Users - View Users Time Zone
	Enables administrator to view the portal time zone for a user via the Admin/Users screen. This permission only works when used in conjunction with the Universal Profile - User Record - View Users permission.
	Core Administration
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Permission Considerations
Administrators with the Universal Profile - User Record - View Users permission can view user records for users within their permission constraints. Administrators must also have one or more of the Users - View or Users - Edit permissions in order to view the corresponding fields on the user record for users within their permission constraints.
As a best practice, administrators or managers who need access to view user records should at least be granted the Universal Profile - User Record - View Users and the Users - View General Information permissions. If an administrator only has the Universal Profile - User Record - View Users permission, then they can only view a blank user record with no fields.
Note: The Universal Profile - User Record - Edit Users permission DOES NOT grant the ability to view user records in the system. Administrators must have the Universal Profile - User Record - View Users permission in order to view user records.
User Record - Options
The following options may be available from the Options drop-down menu:
· Modification History - Select this option to view the Modification History page for the user. This option is only available to administrators who have permission to view users. See User Record - Modification History on page 639 for additional information.
· Change Password - Select this option to reset the user's password. This option is only available to administrators who have permission to change the user's password. See Edit User Password.
· Proxy as this user - Select this option to open the Proxy as Another User page. This page enables the administrator to proxy into the system as another user. This page also displays a history of all administrators who have used the Proxy feature for the user. This option is only available to administrators who have permission to proxy as the user. Important Note: Although the system tracks when administrators proxy as another user, the system does not track the actions that are performed by the administrators on behalf of the user. As such, this functionality should be available to only the top level system administrators. See Proxy as Another User.
· Permissions - Select this option to view all of the user's permissions in all of the user's roles. Each permission's constraints are also displayed. This option is only available to administrators who have permission to manage the user's security administration. See View Permissions - User Record.
· Unlock Account - Select this option to unlock the locked account. A confirmation pop-up opens to confirm the action. This option only appears for a user if their account has been locked due to unsuccessful login attempts. Also, this option is only available to administrators who have permission to unlock the user's account.
· Employee Salary - Select this option to view the Employee Salary Management page for the user. There, administrators can add, remove, and update the user's salaries. This option is available to administrators who have permission to manage the user's salaries. See Employee Salary Management.
· Expand all sections - This option is available by default, regardless of whether there are any collapsed sections on the User Record. Select this option to expand all sections on the User Record. Once this option is selected, the Collapse all sections option becomes available.
· Collapse all sections - This option is available after the Expand all sections option is selected, regardless of whether there are any expanded sections on the User Record. Once this option is selected, the Expand all sections option becomes available.
User Record - Edit Record
Administrators with the Universal Profile - User Record - Edit Users permission can select the Edit Record button in the light grey floating action bar at the bottom of the screen in order to edit the user record. Administrators must also have one or more of the Users - Edit permissions in order to edit the corresponding fields on the user record for users within their permission constraints. See User Record - Edit on page 607 for additional information.
User Record - Effective Dated Records
For organizations that have Effective Dating enabled, the effective date of the user record is displayed at the top of the page in the timezone of the user whose user record is being viewed. See User Record - Effective Dating on page 644 for additional information. 
General Information
The General Information fields are available at the top of the user record, which include basic information about the user, such as name, photograph, and user name.  See User Record - General Information on page 614 for additional information.
Sensitive Information
The Sensitive Information section is only available on the User Record when Encrypted Sensitive Information is enabled in the portal, and this functionality is only available to organizations using Cornerstone HR. This section enables organizations to view and edit Sensitive Personally Identifiable Information (SPII) fields. See User Record - Sensitive Information on page 620 for additional information.
Contact Information
The Contact section contains all of the user's contact information, such as address, phone, and email address. This section should be used to store the user's professional contact information. See User Record - Contact on page 623 for additional information.
Settings
The Settings section contains all of the user's system settings, such as display language, time zone, signature font, and required training approvals. See User Record - Settings on page 626 for additional information.
Organizational Structure
The Organization Structure section contains all of the user's organizational information, such as manager, approver, division, position, and location. See User Record - Organization Structure on page 628 for additional information.
E-Commerce
The E-Commerce Information section contains a user's override amount and value added tax (VAT) number. See User Record - E-Commerce on page 632 for additional information.
User Type and Employment Status
The User Type and Employment Status section contains the user's type (e.g., Employee, Intern, Contractor), user status (e.g., Working, On Leave, Terminated), and additional information regarding the user's status. See User Record - User Type and Employment Status on page 634 for additional information.
User Record Custom Fields
Each User Record custom field category that is defined in Custom Field Administration appears as a section on the User Record. All user record custom fields that are associated with that category appear within the section, which can be expanded and collapsed as with other sections. See User Record - User Record Custom Fields on page 637 for additional information.
[bookmark: _Toc161994693]User Record - Add
The Add New User page enables administrators to create a new user in the system and set the details of the user's record. Administrators are only able to view and set fields based on their permissions. If an administrator does not have permission to view or edit a field on the user record, then the field is not visible to the administrator.
To add a new user record, go to Admin > Tools > Core Functions > Users. Then, select the Add User link.
Note: Users can also be added in bulk using the Data Load Wizard. See Load User Data - Step 1 - Get Started for additional information.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Grades - View
	Grants ability to view the Grade Organizational Unit throughout the system, such as in availability drop down selectors, when editing users, etc. Those without this permission do not see the Grade OU on any screen. This is primarily an administrator permission, although organizational policy should determine whether the Grade OU should be visible to end users on reporting screens, etc.
	Core Administration



	Universal Profile - User Record - Edit Users
	Grants ability to edit user records in the system. The administrator must have additional permissions to edit specific fields on the user record. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission. Note: This permission DOES NOT grant the ability to view user records in the system. Administrators must have the Universal Profile - User Record - View Users permission in order to view user records.
	Core Administration



	Universal Profile - User Record - View Users
	Grants ability to view user records in the system. Administrators can view the Modification History page for user records within their constraints. The administrator must have additional permissions to view specific fields on the user record. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission.
	Core Administration



	Users – Edit Custom Field Information
	Grants ability to view and edit the custom fields on a user record. Administrators are only able to edit a custom field on a user's user record if the user is within their permission constraints and the administrator is within the availability of the custom field. This permission works in conjunction with the Users - View permission. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission.
	Core Administration



	Users – Edit General Information
	Grants ability to edit the general fields on a user record, including first name, last name, username, assigned OUs, and custom relationships. This permission works in conjunction with the Users - View permission. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission.
	Core Administration



	Users - Edit Middle Name
	Grants ability to modify the middle name for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission. This is an administrator permission.
	Core Administration



	Users - Edit Mobile Phone
	Grants ability to modify the Mobile Phone number for a user via the Admin/Users screen. The availability of this permission is controlled by a backend setting. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Prefix
	Grants ability to modify the prefix for a user's name via the admin/users screen. This permission only works when used in conjunction with the Users - View permission. This is an administrator permission.
	Core Administration



	Users - Edit Sensitive Information: Unmasked
	Grants ability to view and edit unmasked Sensitive Personally Identifiable Information (SPII) fields on the user record. Administrators with this permission have the option to view and edit the actual data on the user record. This permission can be constrained by OU, User's OU, User's Self, User's Subordinates, User's Direct Subordinates, User, and Employee Relationship. This is an administrator permission.
	Core Administration



	Users - Edit Signature
	Grants ability to modify the signature font for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission. This is an administrator permission.
	Core Administration



	Users - Edit Suffix
	Grants ability to modify the suffix for a user's name via the admin/users screen. This permission only works when used in conjunction with the Users - View permission. This is an administrator permission.
	Core Administration



	Users - Edit User ID
	Enables administrator to modify the User ID for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Absent Status
	Enables administrator to modify the Absent status for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Active Status
	Enables administrator to modify the Active status for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Address
	Enables administrator to modify the address for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Approver
	Enables administrator to modify the specified Approver for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Email
	Enables administrator to modify the Email Address for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Fax
	Enables administrator to modify the Fax number for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Language
	Enables administrator to modify the portal display language for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Last Hire Date
	Enables administrator to modify the Last Hire Date for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Manager
	Enables administrator to modify the assigned Manager for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Original Hire Date
	Enables administrator to modify the Original Hire Date for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Phone
	Enables administrator to modify the Phone number for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Photo
	Enables administrator to upload a photo for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Reconciliation
	Enables administrator to modify the Reconciliation status for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Required Approvals
	Enables administrator to modify the number of required training approvals for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Time Zone
	Enables administrator to modify the portal time zone for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users – Effective Dating: Manage
	Enables administrator to make effective dated changes to the user record. This permission only works when used in conjunction with the Users - Edit General Information permission. This permission cannot be constrained. This is an administrator permission.
	Core Administration


Emails
	EMAIL NAME
	EMAIL DESCRIPTION
	ACTION TYPE



	New User Record Created (via Add User Page)
	This email can be configured as a notification and is triggered when a new user record is created via the Admin - Users page. This email is not sent to users who are created via a data feed. This email can be sent to the User Created, User Creator, or the User's Manager.
The PASSWORD.RESET.URL email tag is a link that opens a page on which the user can create a password. If this email is sent multiple times to the same recipient, then this URL is regenerated each time and the previous URL is no longer valid. Also, the password reset URL is only valid for 48 hours. If the user does not reset their password within the 48-hour validity period, then the user must click Forgot Password? again to get a new password reset URL.
	System Administration
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Options
The following options may be available from the Options drop-down menu:
· Expand all sections - This option is available by default, regardless of whether there are any collapsed sections on the User Record. Select this option to expand all sections on the User Record. Once this option is selected, the Collapse all sections option becomes available.
· Collapse all sections - This option is available after the Expand all sections option is selected, regardless of whether there are any expanded sections on the User Record. Once this option is selected, the Expand all sections option becomes available.
General Information
The General Information fields are available at the top of the user record, which include basic information about the user, such as name, photograph, and user name.  See User Record - General Information on page 614 for additional information.
Sensitive Information
The Sensitive Information section is only available on the User Record when Encrypted Sensitive Information is enabled in the portal, and this functionality is only available to organizations using Cornerstone HR. This section enables organizations to view and edit Sensitive Personally Identifiable Information (SPII) fields. See User Record - Sensitive Information on page 620 for additional information.
Contact Information
The Contact section contains all of the user's contact information, such as address, phone, and email address. This section should be used to store the user's professional contact information. See User Record - Contact on page 623 for additional information.
Settings
The Settings section contains all of the user's system settings, such as display language, time zone, signature font, and required training approvals. See User Record - Settings on page 626 for additional information.
Organizational Structure
The Organization Structure section contains all of the user's organizational information, such as manager, approver, division, position, and location. See User Record - Organization Structure on page 628 for additional information.
E-Commerce
The E-Commerce Information section contains a user's override amount and value added tax (VAT) number. See User Record - E-Commerce on page 632 for additional information.
User Type and Employment Status
The User Type and Employment Status section contains the user's type (e.g., Employee, Intern, Contractor), user status (e.g., Working, On Leave, Terminated), and additional information regarding the user's status. See User Record - User Type and Employment Status on page 634 for additional information.
User Record Custom Fields
Each User Record custom field category that is defined in Custom Field Administration appears as a section on the User Record. All user record custom fields that are associated with that category appear within the section, which can be expanded and collapsed as with other sections. See User Record - User Record Custom Fields on page 637 for additional information.
Save User Record
To save a new user record, select the Save button in the dark grey floating action bar at the bottom of the screen. The administrator is navigated back to the User Records Administration page. See User Records Administration.
Depending upon the Password Preferences, you may be required to set a temporary password for the new user. After setting the temporary password, click Save. This triggers the New User Created (via Add User Page) email, if configured in Email Administration.
[bookmark: _Ref906104906][bookmark: _Toc161994694]User Record - Edit
The Edit User Record page enables administrators to modify the details of a user's record. Administrators are only able to view and edit fields based on their permissions. If an administrator does not have permission to view or edit a field on the user record, then the field is not visible to the administrator.
Edit a user's user record in one of the following ways:
· Go to Admin > Tools > Core Functions > Users and select the name of the appropriate user.
· Navigate to the user's Universal Profile. Select the User Record tab from the Universal Profile navigation. Then, select the Edit Record button.
For organizations that have Effective Dating enabled, the administrator must set an effective date for the modifications prior to editing the user record. See User Record - Effective Dating on page 644 for additional information. 
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Grades - View
	Grants ability to view the Grade Organizational Unit throughout the system, such as in availability drop down selectors, when editing users, etc. Those without this permission do not see the Grade OU on any screen. This is primarily an administrator permission, although organizational policy should determine whether the Grade OU should be visible to end users on reporting screens, etc.
	Core Administration



	Universal Profile - User Record - Edit Users
	Grants ability to edit user records in the system. The administrator must have additional permissions to edit specific fields on the user record. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission. Note: This permission DOES NOT grant the ability to view user records in the system. Administrators must have the Universal Profile - User Record - View Users permission in order to view user records.
	Core Administration



	Universal Profile - User Record - View Users
	Grants ability to view user records in the system. Administrators can view the Modification History page for user records within their constraints. The administrator must have additional permissions to view specific fields on the user record. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission.
	Core Administration



	Users – Edit Custom Field Information
	Grants ability to view and edit the custom fields on a user record. Administrators are only able to edit a custom field on a user's user record if the user is within their permission constraints and the administrator is within the availability of the custom field. This permission works in conjunction with the Users - View permission. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission.
	Core Administration



	Users – Edit General Information
	Grants ability to edit the general fields on a user record, including first name, last name, username, assigned OUs, and custom relationships. This permission works in conjunction with the Users - View permission. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission.
	Core Administration



	Users - Edit Middle Name
	Grants ability to modify the middle name for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission. This is an administrator permission.
	Core Administration



	Users - Edit Mobile Phone
	Grants ability to modify the Mobile Phone number for a user via the Admin/Users screen. The availability of this permission is controlled by a backend setting. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Prefix
	Grants ability to modify the prefix for a user's name via the admin/users screen. This permission only works when used in conjunction with the Users - View permission. This is an administrator permission.
	Core Administration



	Users - Edit Sensitive Information: Unmasked
	Grants ability to view and edit unmasked Sensitive Personally Identifiable Information (SPII) fields on the user record. Administrators with this permission have the option to view and edit the actual data on the user record. This permission can be constrained by OU, User's OU, User's Self, User's Subordinates, User's Direct Subordinates, User, and Employee Relationship. This is an administrator permission.
	Core Administration



	Users - Edit Signature
	Grants ability to modify the signature font for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission. This is an administrator permission.
	Core Administration



	Users - Edit Suffix
	Grants ability to modify the suffix for a user's name via the admin/users screen. This permission only works when used in conjunction with the Users - View permission. This is an administrator permission.
	Core Administration



	Users - Edit User ID
	Enables administrator to modify the User ID for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Absent Status
	Enables administrator to modify the Absent status for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Active Status
	Enables administrator to modify the Active status for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Address
	Enables administrator to modify the address for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Approver
	Enables administrator to modify the specified Approver for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Email
	Enables administrator to modify the Email Address for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Fax
	Enables administrator to modify the Fax number for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Language
	Enables administrator to modify the portal display language for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Last Hire Date
	Enables administrator to modify the Last Hire Date for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Manager
	Enables administrator to modify the assigned Manager for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Original Hire Date
	Enables administrator to modify the Original Hire Date for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Phone
	Enables administrator to modify the Phone number for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Photo
	Enables administrator to upload a photo for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Reconciliation
	Enables administrator to modify the Reconciliation status for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Required Approvals
	Enables administrator to modify the number of required training approvals for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users - Edit Users Time Zone
	Enables administrator to modify the portal time zone for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View permission.
	Core Administration



	Users – Effective Dating: Manage
	Enables administrator to make effective dated changes to the user record. This permission only works when used in conjunction with the Users - Edit General Information permission. This permission cannot be constrained. This is an administrator permission.
	Core Administration



	User Preferences - Reasons for Change: Manage
	Grants ability to define and configure Reasons for Change on the User Preferences administrator page, which may be used when modifying the user record. The administrator must also have the User Preferences - Core Information: View permission to access the User Preferences page.
This permission is also required to view and set the Reason for Change field when editing a user record.
This permission cannot be constrained. This is an administrator permission.
	Core Administration
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Options
The following options may be available from the Options drop-down menu:
· Expand all sections - This option is available by default, regardless of whether there are any collapsed sections on the User Record. Select this option to expand all sections on the User Record. Once this option is selected, the Collapse all sections option becomes available.
· Collapse all sections - This option is available after the Expand all sections option is selected, regardless of whether there are any expanded sections on the User Record. Once this option is selected, the Expand all sections option becomes available.
General Information
The General Information fields are available at the top of the user record, which include basic information about the user, such as name, photograph, and user name.  See User Record - General Information on page 614 for additional information.
Sensitive Information
The Sensitive Information section is only available on the User Record when Encrypted Sensitive Information is enabled in the portal, and this functionality is only available to organizations using Cornerstone HR. This section enables organizations to view and edit Sensitive Personally Identifiable Information (SPII) fields. See User Record - Sensitive Information on page 620 for additional information.
Contact Information
The Contact section contains all of the user's contact information, such as address, phone, and email address. This section should be used to store the user's professional contact information. See User Record - Contact on page 623 for additional information.
Settings
The Settings section contains all of the user's system settings, such as display language, time zone, signature font, and required training approvals. See User Record - Settings on page 626 for additional information.
Organizational Structure
The Organization Structure section contains all of the user's organizational information, such as manager, approver, division, position, and location. See User Record - Organization Structure on page 628 for additional information.
E-Commerce
The E-Commerce Information section contains a user's override amount and value added tax (VAT) number. See User Record - E-Commerce on page 632 for additional information.
User Type and Employment Status
The User Type and Employment Status section contains the user's type (e.g., Employee, Intern, Contractor), user status (e.g., Working, On Leave, Terminated), and additional information regarding the user's status. See User Record - User Type and Employment Status on page 634 for additional information.
User Record Custom Fields
Each User Record custom field category that is defined in Custom Field Administration appears as a section on the User Record. All user record custom fields that are associated with that category appear within the section, which can be expanded and collapsed as with other sections. See User Record - User Record Custom Fields on page 637 for additional information.
Save User Record
To save changes to a user record, select the Save button in the dark grey floating action bar at the bottom of the screen. When the user record is saved, each field value is validated. 
When saving a user record, the administrator is returned to their original page. For example, if the administrator edits a user record after navigating from the Users search page, then the administrator is returned to the User's search page when the user record is saved. 
If Effective Dating is enabled, following the field validations, the system behavior depends on the effective date:
· Today - If the effective date is set to Today, then each modification is added to the user's Modification History and a new record is added to the Effective Dated Records timeline. Each individual modification is also applied to all future effective dated records that do not specify a modification to the same field.
· Past Date - If the effective date is set to a date in the past, then each modification is added to the user's Modification History and a new record is added to the Effective Dated Records timeline. Each individual modification is also applied to the current user record and all future effective dated records that do not specify a modification to the same field.
· Future Date - If the effective date is set to a date in the past, then a new record is added to the Effective Dated Records timeline. Each modification is not added to the user's Modification History until the effective date of the record is reached and the modifications are processed successfully. Each individual modification is applied to all effective dated records that have an effective date that is beyond the selected effective date so long as the effective dated records do not specify a modification to the same field.
[bookmark: _Ref-2029598800][bookmark: _Toc161994695]User Record - General Information
The User Record page is organized into sections. The General Information fields are available at the top of the user record, which include basic information about the user, such as name, photograph, and user name. 
Note: An asterisk next to a field indicates that the field is required and a value must be entered in order to save the user record.
To add a new user record, go to Admin > Tools > Core Functions > Users. Then, select the Add User link.
Edit a user's user record in one of the following ways:
· Go to Admin > Tools > Core Functions > Users and select the name of the appropriate user.
· Navigate to the user's Universal Profile. Select the User Record tab from the Universal Profile navigation. Then, select the Edit Record button.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Universal Profile - User Record - Create Users
	Grants ability to access the User Record Administration page and to create new users in the system. When creating a new user, this permission grants the ability to add general information, which includes first name, last name, username, assigned OUs, and custom relationships. The administrator must have additional permissions to add any additional fields. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission.
	Core Administration



	Universal Profile - User Record - Edit Users
	Grants ability to edit user records in the system. The administrator must have additional permissions to edit specific fields on the user record. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission. Note: This permission DOES NOT grant the ability to view user records in the system. Administrators must have the Universal Profile - User Record - View Users permission in order to view user records.
	Core Administration



	Users – Edit Custom Field Information
	Grants ability to view and edit the custom fields on a user record. Administrators are only able to edit a custom field on a user's user record if the user is within their permission constraints and the administrator is within the availability of the custom field. This permission works in conjunction with the Users - View permission. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission.
	Core Administration



	Users - Edit Local System ID
	Enables administrator to modify the Local System ID for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View and Users - Edit permissions. This permission cannot be constrained. This is an administrator permission.
	Core Administration



	Users - View
	Grants the ability to search for and view summary information about users in the portal via the Admin/Users screen. This permission can be constrained by OU, User's OU, User Self and Subordinates, and Users. If multiple constraints are added, these constraints are considered OR statements. This is an administrator permission.
	Core Administration



	Users – View General Information
	Grants ability to view the general fields on a user record, including first name, last name, username, assigned OUs, and custom relationships. This permission works in conjunction with the Universal Profile - User Record - View Users permission. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission.
	Core Administration



	Users - View Local System ID
	Enables administrator to view the Local System ID for a user via the admin/users screen. This permission only works when used in conjunction with the Users - View and Users - Edit permissions. This permission cannot be constrained. This is an administrator permission.
	Core Administration


Additional permissions are required to view and edit the various fields on the user record. See User Record Permissions for additional information.
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Photograph
Administrators can view or edit the user photo, provided they have the appropriate permission.
· Change Photo - To upload a new photo or edit and crop an existing photo, click the Change Photo button below the photograph. The recommended size for photos is 200 x 200 pixels. The available file types for photos are jpg, png, and gif.
· Remove Photo - To remove an existing photo, click the Change Photo button below the photograph. Select the Edit tab at the top of the Change Photo window. Then, select the Delete Photo button. When a photo is removed, the default image is displayed for the user throughout the system.
Name
Enter the following name components:
· Prefix - The character limit for this field is 10. Administrators must have permission to view or edit the prefix.
· First Name - This is required. The character limit for this field is 200. This field is considered general information. Administrators must have permission to view or edit general information.
· Middle Name - The character limit for this field is 200. Administrators must have permission to view or edit the middle name.
· Last Name - This is required. The character limit for this field is 200. This field is considered general information. Administrators must have permission to view or edit general information.
· Suffix - The character limit for this field is 10. Administrators must have permission to view or edit the suffix.
User Name
This field is considered general information. Administrators must have permission to view or edit general information.
The value entered here is the user name that the user enters to access the system if the organization does not utilize Single Sign On functionality. This is required and must be unique.If the system is configured so that the User Name field is copied from the User ID field, the User Name field is not editable when creating a new user record or updating an existing user record. When the user record is saved, the User Name is copied from the User ID field. To enable this functionality, contact Global Customer Support. Note: The option to have the User Name field copied from the User ID field is only available if the User ID field is editable by administrators. In addition, the User Name field is only copied from the User ID field if the functionality is enabled, which is indicated by a read-only User Name field.
· The User ID field must be populated prior to saving the user record.
· Any formatting restriction that exists for the User Name field is applied to the User ID field when this functionality is enabled (e.g., may only contain letters, numbers, underscores, spaces, hyphens, special characters, etc.).
User ID
The ID is the unique identifier of the user. If this value is populated by the data feed, it is not recommended to edit this area.
User ID - Auto-Generate
When creating a new user, if the Auto-Generate link is enabled and if the administrator has permission to edit the User ID field, administrators can click this link to automatically generate a User ID. The User ID is set to the First Name field combined with the Last Name field. For example, the generated User ID for John Doe is JohnDoe. 
· The First Name and Last Name fields must be populated prior to clicking the Auto-Generate link.
· If a user with this User ID already exists in the system, the User ID is appended with a unique identifier.
· If necessary, the User ID field can be edited by the administrator after it is generated.
Note: All accented or special characters that may exist in the user's first and last name are removed when generating the User ID. The accented or special characters are removed from the User ID, however, they remain in the user's first and last name. 
Note: This functionality is only available when creating a new user. The functionality is not available when editing a user. The Auto-Generate link only appears if the administrator has permission to edit the User ID field and if the functionality is enabled.
User ID - System Generated User ID
When Cornerstone HR and the System Generated User ID functionality are enabled, a User ID is automatically generated when a user is added to the system. The system-generated User ID value is entered in the User ID field for the new user. Once a User ID value is generated, that value is permanently reserved and cannot be reused.
· If the administrator does not have permission to view or edit the User ID field, the User ID is generated and stored, but the User ID field and value are not displayed on the page.
· If the administrator has permission to view the User ID field, the User ID is displayed on the page, but the administrator cannot modify the value.
· If the administrator who is creating the user has permission to edit the User ID field for the user, then the administrator can edit the system-generated User ID. As a best practice, the User ID value should not be edited after it is generated. In order to control this, administrators should only be granted permission to view the User ID field for users. This enables them to view the value, but they cannot edit the value.
The User ID value is generated according to the User ID Generation Rules. See User ID Generation Rules for additional information.
Local System ID
This field enables organizations to capture an identifier from a local system. This field is optional. Administrators must have permission to view or manage the Local System ID.
This field would typically be used when Cornerstone is generating User IDs for users and the organization wants to store the identifier from their local Human Resources (HR) or Payroll system in the Cornerstone system. 
This field is supported by the Data Load Wizard.
Original Hire Date
Select the date on which the user was originally hired. Administrators must have permission to view or edit the original hire date. The date can be a date in the past.
For external new hires, the value in the Original Hire Date field will be the value in the Hire Date field on the Start Onboarding page. If the Hire Date field is changed on the Edit Onboarding page, then the value on the user record is also changed. If onboarding is canceled, then the value in the Original Hire Date field is removed.
Last Hire Date
Select the date on which the user was most recently hired. For example, if a user was hired to the organization multiple times, this field displays the date of the most recent hiring. Administrators must have permission to view or edit the last hire date.
Allow Reconciliation
Select this option to allow the system to deactivate a user that is not in the data feed. Note: This option does not impact passwords. Administrators must have permission to view or edit the reconciliation setting.
The User ID field is the unique identifier that the system uses to match and update a user's record. 
· If this option is selected and a User ID is NOT sent in the data feed, the user becomes inactive. 
· If a User ID is matched, the system ALWAYS updates the user record regardless of the Allow Reconcile setting. 
Allow Reconcile functionality is used for the purpose of deactivating user records, NOT for controlling updating of user records.
Use Cases:
· If you manually create a user and do not select the Allow Reconcile option, the system does not deactivate the user's record if it is missing from the data feed. This might be used for creating a contractor ID or Admin ID that won't be in the data feed. If the User ID field is blank, the system does not change that user's records because the incoming data feed does not recognize this record since there is no User ID to match.
· If you manually create a user and enter a User ID, a record in the data feed with the same user ID updates the user fields with new information whether or not you have the Allow Reconcile box selected.
· Users that come in through the feed always have a User ID on their record. The system and the data feed work together to ensure proper maintenance and active status between your source system and Cornerstone.
Absent
Select this option to mark the user Absent. An Absent user is still active, but has been marked absent because they are either on a leave of absence or on vacation. Administrators must have permission to view or edit the absent status.
· If the Absent functionality is selected and the user is a manager/approver with training requests to approve, the approval request is routed to the next person in the approval chain if the approval process is required. This functionality only pertains to training requests, not other functions requiring approval.
· A user can mark themselves absent by checking the On Vacation checkbox from the My Account > Preferences > Settings page. See My Account - Preferences - Settings for additional information.
· When a user that is marked absent logs in to the system, the following options appear: 
· Yes, change my status to Available.
· No, leave my status as Absent.
Active Status
Select the appropriate Status option. An Active user can log in and access the system. An Inactive user cannot log in and access to the system, however administrators can access and report on inactive users and can re-activate users at any time.
· Active - Select this option to set the user as active.
· Inactive - Select this option to set the user as inactive.
· Active Period - Select this option to set a date range, during which the user record is active. After selecting this option, use the calendar tool to select the active period.
· Active Start Date - The first date field represents the date on which the user record becomes active. This field is required if the Active Period option is selected. Entering the current date makes the user record active immediately upon saving the user record. If a past date is entered, this has the same effect as entering the current date.
· Active End Date - The second date field represents the date on which the user record becomes inactive. If no end date is selected, the user record remains active until this setting is modified. The Active End Date must be after the Active Start Date.
[bookmark: _Ref14735884][bookmark: _Toc161994696]User Record - Sensitive Information
The User Record page is organized into sections. The Sensitive Information section is only available on the User Record when Encrypted Sensitive Information is enabled in the portal, and this functionality is only available to organizations using Cornerstone HR. This section enables organizations to view and edit Sensitive Personally Identifiable Information (SPII) fields. 
To add a new user record, go to Admin > Tools > Core Functions > Users. Then, select the Add User link.
Edit a user's user record in one of the following ways:
· Go to Admin > Tools > Core Functions > Users and select the name of the appropriate user.
· Navigate to the user's Universal Profile. Select the User Record tab from the Universal Profile navigation. Then, select the Edit Record button.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Universal Profile - User Record - Create Users
	Grants ability to access the User Record Administration page and to create new users in the system. When creating a new user, this permission grants the ability to add general information, which includes first name, last name, username, assigned OUs, and custom relationships. The administrator must have additional permissions to add any additional fields. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission.
	Core Administration



	Universal Profile - User Record - Edit Users
	Grants ability to edit user records in the system. The administrator must have additional permissions to edit specific fields on the user record. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission. Note: This permission DOES NOT grant the ability to view user records in the system. Administrators must have the Universal Profile - User Record - View Users permission in order to view user records.
	Core Administration



	Users – Edit Custom Field Information
	Grants ability to view and edit the custom fields on a user record. Administrators are only able to edit a custom field on a user's user record if the user is within their permission constraints and the administrator is within the availability of the custom field. This permission works in conjunction with the Users - View permission. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission.
	Core Administration



	Users - View
	Grants the ability to search for and view summary information about users in the portal via the Admin/Users screen. This permission can be constrained by OU, User's OU, User Self and Subordinates, and Users. If multiple constraints are added, these constraints are considered OR statements. This is an administrator permission.
	Core Administration



	Users – View General Information
	Grants ability to view the general fields on a user record, including first name, last name, username, assigned OUs, and custom relationships. This permission works in conjunction with the Universal Profile - User Record - View Users permission. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission.
	Core Administration


Additional permissions are required to view and edit the various fields on the user record. See User Record Permissions for additional information.
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Security Considerations
When viewing the User Record page, administrators must have permission to view these fields. In addition, an administrator may have permission to view these fields masked or unmasked. 
When adding a new user or editing the User Record page, administrators must have permission to edit these fields. 
Only administrators whose IP addresses are listed in the Authorized Sensitive Information IP Addresses section on the IP Whitelist page are able to decrypt and view SPII fields. If an administrator has permission to view or edit SPII fields, but the Sensitive Information IP Whitelist has not been configured or the administrator's IP is not on the safe list, then an error message is displayed in this section. See IP Whitelist.
Date of Birth
This field is used to store the user's date of birth (DOB). By default, the entire DOB is masked.
· When an administrator views or edits the user record, a Show link is displayed next to the field if the administrator has permission to view or edit the unmasked value. Select this link to view or edit the unmasked field value. The DOB value cannot be copied. Whenever an administrator selects the Show link for a SPII field, the system captures this information on the backend for auditing purposes.
· When an administrator enters a value for this field or shows the unmasked value for this field, a Hide link is displayed next to the field. Select this link to hide or mask the DOB.
Social Security Number
This field is used to store the user's Social Security Number (SSN). By default, only the last four digits of the SSN are displayed, and the first five digits are masked.
· When an administrator views or edits the user record, a Show link is displayed next to the field if the administrator has permission to view or edit the unmasked value. Select this link to view or edit the unmasked field value. The SSN value cannot be copied. Whenever an administrator selects the Show link for a SPII field, the system captures this information on the backend for auditing purposes.
· When an administrator enters a value for this field and exits the field, the field value is automatically masked. The last four digits of the SSN remain visible.
· When an administrator shows the unmasked value for this field, a Hide link is displayed next to the field. Select this link to hide or mask the first five digits of the SSN. The last four digits of the SSN remain visible.
Proxy as Another User - Sensitive Personally Identifiable Information
When an administrator logs in to the system as another user using the Proxy as Another User functionality, that administrator can never unmask, edit, or set Sensitive Personally Identifiable Information (SPII) fields. This ensures the information is completely secured and can only be accessed by administrators who have the appropriate permissions.
If an administrator attempts to unmask or edit SPII fields, a pop-up opens to indicate that the administrator cannot access SPII fields when a use account is impersonated. If an administrator attempts to create a user and set SPII fields, an error message is displayed when the administrator attempts to save the user record.
In order to be able to unmask, edit, or set SPII fields, an administrator with the appropriate permissions must log in to the system or use Single Sign On (SSO) to log in as themselves.
[bookmark: _Ref-1515044290][bookmark: _Toc161994697]User Record - Contact
The User Record page is organized into sections. The Contact section contains all of the user's contact information, such as address, phone, and email address. This section should be used to store the user's professional contact information. In particular, the user's email address is used when emails are triggered from within the system.
Note: For internal candidates who upload a resume or CV for a job application, these fields are automatically populated by their resume or CV. So if the internal candidate provides their personal address, it will be stored here.
To add a new user record, go to Admin > Tools > Core Functions > Users. Then, select the Add User link.
Edit a user's user record in one of the following ways:
· Go to Admin > Tools > Core Functions > Users and select the name of the appropriate user.
· Navigate to the user's Universal Profile. Select the User Record tab from the Universal Profile navigation. Then, select the Edit Record button.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Universal Profile - User Record - Create Users
	Grants ability to access the User Record Administration page and to create new users in the system. When creating a new user, this permission grants the ability to add general information, which includes first name, last name, username, assigned OUs, and custom relationships. The administrator must have additional permissions to add any additional fields. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission.
	Core Administration



	Universal Profile - User Record - Edit Users
	Grants ability to edit user records in the system. The administrator must have additional permissions to edit specific fields on the user record. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission. Note: This permission DOES NOT grant the ability to view user records in the system. Administrators must have the Universal Profile - User Record - View Users permission in order to view user records.
	Core Administration



	Users - View
	Grants the ability to search for and view summary information about users in the portal via the Admin/Users screen. This permission can be constrained by OU, User's OU, User Self and Subordinates, and Users. If multiple constraints are added, these constraints are considered OR statements. This is an administrator permission.
	Core Administration


Additional permissions are required to view and edit the various fields on the user record. See User Record Permissions for additional information.
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Address Line 1
The character limit for this field is 110. Administrators must have permission to view or edit address information.
Address Line 2
The character limit for this field is 55. Administrators must have permission to view or edit address information.
City
The character limit for this field is 35. Administrators must have permission to view or edit address information.
State
The character limit for this field is 30. Administrators must have permission to view or edit address information.
Zip
The character limit for this field is 35. Administrators must have permission to view or edit address information.
Country
Select a country. Administrators must have permission to view or edit address information.
Phone
The character limit for this field is 30. Administrators must have permission to view or edit address information.
Fax
The character limit for this field is 100. Administrators must have permission to view or edit address information.
Mobile Phone
The character limit for this field is 30. Administrators must have permission to view or edit address information.
The availability of this field is controlled by a backend setting.
Email Address
The character limit for this field is 128. The system verifies that the email address is in a valid format when the administrator navigates away from the field. Administrators must have permission to view or edit address information.
Personal Email Address
The Personal Email Address field is added to the Contact section. The field accepts up to 128 characters, and the value must be a unique email address in the system.
This field allows organizations to capture a secondary email address for employees, aside from their company email address. The field is also used to identify past employees reapplying to an organization as part of the standardized rehire workflow.
[bookmark: _Ref-1866608725][bookmark: _Toc161994698]User Record - Settings
The User Record page is organized into sections. The Settings section contains all of the user's system settings, such as display language, time zone, signature font, and required training approvals. 
To add a new user record, go to Admin > Tools > Core Functions > Users. Then, select the Add User link.
Edit a user's user record in one of the following ways:
· Go to Admin > Tools > Core Functions > Users and select the name of the appropriate user.
· Navigate to the user's Universal Profile. Select the User Record tab from the Universal Profile navigation. Then, select the Edit Record button.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Universal Profile - User Record - Create Users
	Grants ability to access the User Record Administration page and to create new users in the system. When creating a new user, this permission grants the ability to add general information, which includes first name, last name, username, assigned OUs, and custom relationships. The administrator must have additional permissions to add any additional fields. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission.
	Core Administration



	Universal Profile - User Record - Edit Users
	Grants ability to edit user records in the system. The administrator must have additional permissions to edit specific fields on the user record. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission. Note: This permission DOES NOT grant the ability to view user records in the system. Administrators must have the Universal Profile - User Record - View Users permission in order to view user records.
	Core Administration



	Users - View
	Grants the ability to search for and view summary information about users in the portal via the Admin/Users screen. This permission can be constrained by OU, User's OU, User Self and Subordinates, and Users. If multiple constraints are added, these constraints are considered OR statements. This is an administrator permission.
	Core Administration


Additional permissions are required to view and edit the various fields on the user record. See User Record Permissions for additional information.
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Display Language
Select the language in which the system appears to the user. For example, if French is selected, the system appears to the user in French. Administrators can select any of the languages that are available within their portal. Administrators must have permission to view or edit the language.
Time Zone
Select the time zone in which the user resides. This affects how time are displayed in the system. For example, if a training session occurs at 8 AM PST, this session time is adjusted to each user's time zone when they view it. This allows users to view the time without needing to adjust for time zones. By default, no time zone is selected. See Time Zone Application Rules for additional information.
Administrators must have permission to view or edit the time zone.
Required Training Approvals
This defines the number of people (e.g., managers, approvers) from which the user must get approval from before being able to register for training. The required number of approvals set in the user record is bypassed if the administrator sets the learning object to be pre-approved. Important:If the Required Training Approvals field on the user record is set to zero, then no training approvals are ever required for the user, regardless of any training approvals that are set anywhere in the system.
Administrators must have permission to view or edit the user's required training approvals.
Signature
Select the font in which the user's electronic signature is displayed. This defaults to Arial. Administrators must have permission to view or edit the signature.
[bookmark: _Ref-20506340][bookmark: _Toc161994699]User Record - Organization Structure
The User Record page is organized into sections. The Organization Structure section contains all of the user's organizational information, such as manager, approver, division, position, and location. 
To add a new user record, go to Admin > Tools > Core Functions > Users. Then, select the Add User link.
Edit a user's user record in one of the following ways:
· Go to Admin > Tools > Core Functions > Users and select the name of the appropriate user.
· Navigate to the user's Universal Profile. Select the User Record tab from the Universal Profile navigation. Then, select the Edit Record button.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Universal Profile - User Record - Create Users
	Grants ability to access the User Record Administration page and to create new users in the system. When creating a new user, this permission grants the ability to add general information, which includes first name, last name, username, assigned OUs, and custom relationships. The administrator must have additional permissions to add any additional fields. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission.
	Core Administration



	Universal Profile - User Record - Edit Users
	Grants ability to edit user records in the system. The administrator must have additional permissions to edit specific fields on the user record. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission. Note: This permission DOES NOT grant the ability to view user records in the system. Administrators must have the Universal Profile - User Record - View Users permission in order to view user records.
	Core Administration



	Users - View
	Grants the ability to search for and view summary information about users in the portal via the Admin/Users screen. This permission can be constrained by OU, User's OU, User Self and Subordinates, and Users. If multiple constraints are added, these constraints are considered OR statements. This is an administrator permission.
	Core Administration


Additional permissions are required to view and edit the various fields on the user record. See User Record Permissions for additional information.
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Manager
Click the Search icon to select the Manager. The user selected for this field will be able to see the user's transcript, and assign training to the user, and may approve training for the user depending on the training workflow.
· When adding a new user, depending on the backend settings, the administrator who is creating the user may be automatically populated as the user's manager.
· When a manager is selected, the manager's division is displayed below the field.
· If the selected manager becomes inactive, the selected manager is still displayed in the field until a different user is selected.
This field is never required.
Administrators must have permission to view or edit the user's manager.
Approver
Click the Search icon to select the Approver. The user selected for this field will be able to see users transcript, assign training to the user, and may approve training for the user depending on the training workflow.
· When an approver is selected, the approver's division is displayed below the field.
· The default approval workflow is as follows Approver > Cost Center Approver > Manager > Manager's Approver > Manager's Cost Center Approver > Manager's Manager, etc. However, this is often customized for each organization during implementation. If your current system does not have an approver, then the approver is skipped and it goes to the next person in the chain. 
· If the selected approver becomes inactive, the selected approver is still displayed in the field until a different user is selected.
Administrators must have permission to view or edit the user's approver.
Employee Custom Relationships
Click the Search icon to select a user for the custom relationship.
· If the selected user becomes inactive, the selected user is still displayed in the field until a different user is selected.
Administrators must have permission to view or edit the user's core information and custom fields.
Division
Click the Search icon to select the Division. This is required if it is configured to be required on the Manage Organizational Unit Types page.
· If the selected OU becomes inactive, the selected OU is still displayed in the field until a different OU is selected.
This field is only available if it is configured to display on the user record on the Manage Organizational Unit Types page.
Administrators must have permission to view or edit the user's core information and custom fields.
Position
Click the Search icon to select the position. This is required if it is configured to be required on the Manage Organizational Unit Types page.
· If the selected OU becomes inactive, the selected OU is still displayed in the field until a different OU is selected.
This field is only available if it is configured to display on the user record on the Manage Organizational Unit Types page.
Administrators must have permission to view or edit the user's core information and custom fields.
Grade
Click the Search icon to select the Grade. This is required if it is configured to be required on the Manage Organizational Unit Types page.
· If the selected OU becomes inactive, the selected OU is still displayed in the field until a different OU is selected.
This field is only available if it is configured to display on the user record on the Manage Organizational Unit Types page.
Administrators must have permission to view or edit the user's core information and custom fields.
Cost Center
Click the Search icon to select the Cost Center. This is required if it is configured to be required on the Manage Organizational Unit Types page.
· If the selected OU becomes inactive, the selected OU is still displayed in the field until a different OU is selected.
This field is only available if it is configured to display on the user record on the Manage Organizational Unit Types page.
Administrators must have permission to view or edit the user's core information and custom fields.
Location
Click the Search icon to select the Location. This is required if it is configured to be required on the Manage Organizational Unit Types page.
· If the selected OU becomes inactive, the selected OU is still displayed in the field until a different OU is selected.
This field is only available if it is configured to display on the user record on the Manage Organizational Unit Types page.
Administrators must have permission to view or edit the user's core information and custom fields.
Group
Click the plus icon to add the user to one or more groups. The selected groups are displayed below the field. This is required if it is configured to be required on the Manage Organizational Unit Types page.
This field is only available if it is configured to display on the user record on the Manage Organizational Unit Types page.
Administrators must have permission to view or edit the user's core information.
Add User to Group as of Now
CHR administrators can add users to groups "as of now," meaning the date and time the user was added to the group is recorded as the date and time the user added them to the group. It is NOT possible to add users to a group as of a specific date in the past or future.
Self Registration Group
Click the plus icon to add the user to one or more self registration groups. The selected groups are displayed below the field. This is required if it is configured to be required on the Manage Organizational Unit Types page.
This field is only available if it is configured to display on the user record on the Manage Organizational Unit Types page.
Administrators must have permission to view or edit the user's core information.
Custom OUs
Click the Search icon to select the OU. This is required if it is configured to be required on the Manage Organizational Unit Types page.
· If the selected OU becomes inactive, the selected OU is still displayed in the field until a different OU is selected.
This field is only available if it is configured to display on the user record on the Manage Organizational Unit Types page.
Administrators must have permission to view or edit the user's core information and custom fields.
[bookmark: _Ref2035274835][bookmark: _Toc161994700]User Record - E-Commerce
The User Record page is organized into sections. The E-Commerce Information section contains a user's override amount and value added tax (VAT) number. The availability of this section is controlled by backend settings. Also, the administrator must also have permission to manage either tax override amounts or VAT numbers.
To add a new user record, go to Admin > Tools > Core Functions > Users. Then, select the Add User link.
Edit a user's user record in one of the following ways:
· Go to Admin > Tools > Core Functions > Users and select the name of the appropriate user.
· Navigate to the user's Universal Profile. Select the User Record tab from the Universal Profile navigation. Then, select the Edit Record button.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Tax Override - Manage
	Grants ability to add and edit the Override value for users in the E-Commerce Information section of the User Record page. This permission cannot be constrained. This is an administrator permission. This permission only works when used in conjunction with the Users - View permission.
	eCommerce



	Universal Profile - User Record - Create Users
	Grants ability to access the User Record Administration page and to create new users in the system. When creating a new user, this permission grants the ability to add general information, which includes first name, last name, username, assigned OUs, and custom relationships. The administrator must have additional permissions to add any additional fields. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission.
	Core Administration



	Universal Profile - User Record - Edit Users
	Grants ability to edit user records in the system. The administrator must have additional permissions to edit specific fields on the user record. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission. Note: This permission DOES NOT grant the ability to view user records in the system. Administrators must have the Universal Profile - User Record - View Users permission in order to view user records.
	Core Administration



	Users - View
	Grants the ability to search for and view summary information about users in the portal via the Admin/Users screen. This permission can be constrained by OU, User's OU, User Self and Subordinates, and Users. If multiple constraints are added, these constraints are considered OR statements. This is an administrator permission.
	Core Administration



	VAT Number - Manage
	Grants ability to add and edit the VAT number for users in the E-Commerce Information section of the User Record page. This permission cannot be constrained. This is an administrator permission. This permission only works when used in conjunction with the Users - View permission.
	eCommerce - Administration


VAT Number
Enter the user's VAT number, up to 25 characters. This is optional and supports letters, numbers, spaces, and hyphens. Administrators must have permission to manage VAT numbers.
Override Amount
From the drop-down list, select whether the override is a tax percentage or a specific monetary amount. Then, enter the rate or amount in the field, up to 15 characters. The override amount is a user specific tax amount or tax rate. This is optional. The override tax amount or rate is applied to each taxable item in the transaction. Administrators must have permission to manage tax override amounts.
[bookmark: _Ref720431118][bookmark: _Toc161994701]User Record - User Type and Employment Status
The User Record page is organized into sections. The User Type and Employment Status section contains the user's type (e.g., Employee, Intern, Contractor), user status (e.g., Working, On Leave, Terminated), and additional information regarding the user's status. 
The User Status Information is only available to administrators who have permission to view or edit User Type and Status.
To add a new user record, go to Admin > Tools > Core Functions > Users. Then, select the Add User link.
Edit a user's user record in one of the following ways:
· Go to Admin > Tools > Core Functions > Users and select the name of the appropriate user.
· Navigate to the user's Universal Profile. Select the User Record tab from the Universal Profile navigation. Then, select the Edit Record button.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Universal Profile - User Record - Create Users
	Grants ability to access the User Record Administration page and to create new users in the system. When creating a new user, this permission grants the ability to add general information, which includes first name, last name, username, assigned OUs, and custom relationships. The administrator must have additional permissions to add any additional fields. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission.
	Core Administration



	Universal Profile - User Record - Edit Users
	Grants ability to edit user records in the system. The administrator must have additional permissions to edit specific fields on the user record. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission. Note: This permission DOES NOT grant the ability to view user records in the system. Administrators must have the Universal Profile - User Record - View Users permission in order to view user records.
	Core Administration



	Users - View
	Grants the ability to search for and view summary information about users in the portal via the Admin/Users screen. This permission can be constrained by OU, User's OU, User Self and Subordinates, and Users. If multiple constraints are added, these constraints are considered OR statements. This is an administrator permission.
	Core Administration


Additional permissions are required to view and edit the various fields on the user record. See User Record Permissions for additional information.
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The following options may appear in the User Type and Employment Status section:
· User Type - Select the user's type, such as Employee, Intern, or Contractor.
· User Subtype - Select the subtype that applies to the user. This option is only available if the User Type is set to Employee, Contractor, Intern, or Temporary and if at least one subtype is defined for the selected type. If this field is available, then it is required.
· User Status - Select the user's employment life-cycle status, such as Working, On Leave, or Terminated. This option is only available if a value is set for the User Type field. This field is required when a user's User Type Category is Employee, Intern, Contractor, or Temporary.
· Leave Type - Select the type of leave the user is currently on, such as Medical, Sabbatical, or Parental. This option is only available if the User Type is set to On Leave. This field is required when a user's User Status Category is On Leave.
· Termination Date - Select the date on which the user's employment was terminated. This option is only available if the User Type is set to Terminated.
· Termination Type - Select whether the employee chose to leave their position (i.e., voluntary termination) or the organization forced the employee to leave their position (i.e., involuntary termination). This option is only available if the User Type is set to Terminated. The default value for this field is Voluntary, and this field is required when the user's User Status Category is Terminated.
· Eligible for Rehire - Select whether the employee is eligible to be employed with the organization in the future. This option is only available if the User Type is set to Terminated.
· Termination Reason - Select the reason why the employee is no longer working for the organization, such as Retired, End of Contract, or Transfer. If the Termination Type is set to Voluntary, then only voluntary termination reasons are available. If the Termination Type is set to Involuntary, then only involuntary termination reasons are available. This option is only available if the User Type is set to Terminated. This field is required when a user's User Status Category is Terminated.
· Rehired Employee - This field is an employment status that indicates whether or not the user was previously with the company and has been rehired. The field only displays when one of the following user types is selected:
· Contractor
· Employee
· Intern
· Temporary
The field is also available for all user subtypes and statuses. The value in the drop-down is "No" by default. To change the value (i.e., when changing the employment status from Terminated to Working for a former employee who has been rehired), select "Yes" from the drop-down.
When a terminated employee is rehired, their previous organizational units (OU) and employee relationships are removed. This is done so that their new OUs and relationships can be associated with their user record. The new OUs and relationships are updated during the onboarding process.
Note: When first creating a user record, the Rehired Employee field cannot be configured.
Use Case
Seasonal jobs and organizations with high turnover often see an influx of employees that were previously with the company and seek reemployment. In order to identify these users individually and via reporting, employees can be identified as a rehired employee on the user record.
The options for each field are defined in User Preferences. See User Preferences.
[bookmark: _Ref1785426254][bookmark: _Toc161994702]User Record - User Record Custom Fields
The User Record page is organized into sections. Each User Record custom field category that is defined in Custom Field Administration appears as a section on the User Record. All user record custom fields that are associated with that category appear within the section, which can be expanded and collapsed as with other sections. 
By default, the User Record Custom Field panels are displayed in collapsed mode. To expand the User Custom Fields panel, click the expand arrow. The panel expands to display all user custom fields.
Note: For Cornerstone HR customers, the Custom Fields panels are displayed in expanded mode for sections that include at least one required custom field. If there are no required custom fields configured for a Custom Field panel, the section is displayed in collapsed mode.
If a field is configured to display as read-only, it cannot be edited on the User Record page. On the User Record, the custom fields are displayed in the order and category that is defined in Custom Field Administration. See User Record Custom Field - Add/Edit.
When administrators configure a default value for a user record custom field, the User Record page will not display the default value unless the value is explicitly selected for the user.
To add a new user record, go to Admin > Tools > Core Functions > Users. Then, select the Add User link.
Edit a user's user record in one of the following ways:
· Go to Admin > Tools > Core Functions > Users and select the name of the appropriate user.
· Navigate to the user's Universal Profile. Select the User Record tab from the Universal Profile navigation. Then, select the Edit Record button.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Universal Profile - User Record - Create Users
	Grants ability to access the User Record Administration page and to create new users in the system. When creating a new user, this permission grants the ability to add general information, which includes first name, last name, username, assigned OUs, and custom relationships. The administrator must have additional permissions to add any additional fields. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission.
	Core Administration



	Universal Profile - User Record - Edit Users
	Grants ability to edit user records in the system. The administrator must have additional permissions to edit specific fields on the user record. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission. Note: This permission DOES NOT grant the ability to view user records in the system. Administrators must have the Universal Profile - User Record - View Users permission in order to view user records.
	Core Administration



	Users – Edit Custom Field Information
	Grants ability to view and edit the custom fields on a user record. Administrators are only able to edit a custom field on a user's user record if the user is within their permission constraints and the administrator is within the availability of the custom field. This permission works in conjunction with the Users - View permission. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission.
	Core Administration



	Users - View
	Grants the ability to search for and view summary information about users in the portal via the Admin/Users screen. This permission can be constrained by OU, User's OU, User Self and Subordinates, and Users. If multiple constraints are added, these constraints are considered OR statements. This is an administrator permission.
	Core Administration



	Users – View Custom Field Information
	Grants ability to view the custom fields on a user record. Administrators are only able to view a custom field on a user's user record if the user is within their permission constraints and the administrator is within the availability of the custom field. This permission works in conjunction with the Users - View permission. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission.
	Core Administration


Additional permissions are required to view and edit the various fields on the user record. See User Record Permissions for additional information.
[bookmark: _Ref-138326574][bookmark: _Toc161994703]User Record - Modification History
The Modification History page displays each time the User Record page is edited for a user. The Modification History section is only displayed if the administrator has permission to view modification details for a user.
When User Record Auditing is not enabled, the Modification History page includes the name and username of the user who modified the page and the date and time at which it was edited. However, the Modification History section does not display details for each field that was modified.
When User Record Auditing is enabled, the Modification History section displays a detailed record of each successfully completed and scheduled modification to the User Record page for a user. User Record Auditing is only available to organizations that are using Cornerstone HR. Important: User Record Auditing should only be enabled by submitting a case to Global Customer Support.
A user's record can be viewed in the following manners:
· Go to Admin > Tools > Core Functions > Users. Then, select the name of the user in the search results.
· Select the user's photograph from any page within Universal Profile or from Global Search. Then, select the User Record tab.
To view the Modification History page, select the Modification History option from the Options drop-down menu.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Universal Profile - User Record - Create Users
	Grants ability to access the User Record Administration page and to create new users in the system. When creating a new user, this permission grants the ability to add general information, which includes first name, last name, username, assigned OUs, and custom relationships. The administrator must have additional permissions to add any additional fields. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission.
	Core Administration



	Universal Profile - User Record - Edit Users
	Grants ability to edit user records in the system. The administrator must have additional permissions to edit specific fields on the user record. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission. Note: This permission DOES NOT grant the ability to view user records in the system. Administrators must have the Universal Profile - User Record - View Users permission in order to view user records.
	Core Administration



	Users – Edit Custom Field Information
	Grants ability to view and edit the custom fields on a user record. Administrators are only able to edit a custom field on a user's user record if the user is within their permission constraints and the administrator is within the availability of the custom field. This permission works in conjunction with the Users - View permission. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission.
	Core Administration



	Users – Effective Dating: Manage
	Enables administrator to make effective dated changes to the user record. This permission only works when used in conjunction with the Users - Edit General Information permission. This permission cannot be constrained. This is an administrator permission.
	Core Administration



	Users - View
	Grants the ability to search for and view summary information about users in the portal via the Admin/Users screen. This permission can be constrained by OU, User's OU, User Self and Subordinates, and Users. If multiple constraints are added, these constraints are considered OR statements. This is an administrator permission.
	Core Administration



	Users – View Custom Field Information
	Grants ability to view the custom fields on a user record. Administrators are only able to view a custom field on a user's user record if the user is within their permission constraints and the administrator is within the availability of the custom field. This permission works in conjunction with the Users - View permission. This permission can be constrained by OU, User's OU, User's Self, User Self and Subordinates, and User. This is an administrator permission.
	Core Administration



	Users - View Modification Details
	Grants ability to view the Modification Details on the User Record and view User Audits fields when creating a Reporting 2.0 report. This permission only works when used in conjunction with the Users - View permission. This is an administrator permission.
	Core Administration


Additional permissions are required to view and edit the various fields on the user record. See User Record Permissions for additional information.
Permissions
Administrators must have the appropriate permissions to view the modification history for a field. For example, administrators must have either the Users - View General Information or Users - Edit General Information permission to view the modification history for the First Name, Last Name, Username, Standard OU, Custom OU, and Custom Relationship fields. Administrators can only view the modification history of user custom fields that are available to them.
Modification History - User Record Auditing
When User Record Auditing is enabled, the system enables administrators to audit all modifications to employee data via the Modification History page. User Record Auditing is only available to organizations that are using Cornerstone HR. Important: User Record Auditing should only be enabled by submitting a case to Global Customer Support.
Not all fields on the User Record are audited. See User Record - Audited Fields for additional information.
Generate Audit PDF
The Generate Audit PDF link lets you export data from the Modification History into .pdf format. This link is only visible under the following conditions:
· User Record Audit Feature is enabled
· User has the appropriate permissions (Users - View Modification Details)
· User is not the user who's User Record is being viewed
The .pdf displays the results of the search the user has set. It also takes into account all Search, Filter and Sort modifications which are done in the Modification History table.
The .pdf has the following columns: 
· Change Date
· Field Changed
· Field Type
· Changed From
· Changed To
· Changed By
Search Modifications
To search for modifications to a specific field, enter the field name in the Search by field changed field, and select the Search button. The page is updated to display any available modifications to the specified User Record field. If the search matches multiple fields, then modifications to all matching fields are displayed. 
This functionality is only available when User Record Auditing is enabled.
Filter Modifications
The following filter options are available and can be used in conjunction with the Search functionality:
· Field Type - Use this filter to view changes to specific types of fields. The following options are available:
· User Standard Field
· Organizational Unit
· Employee Relationship
· User Custom Field
· Reason for Change - Use this filter to view changes with a specific reason for change. All available reasons for change are available in the drop-down menu. This functionality is only available when Reason for Change is enabled and there is at least one reason for change enabled in User Preferences. See User Preferences - Reasons for Change.
· Include Scheduled Changes - Select this option to include modifications that have an effective date that is in the future. This option is only available when Effective Dating is enabled.
This functionality is only available when User Record Auditing is enabled.
Sort Modifications
The following columns within the Modification History table can be sorted by selecting the column heading:
· Effective Date
· Change Date
This functionality is only available when User Record Auditing is enabled.
Modifications Table
The following information is displayed for each modification:
· Effective Date - This column displays the date and time at which the change is effective. The date and time are displayed in the timezone of the administrator who is viewing the page. Modifications are only displayed if they have successfully completed and have an effective date that is in the past. Note: This column is only available if Effective Dating is enabled.
· Change Date - This column displays the date and time at which the modification was saved.
· Field Changed - This column displays the field that was modified.
· Field Type - This column displays the type of field that was modified (e.g., User standard field, Organizational Unit).
· Changed From - This column displays the value from which the field was modified. This is the old value of the field. If the modified field is an encrypted field, then the field value is displayed as asterisks. If there was no value for the field (i.e., the field was empty), then the column is blank for the field.
· Changed To - This column displays the value to which the field was modified. This is the new value of the field. If the modified field is an encrypted field, then the field value is displayed as asterisks. If there is no value for the field (i.e., the value is removed), then the column is blank for the field.
· Changed By - This column displays the name and username of the administrator who modified the field.
· Reason for Change - This column displays the reason for change that was selected when the modification was made. This column is only available if Effective Dating is enabled.
· If the modification was made through a self-service location such as My Account, then the self-service location is displayed in this column. 
· If no reason was selected for the modification, then "None" is displayed. 
· If the reason for change for an effective dated record is modified, then any new modifications are associated with the newly selected reason for change, and any unaffected modifications remain associated with the previous reason for change.
· For user record changes made via a form, the Reason column displays the reason that is selected in the Reason for Change field on the form. See Build Tab - Define Fields for more information about the Reason for Change field on forms.
By default, modifications are sorted chronologically by effective date and can also be sorted by Change Date. Click the Effective Date or Change Date column heading to sort the table using the column data. Clicking the column heading a second time changes the sort order of the table.
If User Record Auditing and Effective Dating are both enabled, then when the User Record page is saved, all current, past, and future modifications are captured in the Modification History section.
The following special cases may occur:
· New User Record - When a user record is created, the detailed field changes are not tracked in the Modification History section. See the Inserted by section below for additional information.
· New Custom Fields - When a new custom field is created and appears on a user record, this addition is not tracked in the Modification History section. This applies even if a default value is defined for the custom field.
· Password Changes - Password changes are tracked in the Modification History section. However, the original and new values are not tracked. As a result "Not tracked" is displayed in the Changed To and Changed From column for the entry.
· Single-select Checkbox Fields - For single-select checkbox fields, the values are "Selected" or "Unselected."
· Multiple-select Checkbox Fields - For multiple-select checkbox fields, each option that is selected or unselected is tracked as an individual modification and they appear as separate entries in the table.
Inserted by
When a user record is created, the detailed field changes are not tracked in the Modification History section. Instead, "Inserted by" is displayed at the bottom of the table with the name of the administrator who created the user record and the date and time at which the user record was created (e.g., "Inserted by Lori Mullen (lmullen) on 9/2/2011 11:00:05 AM").
Sensitive Personally Identifiable Information (SPII) Fields
When SPII values are modified, the details of the modification, that is the Changed From values and the Changed To values, are not currently displayed in the Modification History.
SPII fields are only available on the User Record when Encrypted Sensitive Information is enabled in the portal, and this functionality is only available to organizations using Cornerstone HR
[bookmark: _Ref-133822934][bookmark: _Toc161994704]User Record - Effective Dating
Effective Dating enables administrators to associate an effective date with changes that are made to the user record. In addition, administrators can view and make modifications to a user's User Record page as of a particular date in the past, present, or future. It is important to note that all effective dates are displayed and applied in the time zone of the user whose user record is being modified.
Effective Dating is only available to organizations that are using Cornerstone HR and that have Effective Dating enabled.
A user's record can be viewed in the following manners:
· Go to Admin > Tools > Core Functions > Users. Then, select the name of the user in the search results.
· Select the user's photograph from any page within Universal Profile or from Global Search. Then, select the User Record tab.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Users – Effective Dating: Manage
	Enables administrator to make effective dated changes to the user record. This permission only works when used in conjunction with the Users - Edit General Information permission. This permission cannot be constrained. This is an administrator permission.
	Core Administration



	User Preferences - Reasons for Change: Manage
	Grants ability to define and configure Reasons for Change on the User Preferences administrator page, which may be used when modifying the user record. The administrator must also have the User Preferences - Core Information: View permission to access the User Preferences page.
This permission is also required to view and set the Reason for Change field when editing a user record.
This permission cannot be constrained. This is an administrator permission.
	Core Administration


[image: ]
As Of Date
The As Of date for a user record indicates the effective date and time of the record that is currently displayed. If the administrator edits the user record, then the modifications are effective as of the selected effective date. This value is displayed in the time zone of the user whose user record is being viewed.
When editing a user record, the As Of date and time is displayed to the right of the page heading. This enables administrators to quickly view the effective date of the information they are viewing.
This value is only displayed if Cornerstone HR and Effective Dating are enabled. Also, this value is only displayed if the administrator has permission to manage effective dating. This value does not display when creating a user record.
Effective Dated Records - View
Administrators can view and modify the user record as of a specific date in the past or future.
Each of the available effective dated records are displayed in a timeline below the page heading. The timeline is only displayed if the administrator has permission to manage effective dating for users.
By default, the user record is displayed with an effective date of Today, and today's date is displayed. The month and day are displayed within the icon, and the year is displayed below the icon. The effective dates are displayed and applied in the time zone of the user whose user record is being viewed.
· If the user record has an effective dated record in the past, then the effective dated record is displayed to the left of the Today icon. If the user has more than one effective dated record in the past, then a Past icon is displayed to the left of the Today icon. 
· If the user record has any effective dated record in the future, then the effective dated record is displayed to the right of the Today icon. If the user has more than one effective dated record in the future, then a Future icon is displayed to the right of the Today icon. 
· For the Past or Future icons, the number of effective dated records in each category is displayed within the corresponding icon. For example, if the user has 16 effective dated records in the past, then "16" is displayed within the Past icon.
To view an effective dated record, select one of the effective dates from the timeline. The page refreshes to display the user's effective dated record for the selected date, and the As Of date displays the effective date of the selected effective dated record. If a Past or Future icon is displayed in the timeline, select the icon to display all available effective dated records in the corresponding category (i.e., Past or Future). The corresponding category icon displays an X. For example, if the Future icon is selected, then all available future effective dated records are displayed, and the Future icon displays an X. If there are many effective dated records, the administrator can select the Left or Right arrows to paginate through all effective dated records. Administrators can select the X to hide all effective dated records in that category.
The Effective Dated Record timeline is only displayed if Cornerstone HR and Effective Dating are enabled. Also, this value is only displayed if the administrator has permission to manage effective dating.
Effective Dated Records - Edit
To edit a user record, select the Edit Record button in the floating action bar at the bottom of the screen. A pop-up opens, which enables the administrator to edit the user record as of a specific effective date. It is important to note that all effective dates are displayed and applied the time zone of the user whose user record is being modified. The following options are available within the pop-up:
· Choose Effective Date - This option is only available if the administrator has permission to manage effective dating for users; administrators without this permission can only edit the user record as of the current date. Using the radio buttons, select an effective date for edits. 
· Edit the user record for today - This option is only available when Today is selected from the Effective Date timeline. Selecting this option creates an effective dated record, and the effective date is set to the date at which the administrator saves the changes to the user record.
· Edit the current view - This option is only available when a specific effective dated record is selected from the Effective Date timeline. The date of the current effective dated record is displayed. Selecting this option edits the existing effective dated record.
· Edit the user record for a specific date - Selecting this option enables the administrator to create a new effective dated record with a specific effective date. The As Of date is updated to display the specified date.
· Note: The Effective Date can be any date in the past that is on or after January 1, 1901. However, the Effective Date cannot be set to a date in the past for a user within an In Progress compensation task, either as an employee or a compensation manager.
· Reason for Change - From the drop-down menu, select the reason for modifying the employee data. This option is only available if Effective Dating and Reason for Change are enabled for the portal. Administrators can configure the available options and whether this field is required in User Preferences. See User Preferences for additional information.
· When a user record is modified, the Reason for Change value is stored in the Modification History.
Note: When a new effective dated record is created, a new entry is added to the Effective Date timeline.
Select the Next button to open the Edit User Record page. Or, select the Cancel button to close the pop-up and return to the View User Record page.
When editing a user record with an effective date that is not set to Today, administrators can only edit fields that can be audited and which they have permission to edit. If a field cannot be audited, it appears inactive and cannot be edited. See User Record - Audited Fields.
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Add User to Group as of Now
CHR administrators can add users to groups "as of now," meaning the date the user was added to the group is recorded as the date the user added them to the group. It is NOT possible to add users to a group as of a specific date in the past or future.
[bookmark: _Ref621792854][bookmark: _Toc161994705]Universal Profile - View Team Flyout
The View Team flyout allows managers, approvers, and custom relationships to quickly navigate between subordinates' profiles and transcripts. When enabled, the View Team flyout is available to managers and dotted line managers on all pages of their Universal Profile and the Universal Profile of their subordinates. This flyout displays the manager's reports visually.
The View Team button displays if enabled in the portal. Administrators may enable or disable this flyout via the My Team Dropdown section within Universal Profile General Preferences. See Universal Profile General Preferences on page 2 for additional information.
Managers of large teams are able to search for a report from within the flyout. If the user serves in multiple roles that are available within the flyout, then the user can select a specific role and view the reports that are associated with that role. When the manager selects a report from the View Team flyout, the manager is directed to a consistent page within Universal Profile. For example, if a report is selected when viewing the Transcript page, the manager is directed to the Transcript page of the selected report. The View Team flyout enables managers to more effectively manage their teams from within Universal Profile. 
To access the View Team flyout, select the View Team button on any Universal Profile page.
[image: ]
View Team Button
The View Team button may be available to managers, approvers, and custom relationships on all pages of their Universal Profile and the Universal Profile of their direct or dotted-line reports. The button appears to the left of the Options button and is only available if the following conditions are met:
1. The administrator has enabled the My Team Dropdown in Universal Profile General Preferences. See Universal Profile General Preferences on page 2 for additional information.
2. The user who is logged in to the system has direct or dotted-line reports.
3. The user has permission to view the Universal Profile of their direct reports.
View Team Flyout
When a manager selects the View Team button, the manager and the manager's reports are displayed within the flyout. The manager is displayed at the top of the flyout, and the manager's reports are displayed in alphabetical order by last name.
If the manager has more reports that cannot be displayed on the page, then pagination options are available at the bottom of the drop-down. See the Search and the Pagination sections below for additional information.
For each user in the flyout, their user photo, full name, and position are displayed. If a direct or indirect report also has direct reports, an arrow icon [image: ] is displayed to the right of the user's information. To view the user's direct reports, select the arrow icon. See the View Indirect Reports section below for additional information.
Managers can select the user's name or photo to view the corresponding user's Universal Profile as long as the manager has permission to view the direct report's Universal Profile. See the Select Report section below for additional information.
To close the View Team flyout, select the Done button.
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Change Role
If the user serves in multiple roles that are available within the flyout, then the user can choose to view a specific set of reports based on a particular role. Depending on the role that is selected, the reports that are associated with the selected role are displayed in the flyout.
To select a different set of direct reports, select the My Direct Reports drop-down menu within the flyout and select the appropriate role. The flyout displays only the reports that are associated with the selected role. If only one role is available, then the drop-down menu is not available.
When selecting a role, the drop-down displays all of the roles in which the user is currently serving. Note: A role is only available if the View Team flyout is configured to include the role and if the manager has reports who are associated with the role. For example, if a user is currently not set as the approver for any users, then the Approver role is not available in the drop-down.
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View Indirect Reports
When a manager views the View Team flyout, the manager and the manager's direct reports are displayed within the flyout.
If a direct or indirect report also has direct reports, an arrow icon [image: ] is displayed to the right of the user's information. To view the user's direct reports, select the arrow icon. The View Team flyout is updated to display the selected user's direct reports, and the selected user is displayed as the manager at the top of the flyout. Availability Note: The arrow icon is only available when the manager relationship is selected. The arrow icon is never available when an approver or custom relationship manager is viewing their reports.
To return to the previous view, within the flyout, select the Return to User link at the top of the flyout. This link displays the name of the direct manager of the manager whose team is currently displayed in the flyout.
The selected view is maintained in the flyout as long as the manager remains on the current user's Universal Profile or navigates to another user's Universal Profile using the View Team flyout.
Select Report
When a manager selects a direct report or their own photograph within the View Team flyout from a particular page within the Universal Profile, the manager is navigated to the corresponding Universal Profile page of the selected user, provided that the manager has access to that page for the user. For example, if a manager is viewing their own Snapshot page and selects a direct report from the View Team flyout, the manager is navigated to the selected user's Snapshot page.
If the manager does not have permission to view the corresponding Universal Profile page for the user or if the corresponding page does not exist for the user, then the manager is navigated to a different Universal Page:
1. If the manager was attempting to navigate to a sub-page (e.g., Snapshot - Goals, Bio - Resume), then the manager is navigated to the corresponding main page (e.g., Snapshot, Bio - About), provided that the manager has access to that page for the user.
2. If the manager was attempting to navigate to a main page (e.g., Snapshot, Actions), then the manager is navigated to the default Universal Profile page.
3. If the manager does not have permission to view a direct report's Universal Profile, then the user's photograph and name are not linked.
When a user is directed to a different page, an alert is displayed at the top of the page that informs the manager that they do not have permission to view the selected page for the selected user. The specific page and user name are displayed in the message.
Search
A Search field is available at the top of the flyout. The search functionality enables the manager to quickly search and locate the appropriate user.
· When the Manager relationship is selected, managers are able to search all direct and indirect reports.
· When a non-Manager relationship is selected, such as Approver or a custom relationship, then the user can search for dotted line reports within the selected relationship.
Managers can search for a report by first name, last name, first and last name, position, position and first or last name, Username, or User ID.
The search is performed when the manager presses the [Enter] key or clicks the Search icon [image: ] within the Search field. The search results are sorted alphabetically by last name. If the search returns more reports than can be displayed on the page, then pagination options are available at the bottom of the flyout.
The search results are maintained in the drop-down as long as the manager remains on the current user's Universal Profile or navigates to another user's Universal Profile using the View Team flyout.
Pagination
If the manager has more reports than can be displayed on the page, then pagination options are available at the bottom of the flyout. The pagination options enable the manager to quickly browse for and locate the appropriate user.
Managers can select a page number to go directly to that page of reports. The manager appears at the top of the flyout menu on all pages. If there are more than five pages, then a Previous Page and a Next Page icon are displayed with the paging controls to allow the manager to navigate to the previous or next page.
The text below the paging controls displays the count of the reports being displayed and the total number of reports.
The selected page is maintained in the flyout as long as the manager remains on the current user's Universal Profile or navigates to another user's Universal Profile using the View Team flyout.
[bookmark: _Ref-392635164][bookmark: _Toc161994706]Universal Profile Options Drop-down Overview
An Options button may be available on various pages of the Universal Profile. The following options may be available in the Options drop-down menu:
· Assign Training - Select this option to assign training to the user whose Universal Profile page you are viewing. This option is only available if you have permission to assign training and when viewing the Universal Profile page of a direct or indirect report. See Universal Profile - Options - Assign Training on page 671 for additional information.
· Award Compensation - Select this option to launch an off-cycle compensation task for a subordinate. This option is only available when viewing the Universal Profile page of a direct or indirect report. See Universal Profile - Options - Award Compensation on page 672 for additional information.
· Create Goal - Select this option to create a goal for a new goal. See Universal Profile - Options - Create Goal on page 675 for additional information.
· Launch Review - Select this option to launch an off-cycle performance review for the user whose Universal Profile page you are viewing. This option is only available if you have permission to launch off-cycle reviews, and an off-cycle review is available for the user. See Universal Profile - Options - Launch Review on page 676 for additional information.
· View All Goals - Select this option to view the user's goals. This option is only available when viewing the Universal Profile of a user who is within constraints of the View Goals permission. See Snapshot - Goals on page 351 for additional information.
· View All Feedback Requests - Select this option to open the Pending Feedback Requests page. This option is only available if you have permission to view the Feedback Details page. See Universal Profile - Options - View Pending Requests on page 677 for additional information.
· Create Feedback Request - Select this option to open the Request Feedback page for the user who's Universal Profile is being viewed. For example, if the user is viewing their own Universal Profile, then they are navigated to their own Request Feedback page. If the user is viewing another user's Universal Profile, then they are navigated to that user's Request Feedback page. Users must have the appropriate permission in order to request feedback on behalf of another user. See Feedback - Request Overview on page 202 for additional information.
· Report Time (Kronos) - This option is available when the Kronos Time & Attendance integration is enabled for a portal. Select this option to quickly log in to their Kronos account from within Cornerstone without having to enter their username and password. There, the user can access and update their time and attendance within the Kronos system.
[bookmark: _Ref-932247875][bookmark: _Toc161994707]Universal Profile - Options - Add External Training
Users are able to add external training to their transcript from the Universal Profile - Transcript page. Note: The Add External Training page is only available when accessed from the Universal Profile - Transcript page. When accessed from any other area in the system, the Add External Training pop-up is utilized.
When a user is viewing their own transcript, the user must have permission to add external training in order to add or edit their own external training. When a user is viewing another user's transcript, the user must have permission to add external training and edit transcript items in order to add or edit the user's external training.
To add external training from the Universal Profile - Transcript page, select the Add External Training option from the Options drop-down menu.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Edit Transcript Items
	Grants ability to modify training due dates, statuses, and scores on other user's transcripts (training records) when viewing training details for particular learning objects on the transcript. User must also have permission to add external training in order to add or edit another user's external training. This permission can be constrained by OU, User's OU, User Self and Subordinates, User, and User's Self.
Note: Users with this permission also will also see the Add SF-128 link on the transcript.
	Learning - Administration



	External Training - Add
	Grants a user the ability to add or edit their own external training. When viewing another user's transcript, the user must also have permission to edit transcript items in order to add or edit the user's external training. This permission cannot be constrained. This is an end user permission.
	Learning


Emails
	EMAIL NAME
	EMAIL DESCRIPTION
	ACTION TYPE



	Request External Training
	User submits request for external training. This email is triggered when user adds external training to transcript.
When the APPROVE.DENY.DEFER.LINKS tag is included in the email, this tag displays the Approve, Deny, and Defer deep links within the body of the email. Note: The Defer option is only available when enabled in the portal.
· When an approver clicks one of the included links, the user is automatically directed to the Approve, Deny, or Defer Request page if the organization is using single sign on (SSO). The approver can then enter the appropriate comments and submit the response. If the organization does not use SSO or if the user is outside the organization's firewall, then the user is directed to the Login page.
· If the approver does not have permission to approve, deny, or defer the training, the approver is directed to an Access Denied page.
	Training


[image: ]
The instructions and field names that appear on this page may vary because they are configurable by the system administrator in Configure External Training Preferences. Also, the system administrator can configure which fields and options are available and required in Configure External Training Preferences. See Configure External Training by Division for additional information. Note: When viewing the Add/Edit External Training page, the preferences that are implemented are based on the user who is viewing the page, even if the user was not the user who initially created the external training.
Enter the following information for the external training.
1. Language - If multiple languages are enabled for the portal, select the language that corresponds with the external training. This field defaults to the user's configured language.
2. Title - Enter the external training title, up to 500 characters. This field is always required.
3. Training Description - Enter a description of the external training, up to 1000 characters.
4. Provider/Institution - Enter the name of the provider or institution associated with the external training, up to 100 characters.
5. Start and End Date - Click the Calendar icon [image: ] to select the training start date and end date. Today's date is selected by default. The Start Date must be before the End Date. Also, the End Date must be a date in the past (i.e., the external training must already be completed).
6. Schedule - Enter the external training's schedule, up to 100 characters.
7. Cost - From the drop-down menu, select the cost currency. Then, enter the training cost in the field. This field can hold a maximum of 18 characters, including 2 decimal places.
8. Credits - Enter the credits that were earned from the external training, up to 5 characters.
9. Training Hours - Enter the number of training hours and minutes completed for the external training. The first field is for entering hours, and the second field is for entering minutes. Both fields have a character limit of 5.
10. Attachments - Attachments can be added to external training.
· To add an attachment, click the Choose File button and select the file. Up to 15 attachments can be added to an external training. Attachments can be up to 25 MB in size and are limited to ppt, pptx, doc, docx, pdf, jpg, jpeg, jpe, png, txt, gif, xls, xlsx, and rtf file types. After selecting the appropriate attachments, click the Save button to save the attachments to the review.
· To download an attachment, click the attachment name.
·  To remove an attachment, click the Remove icon [image: ] to the left of the document title.
11. Competencies - End users may be able to link their external training to competencies by clicking the Select icon [image: ]. This opens the Search Competencies pop-up, where multiple competencies can be selected. See Search Competencies Pop-up for additional information.
12. Comments - Enter any applicable comments for the external training, up to 1000 characters. This field is only available when editing the external training.
13. Custom Fields - Depending on the administrator's configuration, custom fields may appear below the standard fields. Administrator Note: Custom fields that are mapped to external training in Custom Field Administration are displayed below the standard fields that are configured in Configure External Training Preferences. Custom fields only appear if they are configured to be active for the External Training training type and visible to end users on the Transcript. The order in which the custom fields display is determined on the Training Custom Fields page.
After entering the appropriate information, click the Submit button. If configured and enabled in Email Administration, the Request External Training email is triggered.
[bookmark: _Ref1084283618][bookmark: _Toc161994708]SF-182 Form - Overview
When requesting external training, users can use the SF-182 request form if the functionality is available in the portal. 
To request SF-182 external training, select the Add SF-182 External Training option from the Options drop-down menu on the Transcript page.
When SF-182 functionality is available in the portal, the Add External Training option on the Transcript page is changed to Add Regular External Training. Also, an SF-182 filter option is available in the Training Type drop-down at the top of the transcript. When this is selected and the Search icon is clicked, only external training that was requested using the SF-182 request form displays. The results also display in-progress SF-182 requests.
Note: The Add SF-182 External Training and Add Regular External Training options must be configured in SF-182 Preferences in order for the links to display on the Transcript page.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Edit Transcript Items
	Grants ability to modify training due dates, statuses, and scores on other user's transcripts (training records) when viewing training details for particular learning objects on the transcript. User must also have permission to add external training in order to add or edit another user's external training. This permission can be constrained by OU, User's OU, User Self and Subordinates, User, and User's Self.
Note: Users with this permission also will also see the Add SF-128 link on the transcript.
	Learning - Administration



	SF-182 Administration
	Grants ability to view SF-182 requests for populations of users (based on constraints), approve SF-182 forms at any step of the process, and view the link for managing SF-182 specific vendors for their organization. (Governmental clients). This is an administrator permission.
	Limited Use/Obsolete



	SF-182 Requests - Manage
	Grants ability to view SF-182 requests for a population of users based on constraints.
If this permission is added to the dynamic Manager security role, the permission will automatically be constrained to self and subordinates. If the SF-182 approver is a manager and should not be constrained to just self and subordinates, please create a separate security role and add the SF-182 Requests Manage permission to that role with any needed constraints. 
	Limited Use/Obsolete



	User View “Add SF-182” link on Transcript
	Grants ability to view the "Add SF-182 External Training" link to complete the form for requesting an external course (Governmental clients). This is an end user permission.
Note: If a user does not have this permission but has the Edit Transcript Items permission, the Add SF-182 External Training link will also appear.
	Limited Use/Obsolete


Note: The Add SF-182 External option will appear if the user has any one or more of the above security permissions.
When using the SF-182 form to request external training, there are four steps to completing the form:
1. Training
2. Costs and Billing
3. Personal Details
4. Confirm
Form Instructions
To view instructions for completing the form, click the Download Instructions link in the upper-right corner of any step. Note: The Download Instructions link only appears if instructions are created by the administrator. If the link does not appear, then an instructions document is not available.
Required, Read-only, and Pre-configured Fields
Some fields may be required or read-only, depending on how the administrator has configured the form. In addition, some fields may already contain a default value that is configured by the administrator. Pre-configured fields may be editable or read-only, depending on how the administrator has configured the form. Note: An SF-182 request cannot be edited if the vendor is set to inactive.
In-Progress Forms
Forms that are in progress can be saved and completed at a later time. Only the Course Title field is required in order to save the form. Click Save at the bottom of any step to save the form. The form appears on your transcript under the course title with a status of Not Submitted.
To return to an in-progress form, select the Edit option on the Transcript page. This opens the form and allows you to continue completing it. Note: An SF-182 request cannot be edited if the vendor is set to inactive. To delete an in-progress form, select the Withdraw option on the Transcript page. This opens the Withdraw pop-up. Click Submit to delete the form from your transcript.
Status Workflow
When the user submits the form, the external training is added to their transcript. The following is the workflow of the status process once a form is submitted:
	User Action
	SF-182 Form Request Status
	External Training Transcript Status
	External Training Options Available On Transcript

	Saves SF-182
	Not Submitted
	Not Submitted
	Edit, Remove

	Submits SF-182 and SF-182 approvals are required
	Pending Approval Step "<current approval step no.>" (e.g., Pending Approval Step 3)
	Pending SF-182 Form Approval 
	None

	 Edits SF-182 that is currently pending approval
	Pending Approval Step "<current approval step no.>" (e.g., Pending Approval Step 3)
	Not Started
	Edit

	LO approval is also required for user
	Approved
	Pending Approval
	 

	LO approval denied
	Approved
	Denied
	None

	SF-182 approval denied
	Denied
	SF-182 Form Denied
	None

	Exempted
	Same status that the form had at the time of exemption
	Exempt
	None

	Gained all approvals for SF-182 and Register upon Approval is unchecked 
	Approved
	Approved
	Withdraw

	Gained all approvals for SF-182 and Register upon Approval is checked for portal 
	Approved
	Registered
	Withdraw

	User withdraws from training 
	Same status as the form was at the time of withdrawal
	Withdrawn
	None

	Training end date has passed
	Approved
	Registered
	Mark Complete

	User marks complete; External Training and Completion Approvals are required for user
	Approved
	Pending Completion Approval
	None

	Completion approval is granted or external training is completed
	Completed
	Completed
	None


Note: The Register Upon Approval option is configured in Default Approval Requirements (by Division) preferences.
Create SF-182 Request - Step 1 - Training
The Training step is the first step of the SF-182 request process, and it includes the following sections:
· Training Information
· Training and Vendor Location
· Advanced
Some fields may be pre-populated if enabled by the administrator in Configure External Training preferences. The following table shows which fields on the Training step may be pre-populated if their corresponding external training field is enabled by the administrator:
	External Training Field
	SF-182 Field

	Language
	N/A in SF-182. Use end user's language

	Title
	Course Title

	Training Description
	Training Objective

	Training Provider
	Name of Vendor

	Training Dates
	Start and End Date

	Schedule
	N/A

	Cost
	Total direct costs + Total indirect costs

	Credits earned
	Training Credit

	Training Hours
	Training Duty Hours + Training Non-duty hours

	Grade
	N/A

	Comments
	N/A


Training Information
· Course Title - Enter the course title, up to 400 characters.
· Course Number Code - Enter the course number code, up to 250 characters.
· Training Start Date - Enter the start date or click the Calendar icon to select a date from the calendar feature.
· Training End Date - Enter the end date or click the Calendar icon to select a date from the calendar feature.
· Training Duty Hours - Enter the number of duty hours.
· Training Non-Duty Hours - Enter the number of non-duty hours.
· Training Objective - Enter the objective or purpose of taking the training, up to 1000 characters.
Training and Vendor Location
· Name of Training Vendor - Click the Select icon to open the Choose a Vendor pop-up. Select a vendor by clicking the plus sign in the Add column next to the vendor name. This closes the Choose a Vendor pop-up and enters the vendor name in the field.
· Vendor Contact Information - Enter the vendor's street address, city, state, zip, phone number, and email address.
· Training Location Address - Check this option to indicate that the training is located at the same address as the vendor. This populates the address fields with the information in the Vendor Contact area. If the address is not the same, enter the street address, city, state, and zip.
Advanced
· Training Purpose Type Code
· Training Type Code
· Training Sub Type Code
· Training Delivery Type Code
· Training Designation Type Code
· Training Credit Type Code
· Training Credit
· Training Source Type Code
· Training Accreditation Indicator
· Continued Service Agreement Required - This indicates whether you are required to complete the Continued Service Agreement form, and this is configured by the administrator.
· If this option is set to Yes, you are required to download and complete the Continued Service Agreement form, and then attach the completed form to the request. Enter the form's expiration date in the Continued Service Agreement Expiration Date field. Note: The completed Continued Service Agreement form appears in the printable view of the request.
· If the Continued Service Agreement Required toggle is set to Yes and an attachment has not been included, the SF-182 printable form will display a value of Yes but the transcript view will display a value of No to indicate no form was attached.
· If the Continued Service Agreement Required toggle is set to Yes and an attachment has been included, the SF-182 printable form will display a value of Yes AND the transcript view will display a value of Yes.
· If this option is set to No, you are not required to complete the form or enter an expiration date.
· If the Continued Service Agreement Required toggle is set to No then it will display No on both the SF-182 printable form and the transcript view.
[image: ]
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· Click Cancel to cancel the form.
· Click Save to save the form without submitting it. Note: The Course Title field must be completed before you can save the form.
· Click Next to go to Step 2. See Create SF-182 Request - Step 2 - Costs and Billing on page 458 for additional information.
[bookmark: _Ref-1450053090]Create SF-182 Request - Step 2 - Costs and Billing
The Costs and Billing step is the second step of the SF-182 request process, and allows the user to enter cost information about the training. This step includes the following sections:
· Direct Cost and Appropriation/Fund Chargeable
· Indirect Cost and Appropriation/Fund Chargeable
· Other
Direct Cost and Appropriation/Fund Chargeable
To enter costs for tuition, fees, books, or materials:
1. Enter the tuition/fees and books/material costs in the Amount column. The total appears in the Total field at the bottom of the column.
2. Enter the fund information in the Appropriation Fund column. The system automatically calculates the total and populates it in the Total field at the bottom of the column.
Indirect Cost and Appropriation/Fund Chargeable
To enter related travel and per diem costs:
1. Enter the travel and per diem cost in the Amount column. The total appears in the Total field at the bottom of the column.
2. Enter the travel and per diem fund information in the Appropriation Fund column. The system automatically calculates the total and populates it in the Total field at the bottom of the column.
Other
Enter other relevant cost information, including:
· Total Training Non-Government Contribution Cost
· Document/Purchasing Order/Registration Number
· 8-Digit Station Symbol
· Billing Instructions - Enter billing instructions.
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· Click Back to return to Step 1.
· Click Cancel to cancel the form.
· Click Save to save the form without submitting it. Note: The Course Title field must be completed before you can save the form.
· Click Next to go to Step 3. See Create SF-182 Request - Step 3 - Personal Details on page 460 for additional information.
[bookmark: _Ref1173509225]Create SF-182 Request - Step 3 - Personal Details
The Personal Details step is the third step in the SF-182 request process, and it includes the following sections:
· Personal Information
· Advanced
Personal Information
In this section, enter your name and personal contact information, as well as work contact information.
Advanced
· Position Level - Select your position level from the drop-down menu.
· Position Title - Enter your job title.
· Special Accommodation - Use this option to indicate if special accommodations are needed. If Yes is selected, describe the accommodations in the text field.
Navigation
· Click Back to go to Step 2.
· Click Cancel to cancel the form.
· Click Save to save the form without submitting it. Note: The Course Title field must be completed before you can save the form.
· Click Next to go to Step 4. See Create SF-182 Request - Step 4 - Confirm on page 461 for additional information.
[bookmark: _Ref-931108544]Create SF-182 Request - Step 4 - Confirm
The Confirm step is the fourth and final step of the SF-182 request process, and allows the user to review the request for accuracy and submit the request.
Review the information entered on each step and click Submit. This triggers the SF-182 Form Submitted email, if enabled. Once submitted, the SF-182 request is added to your transcript. If the form requires approval, the status of the form is Pending Approval <Current Approval Step>. Note: The approval step is dependent upon the current step in the approval process.
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· Click Back to go to Step 3.
· Click Cancel to cancel the form.
· Click Save to save the form without submitting it. Note: The Course Title field must be completed before you can save the form.
[bookmark: _Ref-1454901552][bookmark: _Toc161994709]Universal Profile - Options - Assign Training
Managers and indirect managers can assign training to their direct and indirect reports from the Universal Profile.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Assign Training
	Grants ability to assign learning objects to the transcripts of those for whom the user is the assigned manager, approver or cost center approver. This is a manager/approver permission.
	Learning


To assign training to a user from the Universal Profile page of another user, click the Assign Training link from the Options drop-down list. This option is only available if you have permission to assign training and when viewing the Universal Profile page of a direct or indirect report.
This opens the Select Training pop-up, in which the manager or indirect manager can select the training that is assigned to the direct or indirect report. 
[image: ]
After the training is selected, the Assign Training page opens with the selected training. See Assign Training for additional information.
[bookmark: _Ref-2128221906][bookmark: _Toc161994710]Universal Profile - Options - Award Compensation
Managers can launch an off-cycle compensation task for a direct or indirect subordinate via Universal Profile.
To launch an off-cycle compensation task for a subordinate via Universal Profile, click the Award Compensation link from the Options drop-down list. This option is only available to managers if at least one active off-cycle compensation task is available to the manager. See Award Compensation for additional information.
The Award Compensation option is available from the following Universal Profile pages:
· Bio
· Feedback
· Actions
· Snapshot - Note: This option is not available on Snapshot subpages. 
[bookmark: _Toc161994711]Universal Profile - Options - Complete Form
To complete a form on behalf of another user, navigate to the user's Universal Profile page. When viewing the user's Universal Profile page, select the Options drop-down menu, and then select the Complete Form option. Note: This option is only available if there is at least one form that is configured to allow the user who is logged in to complete the form for the user whose Universal Profile is being viewed.
When a user is completing a form on behalf of another user, the form title indicates that the form is being completed for another user.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Form Completion - View and Edit OU and Employee Relation Fields
	Allow users to view and modify organizational unit (OU) and employee relation fields when completing a form that contains the fields. The constraints on this permission determine which fields the user can view and edit when completing a form. This permission can be constrained by OU, User's OU, User, User Self and Subordinates, and User Subordinates. This is an end user permission.
	Core


From the Select Form pop-up, select the appropriate form. Note: The pop-up only displays forms that are configured to allow the user who is logged in to complete the form for the user whose Universal Profile is being viewed.
[image: ]
The selected form opens, and the form title indicates that the form is being completed for the selected user. All of the information that is displayed or added in the form pertains to the user for whom the form is being completed.
If OU fields are added to a form, users can only view and edit these fields if they have the Form Completion - View and Edit OU and Employee Relation Fields permission. The constraints on this permission determine which values are selectable in the Select OU control.
When the form is submitted, any approval workflows that are configured are initiated. When the form is approved, the information that is provided in the form is saved for the user. Also, the form is saved in the user's Snapshot: Documents folder.
[image: ]
[bookmark: _Ref-544045066][bookmark: _Toc161994712]Universal Profile - Options - Create Goal
Users can create a goal via the Universal Profile.
To create a goal via Universal Profile, click the Create Goal link from the Options drop-down list. This option is only available to users who have permission to create goals. See Goal - Create/Edit.
The Create Goal option is available from the following Universal Profile pages:
· Bio
· Feedback
· Actions
· Snapshot - Note: This option is not available on Snapshot subpages.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Goals - Create
	Grants ability for user to create goals for self, direct reports, and indirect reports only. Any constraint on this permission is operating as an "AND" function. This permission can be constrained by Employee Relationship, OU, User's OU, and User Self and Subordinates. This is an end user permission.
	Performance


[bookmark: _Ref-1201293128][bookmark: _Toc161994713]Universal Profile - Options - Launch Review
Users with the appropriate permissions are able to launch an off-cycle performance review for another user from the Universal Profile.
To launch an off-cycle review for a user from the Universal Profile page of another user, click the Launch Review link from the Options drop-down list. This option is only available if you have permission to launch off-cycle reviews, and an off-cycle review is available for the user. This opens the Launch Performance Review page.
See Launch Performance Review.
To access another user's Universal Profile - Bio page, select the user's photograph from any Universal Profile or Global Search page. From there, you can access the other Universal Profile pages for the user by clicking the appropriate tab.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Launch Off-Cycle Performance Review Task
	Enables a user to launch an off-cycle performance review task. Having this permission does not guarantee that the user can launch an off-cycle review, only that they will have access to the Launch Performance Review page. A task must still be configured properly for the user to successfully launch an off-cycle review task. This permission works only if user has been designated to launch at least one currently active off-cycle performance review task. This permission can be constrained by OU, User's Subordinates, and Employee Relationship. This is an end user permission and does not apply to an administrator role.



	Feedback - View and Post
	Enables user to view the Feedback page of the Universal Profile and to post feedback. Users can only view the Feedback page for users within their permission constraints. Similarly, users can only post feedback for users within their permission constraints. This permission can be constrained by OU, User's OU, User Self and Subordinates, User's Self, and Employee Relationship. This is an end user permission.
	Universal Profile


[bookmark: _Ref-830543867][bookmark: _Toc161994714]Universal Profile - Options - View Pending Requests
Users are able to access the Pending Feedback Requests page from the Universal Profile.
To view the Pending Feedback Requests page from the user's Universal Profile page, click the View Pending Requests link from the Options drop-down list. This option is only available if you have permission to view the Feedback Details page. This opens the Pending Feedback Requests page.
See Feedback Requests on page 211 for additional information.
To access another user's Universal Profile - Bio page, select the user's photograph from any Universal Profile or Global Search page. From there, you can access the other Universal Profile pages for the user by clicking the appropriate tab.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Feedback Details - View
	Enables user to view the Feedback Details page and provide feedback when they are requested to provide feedback. This permission cannot be constrained. This is an end user permission.
	Universal Profile



	Feedback - View and Post
	Enables user to view the Feedback page of the Universal Profile and to post feedback. Users can only view the Feedback page for users within their permission constraints. Similarly, users can only post feedback for users within their permission constraints. This permission can be constrained by OU, User's OU, User Self and Subordinates, User's Self, and Employee Relationship. This is an end user permission.
	Universal Profile
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Discover a new way to learn and develop your career

While focusing on the skills that matter to you most
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Great! Let's start by adding some skills you

already have
Defining your skills will help us identify relevant opportunities for learning
and career development.

Identify 3 or more skills you have

Q

skills You Might Have
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Now let's choose the skills you want to

develop
Well help you stay on track with your progress and prioritize suggested
learning and development paths based on your preferences.

Identify 1 or more skill to develop

Suggested Skills to Develop
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. X

Last step, let us know if there are any skills

you don't want to develop right now
We'll reduce recommendations for training & development for this skill, so
you can focus on your development priorities.

Identify skills you don't want to develop (optiona)

Q

B banking X

Your Skills
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My Feedback Requests T

View, manage, and distribute requests so that you can collect ongoing feedback.

Last Last
Tite Target Users. Format Skl Responses W Response
Team 360 test Mike Ables Proficiency Rating 2 1 Jan28,2022  Jan28,2022  View
Get Shareable Link
Team 360 test Pat Kelly Profciency Rating 2 1 Jan 28, 2022
Edit Request
Team 360 test Luke Kelly Profciency Rating 2 1 Jan28,2022  Jan28.2022  Eqit Feedback Actions

Team 360 test Smokey Bear Proficiency Rating 2 o Jan 28, 2022
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My Market Analysis Feedback Request

Relationship

Rater

© -
Jennifer Smith

Manager, Talent

kil

market analysis

Rating

Intermediate (3/5)

Date

/2772021
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Invite and/or re-invite additional participants with the following share link

Copy link to dlipboard

q201.csod comyui/performance-ratings/app/rating-requestrequestid=3925360-Seef-9c70-bfcc-17d954¢
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Edit Feedback Actions

Request: Q1 2022 Team Feedback

Filter By

Al v

Assigned Rater

® Mike Ables
® Mike Ables

Luke Kelly

Luke Kelly

Feedback About

a

o &

Luke Kelly

Smokey Bear

Mike Ables

Smokey Bear

Action Status Date Completed
Not Started
Complete Jan 31, 2022
Cancelled
In Progress

Cancel Action

View Feedback
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Private Proficiency Rating

GENERAL INSTRUCTIONS.

Please give this person a candid rating on their actual proficiency level, so they can
identify what areas they need to work on. This rating wil only be visible to you and the
person you'e rating, and not used for formal evaluation.

Feedback about

Resuts wil be visible to
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Proficiency Rating

Please give this person a candid rating on their proficiency level, 5o they can identiy what areas they need to work on. This rating will only be visible t0 you, the person
‘who requested feedback, the person being rated, and their manager.

FradbackAbos P—

o) o avies son, 2022 View Feadback

§ roen S
Luke Kelly sz, 222 View Fasdback

Give Feedback
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Curtis Simms.

interoperability

marketing management

consuling

cAm

interoperability

‘The abilty of computer systems or software to exchange and make use of information with
other systems.

Please rate your proficiency with: nteroperabilty

Do not have this skil
Novice

Beginner
Intermediate
Advanced

Wizard

Comment

ors00

Ext
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Self Rating on Interest

GENERAL INSTRUCTIONS

Answer two quick questions so that you can track your skill improvement over time and
get more personalized development recommendations and career advice. You'll ate.
how much you enjoy using it and how interested you are in developing that skill

Results will be visible to

’ Jon Lolley
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tax
A taxis a financial charge or other levy imposed upon a taxpayer (an individual or

legal entity) by a state or the functional equivalent of a state to fund various public
expenditures. A failure to pay, or evasion of or resistance to taxation, is usually

Show More

Please rate how much you enjoy using: tax

Don't enjoy at all

Don't enjoy very much

Neutral

Somewhat enjoy.

Enjoy very much

Please rate how interested you are in developing: tax

Not at all interested

Not very interested

Neutral

‘Somewhat interested

Very interested
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tax

Ataxis a financial charge or other levy imposed upon a taxpayer (an individuzl or legal
entity) by a state or the functional equivalent of a state to fund various public
expenditures. A failure to pay, or evasion of or resistance to taxation, is usually

Show More

Please rate your proficiency with: tax

Do not have this skill

Novice

Beginner

Intermediate

Advanced

Expert
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Your rating is saved

Proficiency Ratings: tax

Intermediate Expert

@ser
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Create New Request

Request Feedback

Request skill ratings from people in your organization so that you can get a
fuller picture on where you stand. You will be able reuse this same request
later on to get additional ratings and track your improvement over time.

Who is this feedback about?

Myself v
Select a format

(®  Request Private Feedback.

Request someone to provide private feedback about you. This feedback will only
be visible to you and the person providing feedback.

(O private proficiency Rating

Please give this person a candid rating on their actual proficiency level so they
can identify what areas they need to work on. This rating wil only be visible to
you and the person you'e rating, and not used for formal evaluation.

(O Proficiency Ratings shared with your Manager

Please give this person a rating on their proficiency level, so they can identify
what areas they need to work on. This rating wil be visible to you and the person
you'e rating, and their direct manager

Visbity: Rater, You

Feedback Preferences

Select skills

nan effor to promote engagement and responses, please limit selections to no more than 15 ftems.

Q

07250

0sils selected

* Create a Request Name

“This name i for your reference only and it wil not be displayed to the people who receive the 0/ 100
request

After you creste the request you will receive a personalized lnk that you can share with whomever
You wantto rate your sl
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Skill Details

SKL-516

budgets

Finance

Read budget plans, analyse the expenditures and incomes planned during
certain period, and provide judgement on their abidance to the general plans of
the company or organism

€

Ratings

No ratings available

Novice Virtuoso

Rate Proficiency (shared publicly)
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ersal Profile General Prefere

Pages

Define the order, page file and page descripton for each page in the Universal Profile. Order can be configured by cragging and dropping each fow on the page.
“The row at the t9p ofthe lstwillbe the default page that 3 user wil see when navigating o their own Universal Profle.

Page Title Description

Feedback [Feedbsck —

o/ Desgn | <> HTML

Transciipt To configurethe name of Transeript, lesse goto Adrin > To configure the descripton of Transerip, please go'to Admin >
Preferences > Transcript Prefercnces. Preferences > Transeript Preferences.

My Team Dropdown

Enable and configure which reationships display n the My Team dropdown and the it that displays fo each reafionship. When the manager reationship s
‘enabled, managers wil be able o see their irect and indirect tesm. For other employee relationships (ex. Approver),only irectrelsionships are available.

Enable Dropdown : [V}

Add Relatonship: [aea]
Employee Relationan Dropdoun Dispey Tite e ——

vereer )

] overwrite custom settings for all chiid Divisions. To apply new options, you must reset all o the subordinate Divisions' preferences. Ifhis is not checked, the
preferences will only apply 1o new Divisions which are created.
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Critical skills ©

BELOW EXPECTATIONS 12

R Defining Goals

Java Development -+

Accessibilty

HTM

Interaction Design

R Communication

[——

User Experience Design

EXPECTATIONS MET 21

ABOVE EXPECTATIONS 2

Your proficiency

Guiding

Learning

Guiding

Learning

Guiding

Guiding

Learning

Guiding

Learning

Guiding

Expected proficiency

Expert

Applying

Expert

Applying.

Expert

Expert

Applying.

Expert

Aoplying

Expert

1= Status.

Above expectations.

Expectations met

Above expectations.

Expectations met
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People Matrix

Atool to help you visualize and better understand the qualifications of your people

Hi Cornerstone, let’s get you all set up





image159.png
People Matrix

Atk 1oy v i etrecrstand the usbcstons o vour e

Team Matrices (12)

Core skt Mt ) W Targs
Oetned

Tk ot 40

@1 Ow A2

pr—

s
T e 0151

@1 Qs A2

Coe Sl Mot Wih O Targets -
wsining
s

T
Dbt

Core Skt Mt No Targets Detned

T 1)
Tk e 1

@0 @ A0

[T —
waene

saway
e

QDo Os Ao

LR ———

ey
To e 51

@0 @s Ao

°

o

RN ——

ek tmtoes 5

A Team s St ety

@1 02 &2

[E———

[rpe—

@4 @u Ao

A Toam mat_Traing ooy

@1 @« Ao





image160.png
Create Matrix

How would you ke to proceed?

Create new
Build your own matrix from scratch

OR

o Use a template
Save time by utilizing an existing capability model
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Create Matrix

Step 1 - Select Team

Choose users to display in the matrix. By default,your team will be pre-selected. The matrx s limited to 1,000 users.

My Team Matrix

Search Users

[ emoresa

Charies Cook

[ cnersaie Ty User
Offcer

[ swanirews Type: Use

Manager: Jon Loley

Manager: Jon Loley

AddOUs

[ e st

(O o sbordirates

(O e Sstes
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Create Matrix

‘Atool to help youvisualize and better understand the qualification o your people.

Step 2 - Select Skills

Select skils that willbe displayed on the matri for your team. You can add sklls individually or I bulk using capabilty models a the source.

Sechoti [
(@ Ewaviam ] (@ Enoramdoiname

[—

[ sase Copsty e FrfiencyTge L. Erpioees et

Ao Tt

g Gt s s memesae | [T
s [— e N —

Skills Your Team Might Have

“These are skils your team might have based on thelf prof information, sef-ratings, and feedback from others.

- N - |
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Create Matrix

Step 3 - Select Trainings

Select trainings that will be displayed on the matrix for your team.

[ Tack atestversion ofthe rining

Q Startyping to find a raining

p—

Strategy & Businesses Models

This classidentifies the tool adjustments necessary for setting up an accurate CNC operation for
business Includes an Interactive Lob.

Q
‘The key to success? Grit: Angela Lee Duckworth
e S L L

e

Onine Ciase

Ounston

Shours, 30 minues

Remove select
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Create Matrix

Step 4 - Add Rating Source and Title

Add raing source for the skils you have added and  name foryour mtri
* Select defaut rating source

@ tstes g Raing

(O Latest Peer Rating (Average)

() tsesseacng

O oscaatonsony

O Predicted pofiecy

* Add a title to your matrix

My Toam Mat

Add a description
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Create Matrix

Add capability model and rating source

Add a capability model and the defaultrating source to be used. Here you can also add a name.
and description to your matri.

Capability Model
‘Selectmodel v

 Selctdeaut ratig source
@ Lot Mo g

(O Ltest Peer Rating (Average)

O tatestSeratig

7) Declarations Only.
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Nursing Matrix Model

Consumes Nursing capability matrix
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Compensation Summary

No score avalable

Jon does not have any avaiable
compensation widget cata.

View Team 3

Development Plan Progress

0%

Development Plan 2017
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Compensation

5,562.50 USD

Merit Increase

8,039.06 USD

Performance Bonus

5,562.50 USD

Team Bonus

500 Shares
RSA

116,812.50 USD

Current Salary
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Core Competencies
‘Assessment
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Feedback

o e e

’ Feedback Request

.14 ke to hear your thoughs on my latest projec..
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PERFORMANCE

Complete Self Annual Review
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o

Inputting this information is entirely voluntary. This data i only accessed by authorized individuals and will never be distributed to another party.

Jon Lolley

Central
Accountant

Career Preferences





image184.jpeg




image185.png
My Badges

Al

Mind-blowing Mentor

Appreciation

View Team &5

2
N2





image186.png
Competency Ratings

Sort By: Rating ~

Core Competency Assessment for 2011
Status: Not Started Due Date 12/31/2011

Job Specific Competency Assessment
Status: Not Started Due Date 12/31/2011

View Team 3

o5 ¥

o5 ¥
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Development Plan

% SortBy: Create Date ¥ | Dispiay Cancelled Pans

Sales Manager Plan for Promotion
Due Date:3/15/2017 Status: Past Due Created : 6/15/2017

Primary Plan
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Due Date:3/15/2017 Status: Past Due Created : 6/15/2017

Hide Compieted and Past Due Plans
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Development Plan View Team 3 | | ==

Primary Plan
Improve Writing Skills 7
Due Date : 7/3/2018 _ Status : In Progress  Created : 4/4/2018
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Resume Attachments

V Sales Metrics.xlsx
Upload Date: Uploaded By:
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Upload Date: Uploaded By:
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Sample Computer Setup Request Form

Pending Approval.

First Name
Tonie

Last Name
Wan

Last Hire Date

5/19/2015
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Delete
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COLOR CODE

Users and successors can be color coded by specific rating scale metrics on this step. I successors are to be colr coded by the rating scale metric,then that
rating scale meric should be incuded i the Successor Information secton above and not be set to Read Only.

Successors: Impactofloss v &
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SUCCESSOR AND USER SUCCESSION SECTIONS

[ Succession Information by Incumbent - List of the incumbents the user his been named as a successor for.
0 Succession information by Position - List all the positions the user has been named as a successor for

] User Successors - List potential successors for the selected user

[ Postion Successors - List potential successors or the selected user's positon

Maximum Successors: [T Jatouec
Recommend Successors:
Talent Search for Successors:
External Successors:

] Recommend suscessors based on job profes. Enable this option i ob profis e implemented i the system.

[ Search for successors using the Talent Search interface. Users must also have the Candidate Search permission.

[ Extemal Successors can be added as successors.
Rate External Successors: [ Extemal Successors can be rated as successors on mefrics included in Successor Information.

User Search for Successors: [ Search for suzcessors using User Search.
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View Team 3

Users 4 Add successors ~
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Customer Senice.. Maketing Manager Computer Support..
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~
Action Changed From Changed To User Changed By Task Date
Potentil Modified NA Medium Kelle Pauley 127412013
Impact of Loss Modified  N/A High Kelle Pauley 127412013
Readiness Modified N/ Ready Now Kelle Pauley 127412013
Performance Modified /A High Kelle Pauley 127412013
Probability of Loss Mod... N/A Low Kelle Pauley 127412013
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Action Changed From _ Changed To User Changed By Task Date
Successor (Usen) A Curtis Simms Jon Lolley 2017 Talent Review 4/2/2017
Successor (Usen) A.. Claire Smith Jon Lolley 2017 Talent Review  4/2/2017
Successor (Usen) R... Curts Simms Jon Lolley 2017 Talent Review 4/2/2017
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